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Preface

Brief description
This document is part of the SIMOCRANE CMS product package. It describes the structure and 
functionality of SIMOCRANE CMS based on SIMATIC WinCC and the SIMOCRANE CMS 
AddOn package. With SIMOCRANE CMS, SIMATIC WinCC is expanded with specific 
functions of a crane management system.

The scope of functions offered by SIMOCRANE CMS include:

● Graphical visualization of the crane

● Alarm/event system and support for diagnostics

● Replay function: past crane events (historical data) are replayed on the familiar CMS user 
interface

● Measured value acquisition of diverse crane data

● Acquisition and analysis of move data

● Acquisition and analysis of operating hours and counters

● Process data interfaces to various automation systems

● Standard interfaces to higher-level logistics systems

● Evaluation of operating data and acquisition and evaluation of downtimes, Gantt and bar 
charts

The user interface is structured according to user groups and offers different users the 
information and functions they require for their work.

Example applications are also supplied in the CMS add-on package as a basis for configuring 
a CMS station. The example application includes the functions of the crane management 
system described above. This document describes how the example applications can be 
adapted to various project requirements.

Note

We recommend that projects are configured on the basis of example applications. 

Demarcation
SIMOCRANE CMS provides various tools for implementing the required CMS functionality for 
all types of crane applications. It is not a ready-to-run crane management system. The 
functional scope must be configured and planned specifically for the system with the CMS 
system configuration.

Crane Management System (CMS)
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Area of application
The system is designed for use on cranes and for harbor and industrial environments. 
SIMOCRANE CMS, as the SCADA product, used enables adaptation to the most varied 
applications. Scalability permits the building of simple CMS single-user systems up to and 
including complex CMS/RCMS configurations (multi-user systems) in IT infrastructures.

Target groups and level of knowledge
This document addresses the following target groups:

● Sales & Marketing

● Engineering

● Commissioning engineers

● End users

The target groups engineering and commissioning engineers require sound knowledge of 
SIMATIC WinCC.

Additional Information

Siemens product support
You can find the latest information about SIMATIC WinCC products, product support, and 
FAQs on the Internet here (https://support.industry.siemens.com/cs/document/109746335).

You will find information on WinCC as a SCADA system here (http://
support.automation.siemens.com/WW/view/en/10805583/133200).

You will find the latest information on SIMOCRANE products, product support, and FAQs on 
the Internet here (http://support.automation.siemens.com/WW/view/en/10807397/130000). 

Crane application notes can be found on the Internet:
here (http://support.automation.siemens.com/WW/view/en/48342008/136000)

Siemens product support for SIMOCRANE
The following addresses provide support for your SIMOCRANE products:

● Support request on the Internet:

– http://support.automation.siemens.com

● Europe hotline

– Phone: +49 (0) 911 895 7 222

– Fax: +49 (0) 911 895 7 223

– Email: support.automation@siemens.com

Preface
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● America hotline

– Phone: +1 423 262 5710

– Fax: +1 423 262 2231

– Email: support.america.automation@siemens.com

● Asia/Pacific hotline

– Phone: +86 10 6475 7575

– Fax: +86 10 6474 7474

– Email: support.asia.automation@siemens.com

Application support for SIMOCRANE
For additional customer-specific requirements and applications, please contact the following e-
mail address:
applications.cranes.aud@siemens.com

Further assistance
We also offer courses to help you familiarize yourself with SIMOCRANE CMS and its principle 
operation. You will find further information here:
applications.cranes.aud@siemens.com

If you have any additional questions, please contact your local Siemens sales office.

Preface
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Fundamental safety instructions 1
1.1 General safety instructions

WARNING

Danger to life if the safety instructions and residual risks are not observed 

If the safety instructions and residual risks in the associated hardware documentation are not 
observed, accidents involving severe injuries or death can occur.
● Observe the safety instructions given in the hardware documentation.
● Consider the residual risks for the risk evaluation.

WARNING

Malfunctions of the machine as a result of incorrect or changed parameter settings

As a result of incorrect or changed parameterization, machines can malfunction, which in turn 
can lead to injuries or death.
● Protect the parameterization against unauthorized access.
● Handle possible malfunctions by taking suitable measures, e.g. emergency stop or 

emergency off.

WARNING

Malfunction due to uncontrolled changeover between operating states

Uncontrolled change of the operating state can cause malfunctions on machines that can 
result in injuries or death.
● Assess the effects of changeover between operating states in the risk analysis.
● Provide appropriate safety measures, e.g. EMERGENCY OFF.

Crane Management System (CMS)
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1.2 Warranty and liability for application examples
Application examples are not binding and do not claim to be complete regarding configuration, 
equipment or any eventuality which may arise. Application examples do not represent specific 
customer solutions, but are only intended to provide support for typical tasks.

As the user you yourself are responsible for ensuring that the products described are operated 
correctly. Application examples do not relieve you of your responsibility for safe handling when 
using, installing, operating and maintaining the equipment.

Fundamental safety instructions
1.2 Warranty and liability for application examples
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1.3 Industrial security

Note
Industrial security

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Products and solutions from Siemens constitute one element of such a 
concept.

Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the Internet if and to the extent such a connection is necessary and 
only when appropriate security measures (e.g. using firewalls and/or network segmentation) 
are in place.

For additional information on industrial security measures that can be implemented, please 
visit:

Industrial security (https://www.siemens.com/industrialsecurity)

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they become 
available, and that only the latest product versions are used. Use of product versions that are 
no longer supported, and failure to apply the latest updates may increase customer’s exposure 
to cyber threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed at:

Industrial security (https://www.siemens.com/industrialsecurity)

Further information is provided on the Internet:

Industrial security (https://www.siemens.com/industrialsecurity)

Fundamental safety instructions
1.3 Industrial security
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WARNING

Unsafe operating states resulting from software manipulation

Software manipulations, e.g. viruses, Trojans, or worms, can cause unsafe operating states 
in your system that may lead to death, serious injury, and property damage.
● Keep the software up to date. 
● Incorporate the automation and drive components into a holistic, state-of-the-art industrial 

security concept for the installation or machine.
● Make sure that you include all installed products into the holistic industrial security concept.
● Protect files stored on exchangeable storage media from malicious software by with 

suitable protection measures, e.g. virus scanners.
● On completion of commissioning, check all security-related settings.
● Protect the drive against unauthorized changes by activating the "Know-how protection" 

converter function.

Fundamental safety instructions
1.3 Industrial security
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System requirements 2
The selection of the hardware must take into account the local ambient conditions at the place 
of installation. A version suitable for the EMC and vibration stresses of an industrial 
environment is strongly recommended for installation on a crane.

Network

Note

The SIMOCRANE CMS / RCMS may only be operated in trusted networks that are protected 
by firewalls.

Note

Operation of the WebNavigator Client via W-LAN can only be ensured for the SIMATIC Mobile 
Panel PC 12".

Virus scanner
The SIMOCRANE CMS software was tested and released with the following virus scanner:

For Windows 7 (CMS computer on the crane): 

● McAfee® VirusScan® Enterprise 8.8 

● Microsoft Windows Defender (version of the installed operating system)

For Windows 10 (CMS computer on the crane): 

● McAfee® Endpoint Security 10.6.1 (Win10 Version 1809 or higher) 

● Microsoft Windows Defender (version of the installed operating system)

For the remote PC for remote access (WebUX or web navigator): 

● McAfee® WebAdvisor®

● (option) Microsoft Windows Defender (version of the installed operation system)

The virus scanner must be set to meet the requirements of the security functions of the 
SIMATIC/SIMOTION/SINAMICS systems.

Crane Management System (CMS)
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See also: Virus scanner (https://support.industry.siemens.com/cs/mdm/108862708?
c=67032977035&lc=en-WW)

WARNING

INDUSTRIAL SECURITY – system fault due to virus scanner

The automatic deletion or repair of infected files can result in system faults and in potentially 
dangerous crane motions.

The virus scanner must be set such that detection of a virus is reported without automatic 
repair or deletion of the files.

Note
Notes on the use of virus scanners on WinCC stations
● Deactivate the integrated firewall of the virus scanner or do not install it.
● Do not perform manual or time-controlled scans in runtime operation.
● Only monitor incoming data traffic with the automatic scan.
● Only scan local drives.
● Activate the e-mail scan only on WinCC engineering stations.
● Deactivate the display of dialog messages.

Operating system
The SIMOCRANE CMS software was tested and released with the following operating systems:

● Windows 7 SP1 (64 bit, Enterprise/Professional), MUI (Multilingual User Interface), system 
language English, US

● Windows 10 (64 bit, Enterprise/Professional), MUI (Multilingual User Interface), system 
language English, US

Note
Industrial Security

It is recommended that SIMOCRANE CMS / RCMS is only used with an operating system, 
where all system users are password-protected against unauthorized access.

The operating system should always be kept up to date. Customers are responsible for 
installing operating system patches. To determine the compatibility of these patches, contact 
Siemens product support for SIMOCRANE.

Note

Also check on the SIEMENS Industry Online Support site, which Microsoft patches and 
versions have been tested for SIMATIC WinCC.
Tested Microsoft patches: (https://support.industry.siemens.com/cs/document/18752994)

System requirements
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CMS computer on the crane (software)
● SIMATIC WinCC V7.4 SP1 Update 11: 

Installation of SIMOCRANE CMS requires SIMATIC WinCC. 
The license and the installation program of SIMATIC WinCC are contained in the 
SIMOCRANE CMS product package.

Note

You may install more recent updates for SIMATIC WinCC V7.4 SP1 Update 11, but you 
must not install any service pack other than SP1!

● PH-Ready 2014 SP3 
Only for CMS in conjunction with the SIMATIC Process Historian.
"PH-Ready" is a SIMATIC WinCC module. You will find it on the SIMATIC Process Historian 
installation DVD.

● Automation License Manager V5.3 SP3 Update 3

● SIMOCRANE CMS V 4.4 SP3

Optional software:

● WebNavigator server
The installation program of the WebNavigator server forms part of the WinCC installation.

● WebUX server
The installation program is contained in the SIMOCRANE CMS product package.

● Performance Monitor V7.4 SP1

● X-Tools V4.04 SP1

● SIMOCRANE LTRC V1.4

Note

The hard disk requirement for this option must be considered in addition.

CMS computer on the crane (hardware)

CMS Lean & CMS Advanced without PMO
The minimum requirements apply as follows for SIMOCRANE CMS with the SIMOCRANE 
CMS example application "Lean" and the optional WebNavigator:

● Processor: Intel Core i3 or higher

● Main memory: at least 4 GB

● Hard disk: at least 160 GB (preferably more)

● Drives: DVD ROM drive

System requirements
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CMS Advanced with PMO
The minimum requirements are as follows for SIMOCRANE CMS with the SIMOCRANE CMS 
example application "Advanced" – and the options "WebNavigator" and "Performance Monitor 
Server":

● Processor: Multi-core CPU; 3.5 GHz

● Main memory: 16 GB

● Hard disk: 2 x 1 TB (preferably more)

● Drives: DVD ROM drive

CMS Lean & CMS Advanced with X-Tools
The minimum requirements are as follows for SIMOCRANE CMS with the SIMOCRANE CMS 
example application "Advanced" and the options "WebNavigator" and "Fast Trace" with 
installed "X-Tools" on the CMS computer:

● Processor: Multi-core CPU; 3.5 GHz

● Main memory: 8 GB

● Hard disk: 2 x 1 TB (preferably more)

● Drives: DVD ROM drive

CMS Lean & CMS Advanced with X-Tools
The minimum requirements are as follows for SIMOCRANE CMS with the SIMOCRANE CMS 
example application "Advanced" and the options "WebNavigator", "Performance Monitor 
Server " and "Fast Trace" with installed "X-Tools" on the CMS computer:

Note

Using SIMATIC WinCC with Performance Monitor and X-Tools on the same computer, utilizes 
a lot of resources and can mean, for certain applications, that there is not enough computer 
performance available.

For high quantities of data that are processed by X-Tools, we recommend that X-Tools is 
installed on a separate computer, and this computer is then exclusively used for X-Tools.

The hardware requirements for X-Tools are listed in the X-Tools User Manual 01, 
"Introduction": 
See: CMS X-Tools V 04.03 User Manual, Release Notes and Change Log (https://
support.industry.siemens.com/cs/de/en/view/109483230)

● Processor: Multi-core CPU; 3.5 GHz

● Main memory: 16 GB

● Hard disk: 4 x 1 TB (preferably more)

● Drives: DVD ROM drive

System requirements
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CMS Lean & CMS Advanced with X-Tools and LTRC
The minimum requirements are as follows for SIMOCRANE CMS with the SIMOCRANE CMS 
example application "Advanced" and the options "WebNavigator", "SIMOCRANE LTRC" and 
"Fast Trace" with installed "X-Tools" on the CMS computer:

● Processor: Multi-core CPU; 3.5 GHz

● Main memory: 16 GB

● Hard disk: 2 x 1 TB (preferably more)

● Drives: DVD ROM drive

Remote PC for remote access
The minimum requirements are as follows for a remote PC (WebNavigator Client and 
SIMOCRANE CMS client) for remote access to CMS stations:

● Processor: Intel Core i3 or higher

● Main memory: at least 4 GB

● Hard disk: at least 160 GB (preferably more)

● Drives: DVD ROM drive

● WebNavigator Client
The installation program is contained in the SIMOCRANE CMS product package.

● Web browser:  Internet Explorer 11

See also
General information about backward compatibility (Page 370)

Installation (Page 87)

System requirements
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Security features and recommendations 3
3.1 Secure network design

3.1.1 Network access protection
Customers are solely responsible for preventing unauthorized access to their plants, systems, 
machines and networks. 

Such systems, machines and components should only be connected to an enterprise network 
or the Internet if and to the extent that such a connection is necessary and only when 
appropriate security measures (e.g. firewalls and/or network segmentation) are in place.

In order to protect plants, systems, machines and networks against cyber attack, Siemens 
industrial security functions can be incorporated into a customized industrial security concept.

You can find more information about the industrial security functions of SIMATIC/SIMOTION/
SINAMICS under:

● SINUMERIK / SIMOTION / SINAMICS Industrial Security (https://
support.industry.siemens.com/cs/ww/en/view/108862708)

● Security for SIMATIC S7 controllers (https://support.industry.siemens.com/cs/ww/en/view/
90885010)

● Security concept PCS 7 & WinCC (https://support.industry.siemens.com/cs/ww/en/view/
60119725)

● SIMATIC Process Historian 2014 SP3 System Manual (https://
support.industry.siemens.com/cs/ww/en/view/109771899), Chapter 1.2.2 "Security 
settings"

● SIMATIC Process Historian 2014 SP3 System Manual (https://
support.industry.siemens.com/cs/ww/en/view/109771899), Chapter 1.5 "Firewall settings"

Also check the SIEMENS Industry Online Support site to find out which Microsoft patches have 
been tested for SIMATIC WinCC.

Tested Microsoft patches (https://support.industry.siemens.com/cs/document/18752994)

3.1.2 Firewall
The SIMOCRANE CMS / RCMS may only be operated in trusted networks that are protected 
by firewalls. 
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When starting "CMSRuntime.exe" with the firewall of the CMS station activated for the first 
time, "CMSRuntime.exe" must be added to the white list.  
See: Activation of the communication port (CMS with RCMS (WinCC)) (Page 379)

Note

Only enable the required ports. 

Any unnecessarily open ports pose a security risk.
See: Recommendation for system hardening (Page 31)

Security features and recommendations
3.1 Secure network design
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3.2 Identity and access management

3.2.1 Account management and configuration of access rights and other privileges

User groups in the CMS application
In the delivered WinCC project of an example application, a distinction is made 
between four user groups. Different rights are assigned to these user groups for the CMS user 
interfaces:

● Crane operator ("Operator")

● Maintenance personnel ("Maintenance")

● User whose primary objective is to evaluate operating data ("Management")

● Administrator

Additionally, the customer can add new user groups and adapt existing user groups. 
You can find more information about user groups under: User groups (Page 263)

User groups in the CMS configuration editor
When starting the CMS Editor, a distinction is made between two user roles with different rights. 
These roles are based on Windows user groups.

● User
The "User" role is automatically assigned to anyone who starts the CMS Editor. 
The user's rights are restricted to the following functionalities: 

– Parameterization functions for creating and maintaining reference types 

– Changing symbols  

– Adapting displayed message details in the CMSFaults Control 

● CMS Administrator
A "CMS Administrator" must be a member of the Windows user group "CMSAdmin". 
This role has unrestricted access to the functions of the CMS Editor.

3.2.2 Authentication mechanisms

WinCC authentication
WinCC has integrated users. WinCC offers an authentication mechanism for these users. The 
menu of WinCC Runtime changes depending on the user group. 
For further details, please refer to:
WinCC V7.4 SP1 Working with WinCC  (https://support.industry.siemens.com/cs/document/
109746340) (Chapter 14 "Setting up user administration") 

An automatic user logoff function is available in WinCC, but it is not activated. If you activate this 
feature, it allows you to avoid situations where unauthorized persons could gain access to 

Security features and recommendations
3.2 Identity and access management
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specific functions should the logged-on user forget to log off. 
For further details, please refer to:
WinCC V7.4 SP1 Working with WinCC  (https://support.industry.siemens.com/cs/document/
109746340) (Chapter 14.5 "Configuring automatic logout")　 

SIMATIC Logon enables central and system-wide user administration. This simplifies system 
validation for access protection pursuant to FDA 21 CFR Part 11. 
For further details, please refer to: 
WinCC V7.4 SP1 Working with WinCC  (https://support.industry.siemens.com/cs/document/
109746340) (Chapter 14.5 " Central user administration with SIMATIC Logon")　

CMS configuration editor
The CMS configuration editor features an authentication mechanism. The user has different 
rights depending on the user group. 

Authentication is managed via Windows user accounts and Windows user groups.

3.2.3 Management of IDs and login credentials
● Login credentials for the CMS application are managed by WinCC.

Note

Passwords can be changed in the WinCC Editor "User Administrator".

● Login credentials for the CMS configuration editor are managed via Windows user accounts 
and Windows user groups.

Security features and recommendations
3.2 Identity and access management
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3.3 System integrity protection

Patch management
The CMS is patched by means of updates. 

Control system backup and restoration
● CMS configuration data can be restored via backup files. 

It is recommended to regularly create CMS backup files. 
See: Recommendation for system hardening (Page 31)

● WinCC archives can be restored via backup files. 
See: WinCC V7.4 SP1 Working with WinCC  (https://support.industry.siemens.com/cs/
document/109746340) (Chapter 6.4.8 "Archive backup") 

● WinCC configuration data can be restored via a backup of the WinCC project file.

Security features and recommendations
3.3 System integrity protection
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3.4 Secure logging and monitoring

3.4.1 Monitoring and viewing CMS log files

CMS
The CMS log files can be opened via a shortcut menu command (right-click the icon displayed 
in the system tray) when WinCC Explorer is started or the WinCC Runtime is running. 

You can find more information under: System: Basic settings (Page 213)

Replay function 
 A log file is created in the WinCC project directory under ...\CMS\Replay. Events from Replay 
Runtime and the Replay Configuration Editor are entered here. 

WinCC
WinCC log files are available. 
See: WinCC V7.4 SP1 Working with WinCC  (https://support.industry.siemens.com/cs/
document/109746340) (Chapter 1.12.5 "File structure of a project")

3.4.2 Logging of security-related events
You should configure your operating system and the firewalls in such a way that certain events 
(for example, failed login attempts) are recorded. 
See: Recommendation for system hardening (Page 31)

Evaluating the log files at regular intervals will allow you to detect attacks on the security of your 
system at an early stage, for example unauthorized attempts to access a computer or attacks 
from the outside.

Security features and recommendations
3.4 Secure logging and monitoring
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3.5 Recommendation for system hardening
None of the points mentioned in this chapter can guarantee one hundred percent security. 
Many different aspects must be considered to protect a complex system. This chapter 
describes some important aspects which can additionally protect the network.

Following the instructions in the SIMATIC NET SCALANCE manual
● Follow the instructions in the SCALANCE manual. 

SIMATIC NET Industrial Ethernet Security SCALANCE S615 Web Based Management 
(https://support.industry.siemens.com/cs/document/109751632/) (Chapter 2 "Security 
recommendation")

Adapting the computer properties of WinCC
● You can make most of the security settings in WinCC Explorer under "Computer settings".  

See: PC configuration of the CMS station (Page 402) 

Using a virus scanner
● Use an appropriate virus scanner.

See: System requirements (Page 19)

WARNING

INDUSTRIAL SECURITY – system fault due to virus scanner

The automatic deletion or repair of infected files can result in system faults and in potentially 
dangerous crane motions.

The virus scanner must be set such that detection of a virus is reported without automatic 
repair or deletion of the files.

Note
Notes on the use of virus scanners on WinCC stations
● Deactivate the integrated firewall of the virus scanner or do not install it.
● Do not perform manual or time-controlled scans in runtime operation.
● Only monitor incoming data traffic with the automatic scan.
● Only scan local drives.
● Activate the e-mail scan only on WinCC engineering stations.
● Deactivate the display of dialog messages.

Security features and recommendations
3.5 Recommendation for system hardening
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Using an appropriate, up-to-date operating system
● Only use an appropriate operating system. 

See: System requirements (Page 19) 

● The operating system should always be kept up to date.  Customers are responsible for 
installing operating system patches.  Please contact Siemens Support for SIMOCRANE to 
find out whether these patches are compatible - applications.cranes.aud@siemens.com

Note

Also check the SIEMENS Industry Online Support site to find out which Microsoft patches and 
versions have been tested for SIMATIC WinCC.

WinCC-approved security patches can be installed for CMS/RCMS as well.  
We recommend using a backup system for prior testing. 

Tested Microsoft patches (https://support.industry.siemens.com/cs/document/18752994)

Monitoring and restricting access to computers and systems
● Restrict access to the computers.  

Keeping the computers in a locked computer room subject to access control can 
significantly reduce the risk of unauthorized intrusion into the network. 

● Remove unnecessary network shares for directories. 

● Password-protect your operating system against unauthorized access. 

● Only use individual user accounts. 
Never use accounts shared by several users. 

● Activate the password-protected screen saver.  
We recommend that you use the default Windows screen saver. 

● Users shall only be granted rights which are absolutely necessary for their tasks (for 
example, only the administrator is entitled to install software or delete Windows events). 

● If not absolutely necessary for operation, only the administrator shall have the rights 
required for connecting USB devices. 

● Disable any services that are not required.

Activating the auto log-off function of WinCC
Activate the automatic log-off function of WinCC to avoid situations where unauthorized 
persons have access to particular functions should the logged-on user forget to log off. For 
further details, please refer to:

WinCC V7.4 SP1 Working with WinCC  (https://support.industry.siemens.com/cs/document/
109746340) (Chapter 14.6 "Configuring automatic logout")

Security features and recommendations
3.5 Recommendation for system hardening
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Using secure and secret passwords
● The password directives must be set very restrictively and comply with the following 

minimum requirements: 

– The minimum password length is 8 characters. 

– The password must include uppercase and lowercase letters, numbers, and special 
characters. 

– Passwords must be changed at least every 90 days. 

● Ensure that the passwords are only known to the intended users. 
If in doubt, for example after commissioning, change the passwords and instruct the user to 
change the password that has been issued to him or her as soon as possible. 

● Do not save the password in the browser.

You can find notes regarding assigning and handling passwords here:

● Computer Emergency Response Team (CERT) (Choosing and Protecting Passwords) 
(https://www.us-cert.gov/ncas/tips/ST04-002)

● SINUMERIK / SIMOTION / SINAMICS Industrial Security ((https:// 
support.industry.siemens.com/cs/ww/en/view/108862708))

Restricting open firewall ports
Any unnecessarily open port is a security risk! 

● Only open the required firewall ports. 

● If you use a RCMS version that is older than v4.4, you have to enable firewall ports on the 
CMS station to allow communication with a WinCC-based RCMS server. The same port 
must also be selected on the RCMS.  
For configuration details, please refer to: Setting of the firewall port (CMS with RCMS 
(WinCC)) (Page 380) 

● The WinCC WebNavigator server / WinCC WebUX server requires an open port on the 
CMS station for remote access.  
Port "443" is set as default by IIS. This setting can be configured in IIS.  
See: Setting up the SSL certificate for remote access (Page 299)

● CMSFaults Control from the WinCC WebNavigator client requires the open port "24942" on 
the CMS station.

Activating firewall log files
● Activate the log files of the firewall to be able to log security-relevant events. 

You can find more information in the documentation for your firewall. 
See also: Activation of the log files of the firewall of Windows 7, Windows 8, and Windows 
Server 2012 (https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-
server-2012-r2-and-2012/jj717291(v%3Dws.11))
See also: Activation of the log files of the firewall of Windows 10 and Windows Server 2016 
(https://docs.microsoft.com/en-us/windows/security/threat-protection/windows-firewall/
configure-the-windows-firewall-log)

Security features and recommendations
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Activating Windows security event logs
The Windows security event logs are deactivated by default. 

To activate the Windows security event logs, proceed as follows: 

1. Go to Control Panel > Administrative Tools > Local Security Policy.  

2. Click on "Local Policies". Click on "Audit Policy". 

3. Activate event logging. 

According to IEC 62443 3-3, the following events should be logged: 

● Access control 

● Request errors 

● Operating system events 

● Control system events 

● Backup and restore events 

● Configuration changes 

● Potential reconnaissance 

● Activity and audit log events

Keeping installed software up to date.
● Keep the installed software (including the operating system) up to date.  

You need to update the system with security patches. 

● Only install software components which are absolutely required. 
E-mail clients should be avoided. 

Note

Also check the SIEMENS Industry Online Support site to find out which Microsoft patches and 
versions have been tested for SIMATIC WinCC.

Tested Microsoft patches (https://support.industry.siemens.com/cs/document/18752994)

Checking software components and storage media
● Before you install software on a computer, make sure that the software does not include any 

dangerous elements (for example, viruses or Trojans). 

● Only connect data storage devices (CDs and USB sticks) to the computer if you are sure that 
they do not contain any malware.

Using an HTTPS connection for remote access (WebNavigator)
Only permit HTTPS connections for remote access connections (WebNavigator). 

See: Setting up the SSL certificate for remote access (Page 299)

Security features and recommendations
3.5 Recommendation for system hardening
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Storage and import of backup files
● Only authorized personnel should be able to access backup files.  

● Backup files must be stored in an environment with access protection.  

● Only use backup files from sources that you know to be trustworthy.

Security features and recommendations
3.5 Recommendation for system hardening

Crane Management System (CMS)
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SIMOCRANE CMS - an overview 4
4.1 What is SIMOCRANE CMS

SIMOCRANE CMS is a WinCC-based crane management system. It expands the WinCC 
basic system to include crane-specific applications. 

SIMOCRANE CMS includes an editor, which is integrated into WinCC Explorer, and a runtime 
component (CMS Runtime), as well as a runtime component for the Replay function (Replay 
Runtime). Graphic controls are provided in the WinCC Graphics Designer. 

Figure 4-1 The CMS configuration editor

The CMS application provides a comprehensive visualization of the connected crane. It is 
supplied as an example and can be adapted to suit other applications. The user interface is 
designed for operation on touch screens.
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Figure 4-2 Various operator views of the example application for visualizing the connected CMS station

SIMOCRANE CMS provides the following functions:

● Status display of crane components 

● Fault diagnostics and references to fault rectification options 

● Acquisition of move data 

● Calculation of key performance indicators (KPI) and MMBF data 

● Acquisition of load and operating hours counters 

● Evaluation of operating data 

● Reporting 

● Replay and analysis of past events 

● Import/export functions for bulk data configuration

SIMOCRANE CMS can be expanded to include various options and packages:

● SIMOCRANE RCMS
for a web-based remote crane management system 

● SIMATIC WinCC WebNavigator
for remote access to SIMOCRANE CMS via a web client 

● SIMOCRANE CMS Analyzer
for evaluation of crane data 

● SIMOCRANE CMS Fast Trace Viewer
for visualizing fast trace data 

SIMOCRANE CMS - an overview
4.1 What is SIMOCRANE CMS

Crane Management System (CMS)
38 System Manual, 11/2019



● SIMATIC WinCC Performance Monitor
for the calculation and visualization of key performance indicators (KPIs) at the crane 

● PM-Maint
for a maintenance plan system

SIMOCRANE CMS - an overview
4.1 What is SIMOCRANE CMS
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4.2 The components of SIMOCRANE CMS

4.2.1 Overview

Figure 4-3 Design of CMS

The SIMOCRANE CMS product is based on SIMATIC WinCC. It expands the functional scope 
of WinCC to include crane-specific functions, a CMS configuration editor, as well as CMS 
Runtime for the acquisition of crane data. The CMS configuration editor is the configuration 
interface for the CMS station.

The SIMOCRANE CMS application is based on SIMOCRANE CMS and WinCC. It is the 
human-machine interface for the end user. The SIMOCRANE CMS example application 
already covers a high level of functionality. It can be adapted to suit customer-specific 
requirements using the tools of the CMS configuration editor and of WinCC.

4.2.2 SIMATIC WinCC
The SIMATIC WinCC basic software forms the core for the SIMOCRANE CMS crane 
management system. 

SIMOCRANE CMS - an overview
4.2 The components of SIMOCRANE CMS
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The WinCC basic software offers the most important functions of a SCADA system which are 
also encountered in crane applications:

● User administration:
Issuing and checking user access rights both for configuration and the runtime environment. 
SIMATIC Logon integrates itself into the security system and the user administration of 
Windows.

● Visualization:
The WinCC basic software assists with the configuration of bespoke user interfaces by 
providing standard objects in the CMS application. These include, for example, simple 
standard objects, such as lines or rectangles, common graphic objects, buttons, input/
output fields, picture windows, as well as OLE objects and ActiveX controls.

● Alarm/event system:
The alarm/event system records process messages and local events and archives them in 
cyclic archives. The archived messages are displayed in the CMS application by means of 
an integrated ActiveX control. The type of message procedure and archiving can be 
configured.  

● Process value archiving:  
Historical values and value patterns are saved in process value archives. The type of 
recording and archiving can be configured.  

● Reporting:
The WinCC Report Designer is used to save or print data from WinCC in fixed layouts as 
files.

● Bulk data configuration:
Bulk data configuration is possible directly in WinCC.

SIMOCRANE CMS expands the WinCC basic system to include crane-specific features:

● Expansion of WinCC Alarm Logging to include the option of saving additional information 
about messages and displaying them in runtime in the graphic controls 

● Links to various file sources for messages, e.g. references to PDF documents, videos or 
jumps to the STEP 7 editor (provided STEP 7 is installed) 

● Event-controlled acquisition of operating data (move data, counters) from the crane control 
system 

● Past events on cranes can be analyzed using the "Replay" function. The relevant crane data 
are stored in the WinCC archive and can be replayed in Replay mode if necessary. 

● SIMOCRANE CMS Fast Trace Viewer to display fast trace data (acquisition cycle < 
500 ms). 
See also: SIMOCRANE CMS Fast Trace Viewer (optional) (Page 48)

SIMOCRANE CMS - an overview
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4.2.3 CMS configuration editor

Figure 4-4 CMS configuration editor

The CMS configuration editor is the configuration interface for the CMS station. It is integrated 
in the WinCC Explorer. 

The CMS configuration data are stored in separate tables in the WinCC configuration 
database. 

See also: CMS configuration editor (Page 161)

4.2.4 CMS Runtime
CMS Runtime is a stand-alone program without a user interface. Parameterization is 
performed in the CMS configuration editor.

Figure 4-5 Status icon for CMS Runtime in the Windows taskbar

Note

For normal operation, it is recommended that CMS Runtime is started via the WinCC startup list.

Note
Valid license required

CMS Runtime can only be started with a valid license. 

To install licenses, see Transferring a license (Automation License Manager) (Page 93).

SIMOCRANE CMS - an overview
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Tasks of CMS Runtime on the CMS station:
● Provides the required data for the CMS ActiveX objects 

● Monitors trigger tags for acquiring move and MMBF data in WinCC (MMBF = Mean Moves 
Between Failure)  

● Acquires operating data and stores this data in WinCC Tag Logging archives

● Monitors and restores counter values (if the new value of a counter is less than the previous 
value, then this previous value is written back.) 

● Generates system tags in the WinCC tag management on the controller as an interface for 
information in the WinCC Graphics Designer 

● Generates system messages in WinCC Alarm Logging for diagnostic functions

Additional tasks of CMS Runtime on the CMS station in the topology "CMS with RCMS (WinCC)"
The following points only apply to CMS stations in conjunction with RCMS V4.3 SP1.
See also: CMS 4.4 with RCMS server 4.3 SP1 (Page 371)

● Uploads configuration data to an RCMS server 

● Transfers tag values to the RCMS server 

● Generates XML files for the runtime data transfer (acquired operating data, WinCC 
messages) for an RCMS server (data buffer) 

● Transfers XML files to the RCMS server (only RCMS V4.3 SP1) 

● Monitors the used storage volume of the XML files on the PC and provides a disk clean up 
function.

SIMOCRANE CMS - an overview
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4.2.5 CMS application

Figure 4-6 Various operator views of the example application for visualizing the connected CMS station

The supplied applications can be used as a basis for configuring customer-specific systems. 
They are prepared for the following functions by default: 

● Status display of crane components 

● Fault diagnostics and references to fault rectification options 

● Operating data acquisition 

● Calculation of key performance indicators (KPI) and MMBF data 

● Evaluation of operating data 

● Reporting 

● Replay and analysis of past events

The applications "Advanced" and "Lean" are supplied with SIMOCRANE CMS.

● Lean 
This application is designed for use on industrial cranes and for RTG/RMG cranes. 

● Advanced 
This application has an expanded functional scope and is designed for use on harbor 
cranes, such as STS cranes.

SIMOCRANE CMS - an overview
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4.2.6 CMS ActiveX controls
As an open system, WinCC features an interface for ActiveX objects. This allows user-defined 
functions to be added to the function scope of WinCC. CMS ActiveX objects allow access to 
CMS-specific content from WinCC displays.

In order to ensure that these CMS ActiveX objects can still work, even when the 
WinCC Web Navigator is used to visualize the WinCC displays on other computers for 
example, the CMS ActiveX components do not themselves access WinCC data, but instead 
establish the connection to WinCC using CMS Runtime. 

With the CMSFaults control, extended error information is output for the messages from the 
WinCC Alarm Logging. 

4.2.7 SIMATIC WinCC Web Navigator / SIMATIC WinCC WebUX
WinCC Web Navigator and WinCC WebUX extend CMS functionality by providing a remote 
access option. You can use WinCC Web Navigator and WinCC WebUX to operate and observe 
a plant comprising various stations via the Intranet or Internet. This does not require any 
changes to the WinCC project.

WinCC Web Navigator or WinCC WebUX is needed in the crane environment if 

● Remote access to the local CMS station is required.

● other HMI devices besides the electrical room PC are needed on the crane itself (crane 
cabin, checker cabin).

WinCC Web Navigator
The WebNavigator Server is installed on the CMS station in the crane's electrical room. A 
WebNavigator Client can be set up on any Windows PC in the network. The web client allows 
the WinCC project, running on the CMS station, to be operated and visualized from MS Internet 
Explorer. Just like the WinCC basic operator station, virtually all possible displays and 
operations are available to the web client.

WinCC WebUX
The WinCC WebUX server is installed on the CMS station in the electrical room of the crane. 
An HTML5 web browser is required on the remote PC. You also require a WebUX license on 
the CMS station. Just like the WinCC basic operator station, virtually all possible displays and 
operations are available to the web client. 

You can also start the WebUX web client on mobile devices such as tablets or smartphones.

SIMOCRANE CMS - an overview
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4.2.8 SIMATIC WinCC / Performance Monitor (optional)

Figure 4-7 Performance Monitor

You can use the WinCC/Performance Monitor to record and analyze the performance of an 
entire crane system. 

The Performance Monitor was originally developed for machine-oriented or line-oriented 
manufacturing plants but is also easy to use in a crane environment. It is suitable for use on the 
CMS station for evaluating the connected crane.

The Performance Monitor can help to answer the following questions:

● What is the actual performance of a crane compared with the planned performance?

● How is load distributed over the cranes (where is there full load and where no-load 
operation)?

● Why do comparable cranes constantly handle different numbers of containers?

The Performance Monitor acquires downtimes and calculates specific parameters (KPI = Key 
Performance Indicator) so that crane availability and productivity can be increased in the future.

The system offers various display types for analysis results in WinCC Controls. In the example 
application, the following controls are used, for example:

● Gantt chart for overview of operating states of cranes in one overview or over different 
periods

● Bar chart for displaying the key performance indicators, such as availability, performance, 
productivity (containers per hour)
The data can be grouped according to context information.

SIMOCRANE CMS - an overview
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4.2.9 PM-Maint (optional WinCC add-on)
The certified WinCC add-on PM-MAINT is a sector- and technology-neutral tool for 
maintenance planning. 
PM-MAINT is recommended if a project requires this type of functionality. 

Figure 4-8 PM-MAINT certified WinCC add-on

The standard scope of the SIMOCRANE CMS package does not include a maintenance 
planning system. However, it provides all the data required for a system of this kind (e.g. 
operating hours counter). 

PM-MAINT offers both calendar-controlled and event-controlled maintenance of components 
on different single cranes. PM-MAINT therefore assists with the timely maintenance of 
components in order to avoid the cost of premature maintenance or production outage and 
downtimes. 

An import and export function supports the process of configuring bulk data.

Note

Please note the requirements for installing PM-MAINT!

You can find detailed information on PM-MAINT in the relevant product documentation.

SIMOCRANE CMS - an overview
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4.2.10 SIMOCRANE CMS Fast Trace Viewer (optional)
SIMOCRANE CMS Fast Trace Viewer is an ActiveX control, which was developed in order to 
access Fast Trace data from X-Tools. The ActiveX control is embedded in CMS to allow Fast 
Trace data to be displayed.

Figure 4-9 CMS Fast Trace Viewer in the CMS

You can find more information about the SIMOCRANE CMS Fast Trace Viewer in document 
"FAQ_CMSFastTraceViewer.pdf" in folder "SIMOCRANE_CMS_ApplicationExample” on the 
installation DVD.

The required X-Tools software is provided with CMS. The software is used to configure and 
evaluate data, which is analyzed in realtime (online data) – or can be archived for subsequent 
analysis (offline data). X-Tools directly captures the data from SIMATIC S7 and SIMOTION 
controls using suitable software IONs (input-output nodes).

SIMOCRANE CMS - an overview
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Figure 4-10 Configuration with Fast Trace option

4.2.11 SIMOCRANE RCMS web application (optional)
SIMOCRANE RCMS is a web-based Remote Crane Management System.

You can use the RCMS web application to display and evaluate the data of all the connected 
CMS stations. You can, for example, view the operational data of selected cranes, or display 
a general plant overview that shows the current states of the cranes.

SIMOCRANE CMS - an overview
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Figure 4-11 Various operator views for showing the connected CMS stations

The scope of functions provided by the RCMS web application is as follows:

● General plant overview

● Map view of the terminal

● Crane status display

● Fault diagnostics

● Operating data acquisition

● Data analysis across all connected crane systems

● Availability overview

● Start of remote access to a CMS station in the tree structure 

● Tree structure of system with status display and diagnostic data

The RCMS web application consists of an RCMS web server that can be linked to one or more 
SIMATIC Process Historian systems.
The RCMS web clients are connected to the RCMS web server.

SIMOCRANE CMS - an overview
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Figure 4-12 RCMS web server with connected Process Historian and RCMS web clients

4.2.12 SIMOCRANE CMS Analyzer
The SIMOCRANE CMS Analyzer is an application to analyze historical CMS data and to 
generate reports. 
The SIMOCRANE CMS Analyzer either accesses data from the Process Historian database – 
or it directly accesses the WinCC databases of the connected CMS stations. 

Note

SIMOCRANE CMS Analyzer shows the historical data!
The data are not shown in realtime.

Figure 4-13 SIMOCRANE CMS Analyzer

The SIMOCRANE CMS Analyzer offers the following functions: 

● Displays the crane status history 

● Displays the move data

● Displays the load and operating hours counters

● Displays and analyzes the message history

● Calculates MMBF data

● Calculates key performance indicators (KPI)

● Exports data as CSV or PDF file

SIMOCRANE CMS - an overview
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Figure 4-14 SIMOCRANE CMS Analyzer in the network

The SIMOCRANE CMS Analyzer can be installed on any computer in the network that 
complies with the system requirements (see the documentation on the SIMOCRANE CMS 
Analyzer). You can also install SIMOCRANE CMS Analyzer on several computers and operate 
them in parallel. Each SIMOCRANE CMS Analyzer can be connected with the Process 
Historian database and/or with CMS stations. SIMOCRANE CMS Analyzer retrieves its data 
either from the Process Historian database or from the WinCC databases of the CMS stations. 

An up-to-date RCMS license is required on the connected RCMS web server in order to retrieve 
data from the Process Historian database.

You can find more information in the online help for the SIMOCRANE CMS Analyzer.

SIMOCRANE CMS - an overview
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4.3 System design & communication

4.3.1 Internal structure of SIMOCRANE CMS

Figure 4-15 Overview of the components of SIMOCRANE CMS

This diagram shows the components and the communication between the individual 
components of SIMOCRANE CMS:

● The crane control system communicates with the CMS WinCC project via an interface. 

● The CMS configuration editor and the Replay Editor are used for configuring the CMS 
WinCC project and CMS Runtime. The configuration data are stored in the WinCC 
configuration database. 

● During runtime, CMS Runtime communicates with WinCC and the CMS ActiveX controls.
It writes the data into the archive of the WinCC Runtime database.  
In Replay mode, Replay Runtime retrieves the data from the WinCC Runtime database. 

● If the CMS station is connected to a Process Historian, WinCC sends the data to the 
Process Historian. The Process Historian makes this data available to the RCMS web 
server.
The data are stored in a cache to overcome network fluctuations and to ensure data integrity 
("Store and forward"). 

● If the CMS station is connected to a WinCC-based RCMS (4.3 SP1), CMS Runtime writes 
the data into XML files and sends these to the RCMS server.
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4.3.2 Supported controllers and protocols
SIMOCRANE CMS supports various standard communication protocols on the basis of 
WinCC. This means that not only can you connect Siemens controllers to the CMS but also 
controllers from other manufacturers.

Figure 4-16 Communications with the crane control system

SIMOCRANE CMS supports the following communication protocols: 

● TCP/IP 

● PROFINET 

● PROFIBUS 

● OPC

SIMOCRANE CMS supports the following controllers: 

● SIMATIC S7 – 300 

● SIMATIC S7 – 400 

● SIMATIC S7 – 1200 * 

● SIMATIC S7 – 1500 * 

● SIMOTION D 

● SIMOTION C 

● Other 3rd party manufacturers

* References to STEP 7 are possible via TIA Portal Step7. See: References to TIA Portal 
(Page 125)
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4.3.3 Data transfer between the CMS station and the RCMS web application

Figure 4-17 Data transfer between the PLC, WinCC, Process Historian, the RCMS web server, and the RCMS web client

Data from the PLC are continuously transferred to WinCC. SIMOCRANE CMS processes the 
incoming data. 

WinCC sends alarm logging and tag logging data to the Process Historian.  

The RCMS web server receives the data via TCP/IP from the Process Historian database – and 
passes it on to the RCMS web client. The RCMS web client on the user device communicates 
with the RCMS web server via an HTTPS connection.
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4.4 Topology

4.4.1 CMS station at the crane (single-user system / multi-user system)
The CMS station is located in the electrical room of the crane. It can be operated as a single-
user system or a multi-user system with several client stations, e.g. in the crane cabin or in the 
checker cabin.

Figure 4-18 CMS station with CMS clients

In this case, the client stations access the CMS station via the WinCC WebNavigator. 
See: Remote access (Page 287)

4.4.2 CMS stations with RCMS web application (RCMS 4.4 and higher)

Figure 4-19 CMS stations with RCMS web server (RCMS 4.4 and higher)

In a CMS-RCMS (Process Historian) scenario, the CMS stations are connected to the SIMATIC 
Process Historian. They send their operating data and messages to the SIMATIC Process 
Historian, which archives this data.

The RCMS web application accesses the SIMATIC Process Historian database to supply 
operating data and messages for the crane. 
See also: SIMOCRANE RCMS web application (optional) (Page 49)

SIMOCRANE CMS - an overview
4.4 Topology

Crane Management System (CMS)
56 System Manual, 11/2019



4.4.3 CMS stations with RCMS (WinCC) - (RCMS 4.3 SP1 and lower)

Figure 4-20 CMS stations with RCMS station (RCMS 4.3 SP1)

In a CMS-RCMS (WinCC) scenario, the CMS stations are connected to the RCMS server (4.3 
SP1). They send their operating data as XML files. The RCMS server archives this data and 
accesses the archived data. 
See also: CMS 4.4 with RCMS server 4.3 SP1 (Page 371)
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CMS application example 5
5.1 Design of user interface

When designing the CMS user interface on the basis of SIMATIC WinCC, the following aspects 
were especially taken into consideration:

Screen elements
● Symbolic representation instead of realistic graphics:

One design aspect is the use of simple but significant symbols to display screen objects. An 
independent look is presented with a few graphical details.

● Touch operation:
In terms of size, the control elements are large enough that they can be operated in the 
touch mode.

Color concept
The color range offered by the user interface is reduced to a small selection, so that the user 
can quickly distinguish between key events (warnings and faults) and the normal operating 
state.

The color philosophy uses the following color assignments: 

Crane Management System (CMS)
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① Control element: Open details page
② Inactive element: Converter is switched off
③ Dynamic element: Direction of motion
④ Active element: Converter is active
⑤ Warning: Warning for trolley is active
⑥ Faults: General fault active

Figure 5-1 Color philosophy in the CMS

Screen structure
The user interface consists of fixed and dynamic components. The fixed display areas contain 
status and fault displays, which are always visible. The dynamic screen components enable 
navigation through detailed information and operating areas.

The following figure illustrates the structure of the user interface.

CMS application example
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① Primary navigation bar: For toggling between the main CMS menus
② Secondary navigation bar: Screen changeover within main menus (secondary screen con‐

tent)
③ Information bar: Displays important load and position data
④ Operating bar: Activation / deactivation of additional technology functions
⑤ Message line: Displays the current message
⑥ Replay button: Activation / deactivation of Replay mode
⑦ HOME button: Selects the CMS start page

⑧+⑨ Screen content; can be switched using the navigation bar
⑧ Primary screen content: Fixed screen section which is permanently displayed within the main 

menu. Constant primary screen content does not exist in all main CMS menus. 
⑨ Secondary screen content: Variable screen section which is switched over using secondary 

navigation. If there is no fixed primary screen content, all screen content is switched over.
⑩ Group fault bar: Displays general warnings and group faults

Figure 5-2 Screen structure of the CMS user interface

The user can select from three screen levels when switching the screen over. The deeper you 
navigate into the levels, the more detailed the information. Access to detailed information is 
linked to the corresponding user rights.

● Level 1: Switching over the main menus (with or without primary screen content ⑩) using 
the primary navigation bar ②. Each main menu has its own secondary navigation bar.

● Level 2: Switching over secondary screen contents ⑧ using the secondary navigation 
bar ③.

● Level 3: Displaying detail windows. Detail windows can only be accessed with the 
corresponding user rights. The detail windows are displayed using control elements within 
the secondary screen content.

CMS application example
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5.2 User groups
A distinction is made between four user groups and different rights are issued for them for the 
CMS user interfaces: 

● Crane operator ("Operator")

● Maintenance personnel ("Maintenance")

● User whose primary objective is to evaluate operating data ("Management")

● Administrator

Table 5-1 CMS / RCMS user interface user groups

User right User name Description
Crane driving Operator Standard user with few rights. The information dis‐

played focuses on assisting crane operators.
Maintenance Maintenance User with higher-level rights. The information displayed 

focuses on assisting with fault diagnostics and mainte‐
nance.

Manage Management User with higher-level rights. The information displayed 
focuses on the operating data.

Administration Administrator User with unrestricted rights.

Note
Changing the password

After completing the setup, users must change the initially assigned password.
See: Network access protection (Page 25)
See: Changing passwords (Page 264)
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5.3 Condition monitoring
Condition monitoring is simply an indication instrument. The state of the crane components 
along with the most important electrical, mechanical and hydraulic units for crane operations 
are graphically displayed, as are the states of the infeed and technology function components.

The display is prepared such that components and units are easy to recognize. The state of the 
elements is clearly shown by the colors used. Purely static screen objects are shown in gray, 
dynamic elements are blue in normal mode, yellow in a warning state and red in a fault state. 
It is crucial that the critical states can be recognized at a glance by the color alone.

The information displayed should be kept to a minimum. Precisely the information which the 
crane operator or service technician needs to reliably perform his work is normally displayed. 
If necessary, detailed information can be added.

Table 5-2 Status display using a converter as example

Icon Symbol flash‐
es

Description

- Converter inactive / off

Converter ready to start

- Converter active / on

- Converter warning

- Converter fault

An overview display shows the crane overview with the crane's main movements. The following 
screen shows an example of an STS crane. The trolley movement is displayed from the view 
of the crane operator. Displaying the hoist position helps the crane operator by providing him 
with a view he would not otherwise have.
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① Position of the boom (bottom, top, 45°, or none of the three positions)
② Size and load of the spreader
③ Movement of the trolley with limit switches, operating mode and parking position display
④ Movement of the hoist with limit switches and operating mode
⑤ Positioning of the vehicles and number of the lane (Truck Positioning System)
⑥ Movement of the long travel with limit switches and operating mode
⑦ Detailed information about the individual components (here: trolley)

The CMS has a graphic fault display so that faults can be visually localized.

● The group fault display ① at the top edge of the screen shows the faulty component.

● In the secondary navigation bar ②, the button that is assigned to this component flashes.
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● The cause of the fault ③ can be taken from the screen activated by pressing button ②.

● The cause of the fault ④ can be investigated in more detail using the associated text 
message ④.

CMS application example
5.3 Condition monitoring

Crane Management System (CMS)
66 System Manual, 11/2019



5.4 Process control
In most cases, the CMS is simply used as a tool for displaying operating states. Control of a 
value on the crane control system by the CMS add-on is protected, which means that the 
operator has to have the appropriate rights and has to confirm this by acknowledging a security 
prompt.

In principle, CMS also offers the option of initiating operator actions by sending control 
commands to the crane control system (e.g. to switch-on auxiliary systems). Auxiliary systems 
can be switched on using special operator control buttons with integrated status display. In this 
case, each operator control button has several states: 

Operation of the function disabled.

Function is not active.

Activation of the function is requested at the controller.

Function is active. Acknowledgment from the controller.

Another example is the option for presetting parameters and counter values.
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5.5 Fault diagnostics
The CMS acquires the fault messages from different components of the crane. The messages 
are archived, and can be displayed and evaluated using different resources:

● Message list in the user interface

● Report in the PDF and CSV format

● Message statistics (hit list)

In order to support maintenance technicians when analyzing faults, various items of information 
can be called for each message.

5.5.1 Message lists
The current message list provides an overview of the crane's current queued messages. Each 
message is displayed as a separate message line. Various information about a message can 
be displayed in a message line. The following is displayed in the example application:

● Message number

● Time stamp

● Message text

● Group

● Plant ID (PID)

● Location ID (LID)

● Device ID (DID)

As soon as the cause of a message has been remedied, the corresponding message line 
disappears from the current message list. 

The message history can be tracked in the archive list. One message line is displayed for an 
incoming message and one for an outgoing message. The message line is structured in the 
same way as the message list, but additional items are displayed here:

● Message status (raised: +; cleared: -)

● Length of message

The messages displayed in both the current message list and the archive list can be filtered 
using a predefined filter bar ①. In the CMS example application, filtering according to different 
crane components, message number or according to alarm class (fault, warning, event) has 
been configured.
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① Filter bar
② Message list (actual messages / archive)

Figure 5-3 Archive list of the messages

5.5.2 Message statistics
The message statistics evaluate the frequency and average message length for the messages 
which have occurred.

The hit list ① shows an overview of the message numbers, displayed in descending order by 
frequency. For every selected entry of the hit list, an overview of the messages in an archive list 
can be additionally displayed by pressing button ②.

CMS application example
5.5 Fault diagnostics

Crane Management System (CMS)
System Manual, 11/2019 69



① Hit list Message statistics
② Button Opens an archive list

5.5.3 Maintenance instructions and guidelines
You can save maintenance instructions for every message in the CMS. These can then be 
displayed when the selected message appears. Maintenance instructions can include any 
information about causes and instructions on how to resolve the fault.

As well as calling up information that has been saved, you can also add inputs to a maintenance 
instruction during operation, which can also be used by other users in the future.
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① Maintenance instructions Shows saved maintenance instructions for the message selected
② Remarks Input of remarks about maintenance instructions

5.5.4 References to additional information
As with the maintenance instructions, you can save references for any message.

Examples of references to additional information: 

● Circuit diagrams

● Symbols and networks in the crane control system's control program

● Programming Manuals

● Web pages

● Drawings

● Videos

● Word and Excel documents

● PowerPoint presentations

● etc.

The references that are displayed depend on the programs installed on the PC. The reference 
is not opened in the CMS itself, but in a program installed on the PC.

The references available must be in a local path on the CMS station or in a network path which 
can be accessed from various stations.

As with the maintenance instructions, the list of references available for a message is shown 
together with an archive list.
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5.5.5 Web-based diagnostics of components
If crane components or subsystems have web-based diagnostics pages, these can be 
activated directly in the CMS. 

Applications for this diagnostic functionality include:

● SIMOTION IT diagnostics

● Components of the SIMATIC family (CPUs with integrated PROFINET interface, Industrial 
Ethernet Switches)

● SIMATIC PCs; one of the accessories provided with the DiagMonitor package is a web 
server which offers diagnostics for your PC.

● Spreaders from well-known manufacturers
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The web-based diagnostics pages can be integrated in the CMS user interface. For this, the 
following preconditions must be fulfilled:

● The component involved can be accessed via its IP address.

● The relevant diagnostic pages are enabled on the target device.

Figure 5-4 Web-based diagnostics page 
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5.6 Operating data and performance analysis

5.6.1 Recording operational data
The operational data that can be acquired with the CMS include:

● Cargo handling data; set of relevant data for a cargo handling operation

● Mean Moves Between Failure (MMBF); the so-called MMBF value reflects the average 
amount of cargo handling between two faults of relevance to MMBF (cargo handling / fault). 
The mean value relates to a fixed time range. A fault of relevance to MMBF is a fault which 
cannot be rectified by a crane driver, but which causes a crane to stop operating.

● Load and operating hours counter values

5.6.2 Move data
You can acquire a set of relevant operating data for each cargo handling operation ("Move") in 
the CMS. A move data set includes for example: 

● Weight

● Transport direction

● Operating mode

● Positions

● specific data (e.g. container sizes for container cranes)

A default data set for move data acquisition is initialized in the CMS example application. This 
default data set can be expanded in any way.

Data is calculated in the control system. The CMS supports two different acquisition modes:

● Direct acquisition of data: 
As soon as the end of one cargo handling operation has been detected on the controller, the 
event is reported to the CMS which reads the data set and sets the time stamp.

● Buffered data acquisition: 
The controller is initialized for backing up data sets. In this case, the time stamp must be set 
in the control system and transferred to the CMS with the data set.

The move data is displayed in tables in the CMS example application. You can filter the way the 
data sets are displayed by different time slices.
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Figure 5-5 Tabular list of the cargo handling operations that have been acquired

5.6.3 MMBF data
The MMBF data set must be calculated in the control system. The CMS only supports capturing 
values. The control system also reports when a data set is to be read. The following data is for 
example transferred in the data set:

● Number of faults

● Number of moves

● MMBF value

A default data set for the MMBF data acquisition is initialized in the CMS application example. 
This default data set can be expanded in any way.

Note

Using the SIMOCRANE CMS Analyzer you can calculate and display your own MMBF data 
sets.
Additional information is provided in the online help of SIMOCRANE CMS Analyzer.

Data is calculated in the control system. The CMS supports two different acquisition modes:

● Direct acquisition of data: 
As soon as the end of one cargo handling operation has been detected on the controller, the 
event is reported to the CMS which reads the data set and sets the time stamp.

● Buffered data acquisition: 
The controller is initialized for backing up data sets. In this case, the time stamp must be set 
in the control system and transferred to the CMS with the data set.

The MMBF data is displayed in the CMS user interface in the same way as the move data.
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5.6.4 Load and operating hours counter
You can record current counter values on the controller. Time slices can be defined in the CMS. 
The CMS calculates the counters' differential values for these time slices. The CMS supports 
automatic counter restoration when the controller is reloaded. Total and section counters can 
also be used for each counter. You can visualize the total counter and total kilometer reading 
for your car, as well as the section counter and trip recorder. As with your car's trip recorder, a 
reset button can be used to reset the crane's section counter.

You can display the absolute values of the counter values in the CMS user interface. Operating 
hours are displayed in the CMS example application in hours and minutes. The absolute value 
corresponds to the process value on the controller. You can use the RESET buttons to reset the 
section counters.

Figure 5-6 Operating hours display

5.6.5 Performance evaluations

Note

This chapter is only relevant to you if you have installed the "Performance Monitor" option for 
the CMS station in the SIMOCRANE CMS product package.

Based on the crane's status word and the counters, the WinCC Performance Monitor performs 
calculations to assess the counters and analyze the operating states. It is able to establish key 
performance indicators (KPI) such as a crane's availability, utilization, performance, and MMBF 
value. Each crane is set up as equipment in the Performance Monitor. The precondition for 
performance evaluation is that the performance indicators and operating states have been 
defined in the form of operands or structured operands in the Performance Monitor 
Configuration Studio (see Chapter Performance Monitor Configuration (Page 278)).
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To be able to call up the images for display of the crane state and the performance indicators, 
you must first specify in the setting menu that the Performance Monitor software has been 
installed.

Figure 5-7 Settings

The CMS example application contains two graphical displays for evaluating the operating 
states and downtimes based on the definition of the individual values of the crane status word.

● Percentage evaluation of the duration of the individual operating states with reference to the 
overall period considered.

● Display of the duration and sequence of operating status versus a time axis in the Gantt chart

Figure 5-8 Crane status
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The CMS example application also calculates and displays the following performance data:

● Operating state

● Consumed energy

● Number of containers handled (for each size/weight/direction)

● Weight of the containers handled (for each size/direction)

Figure 5-9 Example: Consumed energy

Of course, many other performance indicators can be calculated in the Performance Monitor 
Configuration Studio, e.g.

● Evaluation of downtimes (maintenance, faults, etc.)

● Performance indicators (efficiency, utilization, availability)

In the visualization, each analysis involves calculations over different time ranges (per hour, 
day, week, month, year). Select the time ranges to be displayed in the settings of the relevant 
control:

1. Choose the view to be adapted in the option field.

2. Click the button for opening the settings.

3. Select the time ranges to be displayed on the "Time ranges" tab.
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Figure 5-10 Selecting the time ranges

Alternately, you can configure an individual time range yourself. When setting the modes and 
the other possible options, pay attention to the notes in the Performance Monitor 
documentation, which is also installed.

You will find an overview of the available actions below in the pictures for displaying the crane 
status and other performance data. 

To call the action for the desired view:

1. Choose the view in the option field on the left.

2.  Click on one of the following buttons.
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Opens the setting menu of the currently selected view. In the setting menu, you can 
choose from among the following settings. 
● Displayed indicators 
● Time range to be displayed
● Appearance of the control
● …
If you have created a print job in the WinCC Report Designer and have connected 
it to the view, you can print out the current view by clicking this button. 
Note:
In the example application, this action is not available by default because no print 
job has been created in the Report Designer.
 
To assign a print job to the view, perform the following steps:
1. Open the picture to be edited in the Graphics Designer.
2. Select "Configuration dialog..." from the shortcut menu of the control to be 

configured.
3. Go to the "General" tab and set up the print job under "Print job" in the Report 

Designer.
4. Click "OK" to close the dialog box of the control.
5. Navigate to "Miscellaneous → Operator-Control Enable" in the object proper‐

ties and select "yes" for this property.
6. Save and close the picture.
Exports the data of the selected view into a csv file (e.g. for displaying the data with 
Microsoft Excel).

Opens the help for the selected Performance Monitor Control.

Updates the displayed data in the selected view.
This is necessary, for example, after selecting the time range for display in the view 
settings.

Cancels updating the data.

Note
No support for the Replay function

The WinCC Performance Monitor Controls do not support the SIMOCRANE CMS Replay 
function.  We therefore recommend not preparing the images for Replay.
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5.7 Reporting

5.7.1 Reporting for SIMOCRANE CMS
In SIMOCRANE CMS, you can print out or export data to create reports

Here, you have various options:

● From the application
In the application example, you can do the following:

– Print move data or export as CSV files
See: Move data (Page 74)

– Print MMBF data or export as CSV files
See: MMBF data (Page 75)

– Print load and operating hours counter
See: Load and operating hours counter (Page 76)

Figure 5-11 Buttons for printing and for the CSV export

● From the WinCC Performance Monitor (optional)
In the WinCC Performance Monitor you can do the following:

– Calculate and print key performance indicators (KPI) – or export as CSV files.
See: Performance evaluations (Page 76)

Figure 5-12 Buttons for printing and for the CSV export

● From the SIMOCRANE CMS Fast Trace Viewer (optional)
In the SIMOCRANE CMS Fast Trace Viewer you can do the following: 

– Export trace data as CSV data.
See: SIMOCRANE CMS Fast Trace Viewer (optional) (Page 48)

Figure 5-13 Buttons for CSV export
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● Via the WinCC Report Designer
You can do the following in the WinCC Report Designer:

– Print move data or export as CSV files

– Print operating data or export as CSV files

– Print MMBF data or export as CSV files

In the WinCC Report Designer you can set the regular time intervals when data should be 
automatically printed – or should be exported as CSV.

Figure 5-14 WinCC Explorer > Report Designer

See: WinCC report system (Page 84)
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● Via the SIMOCRANE RCMS web application (optional)
You can do the following in the SIMOCRANE RCMS web application: 

– Print messages or export as CSV files

– Print move data or export as CSV files

– Print operating data or export as CSV files

– Print MMBF data or export as CSV files

Figure 5-15 SIMOCRANE RCMS web application

You can find more information in the SIMOCRANE RCMS System Manual.

● Via the SIMOCRANE CMS Analyzer
You can do the following in the SIMOCRANE CMS Analyzer: 

– Print messages or export as CSV files

– Print move data or export as CSV files

– Print operating data or export as CSV files

– Print calculated MMBF data or export as CSV files

– Print calculated key performance indicators (KPI) – or export as CSV files

Figure 5-16 SIMOCRANE CMS Analyzer

You can find more information in the online help for the SIMOCRANE CMS Analyzer.
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5.7.2 WinCC report system
The WinCC protocol system (Report Designer) can be used to prepare data recorded during 
the runtime in various output formats. The reports can be printed, saved as a file and displayed 
as a preview on the screen.

The reports are based on configurable templates in which data can be brought together in 
precise accordance with requirements. Protocols are therefore available for current or archived 
messages or the operational data displayed.

The example application contains the following reports:

● the current message list

● the alarm log

● the move data

● the MMBF data

● the current counter values

All standard reports are based on a tabulated presentation of the default data in the CMS 
example application. Note that you have to adapt the data to your project as soon as you have 
changed requirements.

Figure 5-17 Form of display for standard reports

In the CMS example application, the standard reports are configured in such a way that they are 
always printed using the PC's standard printer. You can define the standard printer in your PC's 
system control panel.
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5.7.3 Output formats and interfaces
Depending on the version, the CMS offers different data interfaces with different output formats:

● The CMS WinCC add-on provides operational data (move data, MMBF data, counter 
values) in XML format.

● The WinCC controls for displaying archive values such as messages, move data and MMBF 
data support export to CSV format.

● The SIMOCRANE CMS Fast Trace Viewer Control to display trace data from X-Tools 
supports data export in the CSV format.
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Installation 6
6.1 Preconditions

Before you can install SIMOCRANE CMS, the following software must be installed:

● SIMATIC WinCC V7.4 SP1 Update 11 
You may install more recent updates, but you must not install any service pack other than 
SP1!

● Automation License Manager V5.3 SP3 Update 3 or higher

● For further requirements regarding the operating system, service packs, hardware, etc., see 
also: System requirements (Page 19).

Local administrator rights are needed to install SIMOCRANE CMS.

If administrator functions are to be enabled for a user in SIMOCRANE CMS, the user must be 
included in the Windows "CMSAdmin" user group. This user group is not set up automatically 
when the software is installed, but must be created subsequently by a Windows administrator.

NOTICE

Prior to installation: export CMS-specific data with CMS V4.2

Note that you must migrate projects used under CMS V4.2 (WinCC 7.0) and CMS 4.3 (WinCC 
7.2) if you wish to continue to use them under CMS V4.4. 
First back up the data relevant to CMS using CMS V4.2 or CMS 4.3.

See also: Migration of existing projects (Page 391)
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6.2 Installing SIMOCRANE CMS
Install the CMS Setup at the station on the crane that acquires data from the PLC and may 
transfer these data to an RCMS server.

Installation requirements
The following requirements must be met before installation:

● The system requirements must be fulfilled.
See also: System requirements (Page 19)

● WinCC V7.4 SP1 Update 11 must be installed.

Note

You may install more recent updates for SIMATIC WinCC V7.4 SP1 Update 11, but you 
must not install any service pack other than SP1!

● Local administrator rights are needed to install SIMOCRANE CMS. 

Installing additional programs
If the following programs are not already installed, they will be installed at the same time as 
CMS:

● Siemens Automation License Manager V5.3 SP3 Update 3 or higher

● .NET Framework 4.6.2 or higher

● Microsoft Visual C++ 2015 redistributable

Installation
6.2 Installing SIMOCRANE CMS

Crane Management System (CMS)
88 System Manual, 11/2019



Installation
1. Insert the "SIMOCRANE CMS" DVD into the computer and start the setup: 

"SIMOCRANE_CMS_Setup\setup.exe"
If the following programs are not already installed, they will be installed:

– Siemens Automation License Manager 

– .NET Framework 

– Microsoft Visual C++ 2015 redistributable

Note

If the installation process does not continue automatically after a restart, relaunch it by 
double-clicking on file "setup.exe".

SIMOCRANE CMS is then installed.

Figure 6-1 SIMOCRANE welcome screen

2. Follow the instructions on the screen.
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3. Select the directory in which you want to install CMS. 

Figure 6-2 Selecting the installation path

The default installation path for CMS is: "C:/SIMOCRANE CMS".
If CMS is already installed, a warning will be displayed and the installation process aborted. 
When the software has been successfully installed, a window showing the ReadMe file is 
displayed.

Note

If the installation process is aborted, CMS files that have already been installed are 
uninstalled again.

ALM, .NET Framework and the Microsoft Visual C++ 2015 Redistributable Package are not 
uninstalled.

4. Follow the instructions on the screen.

5. Restart the computer to finalize the installation.

Note
Restart required

Before CMS can be started, the computer must be restarted.

Setup is now complete.

Your next steps:
● Transfer the license using the Automation License Manager.

See Transferring a license (Automation License Manager) (Page 93).
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6.3 Installing the SIMOCRANE CMS client
Install the CMS Client Setup on all clients of a CMS station.  

The clients of a CMS station display the screens of the connected CMS station. These can be 
WinCC clients or WebNavigator Clients.

CMS Client Setup must be installed in order to display Active X Controls, for example the 
CMSFaults Control on the client. Active X Controls such as these are not installed by the 
WebNavigator Client.

Note

If you wish to use the WebNavigator Client:

Install the Web Navigator Client before you install the CMS Client Setup.

Installing additional programs
If the following programs are not already installed, they will be installed at the same time as 
CMS:

● .NET Framework 4.6.2 or higher

● Microsoft Visual C++ 2015 redistributable
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Installation
1. Insert the relevant DVD into the computer and start the setup:

"SIMOCRANE_CMS_ClientSetup\setup.exe" on the "SIMOCRANE CMS" DVD
If the following programs are not already installed, they will be installed:

– .NET Framework

– Microsoft Visual C++ 2015 redistributable

Note

If the installation process does not continue automatically after a restart, relaunch it by 
double-clicking on file "setup.exe".

The SIMOCRANE CMS Client is then installed.

Figure 6-3 SIMOCRANE, window: Welcome page

2. Follow the instructions on the screen.

When the software has been successfully installed, a window showing the ReadMe file is 
displayed. 
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6.4 CMS licenses

6.4.1 Licensing concept in CMS
For the CMS station, you require a valid license key for the following:

● To start the SIMOCRANE CMS Runtime

● To start the SIMOCRANE CMS Replay Runtime  

Note
The license keys for SIMOCRANE CMS 4.4 / 4.4 SP1 / 4.4 SP2 are also valid for SIMOCRANE 
CMS 4.4 SP3.

You do not have to install new license keys when you update from SIMOCRANE CMS 4.4 / 4.4 
SP1 / 4.4 SP2 to SIMOCRANE CMS 4.4 SP3.

You must install both licenses!
If you start the WinCC Runtime software without these licenses, the application, CMS Runtime 
and CMS Replay Runtime are automatically closed after the countdown has elapsed.

Figure 6-4 Missing license on the CMS station

See also: Transferring a license (Automation License Manager) (Page 93)

6.4.2 Transferring a license (Automation License Manager)
For more detailed information on the licenses, see: Licensing concept in CMS (Page 93)
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Requirement: USB stick with the license to be transferred.

1. Start the Automation License Manager using the icon or the Start menu. 
The Automation License Manager opens.

2. Insert the USB stick. 
A "Removable Disk" appears below "Own Computer".

Figure 6-5 Automation License Manager - licenses for SIMOCRANE CMS Runtime and SIMOCRANE 
CMS Replay Runtime

Figure 6-6 Automation License Manager - license for SIMOCRANE RCMS

3. Select the entry "Removable Disk" on the left-hand side. 
On the right-hand side you can see the available licenses on the USB stick.

4. Transfer the license by dragging it and dropping it onto the local hard disk or use the right 
mouse button.
- OR -
In the context menu, select "Transfer... ".

5. In the window that opens, select where the license should be transferred to (target). 
After the license has been transferred, it appears on the target drive.

The license has been successfully transferred.

You can find more information about the Automation License Manager in the online help of the 
Automation License Manager.
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6.5 Starting CMS Runtime and/or Replay Runtime automatically on 
system startup

You can start CMS Runtime and/or Replay Runtime automatically as a service on system 
startup without having to log in separately. 

The precondition here is that it is also possible to start the WinCC project automatically. The 
WinCC project must be converted to a service project for this purpose. 

As a result, the WinCC project, CMS Runtime and Replay Runtime are started automatically 
when the computer is started up.

Note

A consequence of this procedure is that the system tray icon of CMS Runtime and/or Replay 
Runtime is no longer visible.

Note

This procedure requires Windows 10!

Note

WinCC service projects do not support additional programs in the WinCC startup list. 

Manual startup or termination of the WinCC service project does not result in startup or 
termination of CMS Runtime and/or Replay Runtime. 

In these cases, CMS Runtime and Replay Runtime must be started or terminated manually.

Automatically starting WinCC as service project
The WinCC project must be started automatically in order to start CMS Runtime and/or Replay 
Runtime automatically on system startup. The WinCC project must run as a service project for 
this purpose.

1. You must convert the WinCC project to a service project. 

2. You must configure automatic start for this service project.

To do this, follow the instructions given in the WinCC documentation. 
See: SIMATIC HMI WinCC V7.4 SP1 WinCC: Configurations: Chapter 3.7 "Configuring WinCC 
ServiceMode"
SIMATIC WinCC configuration (https://support.industry.siemens.com/cs/us/en/view/
109746338)
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Starting CMS Runtime and/or Replay Runtime automatically
In order to start CMS Runtime and/or Replay Runtime automatically on system startup, you 
must create a task in the Windows "Task Scheduler" for every runtime to be started.

1. Open the Windows "Task Scheduler".

2. Click "Create Task" to create a new task.

Note

You must create a task for every runtime to be started (one task for CMS Runtime and one 
task for Replay Runtime).

3. Complete the following steps on the "General" tab:

Figure 6-7 Task Scheduler - General

– Enter a name for the task in the "Name" field.

– Enter a description of the task in the "Description" field. 

– Click "Change User or Group..." 
Enter "SYSTEM" in the "Enter the object name to select" field. 
Confirm with OK.

– In the "Configure for" selection list, select "Windows 10".
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4. Complete the following steps on the "Triggers" tab:

– Click "New" to create a new trigger.

Figure 6-8 Task Scheduler - New trigger

– Select "At startup" in the "Begin the task" selection list.

– Confirm with OK to create the trigger.

5. Complete the following steps on the "Actions" tab:

– Click "New" to create a new action.
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Figure 6-9 Task Scheduler - New action

– Select "Start a program" in the "Action" selection list. 

– Click "Browse" and select the following program path: 
"C:\Windows\System32\cmd.exe".

– Enter the following argument in the "Add arguments (optional)" field: 
To start CMS Runtime:
/C start "" "C:\Program Files (x86) \Siemens\WinCC\SIMOCRANE CMS
\CMSRuntime.exe" 
- or - 
To start Replay Runtime:
/C start "" "C:\Program Files (x86) \Siemens\WinCC\SIMOCRANE CMS
\CMSReplayRuntime.exe"

The corresponding runtime is started automatically on system startup.

Installation
6.5 Starting CMS Runtime and/or Replay Runtime automatically on system startup
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Configuring a CMS station 7
This chapter describes the fundamental settings you need to undertake in the CMS product and 
CMS example application in order to integrate them into your project environment (crane type 
settings, network topology, basic settings in WinCC).

This chapter is therefore mainly aimed at people who have to adapt the CMS example 
application to specific requirements.
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7.1 Configuring the CMS product

7.1.1 Starting the CMS Runtime automatically
Ensure that the "CMSRuntime.exe" of the SIMOCRANE CMS WinCC add-on is entered in the 
WinCC start-up list.

You can check whether the program has been started by the icons on the Windows taskbar.
See also: Starting the CMS Runtime (Page 143)

7.1.2 Settings in WinCC

Initial situation
In order to start the example application on your PC, you first have to undertake some basic 
settings in WinCC so that the example application's defaults can be adapted to your project 
environment.
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Processing steps
1. Enter the name of your PC in WinCC Explorer under "Computer properties", "General" tab.

Note

Please note that the computer name must not be "CMS". You should also observe the 
WinCC guidelines for the assignment of a computer name. If the computer name should be 
the same as the crane name, then it may contain letters and numbers only. The first 
character must be a letter.

Figure 7-1 PC name setting in WinCC Explorer

2. Check the language settings for WinCC Runtime under the "Parameters" tab. Enter the 
runtime language required. "English" is the default runtime language in the CMS example 
application. "German" is offered as the second language in delivery condition.
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Figure 7-2 Runtime language setting in WinCC

Result
After restarting WinCC, you can launch the WinCC Runtime.

Note

Please note that after changing the computer name you will have to restart WinCC before you 
can make any further settings in the CMS editor.

7.1.3 Communication between the CMS station and the crane control system

Initial situation
Based on WinCC, the CMS offers various ways of establishing communication with the control 
level. The channels support various communication drivers. All tags are administered centrally 
in WinCC in tag management. 
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You will find the interface to the crane control system in the "SIMATIC S7 PROTOCOL SUITE" 
communication driver in the "TCP/IP" channel unit in the CMS example application. The 
connection name is "CMS_connection".

Figure 7-3 SIMATIC S7 PROTOCOL SUITE channel

The figure below shows the interface structure of the CMS example application. The interface 
is split into different modules. Modules comprise both crane components and modules for 
operating data acquisition.

Figure 7-4 Interface overview

In the SIMATIC S7, a separate data block is defined for every module which forms the interface 
to the CMS. The data can be addressed in WinCC tag management via the data block and an 
offset in the corresponding data block. The offset, type and size of the data are described in the 
interface. 

With a few exceptions, binary diagnostic information is read as one byte and not as a word or 
double word. This should prevent misunderstandings caused by different processor 
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architectures. High and low bytes are swapped within one word for different processor 
architectures. The interface description is always based on the byte order in WinCC.

Processing steps
You should note the following components when assigning parameters for communication: 

1. Establish the physical connection between the automation system, the crane control system 
and the CMS station's computer.

2. Define the communication driver for your project (e.g. "SIMATIC S7 PROTOCOL SUITE").

3. Define the channel unit (e.g. TCP/IP).

4. Create a logical connection in the channel unit (e.g. CMS_TCPIP).

5. Address the WinCC communications partner in the logical connection and define the 
connection parameters.

Figure 7-5 TCP/IP connection parameters

6. Open tag management in WinCC Explorer.

7. Move (do not copy!) the interface tags from the preassigned "CMS_MPI" connection to your 
newly created connection.

8. If you have created a connection in a channel outside the SIMATIC S7 PROTOCOL SUITE, 
you must adapt the addressing the requirements of the corresponding channel unit.

9. Configure the interface tags on the controller side.
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7.1.4 Limits for the acquisition of messages and operational data

Limits for the acquisition of messages
The following limits apply to the acquisition of messages for operation of a CMS.

The following performance data from the WinCC documentation must be considered in 
particular:

Continuous message load without loss (single user/server) 10 messages s-1   
Message burst (single user/server) 2000 messages per 10 s-1   every 5 min1)

1) If the interval before the next message burst is under five minutes, messages may be lost.

The WinCC system provides a data buffer that can handle a burst of messages for a short time.

Limits for the acquisition and archiving of operating data
The following limits apply to the archiving of operational data on the CMS for operation of a 
CMS.

The following performance data from the WinCC documentation must be considered in 
particular:

Archiving in database for server/single user ("Tag Logging 
Fast")

5000 s-1    2)

Archiving in database for server/single user ("Tag Logging 
Slow")

1000 s-1     2) 3)

2) The stated values apply to archiving without signing-off of data.
3) With "Tag Logging Slow," you must expect longer picture selection times for identical quantities than 

with "Tag Logging Fast."

The example application handles the following data volumes: 

Process value archive Number of tags Acquisition cycle
MoveData 13 On average 1 move per minute
MMBFData 5 1 x per month
CounterHourly 45 1 x per hour
TimerDaily 18 1 x per day
  Total on the CMS ≈ 0.24 s-1

It can be seen that only a fraction of the performance capacity is used by the CMS example 
application. This makes it possible to extend the tag logging of the individual CMS stations in 
the configuration.

Note

The performance limits of SIMATIC WinCC 7.4 also apply to the link between PLC and CMS.
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7.1.5 Configuring the topology

7.1.5.1 General information on setting up the topology
In the following description, we assume you have installed the WinCC add-on SIMOCRANE 
CMS on your computer and entered a valid computer name under "Computer" in the WinCC 
Explorer.

In CMS 4.4, the following role exists, which the CMS 4.4 computer can take on in the topology. 

● CMS station 
The CMS station forms the core of any topology. 
Here, the operational data and messages of the crane are acquired. 
The data can be evaluated on the CMS station

The following forms of topology exist: 

● CMS stand-alone
A CMS station standing alone
See also: Setting the topology (Page 106)

● CMS with RCMS (Process Historian)
CMS 4.4 with RCMS 4.4
See also: Setting the topology (Page 106)
See also: Connecting CMS station to Process Historian (Page 110)
CMS 4.2 / 4.3 SP1 with RCMS 4.4
See also: Backward compatibility (Page 370)

● CMS with RCMS (WinCC)
CMS 4.4 with RCMS 4.3 SP1
See also: Backward compatibility (Page 370)

● Remote access to CMS station or RCMS server via the WinCC Web Navigator
See also: Remote access (Page 287)

7.1.5.2 Setting the topology
These instructions show you how to set up a CMS station that is either stand-alone or 
connected to the RCMS web application via the Process Historian.

See also: General information on setting up the topology (Page 106)

You will find more detailed information on the RCMS web application in the SIMOCRANE 
RCMS Operating Instructions.
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Selecting the topology
1. Open the CMS Editor.

2. In the screen form, open "System" → "Basic settings" → "Topology".

Figure 7-6 Changing the topology

3. Select the setting "CMS stand-alone" or "CMS with RCMS (Process Historian)"

4. Confirm with "OK".

Note
Close the CMS Editor

To apply the setting, close and re-open the CMS Editor.

Result
You have now defined the topology for a CMS station that is either stand-alone or connected 
to the RCMS web application.

You now only have to define the equipment type and the crane.
See: Defining the equipment type (Page 108)
See: Defining the crane (Page 109)

To enable the CMS station to connect to an RCMS web application, it must be connected to the 
Process Historian.
See: Connecting CMS station to Process Historian (Page 110)
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7.1.5.3 Defining the equipment type
Each crane must be assigned to a certain equipment type. To do this, you must create an 
equipment type.

Note

The fields for the status values and icons are only relevant for the topology "CMS with RCMS 
(WinCC)". 
You do not have to fill these fields.

Note

You can only create one equipment type.

1. Open screen form "Topology" → "Equipment".

Figure 7-7 Defining the equipment type

2. Create a name for the equipment type.
The name of the equipment type must only contain letters and numerals.
The first character of the name must be a letter.

3. If necessary, under equipment information, select the WinCC tag for outputting the 
comment typical of the equipment.

Note

The content of the "Value" field is read out when the runtime starts and could be displayed, 
for example, as information on the status bar of the application.
The content of the "Comment" field can only be viewed in the editor.

4. Confirm with "OK".
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7.1.5.4 Defining the crane
You must define the crane on the CMS station.

1. Open screen form "Topology" → "Cranes".

Figure 7-8 Defining the crane

2. Enter the name of the crane in the "Name" field.
The name of the crane must only contain letters and numerals. 
The first character of the name must be a letter.

3. Enter the computer name for the CMS station in the "Computer name" field.

Note

The computer name must not be exactly "CMS"! 
Also follow the WinCC guidelines for the assignment of computer names. 
The computer name and crane name can be identical

4. Select an equipment type in the "Equipment" field.

5. Confirm with "OK".

6. Restart the CMS Runtime to activate the changes to the communication parameters.
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7.1.5.5 Connecting CMS station to Process Historian
You can only connect the CMS station to the Process Historian if the following preconditions are 
met:

● The topology of the CMS station must be "CMS with RCMS (Process Historian)".
See also: Setting the topology (Page 106)

● "PH-Ready" must have been installed and configured.
"PH-Ready" is a module of WinCC. You will find it on the Process Historian Installation DVD.
You will find more detailed information on the configuration of "PH-Ready" in the 
documentation of the Process Historian

Note

The "PH-Ready" version must be compatible with the installed version of WinCC. 
WinCC 7.4 SP1 Update 11 requires PH-Ready 2014 SP3.

● The computer name of the CMS station must meet the following conditions:

– The following characters are forbidden: .,;:!?“‘^´`~_-+=/\|@*#$%&§°()[]{}<>

– The name must not contain any spaces.

– The first character must be a letter.

– The first 12 characters of the computer name must be unique.

● The user name and password at the CMS station and at the Process Historian must be the 
same.

● The Process Historian database must be accessible in the network.
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Processing steps
1. Open WinCC Explorer.

2. Click "Process Historian".
The "WinCC Process Historian Editor" opens.

Figure 7-9 WinCC Process Historian Editor

3. In the "Server 1" field, select the server for the Process Historian.
If you have implemented the Process Historian redundantly, select the redundant server in 
the "Server 2" field

Result
The CMS station is connected to the Process Historian. 

The data are now acquired by the Process Historian and stored.

7.1.6 Alarm/event system for the CMS station

The CMS alarm/event system is based on WinCC Alarm Logging. Additional crane-specific 
requirements of the alarm/event system are covered by the CMS add-on for WinCC. While the 
WinCC messages are displayed in a WinCC Alarm Control, the CMS add-on provides a 
separate control of additional message information. It has already been integrated into the 
CMS example application (MessagesInfo.pdl ).

You can find a detailed description of this integration in Chapter Inserting CMSFaults control 
into a picture (Page 258).
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7.1.6.1 Message procedures
The WinCC Alarm Logging basically supports two message procedures:

● Bit message procedure (message tag)

● Chronological reporting (message telegram)

The CMS example application uses the bit message procedure. Here the controller signals the 
occurrence of an event by means of a message tag. The time stamp of the message is issued 
by WinCC Alarm Logging. 

With chronological reporting, the time stamp of an alarm event is issued by the controller and 
sent to WinCC as a message telegram. This message procedure assumes the appropriate 
configuration on the controller side.

7.1.6.2 Message blocks
Message blocks are configured in the WinCC Alarm Logging. They contain the information 
which is displayed in a message.

The table below shows the message blocks that are defined in the CMS example application. 
You can adjust the message blocks to suit your project requirements. Message block 10 is 
prepared for displaying the contents of both the process value blocks.

Table 7-1 Message blocks

Name Category Number Size Description
Date System block 1 dd:mm:yyyy Date of time stamp
Time System block 2 hh:mm:ss Time of time stamp
Duration System block 3 dd hh:mm:ss Period between "incoming" sta‐

tus and "outgoing" status
Status System block 5 1 char Message status (incoming, out‐

going)
Number User text block 1 4 char Fault number
PID User text block 2 5 char Plant identification (=xxx)
LID User text block 3 5 char Location identification (+xxx)
DID User text block 4 5 char Device identification (-xxx)
Message text User text block 5 90 char Information about the message
Source User text block 6 12 char S7 block / network
Reference User text block 7 10 char Reference in circuit diagram
Group User text block 8 4 char Message group

Configuring a CMS station
7.1 Configuring the CMS product

Crane Management System (CMS)
112 System Manual, 11/2019



Name Category Number Size Description
Equipment 
type::
crane name

User text block 10 32 char Intended for: 
Equipment::crane name
Note:
Must not be used for other pur‐
poses.
Note:
For the topology "CMS with 
RCMS (WinCC)" only:
"@2%s@::@1%s@" must be 
entered so that the content is 
entered automatically during 
runtime.

Crane name Process value block 1 32 char Reserved for CMS
Equipment 
type

Process value block 2 32 char Reserved for CMS

Process val‐
ue

Process value block 3 32 char Process value

7.1.6.3 Message classes and message types
Message classes and message types are configured in the WinCC Alarm Logging.

The table below shows the message classes and message types which are defined in the CMS 
example application. The message class 16 (CMS) and the subordinate message types are 
mandatory for use in CMS system messages and may not be changed. The message class is 
created automatically. You can modify all other message classes and message types.

Table 7-2 Message classes and message types

Class Class 
No.

Type Type No. Status Color

Fault 1 Fault in general 1 incoming 
(+)

outgoing
(-)

Warning 4 Warning in general 49 incoming
(+)

outgoing
(-)

Event 7 Info Operator 97 incoming
(+)

outgoing
(-)
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Class Class 
No.

Type Type No. Status Color

MMBF 14 External 209 incoming
(+)

outgoing
(-)

Internal 210 incoming
(+)

outgoing
(-)

CMSTime‐
Zone

15 CMSTimeZone 
warning

225 incoming
(+)

CMS 16 CMS fault 241 incoming
(+)

CMS warning 242 incoming
(+)

CMS info 243 incoming
(+)

7.1.6.4 Group messages
In the CMS, each WinCC single message is assigned to a group message. The group 
messages are configured in the WinCC Alarm Logging and can be structured hierarchically, so 
that a subordinate group message also initiates the higher-level group message. The diagram 
below shows the group hierarchy of the CMS example application:

Figure 7-10 Principle of the group message in the CMS
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All of the individual messages of class "Faults of gantry 1" are assigned to an alarm group" 
"GA1_Fault". If such an individual message occurs (e.g. "Gantry1 fault brake"), then the directly 
assigned group message ("GA1_Fault") and also the higher-level group message 
("Gantry_Fault") are output.

A status tag can be defined for each configured group message defined, in which a status bit 
is set when the group message is initiated.

This status tag can be evaluated in the user interface:

● Configuring a group fault display in the group fault display (e.g. group messages level 2)

● Initiating group messages (e.g. group messages level 1)

A group fault display visualizes the message statuses in a suitable form for the message 
classes of the example application:

● Inactive (status tag = 0)

● Event (status bit 1 set)

● Warning (status bit 2 set)

● Fault (status bit 3 set)

The status of a group fault display is dynamized using the status tag of the group messages:

Figure 7-11 Group fault display in the CMS

Fault messages from crane gantry 1 initiate the "Gantry_Fault" group message; see diagram 
"Principle of the group message in the CMS". When the group message is initiated, bit 3 in the 
assigned status tags is set. 

For individual messages of the class "Warning", there is an analogous hierarchy. The group 
message, "Gantry_Warning" sets bit 2 in the status tags. For operator messages, there is an 
additional "Event" state. Bit 1 is set in the assigned status tags. The status displays are 
configured so that the fault bit has the highest priority.
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The following table shows the complete group hierarchy for the message class "Fault". The 
group hierarchy for the class "Warning" is structured in the same way. For events there is only 
one group message.

Table 7-3 Group messages for visualizing the group faults

Icon Display group Alarm group Description
General_Fault GE_Fault General crane

Supply_Fault LVD_Fault Low voltage distribution
SU1_Fault Supply unit 1
SU2_Fault Supply unit 2
SU3_Fault Supply unit 3
SU4_Fault Supply unit 4
CRH_Fault Cable reel high voltage

Hoist_Fault HO_Fault Hoisting gear or holding and closing gear
HO1_Fault
HO2_Fault
HO3_Fault
HO4_Fault

Trolley_Fault TR_Fault Trolley or luffing gear
TR1_Fault
TR2_Fault
TR3_Fault
TR4_Fault

Boomhoist_Fault BH_Fault Boom-hoist
BH1_Fault
BH2_Fault

Gantry_Fault GA_Fault Gantry
GA1_Fault
GA2_Fault
GA3_Fault
GA4_Fault

Slewing_Fault SL_Fault Slewing gear
SL1_Fault
SL2_Fault

Spreader_Fault SPR_Fault Spreader
CRS_Fault Cable reel spreader
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Icon Display group Alarm group Description
Auxiliary_Fault AUX_Fault Other auxiliary gear

TLS_Fault Trim list skew
RT_Fault Rope tensioning
LHV_Fault Lighting, heating, ventilation

TechFunction_Fault AUT_Fault Automatic
TPS_Fault "Truck positioning"

OM  "Operator messages"

7.1.6.5 Archive configuration
The archive configuration for messages is defined in the WinCC Alarm Logging. Adapt the size 
and archiving period of the archive and individual segment to the project requirements under 
"Archive configuration".

Figure 7-12 Archive configuration of the message archive in the WinCC Alarm Logging editor

You can set how many messages are to be re-established after a power failure under "Reload 
after power failure". When the system is restarting, pending messages are checked to see if 
they were received before the power failure.
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Figure 7-13 Reloading messages in the case of a power failure

7.1.6.6 Message import in the WinCC Alarm Logging

Initial situation / objective
WinCC Alarm Logging features an import function for individual messages so you don't have to 
create all the messages manually. The import file must be available in text format (*.txt). 

Refer to the WinCC documentation for the structure of the import file and meaning of the 
parameters.

Processing steps
1. Ensure that all message classes, message types, message blocks and message groups 

used in the import file are created in the WinCC Alarm Logging.

2. Ensure that all tags used (message and process value tags) are present in the WinCC tag 
management.

3. Use the "Import messages" dialog to import the messages from the WinCC Alarm Logging 
toolbar "Messages" → "Import individual messages…".

4. Once the import process is complete, a message appears and you can read the import 
status off this. You can check here whether the import is free from faults.
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7.1.6.7 Maintenance instructions in the CMS configuration editor

Initial situation / objective
You can assign a maintenance instruction to each message that is available in WinCC Alarm 
Logging. Only one maintenance instruction can be assigned to each WinCC message. But 
several messages can be assigned to each maintenance instruction.

Below is a description of how to manually configure a maintenance instruction. However, you 
can also use an import function (xml format). It is best to start by manually configuring and 
exporting an instruction. Then you can use this template to extend the import file. 
See also: Import/export: Import/Export (Page 198)

The following group actions are possible for maintenance instructions:

● Generate new maintenance instructions by copying existing maintenance instructions

● Deleting maintenance instructions

Group actions can be triggered for multiple selected maintenance instructions. With the check 
box in the header, you can select or deselect all existing maintenance instructions for a group 
action.

Sequence of steps
Here is an example of how to configure maintenance instructions:

1. Open the CMS editor under "Messages" → "Maintenance instructions"

2. Use "New" to create a new maintenance instruction.

3. Under "Description," enter a name for the maintenance instruction (e.g. Category 0 Stop). 
The "Description" field is mandatory.
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4. In the "Possible cause" and "Possible remedy" fields enter information about a fault's cause 
and remedy.

Figure 7-14 Configuring maintenance instructions in the CMS editor

5. Open the dialog for assigning maintenance instructions to a message under "Messages" → 
"Assign maintenance instructions."
You will find a list of all existing message numbers on the left. 
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6. When you select a message, an info text appears along with information from the message 
text blocks.

7. Select your maintenance instruction from the "Maintenance instructions" list and assign it 
the message number you want either using drag & drop or the arrow keys.
On the right-hand side next to the name of maintenance instruction, it is shown how often 
this note is assigned to a message.

Figure 7-15 Assignment of maintenance instructions to a WinCC message in the CMS editor
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7.1.6.8 Remarks on maintenance instructions

Initial situation / objective
In the CMS application, the user can enter additional remarks to existing maintenance 
instructions in runtime. Such entries appear in the corresponding field along with information 
about the maintenance instruction already displayed.

Figure 7-16 Remarks on maintenance instructions

You can define the scope of assignment for the remarks entry for the maintenance instructions. 
The remarks can be assigned as follows:

● local: Archiving of remark for precisely this message number

● global: Archiving of remark for maintenance instruction; this option is of interest if you have 
assigned a maintenance instruction to several messages.

All remarks entered can also be displayed or edited in the CMS editor.
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Processing steps
1. Open the CMS editor.

2. You can open and edit the texts of remarks entered under "Messages" → "Remarks on 
maintenance instructions". You will find the remarks in the tree shown at the corresponding 
message number.

3. An overview of the entries made can be found under "Messages" → "Logbook". This 
contains a list of who made an entry for the maintenance instructions and when this was 
done (author and time stamp) in Runtime.

Figure 7-17 Logbook for maintenance instructions in the CMS editor

7.1.6.9 References in the CMS editor
As well as being assigned to maintenance instructions, a message in the CMS editor can also 
be assigned various references. References are links between individual messages and 
different sources of information. In the event of a fault, the user calls the linked information from 
the message. For example, this can be a circuit diagram or an operating manual.

You must therefore provide the following information to a reference:

● Program to display the information (for example, Acrobat Reader to display a manual in the 
PDF format), and special command line operators to the program (e.g. to open a certain 
page in the PDF document)
See also: Creating a program call for references (Page 127)

● Path and file name at which the referenced information can be found
See also: Define the file call for reference (Page 129)

● Assignment of the reference to a message and, if necessary, setting for values for command 
line operators
See also: Assigning references (Page 131)

You can assign references both to a message and to a crane or an equipment type.
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You can create references in such a way that the linked files can also be called from the CMS 
client.
See also: Precondition for opening references at CMS clients (Page 127)

You can define macros yourself. These are then entered into the macro list and managed in the 
dialog "Settings" → "Macros". 

In the CMS Editor there are also a few predefined macros; these contain system information, 
such as the installation path of the CMS. You can use these macros. You cannot change the 
value.

There is an import function for the references. 
See also: Message import in the WinCC Alarm Logging (Page 118)

7.1.6.10 References to STEP 7
References to Step 7 are implemented via the reference type "PLCReference". This reference 
type is already predefined. The reference type "PLCReference" is similar in function to the 
WinCC network jump.

Note

For SIMATIC S7 – 1500 PLCs and SIMATIC S7 – 1200 PLCs, you must refer to STEP 7 via the 
TIA Portal.
See: References to TIA Portal (Page 125)

You can use PLC Reference either to open a STEP 7 block (FB, FC) and jump to a network 
there (network jump) or you can display the locations where a STEP 7 symbol is used. Use the 
corresponding call parameters to select between these two options.

Figure 7-18 Network jump
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Figure 7-19 Points of use symbol

Table 7-4 Call parameters for PLC Reference

Call parame‐
ters

Description Network Points of use

-p Path to the STEP 7 project → p[ath] ("") x x
-st Station name in the STEP 7 project → st[ation] ("") x x
-c CPU name in the station → c[pu] ("") x x
-b Name of a block in the CPU program → b[lock] x  
-n Network number in the block → n[etwork] x  
-sy Symbol name of a symbol in the symbol table in the STEP 7 pro‐

gram → sy[mbol]
 x

-d Data source name of WinCC database for error messages → 
D[SNName]

x x

See also
References in the CMS editor (Page 123)

Creating a program call for references (Page 127)

Define the file call for reference (Page 129)

Assigning references (Page 131)

7.1.6.11 References to TIA Portal
References to TIA Portal are made via a reference which calls "CMSPLReferenceTIA.exe". 
"CMSPLReferenceTIA.exe" has a function similar to the WinCC network jump.
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You can find "CMSPLReferenceTIA.exe" on the installation DVD in the folder 
"CMSPLCReferenceTIA". This folder can be found in the folder for the associated application 
example.

Note

In addition to the general preconditions for opening references at CMS clients, the following 
preconditions must also be fulfilled:
● The supplied CMS application example 4.4 SP3 or higher is in use.

If you are using an older CMS application example, contact the application support for 
SIMOCRANE. 

● The CMS user must be a member of the "SIEMENS TIA Openness" user group.
● "TIA Openness" must be installed on the CMS station as part of the TIA Portal installation.
● TIA Portal 15.1 is in use. 

If you wish to use a higher version of TIA Portal, please contact the application product 
support for SIMOCRANE.

You can find additional requirements here: Precondition for opening references at CMS clients 
(Page 127)

You can either open a TIA Portal block (FB, FC) and jump to an available network (network 
jump) from there, or you can display the locations where a TIA Portal symbol is used. Use the 
corresponding call parameters to select between these two options.

Table 7-5 Call parameters for TIA Portal reference

Call parame‐
ter

Description Network Points of use

-p Path to the TIA Portal project → p[ath] ("") x x
-st Station name in TIA Portal project → st[ation] ("") x x
-c CPU name in the station → c[pu] ("") x x
-b Name of a block in the CPU program → b[lock] x  
-n Network number in the block → n[etwork] x  
-sy Symbol name of a symbol in the symbol table in the TIA Portal 

program → sy[mbol]
 x

Note

Opening the TIA Portal may take a few minutes after the reference is executed.

Do not use your keyboard or mouse during this time, as the reference may not otherwise be 
executed correctly!

See also
Creating a program call for references (Page 127)

Define the file call for reference (Page 129)

Assigning references (Page 131)
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7.1.6.12 Precondition for opening references at CMS clients
If you remotely access the CMS station (WinCC WebNavigator client), then you must create the 
infrastructure for the references so that the linked files can also be called-up via the CMS client. 

Figure 7-20 CMS client with installed programs; central network drive with files

On the CMS client, all the programs required to open the linked files must be installed, for 
example, Acrobat, Excel, or Step 7.

Note

For the program call to work on all computers, the programs must be accessible via the same 
path on all computers. Ideally, you will install the programs at the suggested default storage 
location.

You can store the linked files centrally on a network drive to which all connected CMS clients 
have access.

Note

For the file call to work on all computers, the same drive letter must be assigned to the network 
drive on all computers (for example "Z:")

7.1.6.13 Creating a program call for references
In this step, you define the program call for a reference.

You also define the special command line operators, for example, for opening a certain page 
in the PDF document.
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See also: References in the CMS editor (Page 123)

Sequence of steps
1. Open the screen form "Settings" → "Programs".

Figure 7-21 Configuring programs for opening references in the CMS editor

2. Enter any name for the program in the "Description" field, e.g. "Acrobat Reader 11.0".
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3. Enter the program path of the program you want in the "Program" field.
Example program call for Adobe Acrobat Reader: 
"C:\Program Files (x86)\Adobe\Reader 11.0\Reader\AcroRd32.exe" /A 
"page=%Page%" %Reference%
Example program call for Step 7: 
"%ApplicationPath%CMSPLCReference.exe" %Reference%
Note

On the program path, you must enter the predefined "%Reference%" macro as a wildcard 
for the document path. 
There must be a space between the path and the macro "%Reference%".

Note

If the program path contains a space character it must be between quotation marks. 
We therefore recommend always writing the path in quotation marks.

Note

For the "PLC Reference", the path to the program is defined with the help of the 
%ApplicationPath% system macro. The macro provides the SIMOCRANE CMS installation 
path.

4. As an option, you can add other macros in the "Program" field.  
For example, the macro "%Page%" for opening a particular page in the PDF.

Note

You will find parameter instructions for opening programs in the documentation of the 
relevant program.

Note

You can insert a user-defined macro directly with the notation %macro_name%.
If the user-defined macro has not yet been defined under "Settings" → "Macros", when you 
save it you are asked whether you want to transfer the macro to the list of macros or reject 
it.

Result
You have now defined a program call for a reference. In the further steps, you must do the 
following:

● Define a reference to the file to be called. 
See also: Define the file call for reference (Page 129)

● Assign the reference to an equipment type, crane, or message and set the specific values 
for the command line operators. 
See also: Assigning references (Page 131)

7.1.6.14 Define the file call for reference
In this step, you define the reference to the file to be called.  
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Requirement: The program call has been defined. 
See also: Creating a program call for references (Page 127)

Sequence of steps
1. Open the screen form "References" → "References".

Figure 7-22 Configuring references in the CMS Editor

The reference appears in the "References" list on the right. 
The "Qty." column also displays how many times the reference is assigned to a message.

2. Enter any name for the reference in the "Reference" field. For example, "Manual". 

3. Under "Program", select the program call you require.
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4. Under "Type", select the reference type you require.

5. Enter the path and name of the reference in the "Path" field.
Example file call for a PDF document: 
"C:\Program Files (x86)\Siemens\WinCC\SIMOCRANE CMS\Documentation
\SIMOCRANE_CMS_System_Manual.pdf"
Example file call for Step 7: 
-p "Z:\D\CMS\Applikationen\SimCrane 
V200\SimCraneV200\CMS_Stan.s7p" -st "SIMATIC 319-3 PN/DP" -c "CPU 
319F-3 PN/DP" -b %Block% -n %network% -d %WinCCDSNName%
Note
● There must be exactly 1 space before and after each call parameter. 
● Note the use of inverted commas in your parameters. 

Some parameters require inverted commas; however, in others, they must not be used.
See also: References to STEP 7 (Page 124)

Note

You can insert a user-defined macro directly with the notation %macro_name%.
If the user-defined macro has not yet been defined under "Settings" → "Macros", when you 
save it you are asked whether you want to transfer the macro to the list of macros or reject 
it.

Result
You have now defined a reference to a file.  

In a further step, you must assign the reference to an equipment type, crane, or a message. 
Here, you define the specific values for the command line operators.
See also: Assigning references (Page 131)

7.1.6.15 Assigning references
Here, you assign the reference to an equipment type, crane, or message. Here, you set the 
specific values for the special command line operators, for example, for opening a certain page 
in the PDF document.

Requirement: 

● The program call has been defined. 
See also: Creating a program call for references (Page 127)

● The reference to the file has been defined. 
See also: Define the file call for reference (Page 129)

You can assign a reference multiple times. 
The relevant parameters of the reference are set for each assignment.
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Sequence of steps
1. Open the screen form "References" → "Assign references".

Figure 7-23 Assignment of references to a WinCC message in the CMS editor

2. Mark the equipment type, crane, or message that you require in the tree structure.

3. Mark a reference.

4. Press the "<" key to assign the reference.

Note

With the ">" key, you can undo the assignment.

5. Assign values to the parameters for this reference in the "Parameters" list. For example, the 
parameter of the macro %Page% for the number of pages of the PDF.

Note

Macros can also be preset to a fixed value under "Settings" → "Macros". Values are 
assigned in the "Macro text" field (e.g. "1" for the "%Page%" macro). The value then applies 
to all the reference's assignments. 
The value is however overwritten by entries in the "Parameter" field in the assignment 
screen form for references.

6. Use the "Preview" button to test that the reference opens. 
The button simulates the behavior of the runtime.
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7.1.7 Operational data on the CMS station

CMS Runtime records three categories of operational data for a crane:

● Cargo handling data

● Time slices for counter values (operating hours, load and switching cycle counters)

● MMBF data

Each category contains a configurable data set. The data sets are entered in the WinCC Tag 
Logging archives by the CMS Runtime, depending on the event. The background to event 
control is that all values can be entered in the archive in synch with a defined time stamp and 
accessed as a data package for this time stamp later on.

Events include:

● cyclic events

● acyclic events (trigger tag, change in value)

The values entered can be called up in WinCC directly using the WinCC Table Control and 
displayed in tabular form.

The following steps should be followed for configuration:

● Configuring the data sets in WinCC

● Configuration of types of recording/recording events in the CMS editor

7.1.7.1 Data sets for configuring operational data

Initial situation
The data sets are configured in WinCC.

One data set comprises several WinCC process tags, which are archived in a common WinCC 
Tag Logging archive.

You will find the following data sets configured in the example application.

Table 7-6 Operational data sets in the CMS example application

Category Tag group for proc‐
ess tags

WinCC Tag Log‐
ging archive

WinCC screen Description

Move data MoveData MoveData MoveData Move data set
MMBF data MMBFData MMBFData MMBFData MMBF data set
Time slices for 
counter values

CounterTotal CounterHourly - Data set for load and 
maintenance counters

TimerDaily - Data set for operating 
hours counter
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Note

The length of the archive name is limited to 32 characters, the length of the process tag name 
is limited to 64 characters.

In the following, the move data archive is used to describe how you can extend an existing data 
set.

Sequence of steps
1. First of all, create all the new values of the data set as process tags in the tag group 

"MoveData", in the WinCC tag management.

2. Add the new process tags in the WinCC Tag Logging archive "MoveData", or remove values 
you do not need.

3. Open the properties of the new archive tags.

4. Because the values from the CMS Runtime are subsequently entered in the archive, you 
need to define the following properties:

Figure 7-24 Configuration of archive tags for move data acquisition in the WinCC Tag Logging editor

Table 7-7 Setting for archive tags for operating data acquisition

Option Setting
Archiving blocked Activated
Relevant long term Activated
Acquisition type Acyclic

● Proceed in the same way for all other data sets which you wish to change.

● You can also define your own archive. Proceed as described above when configuring the 
archive.

Configuring a CMS station
7.1 Configuring the CMS product

Crane Management System (CMS)
134 System Manual, 11/2019



Result
You have now prepared the operational data sets. However, at the moment you cannot record 
any values. To do this, you must configure the next acquisition steps in the CMS editor. The 
acquisition dialog differentiates between the three categories of operating data.

7.1.7.2 Acquiring move data

Initial situation / objective
Acquiring move data with CMS Runtime means reading a data set associated with a cargo 
handling operation and entering it into a WinCC Tag Logging archive with a common time 
stamp. All the data of the move data set to be acquired must be present as tags in the WinCC 
tag management and be defined in an archive of the WinCC Tag Logging editor. All the data 
must be in the same archive. Trigger tags initiate data recording.

Figure 7-25 Acquiring move data
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The following types of move data acquisition are supported by CMS Runtime:

● Direct acquisition:
The data set time stamp is generated in the CMS. A start and stop event define the time 
frame of the data set. The data is read during the stop event. The start and stop events are 
binary tags in the WinCC tag management. If the value is "1", then CMS Runtime reads 
information and resets the tag to "0". The start time stamp is determined during the start 
event and during the stop event the stop time stamp is determined, the move data is read 
and entered into the WinCC Tag Logging archive. The stop event may only be set to "1" if 
the start event has already been reset to "0".

● Buffered acquisition:
The time stamp of the data set is generated on the controller and transferred to the CMS with 
the data set. The mechanism supports the buffering of data on the controller. The time 
stamp is always transferred from the controller to WinCC split up into individual time 
components (year, month, day, hour, minute, second). The time components must be 
defined as tags in the WinCC tag management and written by the controller along with the 
data set. Time components are byte type tags. The CMS add-on expects and interprets a 
time stamp with decimal coding on a time basis of 24 hours. A trigger tag from the WinCC 
tag management uses the "1" status to signal that a new data set can be read. CMS Runtime 
sets the status to "0" when the data has been read and entered in the Tag Logging archive. 
A new data set can now be written on the controller.

Note

For the trigger control, it is essential you observe the information in the operating 
instructions of the CMS add-on for WinCC.

The following criteria are already fulfilled in the CMS example application:

● Process tags for the move data set in the tag group "MoveData".

● Trigger tags in the tag group "MoveData"

● Time stamp tags in the tag group "MoveData"

● Tag Logging archive "MoveData" for saving the data sets

● WinCC screen "MoveData.Pdl" for displaying the data sets in a WinCC OnlineTableControl.

How to configure the acquisition using CMS Runtime is described below.

Processing steps – direct acquisition
1. Open the CMS editor.

2. Open the move data dialog under "Operating data" → "Move data".

3. Enter the name of the predefined WinCC Tag Logging archive in the "Archive" field 
(e.g."MoveData").

The "Trigger" and "Time stamp" fields define the type of data acquisition. You must note the 
following for the direct acquisition of data:

1. In the "Start" field, enter the WinCC process tag "blnMoveStart" from the tag group 
"MoveData", which signals the start of the cargo handling operation.

2. In the "Stop" field, enter the WinCC process tag "blnMoveStop" from the tag group 
"MoveData", which signals the end of the cargo handling operation.
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3. The fields for "Time stamp" must remain empty.

4. An internal WinCC tag for the cargo handling duration is entered in the "Duration" field. The 
duration is calculated by CMS Runtime.

5. Data acquisition is activated with the "Record data" setting. If you remove the check mark, 
you can shut down the complete processing. No data is transferred and no archive entries 
or XML files are created.

Figure 7-26 Configuration of direct move data acquisition in the CMS editor

Processing steps – buffered acquisition
1. Open the CMS editor.

2. Open the move data dialog under "Operating data" → "Move data".

3. Enter the name of the predefined WinCC Tag Logging archive in the "Archive" field 
(e.g."MoveData").
The "Trigger" and "Time stamp" fields define the type of data acquisition. You must note the 
following for buffered acquisition of data:

4. The "Start" field may remain empty. Otherwise, enter the WinCC process tag 
"blnMoveStart" from the tag group "MoveData" in this field.

5. In the "Stop" field, enter the WinCC process tag "blnMoveStop" from the tag group 
"MoveData". This signalizes that a data set can be read.

6. Enter the respective tags for the time components for the start time in the "Time stamp" → 
"Start" fields.
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7. Enter the respective tags for the time components for the stop time in the "Time stamp" → 
"Stop" fields.
An internal WinCC tag for the cargo handling duration is entered in the "Duration" field.

8. The duration is calculated by CMS Runtime. With buffered acquisition, you can also send 
the "Duration" rather than the stop time from the controller.
Data acquisition is activated with the "Record data" setting. If you remove the check mark, 
you can shut down the complete processing. No data is transferred and no archive entries 
or XML files are created.

Figure 7-27 Configuration of buffered move data acquisition in the CMS editor

7.1.7.3 Acquisition of time slices for counter values

Initial situation / objective
The example application makes a distinction between two types of counter:

● Total counter: Counter for measuring a crane's service life (equivalent to a total kilometer 
reading in a car)

● Section counter: Counter which can be reset from the CMS user interface (similar to a trip 
recorder in a car)

The actual counters are located on the crane control system. Both counters must count in 
tandem. Their current value is defined as a tag in the WinCC tag management. A bit in the CMS 
user interface triggers the resetting of the section counters on the controller.

Use the following naming convention in the WinCC tag management to make an assignment 
between a total counter and a section counter:

● Total counter: → "Counter name"

● Section counter to "Counter name": → "Counter nameRes"
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This means you will not be able to create a total counter with the ending "Res".

The CMS Runtime handles two tasks for the counter values:

● Calculating differential values for a total counter in defined time slices

● Monitoring actual counter values. The CMS runtime monitors the consistency of all total 
counter values and the assigned section counters. (Note the naming convention!)

You can define any time slices in the CMS editor. The time slices are stored in WinCC Tag 
Logging archives. A time slice applies to all values in an archive.

A counter's current values can only be monitored if the total counter is part of an archive 
dedicated to recording time slices in the CMS editor. The section counter must not be part of the 
archive. When the value of a total counter changes, the current value is compared with the last 
counter value stored. If the current value is less than the value last stored, the CMS writes the 
old value back to the controller. This prevents information from being lost, something which 
may occur if the control program is reloaded to the CPU after a certain operating time.

Note

A configuration file is created in the WinCC project directory under "…\CMS\Counter" and 
under "…\CMS\Accumulates" to monitor the counter values and to calculate the difference. If 
the counter values are to be deleted in full, these two configuration files must be removed.

Figure 7-28 Acquisition of time slices for counter values

In the example application, the process tags for the controller's total counter are available in the 
tag group "Counter_Total," the resettable counters are available in the tag group 
"Counter_Reset."

Two tag logging archives, "CounterHourly" and "CounterDaily", have been set up to save the 
time slices.

The following criteria are already fulfilled in the CMS example application:

● Process tags in the tag group "Counter_Total.

● Tag logging archives "CounterHourly" and "CounterDaily" for saving the data sets

The following describes how to configure that the time slices for counter values are entered in 
the CMS editor. The counter restoration is coupled to the acquisition of the counter values.
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Sequence of steps
1. Open the CMS editor.

2. Open the counter dialog under "Operating data" → "Counters".

3. Enter the name of one of the predefined WinCC Tag Logging archives in the "Archive" field 
(e.g."CounterHourly").

4. Select the recording cycle you want under "Cycle". The following options are available:

– Hourly

– Daily

– Weekly

– Monthly

5. Enter the time for initializing the values under "First start".
You can use the setting "Switch off processing" to switch off the processing completely. No 
data is transferred and no archive entries or XML files are created.

Figure 7-29 Configuring the acquisition of counter data in the CMS editor

6. Use "New" to create an additional data set and configure the acquisition for all other counter 
time slice archives (e.g. "CounterDaily") as described above.

Note

Please note that for the initial start, a value initialization must be carried out first. Therefore 
no values are entered in the archive for the first cycle.
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7.1.7.4 Acquisition of MMBF data

Initial situation
The CMS Runtime can acquire what are known as MMBF data which is determined on the 
controller and configured in the WinCC Tag Logging. The process of reading a MMBF data set 
is signaled to the CMS Runtime by the controller using a trigger tag. If the trigger tag value is 
"1", the CMS Runtime reads information, enters the data in a WinCC Tag Logging archive and 
resets the tag to "0".

As with move data, the CMS Runtime supports the following types of MMBF data acquisition:

● Direct acquisition
The data set time stamp is generated in the CMS.

● Buffered acquisition
The time stamp at which the data set was determined on the controller is also set on the 
controller and transferred to the CMS along with the data set. The mechanism supports the 
buffering of data on the controller.

The following criteria are already fulfilled in the CMS example application:

● Process tags in the tag group "MmbfData"

● Trigger tags in the tag group "MmbfData"

● Time stamp tags in the tag group "MmbfData"

● Tag Logging archive "MmbfData" for saving the data sets

The description below explains how you adapt the existing data set or type of acquisition to your 
requirements.

Note

You can also evaluate the MMBF data using the CMS Analyzer. No additional configuration of 
the CMS project is required for this purpose.
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Processing steps – direct acquisition
1. Open the CMS editor.

2. Open the MMBF data dialog under "Operational data" → "MMBF data".

3. Enter the trigger tag for reading the MMBF data set in the "Trigger" field.
The "Time stamp" fields define the type of data acquisition. You must note the following for 
the direct acquisition of data:

– The fields for "Time stamp" must remain empty.

– Data acquisition is activated with the "Record data" setting. If you remove the check 
mark, you can shut down the complete processing. No data is transferred and no archive 
entries or XML files are created.

Figure 7-30 Configuration of direct MMBF data acquisition in the CMS editor

Processing steps – buffered acquisition
1. Open the CMS editor.

2. Open the MMBF data dialog under "Operational data" → "MMBF data".

3. Enter the trigger tag for reading the MMBF data set in the "Trigger" field.
The "Time stamp" fields define the type of data acquisition. You must note the following for 
buffered acquisition of data:

4. Enter the tags for the time components for the time stamp in the "Time stamp" fields.
Data acquisition is activated with the "Record data" setting. If you remove the check mark, 
you can shut down the complete processing. No data is transferred and no archive entries 
or XML files are created.
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7.2 CMS Runtime

7.2.1 General information about operation

7.2.1.1 Starting the CMS Runtime
CMS Runtime has no user interface. The program can either be manually started or it can be 
started using an entry in Windows or WinCC Startup.

Note

For normal operation, it is recommended that CMS Runtime is started via the Windows Startup.

An icon in the Windows system tray indicates that CMS Runtime has been started. 

Figure 7-31 CMS Runtime icon

White with green letters:
A WinCC project is loaded.
WinCC Runtime has started.
White with blue letters: 
A WinCC project is loaded.
WinCC Runtime has stopped.
White with red letters: 
A WinCC project is not loaded.
Red with black letters:
A WinCC project is loaded.
The CMS configuration data contain an error.
CMS Runtime has detected a "fata error".
You can find more information about the error in the CMS error file in folder "…\CMS" of 
the WinCC project directory.

In addition, there is a CMS system tag "@CMSConnectionState", to which the status of CMS 
Runtime is mapped (see Chapter CMS system tags (Page 153)).

Configuring a CMS station
7.2 CMS Runtime

Crane Management System (CMS)
System Manual, 11/2019 143



7.2.1.2 Terminating CMS Runtime
CMS Runtime can be terminated via a context menu command (right-click the icon displayed 
in the system tray).

1. Terminate the CMS application, the CMS editor and the WinCC Graphics Designer.

Note

Always terminate these programs before you terminate CMS Runtime. 
Otherwise the application or the WinCC Graphics Designer may freeze.

2. Right click the CMS Runtime icon in the system tray and select "Exit" in the shortcut menu.

When the WinCC Runtime has crashed or when shutdown of the WinCC Runtime has been 
forced by the function "Reset_WinCC", the computer must be restarted. This is the only way to 
ensure that all processes are correctly restarted. The following error message may otherwise 
appear:

Figure 7-32 WinCC Software License error message

Note

Only use the function "Reset_WinCC" in exceptional cases, i.e. when you cannot find any other 
way to shut down WinCC.
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7.2.2 Process value acquisition

7.2.2.1 Applications
The recording of process values mainly covers two applications:

● Fault analysis when the crane is at a standstill: During the fault analysis, first the trend of 
various process values should be shown as a fault message. The process values in one 
time range are shown in relation to the time stamp of the fault message with pre- and 
posttrigger time period.

● Recording and analysis of continual process values when commissioning the crane

Another criterion for the display accuracy and the quality of the fault analysis is the resolution 
of the measurement points. The higher the resolution, the more measurement points and the 
higher the volume of data.

7.2.2.2 WinCC standard process value archiving
With WinCC Tag Logging, values with maximum 500 ms can be recorded and archived. These 
values are displayed in the CMS example application as continuous trends.

Advantage:

The advantage of WinCC standard process value archiving is that it can be quickly and cheaply 
implemented. 

Disadvantage:

The disadvantage is the low resolution of the trends, since an archiving cycle of 500 ms 
generates an insufficient number of measurement points for the post mortem analysis. The 
SIMOCRANE Fast Trace Viewer can be used for this purpose however.
See: SIMOCRANE CMS Fast Trace Viewer (optional) (Page 48)

7.2.2.3 WinCC standard process value archiving with increased resolution
For the following applications, data can be prepared on the controller, collected and sent to 
WinCC in one telegram:

● Process values with an interval of less than 500 ms are recorded

● Values are acquired with a time stamp from the controller

● Several values can be acquired in time synchronism

The data are entered into a WinCC Tag Logging archive with the time stamp allocated by the 
controller.

For detailed information, for instance on the telegram structure, refer to the WinCC 
documentation (WinCC communication manual → SIMATIC S7 PROTOCOL SUITE channel → 
Special functions).

For SIMATIC S7, there are blocks that can be parameterized for sending a telegram. In the 
S7-400 automation system, there is the integrated function block SFB 37 "AR_SEND" .

Advantage:
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The advantage of this method is that archiving cycles of less than 500 ms are possible in 
WinCC. High levels of configuration effort are not needed on the HMI side. 

Disadvantage:

The high level of configuration effort impacts negatively on the controller side. In particular there 
is a high level of communication between the automation system and WinCC. When several 
process values are being transferred, the cycle time and transfer rate of the communications 
interface must be noted.

7.2.3 Acquiring move data on the CMS station

7.2.3.1 Overview
Certain operating data in the controller are identified in the CMS for the purpose of acquiring 
information about the utilization of a crane or for performing other statistical analyses. These 
data are then transferred to the CMS on the computer for storage in the database.

While some of these values are continuously saved, there is a set of data assigned to the 
movement of a container load. These values are only saved after the movement has been 
completed. These values will be referred to as cargo handling data from now on.

Cargo handling data includes, e.g. values such as:

● Starting time, finishing time and/or duration of a cargo handling operation

● Container size

● Weight

● Direction of motion

● Specification of a mode or status (for example: Automatic mode, heavy-duty operation, dual-
spreader operation ...)

Cargo handling data is stored in WinCC Tag Logging archives. When process values are stored 
in Tag Logging archives, the tags to be archived are normally acquired by WinCC and stored 
in archive tags. However, since cargo handling data must fulfill special requirements, it is 
entered into the archive tags of the Tag Logging archives by CMS Runtime rather than by 
WinCC.

7.2.3.2 Requirements for correct assignment of time stamps
Requirements to be fulfilled to ensure correct assignment of time stamps: 

● Meaningful chronological sequence (start time before stop time)

● Time cannot lie in the future

● Time stamp is a decimal number and is coded in 24h format

● Time format (UTC or local time) is identical on the PLC, CMS and RCMS

● The times are synchronized within an interval of < 1 min
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The CMS Runtime compares all incoming time stamps of the PLC with the current PC time. If 
the incoming time stamps of the PLC are in the future, the current PC time is applied and the 
time stamp is marked with "u" (uncertain).

If several time stamps in the future are received, the following procedure is applied:

● Time stamp 1 = current PC time

● Time stamp 2 = current PC time + 10 sec.

● Time stamp 3 = current PC time + 20 sec.

● Time stamp 4 = current PC time + 30 sec.

● etc.

Calculating the duration of a cargo handling operation on the basis of time stamps with the 
attribute "u" (uncertain) can give an unreliable result.

Note

For further information, see Time synchronization (Page 156).

7.2.3.3 Definition of archives
CMS Runtime can acquire move data in two ways:

● Direct acquisition: 
The time stamp for the data set is set by CMS Runtime based on the system time on the 
computer. A start and stop event define the time frame of the data set.

● Buffered acquisition: 
The time stamp for the data set is set on the controller and transferred to the CMS with the 
data set.

External tags must be created in the WinCC tag management in order to be able to manage 
move data. The process values are part of the controller interface (e.g. direction of movement, 
weight, container size, duration of the cargo handling operation, etc.).

The interface also contains two bits which can be controlled by the controller at the beginning 
and end of a cargo handling operation (trigger bits). The start trigger is not essential for the 
buffered acquisition. If data buffering is required, the time stamp will also need to be specified 
in this interface. The time stamp is always transferred from the controller to WinCC split up into 
individual time components (year, month, day, hour (24 hours), minute, second) as decimal 
value.

At least one archive must be created in the WinCC Tag Logging for long-term storage of move 
data. This archive must be registered with the CMS in the CMS Editor. Further, the two bits to 
signal start or stop and/or the tags for time acquisition must also be specified in this function.

The archive tags in the Tag Logging archives are not written by WinCC (if this were the case, 
the timing of the write operations of individual archive tags would not be synchronous); instead 
they are triggered by the stop bit. They are then read from the crane control system using the 
external tags and are written by CMS Runtime to the archives with a common time stamp. The 
start or end time of the cargo handling operation can be selected as time stamp.
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The archive tags in the Tag Logging archives for managing move data must have the following 
settings – this is mandatory:

Property Value Meaning
Name Name of the archive tag Mandatory field in WinCC; required when dis‐

playing move data via the WinCC Report func‐
tion

Name of the process 
variable

External tags in the WinCC 
tag management system

The value of the specified tag is read by 
CMS Runtime from the controller and entered 
in the archive.

Tag supply System Manually input values are not currently sup‐
ported by WinCC

Archiving Disabled As the values are written from CMS Runtime 
by a program, the writing of values from 
WinCC must be disabled.

Acquisition type Acyclic Values can be entered at times chosen by the 
user.

Note

The length of the archive name is limited to 32 characters, the length of the process tag name 
is limited to 64 characters. 

Figure 7-33 Properties of an archive tag
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7.2.3.4 Execution in runtime
When CMS Runtime starts up, it reads the names of the archives and trigger tags from the 
configuration file and initializes processing of the move data. In this case, all archive tags of the 
relevant archive are read out for each parameterized archive and the external tag linked to the 
archive tag is determined. Furthermore, an information function is activated; this can activate 
a CMS Runtime function every time the status of one of the trigger tags changes.

If the information function detects an incoming edge for one of the two monitored trigger tags, 
one of the two processing functions is activated:

● Start of the cargo handling operation
When the cargo handling operation starts, only the time stamp at which the start was 
detected is stored. The bit for signaling the start of cargo handling is then reset again by 
CMS Runtime. The start may not be required. In this case, the time stamp tags for the start 
time are also acquired at the end of cargo handling sequence.

● End of the cargo handling operation
When the cargo handling operation ends, the time stamp, at which the status change in the 
trigger tag was detected, is initially saved. With a synchronous read task, all external tags 
of the individual archive tags are read from the controller. After the actual values have been 
acquired from the controller, they are written with the same time stamp to the Tag Logging 
archives by CMS Runtime. Archive entries are usually written to the archives with the time 
stamp recorded at the movement start. The time stamp to be used for writing archive data, 
i.e. the one for the start or end event, can be configured separately for each archive in the 
CMS Editor. 
The trigger bit is reset to complete the writing of move data. Once this has happened, the 
process of writing move data on the interface is reenabled on the controller.

Configuring a CMS station
7.2 CMS Runtime

Crane Management System (CMS)
System Manual, 11/2019 149



① Writing of data enabled by the controller.
Reading of data disabled by CMS Runtime

② Start of the cargo handling operation
③ Reading of start time stamp by CMS Runtime.

Writing of data disabled by the controller
④ Writing of data enabled by the controller.

Reading of data disabled by CMS Runtime
⑤ End of the cargo handling operation
⑥ Reading of stop time stamp and move data by CMS Runtime.

Writing of data disabled by the controller
⑦ Writing of data enabled by the controller.

Reading of data disabled by CMS Runtime
Figure 7-34 Protocol for acquisition of move data

The controller disables the writing of data when one of the two trigger bits is set. This ensures 
that the data set acquired is always consistent. Conversely, CMS Runtime disables the reading 
of values when the trigger bits are not set.

The CMS sample application provided contains predefined archives for storing move data with 
a basic set of archive tags. The user can adapt these archives to meet his own requirements 
if necessary. 

7.2.4 Acquiring counter differences at the CMS station

7.2.4.1 Overview
The counters are located in the controller. The CMS only manages the counters' process 
values. The counter values are part of the controller interface (e.g. counts for the number of 
cargo handling operations, the total weight, etc.).
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CMS Runtime distinguishes between two types of counters:

● Total counter: Counters which are valid for the crane's life cycle (equivalent to an odometer 
in a car)

● Section counter: Counter which can be reset from the CMS user interface (trip odometer in 
a car)

Both counters must count in parallel. 

Use the following naming convention in the WinCC tag management to make an assignment 
between a total counter and a section counter:

● Total counter: → "Counter name"

● Section counter to "Counter name": → "Counter nameRes"

This means you will not be able to create a total counter with the ending "Res".

The actual values of the total counters are monitored by CMS Runtime. The actual values of a 
counter can only be monitored if the total counter is a part of an archive used to record counter 
differences in the CMS Editor. The section counter must not be part of the archive. When the 
value of a total counter changes, the actual value is compared with the last counter value 
stored. If the actual value is less than the value last stored, the CMS writes the old value back 
to the controller. This prevents information from being lost, something which may occur if the 
control program is reloaded to the CPU after a certain operating time.

Note

A configuration file is created in the WinCC project directory under "…\CMS\Counter" and 
under "…\CMS\Accumulates" to monitor the counter values and to calculate the difference. If 
the counter values are to be completely reset, then these two configuration files must be 
removed.

7.2.4.2 Definition of archives
Long-term storage of counter differences is only possible if at least one archive has been 
created in the WinCC Tag Logging and this has been registered with the CMS in the CMS Editor 
via the dialog for counter acquisition. The time slice for the counter differences must also be 
defined in the same dialog.

The archive values are written to the Tag Logging archives by CMS Runtime. The time that the 
counter differences are acquired is used as time stamp. The time of acquisition is obtained from 
the acquisition cycle, which is set in the CMS Editor. It is essential that the archive tags in the 
Tag Logging archives for managing the counters have the same settings as the archive tags of 
the cargo handling data archives (see Chapter Definition of archives (Page 147)).
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7.2.4.3 Execution in runtime
The CMS Runtime handles two tasks for the counter values:

● Calculating differential values for a total counter in defined time slices

● Monitoring actual counter values. The CMS Runtime monitors all total counter values and 
their assigned section counters for consistency (please note the naming convention).

When CMS Runtime starts up, it reads the names of the archives and acquisition cycles from 
the configuration file and initializes processing of counter data. The archive tag values from 
each parameterized archive are fetched and the external tag linked to the archive tag is 
determined. This gives users the freedom to adapt the type and scope of the stored data to suit 
their own requirements by creating new, individual archive tags or amending/deleting existing 
ones. If users want to exclude entire archives from processing (or include them), they can make 
the necessary changes in the CMS Editor.

A cyclic function is started in the CMS Runtime which monitors the acquisition cycles for the 
counter archives. Once an acquisition cycle for an archive is complete, all the process tags of 
this archive are read. The difference between the current count and the count for the previous 
cycle is established. Finally, the difference is entered in the Tag Logging archive.

An information function is also started, which is triggered whenever a counter changes. This 
function compares the current value with the last value. If the current value is less than the old 
value, CMS Runtime writes the old value back to the controller

7.2.5 Acquiring MMBF data at the CMS station

7.2.5.1 Overview
Like the acquisition of cargo handling data, the acquisition of MMBF data supports both direct 
acquisition and burrered acquisition. The controller has to specify the time stamp under which 
the data set is to be stored in the Tag Logging archive.

When the controller has to specify the time stamp, the relevant WinCC process tags for reading 
the time stamp must be specified in the function for defining MMBF data in the CMS Editor.

External tags must be configured in the WinCC tag management system before MMBF data 
can be managed. MMBF data is part of the controller interface (e.g. number of cargo handling 
operations, number of errors, calculated MMBF value, etc.).

The interface also has a bit which is set by the controller after a specific period (e.g. one month) 
has passed (trigger).
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7.2.5.2 Definition of archives
At least one archive must be created in the WinCC Tag Logging for long-term storage of MMBF 
data. This archive must be registered with the CMS in the CMS Editor. The trigger bit and, if 
necessary, the time stamp tags also need to be defined in the dialog.

Note

Do not create string tags in the MMBF archive.

String tags are not supported for MMBF data!

Here too, data is written to the archives by CMS Runtime. The time at which WinCC detected 
the change in the trigger bit is used as time stamp, or the time stamp, transferred from the 
controller to the data set. It is essential that the archive tags in the Tag Logging archives for 
managing the MMBF data have the same settings as the archive tags of the cargo handling 
data archives (see Chapter Definition of archives (Page 147)).

7.2.5.3 Execution in runtime
When CMS Runtime starts up, it reads the names of the archives and trigger tags from the 
configuration file and initializes processing of MMBF data. The archive tags from each 
parameterized archive are fetched and the external tag linked to the archive tag is determined. 
Furthermore, an information function is activated; this can activate a CMS Runtime function 
every time the status of the trigger tag changes. This gives users the freedom to adapt the type 
and scope of the stored data to suit their own requirements by creating new, individual archive 
tags or amending/deleting existing ones. If users want to exclude entire archives from 
processing (or include them for processing), they can make the necessary changes in the 
CMS Editor. 

If the information function detects an incoming edge of the monitored trigger tag, then for further 
processing the MMBF event is started.

First, the time stamp at which the status change in the trigger tag was detected is stored. With 
a synchronous read task, all external tags of the individual archive tags are read from the 
controller. If these values on the controller are only written when the trigger bit is reset and 
provided the trigger bit is only set when all values have been successfully written, it can be 
ensured that only those values relating to the current MMBF data set are read from the 
controller and transferred to internal tags. 

After the actual values have been acquired from the controller, they are written with the same 
time stamp to the Tag Logging archives by CMS Runtime.

The trigger bit is reset to complete the writing of MMBF data. Once this has happened, writing 
MMBF data on the interface is re-enabled on the controller.

7.2.6 CMS system tags
The CMS Runtime creates a series of system tags with the prefix "@CMS". The tags in the 
"CMS" group are created at the CMS station.

Configuring a CMS station
7.2 CMS Runtime

Crane Management System (CMS)
System Manual, 11/2019 153



Their content is entered in runtime, e.g. from the information of the CMS editor (Topology → 
Cranes).

Table 7-8 CMS system tags

Tag name Data type Bit Description
@CMSProgramVersion Text tag 

16-bit character 
set

- Version of the CMS Runtime

@CMSDatabaseVersion Text tag 
16-bit character 
set

- Version of the CMS database

@CMSCraneName Text tag 8-bit 
character set

- Name of the crane

@CMSEquipment Text tag 8-bit 
character set

- Equipment type to which the crane belongs

@CMSIPAddress Text tag 8-bit 
character set

- IP address of the CMS station

@CMSConnectionState Unsigned 16-bit 
value

0 When the CMS Runtime started, no major errors 
occurred. All local functions are active.

  1 When the CMS Runtime started, no major errors 
occurred. All local functions are active.

  7 CMS Runtime cannot run. When starting CMS Run‐
time, a fault has occurred that prevents CMS Run‐
time from being executed (e.g. WinCC Runtime has 
not been started, a crane has not been defined in 
the CMS editor, a wrong computer name has been 
entered into the CMS editor, ...). You can find more 
information on this fault in the CMS error file in the 
folder …\CMS of the WinCC project directory.

7.2.7 System messages
CMS Runtime displays general execution and error information in the CMS system messages. 
These system messages use reserved message classes that are created in the WinCC Alarm 
Logging. The messages of these classes only use the status "came in". 

Message class 15 "CMSTimeZone"

This message class contains the following message type:

● CMSTimeZoneWarning: Message type 225 

Message class 16 "CMS"

This message class contains the following message types:

● CMS_Fault: Message type 241

● CMS_Warning: Message type 242

● CMS_Info: Message type 243

The system messages have an offset of 50000 in the WinCC Alarm Logging.
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Table 7-9 CMS system messages

Message 
number

Message type Message text
(user text block 5)

Additional messages at the CMS station
50212 CMS_Info Connection to WinCC Runtime established.
50213 CMS_Info Connection to WinCC Runtime aborted.
Time zone warnings
50400 CMSTimeZo‐

neWarning:
MMBF: PLC time stamp invalid, replaced by current PC time.

50401 CMSTimeZo‐
neWarning:

MoveData: PLC time stamp invalid, replaced by current PC time.

See also
System messages (CMS with RCMS (WinCC)) (Page 389)
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7.3 Time synchronization

7.3.1 General
Time synchronization between the participating hardware modules is crucial in SIMOCRANE 
CMS/RCMS systems.

Time synchronization is performed hierarchically as follows: CMS > PLC.

If you read data from the crane control system with a time stamp, you must ensure that the time 
is kept in UTC (Universal Time Coordinated) on the control system, or that the data transferred 
from the crane control system to the CMS are transferred with a UTC-based time stamp. All the 
necessary tags and scripts are already provided in the CMS example application. You only 
have to adapt the programs and data blocks in the crane control system.

In practice, a synchronization interval of 1 minute has proven successful.

You can find more information on time synchronization in the document "Standard PLC Blocks" 
(S7_Standard_Blocks_SIMOCRANE_CMS.pdf) on the installation DVD.

7.3.2 Setting up time synchronization on the crane control system
You must set up time synchronization on the crane control system.

To do this, you must copy the following data blocks and functions into your SIMATIC S7 project:

● Data block DB_CMS_TIMESYNC (DB1909)

● Function CMS_TIMESYNC (FC1909)

● System function SET_CLK (SFC0)

You can find the data block and the functions in the following libraries on the installation DVD:

● S7 SIMATIC Manager project: "CMS_StandardBlocks_Vxx_Library.zip" 

● S7 TIA Portal: "CMS_StandardBlocks_Vxx_Library.zap15.1"

The data block "DB_CMS_TIMESYNC" handles communication between the crane control 
system and the CMS station for the purposes of time synchronization.
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Figure 7-35 Data block DB_CMS_TIMESYNC (DB1909) - Step 7 TIA Portal / Step 7 SIMATIC Manager

You must adapt the CMS_TIMESYNC function (FC1909).
You must adapt the S7 project such that the CMS_TIMESYNC function (FC1909) is called.

You can find more information on time synchronization in the document "Standard PLC Blocks" 
(S7_Standard_Blocks_SIMOCRANE_CMS.pdf) on the installation DVD.

Procedure
1. Copy the following data blocks and functions from the appropriate library 

("CMS_StandardBlocks_Vxx_Library") into your S7 project.

– Data block DB_CMS_TIMESYNC (DB1909)

– Function CMS_TIMESYNC (FC1909)

– System function SET_CLK (SFC0)

2. Open the CMS_TIMESYNC function (FC1909).

Figure 7-36 CMS_TIMESYNC function
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3. Adapt the following tags:

Tag Setting
IN_Local_Time Set the value to "FALSE" if move data and MMBF data are to be ac‐

quired.
Move data and MMBF data require UTC time.

IN_Time_Sync_Interval The value is preset to 60 seconds. This synchronization interval has 
proven successful in practice.
Adapt this value if necessary.
Note:
The value is hexadecimal.

IN_TIMER Make sure that the preset tag is used exclusively by this function. Oth‐
erwise you must use a different tag.

IN_OUT_Time‐
sync_Edge

Make sure that the preset tag is used exclusively by this function. Oth‐
erwise you must use a different tag.

4. Adapt the S7 project such that the CMS_TIMESYNC function (FC1909) is called.

7.3.3 WinCC tags for time synchronization
The following tags are created in the external tags of the TimeSynchInternal group and 
participate in time synchronization between the CMS station and the crane control system:

Figure 7-37 WinCC tags of the TimeSynch group

Make sure that tags containing a time and date are transferred in the correct data format. You 
can verify whether this has been correctly implemented, for example, by simulating a time 
stamp and checking it afterward in WinCC.

Note

For further details, see the WinCC Online Help.
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7.3.4 WinCC time synchronization script
The time synchronization is performed by the PLC. Time synchronization is not the task of the 
SIMOCRANE CMS.

The trigger tag "TimeSynchronTrigger" exists in the PLC. This can assume the states "0" 
("False") and "1" ("True"). In WinCC, the same tag is called "blnTriggerTimeSync". You can see 
from the addressing (DB1909, D0.1) that it is the same tag.

The "GetTimeZoneBias.pas" action has the job of providing the date values to the PLC in the 
CMS example application.

The required script is already implemented as an example in the supplied CMS example 
application.

This action is triggered by the "blnTriggerTimeSynch" tag trigger. It checks whether the trigger 
value coming from the crane control system is 0. If it is, the time values are created and written 
into DB 1909. The trigger is then set to 1. 

Note

The date and time is only updated in DB1909 of the PLC if the trigger tag changes from "1" to 
"0", not if it changes from "0" to "1". 

Time synchronization is performed in the following sequence:
1. PLC sets the trigger tag from "1" to "0" (cyclically, e.g. once per minute).

2. The script "GetTimeZoneBias.pas" in WinCC recognizes the status change in the trigger 
tag; the script is run.  The UTC time, the local time, and the difference between the two times 
are read by the Windows system of the CMS computer and written into the time 
synchronization data block.

3. The script sets the trigger tag in the PLC from "0" back to "1."
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Figure 7-38 Time synchronization WinCC action
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7.4 CMS configuration editor

7.4.1 CMS Editor
In principle, the Editor always has the same structure, regardless of the system topology that 
has been set. The following topologies can be set: 

● CMS stand-alone

● CMS with RCMS (Process Historian)
(RCMS 4.4 and higher)

● CMS with RCMS (WinCC)
(up to RCMS 4.3 SP1)

The system topology is initially configured in the basic settings of the editor.
See also: System: Basic settings (Page 213)

The following dialogs are used in the CMS Editor to maintain master data:

● Equipment type
With the topology "CMS with RCMS (WinCC)", the equipment type is used for grouping the 
data for evaluations. Messages can be directly assigned to an equipment type. Messages 
assigned to a specific equipment type are "inherited" by all cranes of this type and do not 
need to be acquired separately for each crane.

● Cranes
Information about various cranes that CMS requires is managed in this table.

● Maintenance instructions
Information and instructions designed to help the maintenance engineer to diagnose and 
eliminate faults are stored in this table. These include both information about possible 
causes of failures as well as instructions on how to eliminate them. 

● Logbook
Remarks on the maintenance instructions are provided in this table.

● References
Additional information relating to equipment types, cranes and messages can be collected 
for access by maintenance engineers requiring troubleshooting support. However, 
information of this type is not stored in the database itself, the table provides references to 
a document containing the information. 
Which documents can be displayed is determined by the display programs installed on the 
computer. The name of the program with which the relevant information can be displayed 
is therefore stored with the reference. 
For the purpose of simplicity, the terms "reference" and "referenced information" will be 
used synonymously in the remainder of this document.

● Move data
The data to acquire cargo handling operations is configured in this dialog box. For every 
cargo handling operation that the crane makes, a data set, called move data, is entered into 
a WinCC Tag Logging archive prepared for this purpose.
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● MMBF data 
(Mean Moves Between Failures)
The MMBF acquisition data is configured in this dialog box. On a trigger event from the PLC, 
a data set is entered into a WinCC Tag Logging archive prepared for this purpose.

● Counters
The counters are defined in this dialog box. For each counter, a difference value is written 
to a WinCC Tag Logging archive prepared for this purpose at constant time intervals. The 
difference value is obtained from the actual value of the counter to the value of the same 
counter at the last acquisition. All counters that are defined here are monitored 
simultaneously by CMS Runtime to avoid unwanted resetting of the counters (for example, 
when the control program is reloaded).

● Transfer of messages (for topology "CMS with RCMS (WinCC)" only)
All messages whose configuration and runtime data are transferred to the RCMS 4.3 SP1 
server are selected in this dialog box. The selection can be made according to message 
classes.

● Transfer of tag list (for topology "CMS with RCMS (WinCC)" only)
All tags whose values will be transferred to the RCMS 4.3 SP1 server, either when a value 
changes or cyclically, are defined in this dialog box.

● Transmission of operating data (for topology "CMS with RCMS (WinCC)" only)
All operating data archives whose configuration and runtime data are transferred to the 
RCMS 4.3 SP1 server (move data, counters, MMBF data) are defined in this dialog box.

● Icons (for topology "CMS with RCMS (WinCC)" only)
Terminals, equipment types and cranes are generally selected in a "tree" for editing in the 
respective data entry dialog boxes of an RCMS 4.3 SP1 server. The icons by which the 
corresponding objects are represented in the tree are stored in this table.

● Macros
This table defines text blocks used as place holder in references.

● Programs
This table is used to register the programs available for displaying references with the CMS. 

● Reference types
The information in this table is used to clearly group the references for display in the 
CMSFaults control. This is the sole function of the data in this table.

● User texts
Texts to be displayed in the runtime for different languages are configured in this dialog box.

The topology of the system is defined by the data for terminals, equipment types and cranes. 
They are used to display the tree structure in the CMSNodeTree Control of an RCMS 4.3 SP1.

The data for maintenance instructions and references are used to display supplementary 
message information in the CMSFaults control. 

The data in the help table for the icons is used to visualize individual objects in the tree structure 
of an RCMS 4.3 SP1 to display the system topology.

The data in the auxiliary tables for reference types, macros, and programs is needed to display 
supplementary message information in the CMSFaults control.
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7.4.2 General information about operation

Note

If you have made changes in the CMS editor, you should always restart CMS Runtime to ensure 
that your changes are accepted.

7.4.2.1 User roles
When starting the CMS Editor, a distinction is made between two user roles with different rights. 
These roles are controlled on the basis of Windows user groups.

● User
User is the role automatically assigned to anyone who starts the CMS Editor. A user has 
only restricted access to the functions in the CMS Editor.

● CMS Administrator
A CMS Administrator has to be a member of the Windows user group "CMSAdmin". CMS 
administrators have unrestricted access to the functions of the CMS Editor.
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7.4.2.2 Launching from WinCC Explorer

Figure 7-39 Integration in WinCC Explorer

The functions for acquiring CMS master data are launched either directly by a double click on 
the "Crane Management System" entry or in the WinCC Explorer following a right click on the 
corresponding command in the context menu.
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7.4.2.3 Function selection

Figure 7-40 Functions in the CMS editor 

All available parameterization functions can be accessed via the tree display in the left-hand 
window of the CMS Editor (function tree). The parameterization functions are grouped together 
using a number of categories.

When a parameterization function is selected in the tree display, the associated dialog will 
appear in the right-hand window of the Editor.

When a category is selected in the tree display, all parameterization functions belonging to this 
category are displayed in the right-hand window. The associated dialog can then be called by 
double-clicking the parameterization function in the right-hand window.

Note

You must first define the topology in the dialogs Terminal, Equipment type and Cranes, to 
enable all additional configuration functions.

The structure of the tree display for the available parameterization functions makes a distinction 
between two modes, depending on the user role: Administrator and users

In the administrator mode, in addition to the parameterization functions of the user mode, the 
parameterization functions for creating and maintaining of reference types, changing symbols 
and adapting displayed message details in the CMSFaults Control are also available.
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In addition, the structure of the tree display for the available parameterization functions also 
makes a distinction based on the topology selected.

Table 7-10 Toolbar of the function selection

Icon Meaning
Upload
Opens the "Upload" screen form
Note: 
Only available for the topology "CMS with RCMS (WinCC)"
Im/Export
Opens the "Import/Export" screen form

See also
System: Basic settings (Page 213)

7.4.2.4 Context menu
All dialogs in the CMS Editor are basically identical in terms of functional structure. They differ 
only in the scope of the editor functions offered by the dialog.

All available functions can be called by means of a context menu. Alternatively, most functions 
can also be called via a toolbar in the header of the acquisition dialog. Very frequently used 
functions can be called via a button menu. The footer of the dialog contains a status bar which 
shows, for example, the current text entry mode (insert or overwrite mode).

There are three different dialog types in the CMS Editor:

● Dialogs for acquiring basic data (acquisition dialogs)

● Dialogs for linking different sets of basic data (assignment dialogs)

● Dialogs for activating functions

Each of these dialog types has its own scope of functions, but only the data acquisition dialogs 
feature the entire range of functions. The assignment dialogs do not include the functions 
"New" or "Edit" as these are always executed directly in these dialogs. The dialogs for activating 
functions contain only the help function.

Table 7-11 Context menu toolbar

Icon Meaning Acquisition dialog Assignment dialog Starts functions
New yes no no

Save yes no no

Copy yes no no

Delete yes no no

Filter yes yes no

Remove filter yes yes no
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Icon Meaning Acquisition dialog Assignment dialog Starts functions
Abort yes no no

Import/export yes yes no

Help yes yes yes

7.4.2.5 Button menu
The button menu contains the following buttons:

● Overwrite
In insert mode, a new data record with the displayed data is created; in overwrite mode, the 
displayed data record with the displayed data is overwritten.

● Copy
The currently displayed data record is saved under the new name.

● New
All fields in the acquisition screen are deleted, insert mode is activated.

● Delete
The displayed data record is deleted.

● Abort
In insert mode, all input fields are deleted again; in overwrite mode, the currently displayed 
data record is imported from the database again. This resets all changes which have 
already been made.

7.4.2.6 Status bar
The status bar shows the current status of the insert or overwrite mode during editing. After a 
button has been pressed, a message (e.g. "Data set deleted") will be briefly displayed 
(10 seconds) confirming that the action triggered has been successfully completed.

7.4.2.7 Validity checks
Validity checks are performed on every user input. An input error icon is displayed next to the 
line containing an input error.
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Figure 7-41 Signaling of input errors

The appropriate error message is displayed in the tool tip text for the input error icon. The icon 
continues to be displayed until no further errors are detected.

A data record which contains an error cannot be stored.

Figure 7-42 Signaling of input errors (tool tip)
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7.4.2.8 Filtering
The acquisition dialog opens in a separate window for the specification of filter criteria. The list 
of data records displayed for acquisition is filtered by the inputs in the search window. The filter 
icon in the toolbar changes to indicate that the filter is activated. To indicate that the filter can 
be disabled, the filter icon is displayed with a line through it.

The wildcards "*" (any sequence of any characters) and "?" (exactly 1 character of choice) may 
be used in the filter criteria input fields. However, only one of these characters in each case may 
be specified at the beginning and/or end of the search string. These wildcard characters must 
not be specified within the search string.

Search strings must also not contain any of the following characters:

#, [, ], ~, (, ), \, /, =, >, <, +, -, %, _, &, |, ^, ', "

Searches for wildcards cannot be executed in selection fields. Selection fields can either 
remain empty, or a search can be executed for an exact value in the selection field.

As long as the filter is selected, all other functions in the relevant acquisition dialog are 
performed on the filtered data records. This mechanism can be used, for example, to export a 
data extract.

Figure 7-43 Dialog for entering filter criteria

The filter dialog is structured differently in the dialogs for assigning maintenance instructions or 
references or in the dialog for managing the comments on maintenance instructions. While 
search criteria can be entered in a standardized dialog in the data-input dialogs, additional input 
fields are provided in the assignment dialogs and the dialog for comment management.

Each of these dialogs basically consists of the tree for navigating around the system topology 
on the left-hand side of the acquisition dialog and, on the right-hand side, of the list of 
assignable information or the dialog for editing the acquired data.

The dialogs for acquiring filter criteria are also structured in two halves. The selection criteria for 
the data displayed in the navigation tree can be entered in the top half. The acquisition dialog 
is displayed again in the bottom half; the criteria for searching for assignable information can be 
entered in this dialog.
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Figure 7-44 Dialog for entering filter criteria (assignment dialogs)

7.4.2.9 Import/export
Import and export functions are provided for all CMS data. These functions can be called from 
two locations.

On one hand, a dialog can be called to start the export functions from the function tree or the 
function can be selected from the toolbar. This dialog offers the full range of import and export 
functions and is therefore suitable as a direct access point from which multiple import and/or 
export operations can be started at the same time.

However, if the user wishes to import or export the data of one particular type only, this can be 
done from the relevant acquisition dialog. A dialog for selecting an import or export function and 
for entering the path to the import or export file can be called via the toolbar or the context menu.

From the central import or export dialog, it is only possible to export all the data from the 
selected table. If an export operation is started from the relevant acquisition dialog, the data to 
be exported can be filtered.

Figure 7-45 Starting an import / export operation from the acquisition dialog
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Figure 7-46 Starting an import / export operation from the acquisition dialog (languages)

7.4.3 Configuration

This chapter describes individual parameterization functions. The individual parameterization 
functions are listed in the order in which they are displayed for selection in the function tree.

7.4.3.1 Topology: Equipment types

Figure 7-47 Acquisition of equipment types
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For the topologies "CMS stand-alone" and "CMS with RCMS (Process Historian)"
For CMS stations with the topologies "CMS stand-alone" and "CMS with RCMS (Process 
Historian)", the following fields are relevant:

Table 7-12 Equipment types

Input field Meaning Unique Mandatory 
field

Name Name of the equipment type
The name of the equipment type must not be exactly 
"CMS". Moreover, it must only contain letters and num‐
bers. The first character of the name must be a letter.

yes yes

WinCC tag Name of a WinCC tag for displaying an equipment-spe‐
cific comment

no no

Value Equipment-specific comment to be displayed in a 
WinCC screen
The content of the "Value" field is written to the WinCC 
tag when the runtime starts and could be displayed, for 
example, as information on the status bar of the appli‐
cation

no no

Comment Optional comment. 
This comment can only be seen in the editor.

no no

Note

You can only create one equipment type.

For the topology "CMS with RCMS (WinCC)"
In addition, the following fields are relevant for operating a CMS in the topology "CMS with 
RCMS (WinCC)":

Table 7-13 Equipment types

Input field Meaning Unique Mandatory 
field

Icon Identifier of icons assigned to the equipment type no yes
OK status val‐
ue

Range of numbers for "OK" status * no no

Idle status 
value

Range of numbers for "Idle" status * no no

Warning sta‐
tus value

Range of numbers for "Warning" status * no no

Fault status 
value

Range of numbers for "Fault" status * no no

*) You may enter several values or intervals separated by ",". Intervals are coupled by "-". The interval is 
defined exclusively by the start and stop values. Spaces are allowed and the length of the number range 
is limited to 255 characters.
Example: 2; 8; 32-128
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Status values can be defined for each equipment type. These can be used to control the display 
of a crane in the CMSNodeTree control on the RCMS server.

The icons defined in this dialog are used to represent the operating state of this equipment type 
and all associated cranes of this equipment type in the crane selection tree of the CMS Editor 
and in the CMSNodeTree control in the CMS Runtime application. The icons must first be 
entered in a separate dialog; (see Chapter Settings: Icons (Page 203)).

In the CMSNodeTree control, the current operating status of the crane shown will determine 
which of the icons for displaying cranes, equipment types, and terminals appears in the tree. 
The value of a WinCC tag entered in the data entry dialog box for the crane data is used to 
determine a crane's operating state. The fields for acquiring the number ranges for the status 
values in this dialog are used to assign the value of this tag to the various operating states.

The WinCC messages of each equipment type must be available in the WinCC Alarm Logging 
of the RCMS server. When uploading configuration data, the messages are automatically 
generated in the WinCC Alarm Logging. In this case, the set offset is added to the message 
numbers. Non-existent message classes, message types, message blocks, and group 
messages are created. For each equipment type, such a set of messages is created in the 
WinCC Alarm Logging of the RCMS server. For the runtime transfer of messages from the CMS 
station, the offset defined in this dialog is automatically added to the message number as well 
as the crane name in process value 1 and the equipment type in process value 2 of the 
message. Using the crane name in process value 1, the assignment of the configured instance 
message to the crane is established on which this message was initiated.

Note

You can only create one equipment type.

7.4.3.2 Topology: Cranes

Note

This section describes the screen form "Cranes" for the topologies "CMS stand-alone" and 
"CMS with RCMS (Process Historian)"

A crane corresponds to a CMS station, at which messages and operational data are recorded. 
A crane must always be assigned to an equipment type. 
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The crane has access to the data of the WinCC tag management.

Input field Meaning Unique Mandato‐
ry field

Name Name of the crane
A crane's name must be unique.
The name of the crane must not be exactly "CMS". 
Moreover, it must only contain letters and numbers. 
The first character of the name must be a letter.

yes yes

Equipment type Identifier of the equipment type to which the crane is 
assigned
The equipment type must already have been created in 
the dialog box "Topology" → "Equipment types".

no yes

Computer name Name of the computer on which the CMS is running yes yes
Comment Optional comment no no

Figure 7-48 Acquisition of the crane

7.4.3.3 Topology: Cranes (CMS with RCMS (WinCC))

Note

This section describes the screen form "Cranes" for the topology "CMS with RCMS (WinCC)".

A crane corresponds to a CMS station, at which messages and operational data are recorded. 
A crane must always be assigned to an equipment type. The communication parameters 
between CMS station and RCMS server are defined at the crane. The crane also has access 
to the data of the WinCC tag management.
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Using the crane name, the acquired runtime data are assigned at the RCMS server.

Table 7-14 General parameters (CMS with RCMS (WinCC))

Input field Meaning Unique Mandato‐
ry field

Name Name of the crane
A crane's name must be unique.
The name of the crane must not be exactly "CMS". 
Moreover, it must only contain letters and num‐
bers. The first character of the name must be a 
letter.

yes
(per terminal)

yes

Equipment type Identifier of the equipment type to which the crane 
is assigned
The equipment type must already have been cre‐
ated in the dialog box "Topology" → "Equipment 
types".

no yes

Computer name Name of the computer on which the CMS is running yes yes
Comment Optional comment no no
IP address RCMS IP address of the RCMS server yes yes
IP address NIC This setting is only required if the PC of the CMS 

station has multiple network cards. The IP address 
of the network adapter via which communication is 
established to the RCMS server is then in this set‐
ting.

yes no

Port number Number of the port used for communication with 
the RCMS server
The port number must be the same on the RCMS 
server and all connected CMS stations.

no yes

Crane status tag Name of a WinCC tag that can be used to read the 
crane status for controlling the display of the crane 
in the CMSNodeTree control.

yes no

Synchronization in‐
terval for messages

Interval during which messages are transferred to 
the RCMS server; specified in seconds

no yes

Synchronization in‐
terval for operational 
data

Interval during which operating data (such as 
move data, MMBF data, etc.) is transferred to the 
RCMS server; specified in seconds

no yes

Crane is synchron‐
ized with RCMS.

Synchronization with the RCMS server is active. no no

Configuring a CMS station
7.4 CMS configuration editor

Crane Management System (CMS)
System Manual, 11/2019 175



Figure 7-49 Acquisition of the crane

In the CMSNodeTree Control at the RCMS server, the acquired cranes can be displayed 
depending on their actual status. To enable this status to be evaluated in the CMSNodeTree 
control, the name of a WinCC tag in which the current crane status is encrypted is acquired in 
this dialog. How the values of this tag are assigned to the various crane states is defined for the 
equipment type; see Chapter Topology: Equipment types (Page 171) The tag acquired here is 
automatically transferred to the RCMS server.

Short synchronization intervals may decrease system performance especially at a high 
synchronization data amount. Particularly for messages, depending on the acquisition cycle or 
the message frequency, it must be weighed up just how short these synchronization intervals 
must be selected for an individual case.

In terms of synchronizing operating data, it is important to note that writing values to the WinCC 
Tag Logging archives requires quite a lot of effort. Having said this, there is little impact on 
performance if more than one value is written simultaneously. Therefore, it is better, for 
example, to transfer as many data sets as possible to the RCMS at the same time.

Note

If the communication settings are changed, CMS Runtime will need to be exited and restarted 
in order that these modified settings become effective.

7.4.3.4 Messages: Maintenance instructions
Maintenance instruction texts are descriptions which can be displayed in conjunction with a 
message in the CMSFaults control for the purpose of assisting maintenance staff with 
diagnostics and fault elimination.
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These can include both information about possible causes as well as instructions on how to 
eliminate faults.

Table 7-15 Maintenance instructions

Input field Meaning Unique Mandatory 
field

Description Maintenance instruction text yes yes
Possible cause Description of the possible cause of the fault no no
Possible remedy Description of a possible repair measure no no
Comment Comment on the maintenance instruction, is al‐

so displayed in CMSFaults.
no no

Figure 7-50 Acquisition of maintenance instructions

The available maintenance instructions are listed in a table on the left-hand side of the dialog. 
The numeric value in the center table column indicates how often the maintenance instruction 
is assigned to a message.

Maintenance instructions, which are assigned to a message or an equipment type, cannot be 
deleted directly. If an attempt is made to delete an instruction text which is already assigned, a 
message stating the number of existing assignments is displayed. The user then has the option 
of aborting the delete operation, or of deleting the maintenance instruction including all 
assignments and logbook entries if any exist.
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7.4.3.5 Messages: Logbook
The remarks on maintenance instructions can be maintained/updated in this dialog.

Table 7-16 Logbook

Input field Meaning Unique Mandatory 
field

Author Name of the author yes, with date yes
Entry date Date of acquisition; is preset to the current 

date for new entries
yes, with author yes

Assignment Indicates whether the comment is assigned 
to a message or a maintenance instruction 
text.

no yes

Entry Comment text or logbook entry text no no

Figure 7-51 Editing / acquisition of individual logbook entries

Entries that come from the CMSFaults Control are identified under "Assignment" with 
"Message". The assignment cannot be edited.
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No new remarks on maintenance instructions (assignment "Message") can be generated in this 
dialog.

Note

The difference between this and the function for maintaining remarks on maintenance 
instructions (see Chapter Messages: Remarks on maintenance instructions (Page 179)) is that 
this function displays all existing remarks in a list which is sorted according to author and date. 
With the function for maintaining remarks on maintenance instructions, the remarks are 
selected via the objects to which the remarks are assigned. 

7.4.3.6 Messages: Remarks on maintenance instructions
Maintenance instructions relating to a specific message can be displayed in the CMSFaults 
control. These instruction texts cannot be modified in the CMSFaults control, but this control 
can be used to acquire remarks on the instructions, such as information about maintenance 
work performed, unforeseen difficulties or feedback as to whether the instruction was useful, 
etc.

Table 7-17 Adaptation of remarks on maintenance instructions

Input field Meaning Unique Mandatory field
Author Name of the author yes, with date yes
Date Date of acquisition; displays the current 

date per default for new entries.
yes, with author yes

Field Specifies the field in the CMSFaults con‐
trol for which the displayed remark was 
acquired (cannot be edited).

  

Remark Remark text no no
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Figure 7-52 Editing of remarks on maintenance instructions in systems with multiple terminals

If remarks on maintenance instructions are acquired in the CMSFaults control, they cannot be 
subsequently edited in this control. This measure has been taken so that the complete history 
of such entries can be traced. 

However, this dialog can be used to edit unnecessary or inaccurate remarks on maintenance 
instructions.

To allow the selection of remarks that require editing, a tree is created which displays terminals, 
equipment types and cranes as well as the assigned maintenance instructions and messages. 
The two nodes for maintenance instructions and messages, which are directly assigned to an 
equipment type, are listed below the relevant equipment type. 

The instruction texts or messages are inserted below the nodes for maintenance instructions. 
If remarks have been acquired for these instructions or messages, they will be displayed 
directly below the corresponding node. Remarks are displayed in a chronological order, with 
the latest entry listed right at the top.

To edit or delete a remark, it must be selected in the tree. The data of the remark is then shown 
in the detail view on the right of the dialog window.

Meaning of individual icons in the remark selection tree:

Table 7-18 Icons in assignment dialogs

Icon Meaning
Maintenance instruction

Reference

Remark on a maintenance instruction
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Icon Meaning
Message

Message class

7.4.3.7 Messages: Assignment of maintenance instructions
In this menu, the created maintenance instructions can be assigned to the messages in WinCC 
Alarm Logging. The maintenance instructions can then be displayed during WinCC Runtime 
via the CMSFaults Control.

Figure 7-53 Assignment of maintenance instructions to messages or cranes

A tree for assigning maintenance instruction texts is displayed on the left-hand side of the 
dialog. This contains nodes for the messages in addition to terminals, equipment types and 
cranes. The existing maintenance instructions are displayed in a table on the right-hand side. 
The numeric value in the center table column indicates how often the maintenance instruction 
is assigned to a message.

Maintenance instruction texts can be dragged and dropped at the required message in the tree. 
Alternatively, the required message in the tree can be selected and the maintenance instruction 
assigned to it by means of a button. The messages are assigned to the equipment type in the 
tree.

With the drag and drop assignment method, closed nodes in the tree automatically expand 
when the cursor is positioned either on the icon or the label of the closed node.

The icon on the left is displayed whenever the cursor is positioned over a node to which 
maintenance instructions cannot be assigned. For example, a maximum of one maintenance 
instruction text can be assigned to a message. If an attempt is made to drag and drop an 
instruction text onto a message which already has an assignment, this icon is displayed to 
signal that no further text can be allocated to this particular message. 
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At all nodes which are free for the assignment of a maintenance instruction text, the icon on the 
left is displayed whenever a text is dragged and dropped on them.

There are three different methods by which maintenance instruction assignments can be 
canceled again, i.e.

● by selecting the maintenance instruction and then deleting it with the Del key.

● Click on the appropriate button in the dialog.

● by using drag and drop to remove the instruction from the tree.

This function does not require any special command buttons for saving changes to 
assignments. Instead, assignment changes are entered directly in the database.

7.4.3.8 References: References
Supplementary information for display in the CMSFaults control can be acquired for equipment 
types, cranes, and messages. This information can be accessed by maintenance personnel 
when they require troubleshooting guidance. 

However, only references to this troubleshooting guidance information are stored in the 
database, rather than the information itself.

In order to offer the option, for example to globally change the path to several references, 
macros can be used to define these references. In this context, a macro is a wildcard character 
entered during parameter assignment and subsequently replaced by a stored value during 
runtime.

Table 7-19 References

Input field Meaning Unique Mandatory 
field

Reference Description of the reference yes yes
Reference 
type

Type of reference no yes

Program Program with which the reference can be displayed. no yes
Path Path for accessing the reference no no
Parameters Name of the reference with any parameters which may 

be needed to open the reference
no yes

Comment Optional comment no no

In contrast to maintenance instructions, which can only be assigned to a message, a reference 
can also be assigned to a crane and an equipment type.

● References, which are assigned to one message, are displayed for this message, for all 
cranes of the same equipment type.

● References, which are assigned to an equipment type, are displayed for each message, for 
all cranes of the relevant equipment type.

● References, which are assigned to a crane, are displayed for each message, for this crane.
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The references that have been created are listed in a table on the left-hand side of the dialog. 
The numeric value in the center table column indicates how often the reference is assigned to 
one message.

References which are still assigned to messages, equipment types or cranes cannot be deleted 
directly. If an attempt is made to do so, a message is displayed indicating the number of active 
assignments. The user then has the option of aborting the delete operation, or of deleting the 
reference and all its assignments.

Figure 7-54 Acquisition of references

Each individual reference is assigned to a specific reference type. This reference type is 
displayed as additional information in the CMSFaults control. Otherwise, this parameter has no 
further significance.

To acquire a reference, it is necessary either to directly select a program, which has been 
specified in the program acquisition dialog, or enter the predefined input <empty> in this field 
to indicate that no program is to be specified for this particular reference. When a program is 
specified, the relevant program is launched to display the reference.

If the field "Program" is left empty (entry: <empty> because a value has to be selected), the 
information required to display the reference is determined from the CMSFaults control using 
the file extension of the reference file and the associated Windows link. In this case as well, a 
program with the reference file as the launch parameter is ultimately called.

When specifying paths, it is important to ensure that the reference file to be opened can be 
accessed even if the relevant directory is stored on another computer. Furthermore, the 
programs for displaying the references must be installed on the computer on which the relevant 
reference file is to be displayed.

Macros can be selected from a list and inserted via drag & drop. Alternatively, they can be 
inserted manually into the reference. Where a manually entered macro is not yet available in 
the macro table, it can be entered into the database directly once you have responded to the 
relevant prompt. A macro is defined using the following notation: %Macroname%
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Macros can be edited, as required, as part of the function for managing macros.

Note

If spaces are used in the reference, please note that spaces in a command are interpreted as 
separators. Where necessary, the reference should be enclosed within inverted commas.

Figure 7-55 Acquisition of references (macros)

The diagram above shows the acquisition dialog for references with macro table. The macro 
selected in the table can be dragged and dropped to the required location. 

7.4.3.9 References: Assignment of references
In this dialog assign the references to one or more messages, a crane or an equipment type.

If macros have been used to define references or the program needed to display the reference, 
the actual values of the macros to be used when displaying the reference must also be 
acquired. These actual values are then stored along with the assignment. This means, for 
example, that a single reference can be called for each message with a different parameter in 
each case.
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Figure 7-56 Assignment of references to messages, equipment types or cranes

References can be assigned to cranes, equipment types or WinCC messages. Unlike 
maintenance instruction texts, however, there is no restriction on the number of references 
which can be assigned.

A tree for assigning references is displayed on the left-hand side of the dialog. This contains 
nodes for the references and messages in addition to terminals, equipment types and cranes. 
The existing references are displayed in a table on the right-hand side.

To assign references, they can be dragged and dropped at the required position in the tree. 
Alternatively, the required position in the tree can be selected and the reference assigned to it 
by means of a button.

With the drag and drop assignment method, closed nodes in the tree automatically expand 
when the cursor is positioned either on the icon or on the label of the closed node.

The icon on the left is displayed whenever the cursor is positioned over a node to which a 
reference cannot be assigned. 

At all nodes where a maintenance instruction can be assigned, this is displayed with the 
adjacent icon when making the assignment by dragging and dropping.

Reference assignments can be canceled in three different ways, i.e. by selecting the reference 
and deleting it with the Del key, by clicking on the Delete button in the dialog or by dragging the 
reference out of the tree.
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The following algorithm is used to acquire the actual macro parameters:

● Clicking a reference in the table containing all the available references will cause those 
macros used for display to appear. At this stage, it is not yet possible to enter the actual 
parameters in the table containing the available references. The sole purpose of this macro 
list is to provide the user with an overview of which macros were specified when the 
reference was being defined. However, it also displays the macros used for defining the 
program.

● Once a reference has been assigned to a terminal, equipment type, or crane, the available 
macros for the current assignment are displayed along with any values which may have 
already been specified. The macro details can also be displayed for a preexisting 
assignment. Clicking the macro name in the parameter list copies the contents of the line in 
the list to the line for acquiring the macro value. Once the value has been changed, it can 
be saved by clicking "Update".

Whenever an actual parameter of a macro has been changed, the resulting command used to 
display the reference appears in a field at the bottom of the dialog. Clicking "Preview" shows 
whether the reference can be displayed after all the macro values have been substituted or, if 
no macros are being used, whether the reference will be displayed correctly.

This function does not require any special command buttons for saving changes to 
assignments. Instead, assignment changes are entered directly in the database. Changes only 
need to be confirmed during acquisition of actual macro values.

7.4.3.10 Operating data: Move data

Note

Move data, for example, movement data, MMBF, counters, time stamps as well as messages 
to SIMATIC S7 communication blocks are supplied separately as an application. Details are 
available on the Siemens support pages – or you can contact the CMS hotline (see 
Chapter Preface (Page 3)).

Operational data can be acquired on the CMS station. This includes data such as move data, 
MMBF data, as well as basic data acquired to evaluate counters (also see Chapter Acquiring 
move data on the CMS station (Page 146)).

This dialog is used to acquire the parameters required to control the acquisition of move data 
by CMS Runtime.

Table 7-20 Move data

Input field Meaning Unique Mandatory 
field

Archive Name of the WinCC Tag Logging archive for acquisition 
of move data

yes yes

Start trigger Binary WinCC tag for starting acquisition of move data no no
Stop trigger Binary WinCC tag for ending acquisition of move data no yes
Start time 
stamp

WinCC tags for acquisition of the time stamp for starting 
a cargo handling operation from WinCC

no no
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Input field Meaning Unique Mandatory 
field

Stop time 
stamp

WinCC tags for acquisition of the time stamp for ending 
a cargo handling operation from WinCC

no no

Start Location WinCC tag for acquisition of a character string at the 
start of a cargo handling operation

no no

Stop Location WinCC tag for acquisition of a character string at the 
end of a cargo handling operation

no no

Duration WinCC tag for managing the duration of a cargo han‐
dling operation

no no

Definition 
time stamp

Used to select whether the start or stop time is stored as 
the time stamp

no yes

Figure 7-57 Acquisition of move data

When this dialog is opened, all existing Tag Logging archives are read out of the active WinCC 
project and displayed in the selection field for the archives. Unlike all the other selection fields 
in the CMS, the user can also enter names in this selection field. This means that archives 
which do not yet exist can be defined.

Furthermore, the binary WinCC tags, which the CMS monitors so that it can detect the point at 
which a cargo handling operation starts or stops, must also be defined as part of the acquisition 
process for move data. These names can be entered via the keyboard; alternatively, the "..." 
button can be used to open the WinCC dialog for selecting WinCC tags. In this case, the display 
is automatically restricted to binary tags.

The start trigger is not required where WinCC tags are specified for reading the WinCC time 
stamp. In this case, the start time stamp is read if the stop trigger has been detected by CMS 
Runtime.
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It is also possible to specify the time stamp which will be stored with the move data. This can 
be selected as either the start time or end time of a cargo handling operation.

Figure 7-58 Acquisition of move data (acquisition of WinCC tags)

● Time stamp
On the controller, the time stamp for transfer must be split into its constituent parts (year, 
month, day, etc.). WinCC tags can then be specified in the fields for the time stamps. These 
tags are used to transfer the start and stop time stamps for a cargo handling operation to the 
PC. CMS Runtime expects and interprets a time stamp with decimal coding on a time basis 
of 24 hours.
If no tags are specified, the time stamps are determined from the system time on the PC as 
soon as the relevant trigger bit has been read.

● Duration
It is not possible to store two time stamps in WinCC Tag Logging archives. In view of this, 
a time stamp and the duration of a cargo handling operation are stored in the Tag Logging 
archives in the CMS. This field is used to store the name of the tag that enables the duration 
of a cargo handling operation to be read from the controller. 
Pay particular attention to the following aspect: If both the start and stop time stamps for a 
cargo handling operation are read from the controller, it is possible to calculate the duration 
of a cargo handling operation from the time stamps and enter the duration thus calculated 
into the Tag Logging archive. 

As soon as you have selected the topology "CMS with RCMS (WinCC)", you can transfer 
configuration data and runtime data for this archive. You can make the settings for the transfer 
operations in a separate dialog box; see Chapter CMS-RCMS data transfer: Transfer 
operational data (Page 194).
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7.4.3.11 Operating data: Counters
During entry of basic data for counter analysis, differences between the counter values, read 
from the controller, are calculated cyclically and stored in WinCC Tag Logging archives (also 
see Chapter Acquiring counter differences at the CMS station (Page 150)).

Table 7-21 Counters

Input field Meaning Unique Mandatory 
field

Archive Name of the WinCC Tag Logging archive for storing 
counter differences

yes 
(archive, first 

start)

yes

Cycle Used to select the cycle for acquiring differences no yes
First start Used to specify the part of the cycle when initial anal‐

ysis begins
yes 

(archive, first 
start)

yes

Acquire data Select whether data acquisition is activated. no no

Figure 7-59 Acquisition of counters

When this dialog is opened, all existing Tag Logging archives are read out of the active WinCC 
project and displayed in the selection field for the archives. Unlike all the other selection fields 
in the CMS, the user can also enter names in this selection field. This means that archives 
which do not yet exist can be defined.

To have the additional option of performing an analysis outside the current clearly defined 
intervals (e.g. a shift analysis to be performed every 8 hours as opposed to hourly, daily, 
weekly, or monthly), archives can also be entered more than once with the same cycle but 
different start times. In these cases, the system calculates the difference between the actual 
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PLC value and the last processed counter value from the previous start-time (shift). In the 
following diagram, a "CounterShift" Tag Logging archive parameterization illustrates this point. 
This archive is specified three times with a daily cycle and start times of 06:00, 14:00, and 
22:00. If the analysis is started at 22:00, the difference in counter values at 22:00 (value 
currently read) and 14:00 (value of this archive when last evaluated) is formed.

Figure 7-60 Shift evaluation

The counters run on the controller. The raw counter values are acquired as WinCC tags. The 
values of all WinCC tags that are defined in these archives are also monitored each time a value 
changes, regardless of the evaluation time. If the new value of a tag is less than the previous 
value, then this previous value is written back.

As soon as you have selected the topology "CMS with RCMS (WinCC)", you can transfer 
configuration data and runtime data for this archive. You can make the settings for the transfer 
operations in a separate dialog box; see Chapter CMS-RCMS data transfer: Transfer 
operational data (Page 194).

Note

With a weekly cycle, the first start is calculated from the first day of the week stored in the 
operating system and the value specified.

With a monthly cycle, the analysis is always performed on the same day of the month 
concerned. Cycle lengths will vary, depending on how many days there are in a month. 
Similarly, a monthly cycle due to begin on the 30th of each month will never be performed in 
February.
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7.4.3.12 Operating data: MMBF
This dialog box is used to enter the parameters required to control the acquisition of MMBF data 
by CMS Runtime (MMBF = Mean Moves Between Failures); also see Acquiring MMBF data at 
the CMS station (Page 152).

Table 7-22 MMBF data

Input field Meaning Unique Mandatory 
field

Archive Name of the WinCC Tag Logging archive for acquis‐
ition of MMBF data

yes yes

Trigger Binary WinCC tag for starting acquisition of MMBF 
data

no no

Time stamp WinCC tags for acquisition of the WinCC time stamp no no
Acquire data Select whether data acquisition is activated. no no

Figure 7-61 Acquisition of MMBF data

When this dialog is opened, all existing Tag Logging archives are read out of the active WinCC 
project and displayed in the selection field for the archives. Contrary to all of the selection fields 
in the CMS Editor, the user can also enter names in this selection field. This means that 
archives which do not yet exist can be defined.
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The following values can be acquired in this dialog:

● Trigger
This WinCC tag is set by the controller in order to signal to the CMS that an MMBF data set 
is to be written. The tag is reset by CMS Runtime once the data set has been written.

● Time stamp
If the time stamp for the MMBF data set is calculated on the controller, the WinCC tags can 
be specified in the fields for the time stamp. These tags are used to transfer the time stamp 
to the PC, as a WinCC time stamp cannot be read directly from the controller. 
If no tags are specified, the time stamp is calculated from the system time on the PC.

As soon as you have selected the topology "CMS with RCMS (WinCC)", you can transfer 
configuration data and runtime data for this archive. You can make the settings for the transfer 
operations in a separate dialog box; see Chapter CMS-RCMS data transfer: Transfer 
operational data (Page 194).

7.4.3.13 CMS-RCMS data transfer: Transfer messages

Note

This dialog box is only available in the topology "CMS with RCMS (WinCC)".

In this dialog box, you can activate or deactivate the transfer of configuration and runtime data 
for the messages that exist in WinCC. In this way, you can activate or deactivate entire 
message classes or individual messages.

Table 7-23 Transferring messages

Input field Meaning Unique Mandatory 
field

Configuration The setting determines whether the configuration da‐
ta should be transferred to the RCMS server (only for 
message classes).

yes no

Runtime The setting determines whether the runtime data 
should be transferred to the RCMS server.

yes no
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Figure 7-62 Settings for the transfer of messages

The list of all message classes, for which messages are available in WinCC Alarm Logging, are 
shown in the table above. If you select a message class in the list, then the associated 
messages are shown in the table below.

You can deactivate the transfer of configuration and runtime data, either for an entire message 
class or for individual messages. If the transfer of the class is deactivated, then the transfer of 
all messages within the class is also deactivated.

As soon as you have activated the configuration data transfer for a message class, you can 
generate this archive on the RCMS server with an upload. There you can overwrite the instance 
messages for the equipment type to which this crane is assigned. The message offset that you 
defined for the equipment type under topology in the CMS Editor (see Chapter Topology: 
Equipment types (Page 171)) is added to the message number. A download from the RCMS 
server is also possible.

As soon as you have activated the runtime data transfer for the messages, an XML file is written 
for each message that is acquired. The file is stored in the WinCC project directory under …\CMS
\Messages\Files\yyyy-mm-dd. Once the file has been transferred, it is deleted from the 
directory. If an error occurs during the transfer, the file is moved to the folder …\CMS\Messages
\Errors\yyyy-mm-dd . At transfer, the crane name defined in the topology is transferred in 
process value 1 in order to assign the message to the crane at the RCMS.

In the directories …\Files and …\Errors , a new subdirectory is generated every day with 
the current date to limit the data volume in a directory. You can define a disk clean-up in a 
dedicated dialog box to delete old XML files (see System: Basic settings (Page 213)).
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7.4.3.14 CMS-RCMS data transfer: Transfer operational data

Note

This dialog box is only available in the topology "CMS with RCMS (WinCC)".

In this dialog, you can activate or deactivate the transfer of configuration and runtime data for 
the acquired operating data archives (move data, counters, MMBF data).

Table 7-24 Transfer of operational data

Input field Meaning Unique Mandatory 
field

Configuration The setting determines whether configuration data 
should be transferred to the RCMS server.

yes no

Runtime The setting determines whether runtime data should 
be transferred to the RCMS server.

yes no

Figure 7-63 Settings for the transfer of operational data

The list of all operational data archives is shown in the table above. If you select an archive in 
the list, then the associated tags are shown in the table below.

You can deactivate the transfer of the complete archive as well as the transfer of individual tags 
of an archive. If the transfer of the archive is deactivated, then the transfer of all tags within the 
archive is also deactivated.

As soon as you have activated the configuration data transfer for an archive, you can generate 
this archive on the RCMS server with an upload. There, the archive is created with the crane 
name, followed by "_", as prefix (crane name_archive name). The names of the archive 
tags remain unchanged. The process tags are generated as internal tags in the tag group 
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"Crane name" and have the crane name, followed by "_", as prefix. A download from the RCMS 
server is not possible.

As soon as you have activated the runtime data transfer for the archive / the archives for 
acquiring cargo handling operations, an XML file is written for each cargo handling operation 
that is acquired. The file is stored in the WinCC project directory under …\CMS\Moves\Files
\yyyy-mm-dd.

Once the file has been transferred, it is deleted from the directory. If an error occurs during the 
transfer, the file is moved to the folder …\CMS\Moves\Errors\yyyy-mm-dd .

As soon as you have activated the runtime data transfer for the archive / the archives for 
acquiring counter differences, an XML file is written for each time slice that is acquired. The file 
is stored in the WinCC project directory under …\CMS\Accumulates\Files\yyyy-mm-dd.

Once the file has been transferred, it is deleted from the directory. If an error occurs during the 
transfer, the file is moved to the folder …\CMS\Accumulates\Errors\yyyy-mm-dd .

As soon as you have activated the runtime data transfer for the archive / the archives for 
acquiring MMBF data, an XML file is written for each MMBF data set that is acquired. This XML 
file is stored in the WinCC project directory under …\CMS\MMBFs\Files\yyyy-mm-dd.

Once the file has been transferred, it is deleted from the directory. If an error occurs during the 
transfer, the file is moved to the folder …\CMS\MMBFs\Errors\yyyy-mm-dd .

In the directories …\Files and …\Errors , a new subdirectory is generated every day with 
the current date to limit the data volume in a directory. You can define a disk clean-up in a 
dedicated dialog box to delete old XML files (see System: Basic settings (Page 213)).

7.4.3.15 CMS-RCMS data transfer: Transfer Taglist

Note

This dialog box is only available in the topology "CMS with RCMS (WinCC)".

The "Taglist" is used to transfer the values of individual WinCC tags. The transfer of the WinCC 
tags to the RCMS server can either be triggered cyclically or when changes are made.

Table 7-25 Transfer of the tag list

Input field Meaning Unique Mandatory 
field

Tag Name of the WinCC tag to be transferred yes yes
Acquisition Selects in which cycle the tag should be read no yes
First start Specifies when the tag should be read for the first 

time
no yes

Add to struc‐
ture tag on 
RCMS

Selects whether the tag is part of the structure in‐
stance at the RCMS

no no

Transferring 
data

Selects whether runtime data is to be transferred no no
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Figure 7-64 Acquisition of tag lists

● WinCC tag
Name of the WinCC tag to be transferred.

● Acquisition

– Cyclic
With cyclic processing, all the values specified in the cycle are read and transferred to 
the RCMS server. With hourly or daily transfers, the start of the cycle can also be 
specified with greater precision. With hourly acquisition, it is possible to specify the 
minute when the cycle will start; with daily acquisition, it is possible to specify both the 
hour and the minute when the cycle will start.

– Upon change
For every change exactly the changed values are transferred.

As soon as you have tags defined in the list and set the check mark "Add to structure tag on 
RCMS", you can generate these tags on the RCMS server by performing an upload. There, a 
structure type with "@CMS" and the equipment type defined under topology as prefix is 
generated (@CMSequipment type). Existing structures are overwritten. In addition, a 
structure instance with the crane name as a prefix is generated in the crane name tag group.

As soon as you have set the check mark "Transfer data", the values of these tags are 
transferred to the RCMS server according to the selected acquisition type. Tag values are not 
buffered on the CMS.
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7.4.3.16 CMS-RCMS data transfer: Upload (CMS station)

Note

This dialog box is only available in the topology "CMS with RCMS (WinCC)".

You can start an upload in the upload dialog box on the CMS station.

Figure 7-65 Upload of configuration data (CMS station)

During the upload, the data from one crane or multiple cranes is transferred to the RCMS 
server. There is always only one data set per equipment type. The upload overwrites the data 
of the equipment type at the RCMS with that of the crane, whose data are transferred. If the 
upload is initiated from a CMS station, then no second upload is possible in parallel from 
another CMS station.

Note

After data has been uploaded to the RCMS server, at the RCMS you must check as to whether 
the data of the other cranes of this equipment type are still consistent. You can initiate a 
download at the RCMS server to adapt data of cranes that are not consistent.

In the editor function tree, using the markings of the functions, you can identify whether data at 
the CMS station have been changed, which must be uploaded to the RCMS server for data 
alignment.

To perform an upload, the following preconditions must first be available:

● It must be possible to access the RCMS server via TCP/IP

● Setting up the communication parameters in the dialog (Topology → Crane) on the CMS 
station

Configuring a CMS station
7.4 CMS configuration editor

Crane Management System (CMS)
System Manual, 11/2019 197



● Setting up the communication parameters in the dialog (Topology → Crane) on the RCMS 
server

● CMS Runtime active on the CMS station

● CMS Runtime active on the RCMS server

● WinCC Runtime has been exited on the RCMS server!

● WinCC editors on the RCMS server are closed!

When the dialog is opened and there is no connection to the RCMS server, then you receive a 
corresponding message.

The upload dialog has two tabs. Outputs (information) for the current upload processes are 
listed under the "Log" tab. Errors during the upload are listed under the "Errors" tab.

Start the upload using the Start button at the lower right edge of the screen. 

Note

All of the data for this equipment type available in the RCMS server will be overwritten.

Note

Do not interrupt the upload. This can result in loss of data.

Note

If there is a large number of messages in the WinCC Alarm Logging, the upload/download 
process can take several minutes.

If the upload is finished with errors, then you must start a new upload after resolving these 
errors. An error description can be found under the "Errors" tab.

You receive a message as soon as the upload has been successfully completed. The marking 
of the changed data in the function tree disappears.

7.4.3.17 Import/export: Import/Export
A rough distinction is made between user and system data in relation to imports and exports. 

User data include data which are generally acquired or changed in normal operation, such as

● Equipment

● Cranes

● Maintenance instructions

● Assignments between messages of an equipment type and maintenance instructions

● Log (remarks on maintenance instructions)

● Assignments between messages of an equipment type, maintenance instructions and logs 
(remarks on maintenance instructions)

● References

● Assignments between equipment types, cranes, messages and references
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● Settings for the move data

● Settings for acquiring MMBF data

● Settings for acquiring counter differences

● Tag list

System data basically include data that are provided as defaults during installation, or data that 
are acquired during commissioning and seldom changed once the system is running, such as:

● Icons

● Programs

● Macros

● Reference types

Two different import and export functions are provided under "Setup" for language-specific 
information in the CMS:

● Transfer

● Translation

The transfer functions are used to exchange language-specific information between different 
installations. In this case, all the information such as installed languages, component names 
etc. are processed. The translation functions only handle data that is required for translation 
purposes. Furthermore, only the data for one language at a time can be displayed for 
translation.

Figure 7-66 Import / export of user data

The "Select All" button can be used to activate all the check boxes for the import/export function 
at the same time. If necessary, the selection can be changed again at a later time. Once the 
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import has been started, all the successfully processed data types are deselected by the 
system. If errors or warnings occurred when data was being imported or exported, the data 
concerned will not be deselected. This enables data export or import to recommence as soon 
as the necessary corrections have been made. The "Deselect All" button can be used to 
deactivate all the check boxes at the same time.

Note

The checkmarks to select the individual options cannot be used if you have still not defined an 
equipment type in the dialog used to acquire equipment types.

Before user data are imported, it must be considered whether system data need to be adapted 
first. If, for example, new terminal or equipment type data are to be imported which contain 
symbols that do not yet exist in the CMS, these icons would need to be imported first or entered 
in the icon acquisition dialog before the topology data import can be started. The same applies 
to the import of references. In this case, it may be necessary to specify additional reference 
types or programs first.

Data is imported and exported in an XML format. A complete description of the format can be 
found in the appendix.

Figure 7-67 Import / export of system data

Two different functions are used to import and export languages. The import/export transfer 
function is used primarily to transfer the complete, language-specific database. With an export 
transfer operation, all information about the implemented languages, the available dialog or 
message components and the acquired language-specific information are bundled together in 
an export file or are expected in a file for import.
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When language-specific information is imported / exported for translation, only the data 
pertaining to one language is exported. Furthermore, only the information which is required for 
translation purposes is exported. This data includes

● identification of the component

● text to be translated

● comment on the component (if stored)

The following import functions are provided:

● Replace
All existing data are deleted and replaced by the imported data.

● Change
Only existing data are changed. Newly imported data are ignored.

● Add
Existing data are not changed. Only new data are accepted.

● Change or add
Existing data are changed. New data are accepted.

● Synchronize
Existing data are changed and new data are accepted. Data which are not found in the 
import file are deleted.

Data import with "Replace" or "Synchronize"?
In "Replace" mode, all data are first deleted from the table. However, data with assigned 
references cannot be deleted. In this case, the import operation will be aborted with an error 
message. In "Synchronize" mode, the existing data are matched to the data to be imported. As 
long as this operation does not cause any entries in the existing database with assigned 
references to be changed or deleted, the import operation will proceed successfully. The import 
process will be aborted with an error message only if the existing database contains entries with 
assigned references which will be changed or deleted by the synchronize operation.

If no references are assigned to the import data, the "Replace" import mode should be used as 
the computer resources used by this function are significantly lower.

For data which do not contain references to other tables, the functions "Replace" and 
Synchronize" are identical. The functions differ only in relation to data which are referenced by 
other tables. An example of this data type are the entries in the icons table which are 
references, for example, from the tables for terminals or equipment types.

Data is imported and exported in an XML format. A complete description of the format can be 
found in the appendix.

7.4.3.18 Import/export: Importing FMDB data
Importing FMDB data (FMDB: Fault Message Database) is available for bulk data handling of 
the additional error information.
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When importing using this function, several operations are combined:

● Creating maintenance instructions and assigning these to the existing messages.

● Creating assignments to references containing special macros (see below). In this case, 
these references must have already been created. Here, only assignments are created, 
whereby the actual values of the macros, acquired in the import file, are saved in the 
assignment sets.

Figure 7-68 Import/export of FMDB data

An XML file is used to import data into the CMS Editor. The table below shows all the XML tags 
with a fixed meaning in the CMS:

Table 7-26 XML tags in FMDB data

Name Description Application 
in the CMS

Length in the 
CMS, type

IFNo Error number Key Long integer
InstructionText Instruction text 1, possible cause Maintenance in‐

struction
2,000 charac‐

ters
TestText Instruction text 2, possible remedy, test in‐

struction
Maintenance in‐

struction
2,000 charac‐

ters

Special macros are used for the automatic assignment of references during the import of FMDB 
data. At the start of the import, all the references in which this type of special macro is used 
directly (via the reference entry) or indirectly (via the program entry) are brought together in a 
list. Before the import starts, the user can select from this list the references for which 
assignment sets are to be created as part of the import process.

A selection of these special macros is preinstalled along with the CMS. The user can 
supplement these with additional special macros.
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This type of special macro always begins with the character string "%FMDB_", followed by the 
name of the XML tag whose contents are to be used as a macro value when the reference is 
displayed.

Table 7-27 Predefined macros for FMDB import

Macro name Meaning
%FMDB_CircuitDiagramFilename% File name of the circuit diagram
%FMDB_CircuitDiagramPath% Path to the file for the circuit diagram
%FMDB_Drw_Plant-ID% Higher level designation in the circuit diagram
%FMDB_Drw_Sheet% Page in a circuit diagram sheet
%FMDB_CD_Page% Absolute page in the circuit diagram
%FMDB_PLC_Block% Block of a program in the STEP 7 project
%FMDB_PLC_NW% Network of a block in the STEP 7 project
%FMDB_Step7ProjectName% File name of the STEP 7 project
%FMDB_Step7ProjectPath% Path to the file of the STEP 7 project

7.4.3.19 Settings: Icons

Note

This dialog box is only available for the topology "CMS with RCMS (WinCC)".

This dialog is accessible only to users who belong to the Windows user group "CMSAdmin".

Terminals, equipment types and cranes are generally selected in a tree display. For this 
purpose, individual terminals and equipment types can be represented by different icons. The 
icons, with which the corresponding objects are represented in the tree, are stored in this dialog.

Table 7-28 Icons

Input field Meaning Unique Mandatory 
field

Name Name of the icon yes yes
"OK" icon Path to the icon for displaying the "OK" status. no yes
"Idle" icon Path to the icon for displaying the "Idle" status no yes
"Offline" icon Path to the icon for displaying the "Offline" status no yes
"Warning" icon Path to the icon for displaying the "Warning" sta‐

tus
no yes

"Fault" icon Path to the icon for displaying the "Fault" status no yes
"CMSRuntime 
down" icon

Path to the icon for displaying the "CMS Run‐
time down" status

no yes

"WinCC Runtime 
down" icon

Path to the icon for displaying the "Win Runtime 
down" status

no yes

"PLC cannot be ac‐
cessed" icon

Path to the icon for displaying the "PLC cannot 
be accessed" status

no yes
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Input field Meaning Unique Mandatory 
field

"Undefined" icon Path to the icon for displaying the status if none 
of the other options apply

no yes

Comment Optional comment no yes

Figure 7-69 Acquisition of icons

It is important to note that graphic symbols of any size can be specified in the icon acquisition 
dialog, but that the graphics will be either scaled or truncated depending on format if they are 
too large. The size for displaying icons in the control elements is optimized for 16 x 16 or 32 x 32 
pixels. All popular graphics formats such as bmp, jpg, gif, png, ico, emf, etc. can be selected as 
file formats.

The displayed icon path is the same as the path used to load the icons. Since the graphics 
themselves are also stored in the database, this path information is later merely a comment 
indicating the load path of the icons.

The appropriate "x" button can be used to delete an icon from the acquisition dialog.

7.4.3.20 Settings: Macros
In the CMS macros are named text blocks. The names of these macros can be used as 
wildcards in the functions for managing programs and references. Special macros are used in 
the function for importing FMDB data to automatically create links to references. 
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When references are displayed, these wildcard characters are replaced by the relevant macro 
values.

Macros are acquired in this dialog:

● Macro name
The macro name must start and end with the % character. 
Example: %Page%

● Macro text
Here, you can assign a fixed value to a macro, which is then applicable to all locations where 
it is used. An example is the path to certain documents.
In the other case, only assign the macro with a value if the reference or a program that uses 
it is assigned a message or equipment type. An example for a macro of this type is the page 
in a circuit diagram.

In the CMS Editor, there are also special FMDB macros as well as some predefined macros that 
contain system information such as, e.g. the installation path of the CMS.

You can use the macros for system information. You cannot change the value. This is the 
reason that they do not appear in this dialog, but only in the dialog to acquire references and to 
acquire programs. Special FMDB macros are used for FMDB import (see Chapter Import/
export: Importing FMDB data (Page 201)).

In the CMSFaults control, as part of the function for displaying the information referred to in the 
reference entries, the macro names in the reference and program entries are replaced by the 
contents of the text blocks (current values of the macros). The resulting command is then sent 
to the operating system in order to display the information.

Table 7-29 Macros

Input field Meaning Unique Mandatory 
field

Macro name Name of the macro yes yes
Macro text Text to be used instead of the name when the place‐

holder is replaced
no no

Comment Comment on the macro no no
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Figure 7-70 Acquisition of macros

Macros are acquired in this dialog, although system-defined macros are not displayed here.

Note

If spaces are used in macro texts, please note that spaces may be interpreted as separators in 
commands when the Windows program is called.

7.4.3.21 Settings: Programs
In this dialog, the CMS is notified about the programs with their special parameters, which are 
used to display referenced information ("References").

Table 7-30 Programs

Input field Meaning Unique Mandatory 
field

Description Name of the program as it is displayed in the se‐
lection fields

yes yes

Program Text of the command to be used to start the pro‐
gram.

no yes

Comment Optional comment no no
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Figure 7-71 Acquisition of programs

As long as the referenced file is of a type known to Windows and no additional parameters are 
required to display the information, no entries need to be made in this dialog. In this case, the 
reference can be launched directly via the Windows link.

In the case of programs which can be launched via the Windows search path, no path needs 
to be specified.

The part of the command where the reference is to be subsequently inserted needs to be 
identified by means of the symbolic name "%Reference%". 

Additional macros can also be manually entered in the command string to call a program. If a 
manually entered macro is not yet available in the macro table, it can be entered into the 
database directly after a corresponding dialog.
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Figure 7-72 Acquisition of programs (macros)

In the dialogs, the existing macros are displayed in a table on the right-hand side. The macro 
selected in the table can be dragged and dropped to the required location.

Note

If spaces are used in the command string, please note that spaces are interpreted as 
separators. Where necessary, the command should be enclosed within inverted commas.

Note

It is possible to use the same program more than once with different parameters, but a unique 
name must then be assigned for each program invocation. Alternatively, macros can also be 
used here.

7.4.3.22 Settings: Reference types

Note

This dialog is accessible only to users who belong to the Windows user group "CMSAdmin".

The information acquired in this dialog is used to create clear groups of references for display 
in the CMSFaults control. These reference types are displayed in the CMSFaults control as 
supplementary information to the reference name in the reference list. This dialog can also be 
used to define the order in which reference types are displayed in the CMSFaults control. A 
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certain basic inventory of reference types is installed with the CMS package. This basic 
inventory, which is listed in the screen below, can be adapted or extended in this dialog.

Table 7-31 Reference types

Input field Meaning Unique Mandatory 
field

Reference type Language code for the reference type yes yes
Sequence Sort identifier no yes
Comment Optional comment no no

Figure 7-73 Acquisition of reference types

If a new reference type is set up in this dialog, an entry in the table for language-specific texts 
is automatically created for each language implemented. The code identifier entered in this 
dialog is the default entry for the text.

The display texts can be modified under the dialog name "ReferenceTypes" in the language 
table.

7.4.3.23 Installation: Usertexts

Note

This dialog is accessible only to users who belong to the Windows user group "CMSAdmin".

None of the texts used in the CMS controls and none of the messages output from the CMS are 
stored in the dialogs themselves, nor are they an integral component of the program. Instead, 
they are loaded from the database.
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As this information is automatically loaded when the CMS is installed, normally you don't have 
to make any entries in this dialog. However, if there are additional application-specific reference 
types, then manual postprocessing is required.

Table 7-32 Usertexts

Input field Meaning Unique Mandatory 
field

Component 
name

Name of the dialog component, language code 
value or message identifier

yes yes

Usertext Name Name of the usertext no yes
Comment Optional comment no no
Text Language-specific text no yes

Figure 7-74 Acquisition of user texts

7.4.3.24 Installation: Languages

Note

This dialog is accessible only to users who belong to the Windows user group "CMSAdmin".

You edit the texts of the SIMOCRANE CMS language in this dialog. 
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The SIMOCRANE CMS language defines the CMS editor texts and specific texts of the 
SIMOCRANE CMS Runtime application. It also includes ActiveX Controls texts.

Table 7-33 Languages - general

Input field Meaning Unique Mandatory 
field

Dialog name Name of the dialog, data type or message group yes yes
Component 
name

Name of the dialog component, language code 
value or message identifier

yes yes

Dialog/message Switch defining whether the text for a field is ac‐
quired in a dialog or a message

no yes

Comment Optional comment no no

Figure 7-75 Acquisition of language-specific texts - general

Table 7-34 Languages - language

Input field Meaning Unique Mandatory 
field

Text Language-specific text no yes
Font Display font for the language-specific text (for dia‐

log fields only)
no yes 

(only for dia‐
logs)
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Input field Meaning Unique Mandatory 
field

Length Length of the dialog field and current length of the 
entered text.
The field is read-only. 
The lengths are specified in pixels.

no yes 
(only for dia‐

logs)

Tooltip Language-specific tooltip text (implemented only 
for context menu entries in the current version.)

no no

Icon Language-specific icon (for messages only)
The optimized size for the display of icons in mes‐
sage dialogs is 32 x 32 pixels. 
The display size of icons in Treeview control ele‐
ments is limited to 16 x 16 pixels.

no no

Figure 7-76 Acquisition of language-specific texts

The text display dialog screen shows both the dynamic length of the text and the static length 
of the text display label. The dynamic length is calculated on the basis of the selected font. The 
static length is defined when the dialog is implemented. Both these lengths are displayed in 
pixels.
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7.4.3.25 System: Maintenance
The primary purpose of this function is to prevent data loss caused by hard disk failures, 
parameterization errors, etc. It can also be used to copy the entire master database of a CMS 
between different computers. It is also capable of restoring the database to its original 
installation state.

Figure 7-77 Maintenance (backup / restore)

This dialog contains the functions for database maintenance. For all functions, a parameter can 
be used to determine whether the configuration file should be included in the function as well 
(see Chapter System: Basic settings (Page 213)).

When a backup is performed, the contents of all tables are always copied to the target directory. 
Data cannot be selected more specifically. In order to ensure that data of different database 
dates are not mixed, all data from a previous backup operation are deleted from the target 
directory before the next backup is performed.

The function for resetting the database to its delivery state is used to empty all tables of their 
contents and fill them up again with the data provided during installation.

7.4.3.26 System: Basic settings
In the acquisition dialog for modifying basic settings, the contents of the CMS configuration file 
can be adapted to meet specific requirements. A template for this configuration file is installed 
with the CMS software.

When the CMS Editor is launched for the first time, this template is copied to the CMS directory 
within the WinCC project directory. This means that these settings can be adapted specifically 
for each WinCC project. However, no provision is made for user-specific settings.
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"Colors" tab

Figure 7-78 Changing the basic settings: Colors

All relevant colors for displaying CMS objects can be set on the "Colors" tab. Before the colors 
for all objects are accepted, they can be viewed in the example fields.

● Dialog: The colors of the dialogs for acquisition of data

● Testboxes: The colors of all input fields

● Table heading: The color of the table captions

● Table row description: The color of the row labeling in the tables

● actual row(selected): Marking a selected element

● referenced: Color of an element if there are references for this element

● referenced(selected): Marking of a selected element if there are assignments to this element

● changed: Color of an element if something has been changed

● changed(selected): Marking of a selected element if this element has been changed
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"Logs" tab

Figure 7-79 Changing the basic settings: Trace

The settings for the CMS Trace functions are selected under the "Trace" tab. The format of log 
file names is generally as follows:

<path>\<name>.<year>.<month>.<extension>
This means that a new log file is created every month. Log files are always extended. They must 
be deleted by the user as no function has been implemented to delete them automatically.

As soon as a log file has reached a certain size, the logged status up until then is backed up with 
a consecutive number as a supplement. The current file is deleted and then continued with the 
actual outputs.

The following log files can be provided by the system:

● Error log
The error log records all internal errors which occur in the CMS system. If no WinCC project 
is open or if the function is not enabled, then these entries are written to the Windows event 
log.

● Execution log
The execution log stores a large quantity of internal information about the CMS execution 
history. The primary purpose of this file is to provide detailed troubleshooting information 
when required. However, as it can become very long over a relatively short period and a 
considerable amount of time is required to write the log, this log should be activated only if 
its diagnostic functions are really needed.

● Import log
All errors and warnings relating to imports are always displayed in a dialog. In addition to this 
dialog, errors and warnings relating to imports can also be logged in a file.
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"Comments" tab

Figure 7-80 Changing the basic settings: Validity of remarks

The response of the CMSFaults control to the input of remarks on maintenance instructions can 
be defined on the "Annotations" tab.

● Ask
Every time a remark is stored, a dialog is displayed in which the user can define the validity 
of the entered remark.

● Global
All entered remarks are assigned to the maintenance instruction itself. Since a maintenance 
instruction text can be assigned to multiple WinCC messages as well as multiple cranes or 
equipment types, an assigned remark is displayed at every location at which the instruction 
text is used.

● Local
All entered remarks are assigned to the WinCC message.
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"Languages" tab

Figure 7-81 Changing the basic settings: Acquisition of languages

The languages which are available for use in the CMS can be maintained on the "Languages" 
tab. If a new language is set up here, the language-specific information of the default language 
is copied for the new one. Using the export functions, this information can then be exported for 
translation and finally imported again.

In order to ensure that one language is always designated as the default, the tick next to the 
default language can never be removed directly. To define a different language as the default, 
the new default language must be selected and ticked as the default. The system then 
automatically removes the tick from the default language checkbox on the other language.

The language-specific texts to be loaded from the database for displaying CMS objects are 
defined by the LCID and the code. The LCID is determined by WinCC ODK functions and the 
language-specific texts are then selected on the basis of the code. For a description of these 
data, please refer to WinCC Help, Description of VBS Fundamentals, item "Local ID (LCID) 
Chart".

The tab sequence merely controls the sequence in which the tabs for individual languages are 
displayed in the dialog for maintaining language-specific texts.

Mandatory fields:

● Country / Region

● Code

● LCID

● Tab sequence

The changes on this tab are stored only with the buttons which are displayed on the tab itself. 
The buttons at the bottom of the dialog have no function in this tab.
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"Topology" tab

Figure 7-82 Changing the basic settings: Topology

The topology of the system can be defined on the "Topology" tab. The following settings can be 
selected:

● CMS stand-alone

● CMS with RCMS (Process Historian)

● CMS with RCMS (WinCC)

There must be precisely one equipment type and one crane.

Note

Every time the topology settings are changed, the CMS Editor must be closed so that the 
changes can be applied in the editor.

For the changed settings to be applied, the CMS Editor and CMS Runtime must be ended and 
restarted.
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"Message Details" tab

Figure 7-83 Changing the basic settings: Message details

In the "Message details" tab, the display of message details (message text blocks) from the 
WinCC Alarm Logging can be controlled in the CMSFaults Control.

Table 7-35 Basic settings: Message details

Input field Meaning Unique Mandatory 
field

Sequence Numeric value to control the sequence in the dis‐
play in the CMSFaults Control. The block with the 
lowest value is displayed first.

no yes

Display Select whether data acquisition is activated. no no
Comment Optional comment no no
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"Computer" tab

Figure 7-84 Changing the basic settings: Computer

Note

This tab is only available for the topology "CMS with RCMS (WinCC)".

You can specify the following settings under the "Computer" tab:

● Minimum free hard disk space on the CMS station: 
If the free disk space falls below this lower limit when an XML file is written (data transferred 
to the RCMS server), the function for writing XML files will be stopped. From this point, data 
will only be entered in the crane's Tag Logging archives.

● Maximum buffer time for XML files: 
Once XML files become older than a certain number of days, these files, including the date-
based folder, are deleted.

Note

Do not use any method other than the "Clear buffer" button to delete the XML files and transfer 
directories. By doing this, you ensure that the system can continue to generate XML files.

If you delete the transfer directories manually, you might also delete the directory required for 
current XML files. This directory is created only once per day or when the CMS is restarted.
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Configuring the CMS application 8
8.1 Important note about adapting the CMS application

This chapter describes the configuration work you need to perform in the CMS example 
application in order to adapt the example application to your specific requirements. It describes 
configuration work which is specific to the CMS example application. It is assumed that you are 
generally familiar with WinCC.

Note
Technical requirements for adapting the example application:
● Very good knowledge of WinCC
● Detailed knowledge of the Replay function
● If scripts have to be written: 

Experience with writing scripts (VB scripts and/or C scripts)

Note

Note the design information provided in the appendix when undertaking configuration work.
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8.2 Default settings in the example application

Initial situation
Some parameters that are required in the status display of the example application (limits for 
traveling distances) can be parameterized in the runtime interface, without changing the 
WinCC screens in the editor. This parameter assignment can be performed during system 
runtime and does not require a restart.

The settings you undertake in the runtime are written to internal WinCC tags. You can find all 
tags that contain settings in the internal WinCC tag group "Settings". The property "Runtime 
Persistence" is set for all tags of this tag group. This means that the value that this tag had 
before WinCC Runtime was stopped the last time, is re-established the next time that the 
runtime is started.

Figure 8-1 Runtime persistency

Processing steps
1. Start the WinCC Runtime.

2. Log onto the start page of the CMS user interface as an administrator.

3. Open the "Settings" menu and define your parameters in the individual tabs of the menu.
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8.2.1 "Settings General" tab
The following display provides an overview of the setting options available in the "General" tab.

① Technology functions Select the technology functions present. Enter the computer name 
(if present) of the WebNavigator Client PC in the crane cabin if you 
want to restrict operation of the technology functions to this PC.

② Replay To be able to use the Replay function on the user interface of the 
CMS, select "Replay technology installed."

③ Performance Monitor To be able to use the Performance Monitor function on the user 
interface of the CMS, select "Performance Monitor installed."

④ Spreader Check the box of the crane spreader you want to use.
⑤ SIMATIC S7 web server Select whether in your project the web server on the SIMATIC S7 

CPU is activated. Then enter the IP address of your S7.
⑥ SIMOTION web server Select whether in your project the web server on SIMOTION is 

activated. Then enter the IP address of your SIMOTION.
⑦ SIPLUS CMS Select whether the SIPLUS Trace Viewer is to be used in your 

project. Then enter the IP address and the port number of the 
Trace Viewer server.

⑧ Archive Backup Connector/
Remover

Check this box if you want to link WinCC backup archives with the 
application.
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8.2.2 "Settings Drives" tab
The following display provides an overview of the setting options available in the "Drives" tab.

① Hoist Drives Enter the number of hoist drives.
② Boomhoist Drives Enter the number of boom-hoist drives.
③ Trolley Drives Enter the number of trolley drives.
④ Gantry Drives Enter the number of gantry drives.
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8.2.3 "GUI Settings" tab
The following display provides an overview of the setting options available in the "GUI Settings" 
tab.

① Hoist Positions "Maximal position up": 
Specify the maximum traversing position of the hoist in the upward 
direction.
"Maximal position down": 
Specify the maximum traversing position of the hoist in the down‐
ward direction.
"Prelimit Ground": 
Specify the height of the hoist above the ground as of which a visual 
warning status is displayed (yellow).
"Limit Ground": 
Specify the height of the hoist above the ground as of which a visual 
fault status is displayed (red).

② Trolley Positions "Maximal position waterside": 
Specify the maximum traversing position of the trolley on the water‐
side. 
"Maximal position landside": 
Specify the maximum traversing position of the trolley on the land‐
side.

③ Gantry Positions "Maximal position right": 
Specify the maximum traversing position of the gantry towards the 
right.
"Maximal position left": 
Specify the maximum traversing position of the gantry towards the 
left.
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④ Crane type & hoist equip‐
ment

Depending on the selection, the appearance of the crane changes in 
the start picture.
Note: 
This selection is only for the application example "Lean"!
Note: 
In WinCC, you can create additional crane types and hoist equip‐
ment in the selection list.  
You must create a picture <crane type>_<hoist equipment>.pdl for 
each possible combination of crane type and hoist equipment. 
Ensure that <crane type> and <hoist equipment> are written pre‐
cisely the same in the list and in the picture names. 
"Crane type": 
Select the crane type.
"Hoist equipment": 
Select the hoist equipment being used.
"Save": 
Saves the selection of the crane type and the hoist equipment type.
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8.2.4 "Settings Temperature" tab
The following display provides an overview of the setting options available in the "Temperature" 
tab.

① Hoist Temperature Settings Temperature settings for the drives and brakes of the hoist.
The bar chart display is activated when you check the box.
"Alarm High": 
Specify the temperature as of which an excess temperature alarm 
must be output.
"Warning High": 
Specify the temperature as of which an excess temperature warning 
must be output.
"Warning Low": 
Specify the temperature as of which a low temperature warning must 
be output.
"Alarm Low": 
Specify the temperature as of which a low temperature alarm must 
be output.
"Maximum": 
Enter the upper limit for the bar chart here.
"Minimum": 
Enter the lower limit for the bar chart here.

② Gantry Temperature Set‐
tings

Temperature settings for the drives and brakes of the gantry.
The bar chart display is activated when you check the box.
See ① for settings.
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③ Trolley Temperature Set‐
tings

Temperature settings for the drives and brakes of the trolley.
The bar chart display is activated when you check the box.
See ① for settings.

④ Boomhoist Temperature Set‐
tings

Temperature settings for the drives and brakes of the boom-hoist.
The bar chart display is activated when you check the box.
See ① for settings.

8.2.5 "Drive Selection" tab
The following display provides an overview of the setting options available in the "Drive 
Selection" tab.

① Number of Crane Main Equip‐
ment

Select the number of trolleys and hoists.

② Number of Drives Select the number of drives for trolleys, hoists and gantry.
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8.2.6 "User settings" tab
The following display provides an overview of the setting options available in the "User settings" 
tab.

You can create and delete users, and you can change user names and passwords.
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8.2.7 "Crane Type Selection" tab
The following display provides an overview of the setting options available in the "Crane Type 
Selection" tab.

① Crane place of use Select the location where the crane is in use.
You can select different crane types depending on the place of 
use:
● Harbor:

RTG
RMG

● Industrial:
OHBC

② Select crane picture Select the crane picture that is to be displayed on the CMS home 
screen and diagnostics pages.

③ Lifting gear type Select the hoist equipment of the crane.
④ Crane-specific functions Select the properties of the crane:

● Weight sensor 
● Auxiliary hoist
● Gantry
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8.3 Windows and window contents

8.3.1 Window layout in the example application
All permanently visible picture windows in the example application are shown in the following 
figure 

Figure 8-2 Window layout in the example application

No. Description
① Control bar
② Primary navigation bar
③ Status bar window
④ Message line
⑤ Replay button
⑥ Home button
⑦ Menu window
⑧ Group display

A picture tag is assigned to each picture window with a dynamized picture name (Picture name 
property).
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8.3.2 General information about picture navigation
Screen navigation is based on internal WinCC tags.

● Status tag: Status of navigation bars (Type Byte)

● Picture tag: Screen name of a picture window (Type Text-8)

● Display tag: Visibility of detail and dialog windows

A picture tag is assigned to each picture window with a dynamized picture name (Picture name 
property). The figure below illustrates how picture tags are used to switch between screens and 
how the three navigation levels are interconnected:

● The main screen is shown in ①. The menu window is colored blue, since it is a picture 
window with picture tags.

● The first button of the primary navigation is pressed in ②. The menu window is assigned to 
the main screen of the first menu via the picture tag. The main screen contains one or two 
picture windows and a navigation window. The first menu contains two picture windows and 
a navigation bar window for the secondary navigation. The secondary navigation 
dynamizes the picture tags of one of the picture windows.

● ③ indicates that the first button in the secondary navigation bar assigns a screen to the 
picture window (GeneralDiagnostics.Pdl).

The screens contain one or more magnifying glass pushbuttons. The magnifying glass button 
can be used to open a detail screen ④. When this happens, the display tag for the detail 
window is set to"TRUE" in the main screen and a picture name is assigned to the picture tag.

The same procedure applies to all the other menus.
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Figure 8-3 Principle of screen navigation

There is an internal tag for each navigation bar and this features the selection status of the 
entire navigation bar (selection status tag). The tag changes its value as soon as a button is 
pressed in the navigation bar. Every button is assigned a selection status where the button is 
active. The buttons are WinCC status displays (see next section).

8.3.3 General information on detail pictures and buttons on detail pictures
Within a picture, you can create a button for opening a detail picture. When this happens, the 
display tag for the detail window is set to "TRUE" in the main screen and the picture name for 
the detail picture is assigned to the picture tag.
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Naming convention for detail pictures

Figure 8-4 Naming convention for detail pictures

● Name of the detail picture:
Except for the following restriction, you can freely select the name of the detail picture:
The name of the detail picture must not start with "@".

● Name of the detail picture tag:
@CMSDetailPic

● Name of the display tag for detail pictures:
@CMSDetailVisible
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Actions for the mouse click
For the mouse click on the button that opens the detail picture, you should have actions 
executed for the following events.
"Object properties" → "Event tab" → "Mouse" → "Mouse click"

Figure 8-5 Object properties of the button for detail pictures

Event Tag ① Constant ② Description
Mouse click "@CMSDetailVisible" "1" This makes the detail picture visible.
Press Left "@CMSDetailPic" <picture name>.pdl The name of the detail picture is entered here.
Release Left "@CMSTagPrefix" <tags prefix> Only assign a tag prefix if it is required.

Note

To ensure that buttons also work in Replay mode, you must place the prefix @NOTP:: in front 
of the tags.

See: The tag prefix mechanism (Page 309)
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8.4 Navigation bars and navigation buttons

8.4.1 General information on navigation bars and navigation buttons
With SIMOCRANE CMS, you can implement up to 10 primary navigation buttons and 10 
secondary navigation buttons - in total therefore, up to 110 navigation buttons.

General information about navigation
Screen navigation is based on internal WinCC tags.

● Status tag: Status of navigation bars (Type Word) 

● Picture tag: Screen name of a picture window (Type Text-8) 

● Display tag: Visibility of detail and dialog windows

See also
Naming convention for pictures and secondary navigation bars (Page 237)

Naming convention of navigation buttons and visible tags for Replay (Page 237)

Navigation bar: Status tag (Page 238)

Navigation button: VB script for mouse click (Page 239)

Navigation bar: Creating a secondary bar (Page 240)

Creating a navigation button (Page 241)

Navigation button: Adapting the position (Page 243)

Navigation button: Adapting the link destination (Page 245)

Adapting navigation button for Replay (Page 334)
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8.4.2 Naming convention for pictures and secondary navigation bars
The following naming conventions apply to the main pictures and their secondary navigation 
bars.

Figure 8-6 Naming convention for main pictures and secondary navigation bars

● Name of the picture "@CMSMenuX.pdl" 

● Name of the picture tag: "@CMSMenuXPic" 

● Name of the secondary navigation bar: "CMSMenuXNav.pdl" 

● Status tag of the navigation bar: "@CMSMenuXSelection"

"X" is the position of the button of the primary navigation bar that calls the window with the 
navigation bar.

8.4.3 Naming convention of navigation buttons and visible tags for Replay
The following naming conventions apply to the navigation buttons and their visible tags.

Figure 8-7 Button_visible, position of new buttons on the primary and secondary navigation bar
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Name and visible tag of 7th button on the primary navigation bar:

● Name of the primary navigation button: "Button7"

● Name of the visible tag: "@NOTP::@ReplayButtonVisible7"

Name and visible tag of the 4th button on the secondary navigation bar that is called via the 7th 
button of the primary navigation bar.

● Name of the secondary navigation button: "Button7_PictureName"

● Name of the visible tag: "@NOTP::@ReplayButtonVisible74"

To ensure that navigation bars are correctly shown and hidden in Replay mode, the navigation 
buttons must be named according to the following convention:

● Names of the primary navigation buttons:
"ButtonX", where "X" is a number between 1 and 10 and indicates the position of the 
navigation button in the primary navigation bar.
The name must not contain an underscore character "_"!

● Names of the secondary navigation buttons:
"ButtonX_Bildname", where "X" is the number of the level-1 button (number between 1 and 
10) and "PictureName" is the name of the picture to be called without the file extension ".pdl".
The name must not contain an underscore character "_"! The underscore character "_" is 
interpreted as a separator and must therefore not be used in the picture name.

8.4.4 Navigation bar: Status tag
Each navigation bar has its own internal status tag that represents the selection status of the 
entire navigation bar.

The tag changes its value as soon as a button is pressed in the navigation bar. Every navigation 
button is assigned a selection status where the button is active.

● Status tag of the primary navigation bar: 
@CMSPrimSelection

● Status tag of the secondary navigation bars: 
@CMSMenuXSelection; where X is a number between 1 and 10.

Figure 8-8 Values for the status tags of the primary and secondary navigation bars

Configuring the CMS application
8.4 Navigation bars and navigation buttons

Crane Management System (CMS)
238 System Manual, 11/2019



The values for the status tags are displayed in the graphic. For example, the highlighted 
navigation button would have value "64" for the seventh position in the navigation bar.

To ensure that the navigation button graphic can be displayed correctly depending on status 
(selected, not selected), you must assign the position of the navigation button to the associated 
status tag.
See: "Navigation button: VB script for mouse click (Page 239)"

8.4.5 Navigation button: VB script for mouse click
You may have to adapt the VB script for the mouse click on a navigation button to the following 
aspects.

Figure 8-9 NaviButtonClickScript

No. Description
① Picture tag that defines the image structure to be opened. 

● Primary navigation bar: @CMSPrimPic
● Secondary navigation bars: @CMSMenuXPic; where X is a number between 1 and 10.

② Status tag for the navigation bar 
Each navigation bar has its own status tag
● Primary navigation bar: @CMSPrimSelection 
● Secondary navigation bars: @CMSMenuXSelection; where X is a number between 1 and 10.

③ Link destination (picture name) to which the navigation button is linked.
● Primary navigation bar: @CMSMenuX.pdl; where X is a number between 1 and 10.
● Secondary navigation bars: <PictureName>.pdl; for example, Auxiliaries.pdl

④ Sets the state of the status tag of the navigation bar. The value corresponds to the position of the navigation button on 
the navigation bar.
See: "Navigation bar: Status tag (Page 238)" 
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8.4.6 Navigation bar: Creating a secondary bar
This section describes how to create a secondary navigation bar.

You must perform these steps if you want to insert a navigation bar into an existing window or 
if you want to create a new window with the navigation bar.

Figure 8-10 Naming convention for main pictures and secondary navigation bars

1. Create the window by applying the new navigation bar in accordance with the conventions 
for windows and navigation bars.
See: "Naming convention for pictures and secondary navigation bars (Page 237)" 

Note

You may have to create new picture window tags in the tag management.

2. Copy an existing navigation bar and give it an appropriate name.

3. Adapt the status tags of the navigation bar for all buttons: 
"Object properties" → "Event tab" → "Mouse" → "Mouse click" 
Adapt the status tag to the associated navigation bar. 
Example of the 7th secondary navigation bar: 
"subMenuSelektion = HMIRuntime.Tags ("@NOTP::@CMSMenu7Selection")"

4. Adapt the name and the visible tags of the navigation buttons. 
See: "Adapting navigation button for Replay (Page 334)"  

5. Define the link destination of the navigation button. 
See: "Navigation button: Adapting the link destination (Page 245)" 

6. Assign suitable graphics to the navigation button. 
See: "Navigation button: Adapting a graphic (Page 241)" 
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8.4.7 Creating a navigation button
This section describes how to create a navigation button on a primary or secondary navigation 
bar.

1. Use the shortcuts "Ctrl" + "C" and "Ctrl" + "V" in the Graphics Designer to duplicate an 
existing navigation button. 

2. Adapt the name of the navigation button: 
"Object properties" → "Properties tab" → "Status display" → "Object name" 
For primary navigation buttons: "ButtonX" 
For secondary navigation buttons: "ButtonX_PictureName" 
See: "Naming convention of navigation buttons and visible tags for Replay (Page 237)" 

Figure 8-11 Object name of secondary navigation buttons

3. Position the navigation button on the navigation bar and adapt it according to its position on 
the navigation bar. 
See: "Navigation button: Adapting the position (Page 243)" 

4. Define the link destination of the navigation button. 
See: "Navigation button: Adapting the link destination (Page 245)" 

5. Assign suitable graphics to the navigation button. 
See: "Navigation button: Adapting a graphic (Page 241)" 

8.4.8 Navigation button: Adapting a graphic
This section describes how to change the graphics of a navigation button. 
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You can create your own graphics for buttons. These should have the following properties:

● Square format 

● File format: .svg

Note

.svg graphics created with Visio are not correctly displayed in WinCC.

If necessary, application support for SIMOCRANE can provide a tool that prepares .svg 
graphics created with Visio for correct display in WinCC.

● Storage location: Project folder "GraCS" (<<WinCCProjectPath>>\GraCS)

Adaptation is described as exemplified by navigation button "Button2" of the primary navigation 
bar.

1. Open the navigation bar in Graphics Designer (in this example "@CMSPrimNav.Pdl").

Figure 8-12 Graphic of the navigation bar "@CMSPrimNav.Pdl"

2. Right-click on Button2.
A "Status Display Configuration" dialog box for Button2 opens.

3. Assign the graphics that will be displayed depending on the navigation button's status to the 
navigation button. 

4. Select a suitable tag for the navigation bar in the "Tag" field. 
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5. Assign the graphic for "inactive" to all values in which the button is not selected. 

6. Assign the graphic for "activated" to the value of the active status.

Figure 8-13 Adapting the graphics of a navigation button

8.4.9 Navigation button: Adapting the position
This section describes how you must adapt the functionality of a navigation button in 
accordance with its position on the navigation bar if you want to move it or copy it to another 
position.

Note

The naming conventions must be followed so that navigation buttons on the primary and 
secondary navigation bars can be shown and hidden depending on the pictures prepared in the 
Replay Configuration Editor. 

You will find detailed information about the naming convention and visible tag here: "Naming 
convention of navigation buttons and visible tags for Replay (Page 237)". 

1. In Graphics Designer, position the navigation button at the required position on the 
navigation bar.

2. Adapt the name of the navigation button in accordance with its position on the navigation 
bar:
"Object properties" → "Properties tab" → "Status display" → "Object name" 
For primary navigation buttons: "ButtonX" 
For secondary navigation buttons: "ButtonX_PictureName"
"X" indicates the position of the navigation button in the navigation bar (values: 1..10).
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3. Assign a visible tag to the button for display in Replay mode: 
"Object properties" → "Properties tab" → "Miscellaneous" → "Display" 
For primary navigation buttons: "@NOTP::@ReplayButtonVisibleX" 
For secondary navigation buttons: "@NOTP::@ReplayButtonVisibleXY" 
"X" indicates the position of the navigation button in the primary navigation bar (values: 
1..10).  
"Y" indicates the position of the navigation button in the secondary navigation bar (values: 
1..10).

Figure 8-14 Property display button 74

4. If necessary, adapt the status tag to the navigation bar in which the button is used. 
"Object properties" → "Event tab" → "Mouse" → "Mouse click" 
Adapt the status tags to the associated navigation bar. 
Example of the 7th secondary navigation bar: 
"subMenuSelektion = HMIRuntime.Tags ("@NOTP::@CMSMenu7Selection")"

5. Write the value of the status tag: 
"Object properties" → "Event tab" → "Mouse" → "Mouse click" 
With "MenuSelection.Write", specify the value for the position of the navigation button on the 
navigation bar. 
Example: "MenuSelection.Write = 64" for position 7 in the navigation bar

Note

This value must be a power of two between 1 and 512. 
See: "Navigation bar: Status tag (Page 238)" 

6. Assign the graphics that will be displayed depending on the navigation button's status to the 
navigation button. 
See: "Navigation button: Adapting a graphic (Page 241)" 
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8.4.10 Navigation button: Adapting the link destination
This section describes how to adapt the link destination of a navigation button.

Note

The naming conventions must be followed so that navigation buttons on the primary and 
secondary navigation bars can be shown and hidden depending on the pictures prepared in the 
Replay Configuration Editor. You will find detailed information about the naming convention 
and visible tag in Section: "Naming convention of navigation buttons and visible tags for Replay 
(Page 237)" 

1. Create the link destination in the object properties for the mouse click: 
"Object properties" → "Event tab" → "Mouse" → "Mouse click" 
Example: MenuPic.Write "@CMSMenu5.pdl".

2. For navigation buttons on the secondary navigation bars, adapt the name of the navigation 
button according to the link destination: 
"Object properties" → "Properties tab" → "Status display" → "Object name"
Example: "ButtonX_PictureName"; where "PictureName" is the name of the picture to be 
called without the file name extension ".pdl".

8.4.11 Screen initialization

Initial situation / objective
Screen navigation is based on internal WinCC tags. The navigation variables must be initialized 
when starting the runtime.

The following initializations are carried out in the example application:

● The selection state for all navigations is set to 1.

● The picture tags of the main navigation and of the individual menus are initialized in the 
starting value of the picture tags with the name of the first screen in the menu.

How to change the screen initialization is described below.

Processing steps
1. Open the tag group "Screens" in the WinCC tag management / internal tags.

2. Open the properties of a picture tag (e.g. @CMSMenu4Pic).

3. In the Start value of the tags, replace e.g. the first screen of the 4th menu ("Fault-
Diagnostics" → "Messages.PDL") with a new screen, e.g. "MessageList.PDL".

4. Save the change.
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8.5 Group fault bar

8.5.1 General information about the group fault bar

Initial situation / objective
The state of the group fault bar is formed via group messages in the WinCC Alarm Logging. 
See: Group messages (Page 114)).

Each element in the group fault bar has three possible states

● Bit 1: Inactive (not a fault, not a warning)

● Bit 2: Warning

● Bit 3: Fault

Figure 8-15 Principle of the group fault display

There are only two states for operating messages:

● Inactive

● Active

See also
Adding elements to the group fault bar (Page 247)
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8.5.2 Adding elements to the group fault bar

Processing steps
These instructions show the steps required to add an element to the group fault bar.
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See also: General information about the group fault bar (Page 246)

1. Create four graphics (inactive, active, warning, fault) for the display element. 
File format: .svg 
Storage location: Project folder "GraCS" (<<WinCCProjectPath>>\GraCS)

Figure 8-16 Editing the status graphics of a group display

2. Right-click a placeholder on the group fault bar and select "Configuration dialog" from the 
shortcut menu to open the "Status Display Configuration" window.

Figure 8-17 Status tag of a group display

3. Assign the graphics for the "Warning" status to status 4 (bit position 2).

4. Assign the graphics for the "Fault " status to status 8 (bit position 3).
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5. Select the appropriate status tag in the "Tag" field. 
You must now link this tag to bit 2 and bit 3 of the associated group signal.

6. Open the alarm logging.
Link bit 2 and bit 3 of the appropriate group signal to the status tag of the element.

Figure 8-18 Assigning bit 2 and bit 3 of the group signal to the status tag of the group display

Note

You can also organize the group signals hierarchically. The lower-level messages can also 
trigger the higher-level group signal.
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8.6 WinCC Alarm Control and CMSFaults Control

8.6.1 Message filter in the WinCC Alarm Control
In the CMS example application, the messages are displayed in the WinCC Alarm Control. The 
messages displayed can be filtered according to various criteria in the CMS example 
application using predefined buttons on a filter bar.

The filter buttons transmit an SQL filter string to the WinCC Alarm Control property 
"MsgFilterSQL". The reset button passes an empty string to the WinCC alarm control.

You will find the filter bar on the "MessagesFilter.PDL" screen. The following filter strings are 
available in the example application:

Icon Name Filter string Description
Fault "CLASS=1" Only messages of message class 1 

→ Fault

Warnings "CLASS=4" Only messages of message class 4 
→ Warning

CMS system 
messages

"CLASS=16" Only messages of message class 16 
→ CMS

General "TEXT8 LIKE 'GE'" Only messages with the group abbre‐
viation "GE" in the user text block 8.

Hoisting gear "TEXT8 LIKE 'HO" Only messages with the group abbre‐
viation "HO" in the user text block 8.

Trolley "TEXT8 LIKE 'TR" Only messages with the group abbre‐
viation "TR" in the user text block 8.

Boom-hoist "TEXT8 LIKE 'BH" Only messages with the group abbre‐
viation "BO" in the user text block 8.

Gantry "TEXT8 LIKE 'GA" Only messages with the group abbre‐
viation "GA" in the user text block 8.

Spreader "TEXT8 LIKE 'SPR" Only messages with the group abbre‐
viation "SPR" in the user text block 8.

Reset Filter "" The filter is reset.
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8.6.2 General information about CMSFaults control
The CMSFaults control is an ActiveX object for displaying crane-specific information relating to 
WinCC messages.

Note

The CMSFaults control just displays the maintenance instruction that is assigned to the WinCC 
message.

Maintenance instructions assigned to the equipment type or crane are not shown

The CMSFaults Control is already integrated in the CMS example application. You will find the 
integrated CMSFaults Control in the "MessagesInfo.Pdl" picture.

Message numbers and message timestamps for the currently selected message are read out 
using a VBS project module. Depending on the message number, the information assigned to 
this message in the WinCC Alarm Logging and CMS Editor is displayed. 

The ActiveX control CMSFaults has no direct access to WinCC, the database or the data in the 
configuration file. All data are read by CMS Runtime. An appropriate message is therefore 
displayed if CMS Runtime is not running. This message is unalterably stored in English in the 
program and cannot be altered.

Figure 8-19 CMSFaults Control (display of the runtime)

CMSFaults Control consists of three tabs:

● Tab 1: "Details" 
Displays the message details in tabular form. 
The information comes from the message blocks in the WinCC Alarm Logging.

● Tab 2: "Maintenance instructions"
Displays the maintenance instruction assigned to the message. 
Fields for entering comments can also be offered to the user.

● Tab 3: "References"
Displays the references assigned to the message. 
In the example application, this tab is only enabled for users of the "Maintenance" group.
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To facilitate operation of the CMSFaults control on touch panels (activating functions with a 
double click on touch panels, for example, can be problematic), it is possible to execute all 
commands, such as scrolling through tabs, navigating round tables or opening reference files, 
by buttons in the WinCC application. In this case, commands are written to properties of the 
CMSFaults control.

Note

No references are available on the WebNavigator Client because access to the local hard disk 
of the web server is not possible.

8.6.3 WinCC object properties of the CMSFaults Control
Below you will find a description of the WinCC object properties of the CMSFaults Control.

Figure 8-20 CMSFaults Control object properties

With the following WinCC object properties, you can have actions executed:

Command Function
WinCCMessageNumber WinCC message number
OpenReference Open the currently selected reference
FirstRow Position on the first row in the reference table
PreviousRow Position on the previous row in the reference table
NextRow Position on the next row in the reference table
LastRow Position on the last row in the reference table
FirstTab Position on the first tab in the CMSFaults control
PreviousTab Position on the previous tab in the CMSFaults control
NextTab Position on the next tab in the CMSFaults control
LastTab Position on the last tab in the CMSFaults control
Command Find the information for the message currently selected in the WinCC Alarm control
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Command Function
NewLogEntryCause Clear the window for entering a new comment for the displayed maintenance instruction 

text (possible fault cause)
NewLogEntryRemedy Clear the window for entering a new comment for the displayed maintenance instruction 

text (possible remedy)
NewLogEntryComment Clear the window for entering a new comment for the displayed maintenance instruction 

text (comment)
UpdateLog Save the entered comments

With the following WinCC object properties, you can read out information:

Setting Function
CaptionWinCCAlarmControl Window caption of the WinCC Alarm Control
Server name Name or IP address of the computer on which the WinCC project is running. 
WinCCTableControlName Name of an optional WinCC online table or online trend control (no longer evaluated)
WinCCPictureName Name of the WinCC screen containing an optional WinCC Online Table or WinCC 

Online Trend control (no longer analyzed)
TimeUnit Unit of time interval
TimeOffsetPreTrigger Time interval before trigger
TimeOffsetPostTrigger Time interval after trigger
SelectionStart (ReadOnly) Time stamp of the displayed message, offset by the pretrigger time interval
SelectionStart (ReadOnly) Time stamp of the displayed message, offset by the posttrigger time interval
EnableLog True: Entering comments on maintenance instructions has been released.
EnableLogButtons True: Buttons for entering comments on maintenance instructions are visible.
EnableLogCauses True: Field for entering causes is visible.
EnableLogRemedies True: Field for entering remedies is visible.
EnableLogComments True: Field for entering comments is visible.
EnableTabDetails True: The "Message details" tab is visible.
EnableTabCauses True: The "Maintenance instructions" tab is visible.
EnableTabReferences True: The "References" tab is visible.

8.6.4 WinCC events of the CMSFaults Control

Figure 8-21 WinCC events of CMSFaults
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Table 8-1 Events of CMSFaults

Event Function Parameter
SelectionChanged Triggered if the message selected 

changes
SelectionStart: 
Time stamp of the selected message, minus 
the interval before the trigger, expressed 
as yyyy-MM-dd HH:mm:ss
SelectionStop: 
Time stamp of the selected message, plus 
the interval after the trigger, expressed 
as yyyy-MM-dd HH:mm:ss

CMSFaultsBusy Triggered if an action is performed -
CMSFaultsReady Triggered if the action is ended -
onChangeTabDetailsVisible Triggered if the "Details" tab becomes 

visible or invisible.
0: Tab is invisible. 
Anything else: Tab is visible.

onChangeTabCausesVisible Triggered if the "Maintenance instruc‐
tions" tab becomes visible or invisible.

0: Tab is invisible. 
Anything else: Tab is visible.

onChangeTabReferencesVisible Triggered if the "References" tab be‐
comes visible or invisible.

0: Tab is invisible. 
Anything else: Tab is visible.

8.6.5 CMSFaults Control properties
Below you will find a description of the properties of the CMSFaults Control. 

You can open the CMSFaults Control properties by double-clicking the CMSFaults Control in 
Graphics Designer.

Colors
The color settings of the CMSFaults Control can be changed on this property page.

Figure 8-22 CMSFaults properties page, colors
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Layout
The display features of the CMSFaults ActiveX can be adjusted on this property page. In this 
case, each of the three tabs can be completely enabled or disabled. At least one tab, however, 
must always be visible. 

Note

You can also make these entries in the WinCC properties dialog box by deactivating the setting 
with "0" or "false". Any other input will activate the corresponding setting.

Figure 8-23 CMSFaults properties page, layout

● Enable log
Activates / deactivates the input fields for entering comments for maintenance instructions 
together with associated control buttons. 
If the log is disabled, only the information stored in the CMS is displayed in CMSFaults 
Control.

● Enable log buttons
Activates / deactivates buttons for deleting the content of the field, for creating a new entry, 
and for saving changes.
You can hide the buttons with this property. You must then trigger the actions that are linked 
to these buttons by writing particular properties of the CMSFaults Control.

● Enable the field for entering possible causes
Activates / deactivates an input field for entering the possible cause.

● Enable the field for entering possible remedies
Activates / deactivates an input field for entering the possible remedy.

● Enable the field for entering comments
Activates / deactivates an input field for entering the comments.
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WinCC
The connection to WinCC can be configured on this property page.

Figure 8-24 CMSFaults properties page, WinCC connection
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● Server Name
Name or IP address of the server on which the WinCC project is running. This server name 
is used to establish communication with CMS Runtime if you wish to use the control on a 
Web Client.

Note

Note:
The following properties are obsolete and should not be used:
- Window Caption of the WinCC Alarm Control
- Name of the WinCC Picture
- Name of the WinCC Table Control
- Time Interval before Trigger / after Trigger
- Unit of Time Interval

● Window Caption of the WinCC Alarm Control
Title of the WinCC message window in which the message is selected.

Note

This setting does not involve the name of the Alarm Control, but the window caption that can 
be entered as a property.

Note

The WinCC function for determining messages via the window caption of the Alarm Control 
is case sensitive.

● Name of the WinCC screen
Name of the WinCC screen in which Alarm Control and Trend Control are located

● Name of the WinCC Table Control
Name of the Trend or Table Control in which the curve values are to be displayed.

Note

WinCC Alarm Control and WinCC Table / Trend Control must be in the same WinCC screen.

● Time Interval before or after the Trigger
Number of time units before the trigger instant (time before the event) as well as number of 
time units after the trigger instant (time after the event). This results in start and finish times 
for the display of the archived measured values in the WinCC Table / Trend Control.

● Unit of Time Interval
Unit of the time by which the start or finish time is corrected. The following are possible:
h: Hours
m: Minutes
s: Seconds

Configuring the CMS application
8.6 WinCC Alarm Control and CMSFaults Control

Crane Management System (CMS)
System Manual, 11/2019 257



8.6.6 Inserting CMSFaults control into a picture
These instructions show the steps required to insert a CMSFaults Control into a picture of your 
own.

Note

The CMS Runtime must be running when you link the control so that the colors from the CMS 
configuration file are applied. 

If the CMS Runtime is not active when the control is integrated, the colors must be adapted 
manually.

Automatic comparison with the configuration file of the CMS at a later time is not possible.

When the CMSFaults Control is linked into a WinCC picture, the following occurs:

● All tabs implemented in the CMSFaults Control are activated.

● Input of logbook entries is activated.

● Control via buttons is activated.

All these settings can be adjusted later.
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Sequence of steps
1. Insert the CMSFaults Control into the picture using the object pallet "Controls". You will find 

the control under "Siemens CMSFaults Control".

Figure 8-25 Insert the CMSFaults Control in WinCC Graphics designer

2. Open the object properties of the CMSFaults Control.
See: WinCC object properties of the CMSFaults Control (Page 252)

Figure 8-26 CMSFaults Control object properties

3. Assign the IP address of the computer to the "server names" property.
To enable the CMSFaults control to work on web clients, too, enter a tag here:
server name = @NOTP::@CMSServerIPAddress
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4. Assign the message number of the currently selected message in the WinCC Alarm Control 
to the "WinCCMessageNumber" property. 
You can also use the VBS project module "GetSelectedMessageNumber.bmo" to read out 
the message number and message time stamp.
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5. Open the properties of the CMSFaults Control by double-clicking.
See: CMSFaults Control properties (Page 254)

Figure 8-27 CMSFaults properties page, colors

– "Colours" tab:
 Here, you make changes to the displayed colors. 

– "WinCC" tab: 
Here, you adapt the connection to WinCC. 
Here, you configure the display of curve values in a TrendControl in the same picture.

– "Layout" tab:  
Here, you activate / deactivate display of the three tabs.  
You can disable the option for entering remarks for the maintenance instructions. 

6. Open the CMS editor to adapt the display and sequence of information. 
"System" → "Basic settings" → "Message details" tab

Figure 8-28 Configuring message details in the CMS editor
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– "Sequence" field 
Here, you can configure the order of information in the "Details" tab in the CMSFaults 
Control. 
The lower the value entered, the further up the list the information is. 

– "Display" check box 
Here, you can activate / deactivate display of information on the "Details" tab in the 
CMSFaults Control.

Configuring the CMS application
8.6 WinCC Alarm Control and CMSFaults Control

Crane Management System (CMS)
262 System Manual, 11/2019



8.7 User groups
Four user types with different rights are configured in the WinCC User Administrator in the 
example applications; see User groups (Page 63).

Table 8-2 Default WinCC user types in the example applications

Name Password Logon Rights in the WinCC User Administrator
Operator Operator ● CMS:

possible
● Web client:

possible

● Screen changeover
● Restricted scope of navigation
● Operation of sub-system screens

RCOSOperator RCOSOperator ● CMS:
Possible

● Web client:
Possible

● Screen changeover
● Restricted scope of navigation
● Operation of sub-system screens
● Operation of RCOS relevant screens

Maintenance Maintenance ● CMS:
possible

● Web client:
possible

● Screen changeover
● Minimum restricted scope of navigation
● Operation of sub-system screens
● Counter reset
● PLC Reference

Management Management ● CMS:
possible

● Web client:
possible

● Screen changeover
● Minimum restricted scope of navigation
● Operation of sub-system screens

Administrator Administrator ● CMS:
possible

● Web client:
possible

Unrestricted rights:
● Screen changeover
● Unrestricted scope of navigation
● Operation of sub-system screens
● Counter reset
● Make basic settings
● Terminating the WinCC Runtime

When a user logs on in the CMS example application, an internal authorization tag is initially set 
to "1". This tag controls whether the user can see user-specific elements in the user interface.

On the WinCC start page, standard WinCC functions are used to log on.
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8.7.1 Changing passwords

Initial situation / objective
Passwords can be changed in the WinCC Editor "User Administrator" 

Note

Ensure that the passwords are only known to the intended users! 

If in doubt, for example after commissioning, change the passwords so that you do not put 
network security at risk.

Processing steps
1. Open the WinCC User Administrator.

2. You can change the password in the toolbar under "User" → "Change password".

8.7.2 Automatic user log-off

Initial situation
An automatic log-off function is available in the CMS example application, but is not activated.

Automatic user log-off is a standard function of WinCC. A global action in the CMS example 
application ensures that 

● The corresponding internal user tag is reset to "0".

● The standard user is logged on.

● Navigation is reset to the initial situation.

Processing steps
1. Open the WinCC User Administrator.

2. Select the user for whom you want to set up automatic log-off on the left.
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3. Under "Automatic logout" in the field "after" … "minutes", enter the number of minutes after 
which the user is to be logged off.

Figure 8-29 WinCC User Administrator

4. Select whether the log-off is to be performed after "absolute time" or after "idle time".

Result
After a certain time interval, a user whom you have defined is automatically logged off. This 
allows you to avoid situations where unauthorized persons have access to particular functions 
when the logged-on user forgets to log off.
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8.8 Languages

8.8.1 General information about language management in CMS
There are three different sources for language-dependent texts in SIMOCRANE CMS:

● The WinCC configuring language 
This is the source of the texts displayed in the WinCC Explorer.

● The SIMOCRANE CMS language 
This is the source of CMS Editor texts and specific texts in the SIMOCRANE CMS Runtime 
application. It also includes ActiveX Controls texts.

● The WinCC Runtime language  
This is the source of texts displayed from the WinCC Runtime application.

The SIMOCRANE CMS application retrieves its texts from the WinCC Runtime language and 
the SIMOCRANE CMS language.

If the WinCC Runtime language is switched over, then the language for the ActiveX Controls of 
CMS is also switched over. In this case, the SIMOCRANE CMS language must be defined and 
translated. 

Unlike the texts for the WinCC Runtime language, SIMOCRANE CMS language texts are not 
stored in the text library, but in a separate CMS database.

Maintenance instructions and references in the CMS editor can only be displayed in one 
language. This language must be defined during configuration.
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The example applications are supplied in English and German as standard.  

Please first check whether the language you need can be displayed by WinCC.

You can find instructions for defining the runtime language for your project here: Settings in 
WinCC (Page 100)

See also
Button for changing the runtime language of the CMS application (Page 267)

Setting the WinCC configuring language (Page 268)

Adding and translating the WinCC Runtime language (Page 268)

Adding and translating the SIMOCRANE CMS language (Page 271)

8.8.2 Button for changing the runtime language of the CMS application
To be able to switch over the runtime language in the CMS application, create a button for 
changing the language, e.g. in the "CMSHome.pdl" screen.

This button must activate the following VB script for a mouse click event.

' WINCC:TAGNAME_SECTION_START 
' Const TagNameInAction = "TagName" 
Const tagLanguage = "@NOTP::@CMSStatusLanguage" 
' WINCC:TAGNAME_SECTION_END 
Dim lngLanguage  lngLanguage = 1033 '1033 = English (USA) 
HMIRuntime.Language = lngLanguage 'set Runtime language  
hmiruntime.Tags(tagLanguage).write lngLanguage 'store value to tag

Note

The number "1033" is the LCID code for English (USA) and may need to be replaced by the 
appropriate LCID code of the alternative language. LCID (Local ID) is the numerical code 
defined by Microsoft for national languages. 

You can find a list of LCID codes under keyword "LCID" in the WinCC Online Help.

See also
General information about language management in CMS (Page 266)

Adding and translating the SIMOCRANE CMS language (Page 271)

Adding and translating the WinCC Runtime language (Page 268)
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8.8.3 Setting the WinCC configuring language
The configuring language defines the language of the WinCC Explorer. 

Languages are installed at the same time as WinCC. 

SIMOCRANE CMS is available in English and German as standard. New languages can be 
added at any time.

Note

The configuration language can only be changed if the required language was installed while 
WinCC was being installed.

1. To change the language, select "Tools" → "Languages" in the WinCC Explorer and then 
choose a different language.

WinCC Explorer will then be displayed in the language you have chosen.

See also
General information about language management in CMS (Page 266)

Adding and translating the WinCC Runtime language (Page 268)

Adding and translating the SIMOCRANE CMS language (Page 271)

8.8.4 Adding and translating the WinCC Runtime language

8.8.4.1 Adding the WinCC Runtime language

Initial situation
The WinCC Runtime language defines the language of the WinCC Runtime elements. These 
include, for example, message texts, tooltips or texts that are configured in the Graphics 
Designer.

Note

Texts specific to SIMOCRANE CMS are not included with the WinCC Runtime language.

To ensure that all elements of your project can be displayed in the target language, you must 
also add / change the SIMOCRANE CMS language.

See: Adding and translating the SIMOCRANE CMS language (Page 271)

In order to add a new WinCC Runtime language, you must add a new language in the WinCC 
Text Library. 
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Sequence of steps
1. Open the "Text Library" in "WinCC Explorer".

2. Select "Language" → "Add/Remove" in the "Text Library" in order to open the "Add/Remove 
Languages" dialog.

3. Add a language in the "Add/Remove Languages" dialog.

4. Choose the WinCC Runtime language to be preassigned to texts in the new WinCC 
Runtime language in the box "Preassign texts for new languages with".
The language you choose must already be a WinCC Runtime language. We recommend 
that you assign texts in English to the texts.

5. Click "OK" to create the new WinCC Runtime language.

Result
The new WinCC Runtime language has now been created. 

You now need to translate the texts of the new WinCC Runtime language. 

See: Translating the texts of the WinCC Runtime language (Page 269) 

See also
General information about language management in CMS (Page 266)

8.8.4.2 Translating the texts of the WinCC Runtime language

Initial situation
You can export texts of the WinCC Runtime language using the WinCC Text Distributor and 
then translate the WinCC Runtime language. You then reimport the translated WinCC Runtime 
language. 

Configuring the CMS application
8.8 Languages

Crane Management System (CMS)
System Manual, 11/2019 269



You can also edit the alarm/event system texts directly in the WinCC Text Library.

Note

Texts specific to SIMOCRANE CMS are not included with the WinCC Runtime language. To 
ensure that all elements of your project can be displayed in the target language, you must also 
add and translate the SIMOCRANE CMS language.

See: Adding and translating the SIMOCRANE CMS language (Page 271)

Sequence of steps
1. Start the WinCC Text Distributor and select all the elements to be exported.

Note

If you do not export all the elements, you may have problems when you try to import them 
again!

2. Export one or more existing languages in the txt or csv format. 
Depending on the size of the project it may take several minutes to export the language 
texts.

3. Open the export file in MS Excel using "File" → "Open".

4. Select the exported csv file under "File name" and text files (*.prn, *.txt, *.csv) under "File 
format". In this way you can ensure that MS Excel correctly interprets the dividers in the file.

5. Make sure that the file format is retained during translation.

6. Once translated, save the file in csv format.

7. Import the edited file using the WinCC Text Distributor. 
Again here you can choose which language you want to import.
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Result
The translated texts of the WinCC Runtime language are now available.

See also
General information about language management in CMS (Page 266)

8.8.5 Adding and translating the SIMOCRANE CMS language

8.8.5.1 Adding the SIMOCRANE CMS language

Initial situation
The SIMOCRANE CMS language defines the language of the CMS editor texts and specific 
texts of the SIMOCRANE CMS Runtime application. It also includes ActiveX Controls texts.

Note

To ensure that all elements of your project can be displayed in the target language, you must 
also add / change the WinCC Runtime language. 

See: Adding and translating the WinCC Runtime language (Page 268)

Create a new SIMOCRANE CMS language in the CMS editor.

Texts in the standard language are preassigned to the new language.
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Sequence of steps
1. Open the "Basic settings" dialog.

"System" → "Basic settings" → "Languages"

2. From the list of languages, select the SIMOCRANE CMS language to be assigned to texts 
in the new SIMOCRANE CMS language, and activate the "Standard language" checkbox. 

3. Click on the button "New" to create a new language. 

4. Enter the following settings:
"Country/Region" box: 
Enter the name of the new language in this box.

Note

You can find a list of LCID codes and the matching abbreviation under keyword "LCID" in the 
WinCC documentation.

"Short Sign" box: 
Enter the associated language code for the new language here. The language code must 
match the LCID code.
"LCID" box: 
Enter the correct Local ID for the new language. This is the numerical code defined by 
Microsoft for national languages. 
"Tab Order" box: 
Here, define in which sequence the tabs are to be displayed on the screen forms 
"Installation" → "Language" and "Installation" → "User texts".
Enter a number between 0 and 255.

5. Click "OK" to create the new SIMOCRANE CMS language.

Result
You can now translate the texts.
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See: Translating the SIMOCRANE CMS language (Page 273)

See also
General information about language management in CMS (Page 266)

8.8.5.2 Translating the SIMOCRANE CMS language

Initial situation
The SIMOCRANE CMS language to be translated has already been created.  
See: Adding the SIMOCRANE CMS language (Page 271)

When creating the new SIMOCRANE CMS language, the SIMOCRANE CMS language was 
already preassigned with the entries of the SIMOCRANE CMS standard (default) language. 
You can now translate the new SIMOCRANE CMS language.

The SIMOCRANE CMS language is managed on the "Languages" and "User texts" screen 
forms. The "Languages" screen form manages those texts that are also used in the CMS Editor. 
The "User texts" screen form only manages those texts that are used in the application itself.

Figure 8-30 SIMOCRANE CMS language
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Translating texts in the screen "Languages"
You translate CMS editor texts and specific texts of the SIMOCRANE CMS Runtime application 
in the screen "Languages".

1. Open the "Languages" dialog.
"Installation" → "Languages"

Figure 8-31 Acquisition of language-specific texts - "Languages" screen

2. Select the tab for the language that you wish to translate.

3. Select an entry from the list and translate it. 

4. Perform this operation for all entries from the list.

Configuring the CMS application
8.8 Languages

Crane Management System (CMS)
274 System Manual, 11/2019



Translating texts in the screen "Usertexts"
1. Open the "Usertexts" dialog.

"Installation" → "Usertexts"

Figure 8-32 Acquisition of language-specific texts - "Usertexts" screen

2. Select the tab for the language that you wish to translate.

3. Select an entry from the list and translate it.

4. Perform this operation for all entries from the list.

Result
The new SIMOCRANE CMS language has now been translated to the target language.

See also
General information about language management in CMS (Page 266)

Installation: Languages (Page 210)
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8.9 Integrating web-based documentation

Initial situation / objective
The CMS example application provides an example of web-based documentation in the 
"Documentation" menu. This only contains a few sample documents. You can integrate any 
number of your own pieces of documentation. Note the following information.

Processing steps
1. Produce web-based documentation, and name the start page "index.htm".

2. Open the folder for the web-based documentation in the "…\CMS\CMS_Documentation" 
project directory.

3. Delete the entire contents of the "CMS_Documentation" folder.

4. Copy your web-based documentation into the "CMS_Documentation" folder

5. Ensure that the "index.htm" start page is in the folder.

6. Check the accessing of documentation in the CMS example application, "Documentation" 
menu.

Result
The web-based documentation that you have produced is displayed in the CMS example 
application.
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8.10 Bulk data configuration in WinCC
You can use the Configuration Tool to create a totally new WinCC project using MS Excel or to 
edit the data of an existing project. All the tools available in MS Excel can be used to edit the 
data. For example, the Configuration Tool provides drop-down list fields, a function for 
automatically completing data, and input instructions during configuration. The Configuration 
Tool is particularly useful when editing the tag management or Text Library.

If the Configuration Tool is installed, you can use the toolbar in Excel to produce special folders, 
known as WinCC project folders.

Figure 8-33 WinCC Configuration Tool add-in in MS Excel

You can find information on operating and using the Configuration Tool in the WinCC 
documentation.

Figure 8-34 WinCC Configuration Tool
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8.11 Performance Monitor configuration
In the CMS example application, the Performance Monitor acquires the following basic data 
from the CMS station tag management:

● Operating states of all connected cranes

● Counter values of the connected cranes

All operating states and counter values are read from the WinCC tags that are directly 
connected to the process.

The Performance Monitor project data are automatically also copied when the WinCC project 
is copied. The following provides a short overview of the configured operands and KPIs in the 
Performance Monitor Configuration Studio.

Note

For a better understanding of this chapter, first read the Performance Monitor documentation, 
which is also installed, and the Getting Started document, which is available on the product 
support pages of Siemens. This recommendation also applies in respect of possible changes 
to the configuration of the Performance Monitor.

Note
License for 30 operands

The SIMOCRANE CMS product package for the CMS station contains a license for up to 30 
operands. If more operands are required to analyze your crane, you require an upgrade 
license, which you must order separately.

The Performance Monitor works with operands and KPIs, which can be calculated from the 
operands. The object model is used for this. This means that all necessary operands and KPIs 
first have to be created without defining the process connection directly, too. You can then 
generate an instance from the created KPI, in which you then configure the connection with the 
process tags. In this way, you can generate multiple instances from one created KPI, which are 
then supplied with values via different tags.

8.11.1 Evaluation of the crane status
The crane status is displayed by the variable "wrdCraneStatus" in the WinCC tag management. 
In the example application, the values of the tags have the following meanings:

4 OK
2 Idle
32 Warning
128 Fault
0 Offline

First create a structured operand to map this value assignment in the Performance Monitor. If 
additional statuses are configured in the control or the values of the tags "wrdCraneStatus" 
have other meanings, you must adapt the structure operand accordingly.
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Figure 8-35 Configuration of the crane status: Creating a structured operand

Then create from this definition an operand with the name "CraneStatus" whose evaluation 
type is the previously created structured operand.
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Figure 8-36 Configuration of the crane status: Creating an operand

For the percentage evaluation of the duration of the different operating status, with reference 
to the total period under consideration, the following KPIs are also considered.

OK (CraneStatus.Ok.Time/(CraneStatus.Ok.Time+CraneStatus.Idle.Time
+CraneStatus.Warning.Time+CraneStatus.Fault.Time+CraneStatus.Off‐
line.Time))*100

Idle (CraneStatus.Idle.Time/(CraneStatus.Ok.Time+CraneStatus.Idle.Time
+CraneStatus.Warning.Time+CraneStatus.Fault.Time+CraneStatus.Off‐
line.Time))*100

Warning (CraneStatus.Warning.Time/(CraneStatus.Ok.Time+CraneSta‐
tus.Idle.Time+CraneStatus.Warning.Time+CraneStatus.Fault.Time+Cra‐
neStatus.Offline.Time))*100 

Fault (CraneStatus.Fault.Time/(CraneStatus.Ok.Time+CraneStatus.Idle.Time
+CraneStatus.Warning.Time+CraneStatus.Fault.Time+CraneStatus.Off‐
line.Time))*100

Offline (CraneStatus.Offline.Time/(CraneStatus.Ok.Time+CraneStatus.Idle.Time
+CraneStatus.Warning.Time+CraneStatus.Fault.Time+CraneStatus.Off‐
line.Time))*100
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Figure 8-37 Configuration of the crane status: Creating key performance indicators

Now define an item of equipment. In this example, this is "STSCrane1" in the group 
"STSCrane." The equipment is automatically also created in the area of the instances.
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Figure 8-38 Configuration of the crane status: Defining the equipment

Now drag the KPIs under "Instances"  → "STSCrane" → "STSCrane1" → "Key Performance 
Indicators" out of the "Details view" (left) into the list (right). In this way, you create an instance 
of the KPI. The result is illustrated in the diagram below. 
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Figure 8-39 Configuration of the crane status: New KPI instance

Then connect the operands required for calculation of the KPI instances under "Instances" → 
"STSCrane" → "STSCrane1" → "Key Performance Indicators" → "Operands" to the process. The 
data source is "wrdCraneStatus" in this case.

Figure 8-40 Configuration of the crane status: New instance

After storage of the configuration, the crane status can be displayed in runtime with the WinCC 
PerformanceGanttControl. You can also display the percentage evaluation of the duration of 
the individual operating states with the WinCC PerformanceViewControl.

8.11.2 Counters 
For the counters calculated in the control, operands, KPIs, and the corresponding instance 
must also have been created. Because the counters are already calculated in the control, you 
must create the counters as external counters. Creation of a counter in the Performance 
Monitor Configuration Studio using the counter for the energy consumed is shown below by 
way of example. All other counters must be created in an analogous way.

Requirements:

● The equipment has been created as described in Chapter Evaluation of the crane status 
(Page 278).

Procedure:

First create an operand with the evaluation type "Number" for the counter.
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Figure 8-41 Configuration of a counter: Creating an operand

Then create a KPI. Because the counter is already calculated in the control, the operand only 
has to be multiplied by one to take over the value unchanged from the control.
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Figure 8-42 Configuration of a counter: Creating a KPI

To ensure that the counter is acquired for the crane, generate from the created KPI under 
"Instances -> STSCrane -> STSCrane1 -> Key Performance Indicators" and instance in the 
corresponding equipment. To this by dragging the KPI out of the detailed view (left) into the list 
of the KPI instances (right). The result is shown in the following screenshot.

Figure 8-43 Configuration of a counter: Generating a new KPI instance

Define under "Instances -> STSCrane -> STSCrane1 -> Key Performance Indicators -> 
Operands" the process connection and the type of the counter. Select external counting as the 
"Type of calculation."
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Figure 8-44 Configuration of a counter: Process connection and counter type of the new instance

After storage of the configuration, the counter can be displayed in runtime, for example, with the 
WinCC PerformanceViewControl.
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Remote access 9
9.1 General information about remote access to CMS stations

With remote access, the screens of the CMS station can be viewed via a remote PC in the 
network. Typical examples of remote PCs include touch operator panels in the operator's cabin 
or in the checker cabin or a service PC in a maintenance building.

The precondition for remote access is a TCP/IP connection between the CMS station and the 
remote PC.

Remote access can be implemented using two different methods:

● WinCC WebNavigator
The WinCC WebNavigator server runs on the CMS station. The WinCC WebNavigator 
client runs on the remote PC.
For remote access via the WebNavigator, the WinCC WebNavigator server must be 
installed on the CMS stations. You also require a WebNavigator license on the CMS station. 
The WinCC WebNavigator client and the SIMOCRANE CMS client must be installed on the 
remote PC. 
The accessed CMS station is displayed by the program "WinCCViewerRT" or via a web 
browser. 

● WinCC WebUX
The WinCC WebUX server runs on the CMS station. 
An HTML5 web browser is required on the remote PC. 
You also require a WebUX license on the CMS station. 

You have the same operating options as at the CMS Station:

● Navigating through the screens 
This navigation does not influence the screen displayed at the CMS station. 

● Activating or deactivating functions

● Exporting data from the CMS station

● With various tools, CMS station data can be analyzed and locally saved.

● Starting and exiting Replay mode (WebNavigator only!)

In case of a fault, diagnostic information can be called up beforehand. In the best case scenario, 
a fault can be resolved in this way. 

This configuration is especially suitable for simple solutions for cranes in industrial applications.
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Figure 9-1 Remote access to CMS stations (left: WinCC WebNavigator; right: WinCC WebUX)

Note

Carefully observe the installation notes provided in the system manual for WinCC 
WebNavigator for commissioning and for important security notes.

See: WinCC WebNavigator system manual (https://support.industry.siemens.com/cs/
document/109746337/wincc-basic-options-v7-4-sp1%3A-webnavigator-datamonitor-webux-
connectivity-pack?dti=0&lc=de-WW
// XmlEditor.InternalXmlClipboard:6dee0b4b-053f-882a-ed66-a9c49964538d)

Note
Use an HTTPS connection

For network security reasons, we urgently recommend that it is only possible to establish 
remote access via a secure HTTPS connection in the case of remote access via WinCC 
WebNavigator.

A secure HTTPS connection is essential for remote access via WinCC WebUX.

See: Setting up the SSL certificate for remote access (Page 299)

See also
Remote access via web browser (WebNavigator) (Page 294)

Setting up remote access (WebNavigator) (Page 289)

Remote access via WinCCViewerRT (Page 292)
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9.2 WebNavigator

9.2.1 Setting up remote access (WebNavigator)

Initial situation / objective
The WinCC WebNavigator server runs on the CMS station for remote access via the WinCC 
WebNavigator. The WinCC WebNavigator client runs on the remote PC.

See also: General information about remote access to CMS stations (Page 287)

Installing the WinCC WebNavigator server (CMS station)
1. Establish a LAN connection between the local CMS station and the remote PC.

2. Start the WinCC Explorer and open the project for which you want to configure remote 
access.

3. Choose "WebConfigurator" from the shortcut menu of the WebNavigator. 

Figure 9-2 Configuring the WebNavigator server

4. Configure the WinCC WebNavigator server on the local CMS station.

Note
Restart required

To complete configuration, you must restart the system.
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5. Launch the "Web-View Publisher" in WinCC Explorer and follow the instructions on the 
screen.

Figure 9-3 WinCC WebNavigator: Web View Publisher

6. Create the users who will have access to the WinCC WebNavigator in your CMS project.

7. Activate access to the WinCC WebNavigator for these users under "User Administration" in 
the WinCC Explorer.
Define the start picture.

Note

If you want to use an alternative start screen for users in the WinCC WebNavigator, you 
must define this start screen in the WinCC user administrator under "Start Picture".

Figure 9-4 WinCC User Administrator
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If you are using functions in WinCC screens that are not executable in the WinCC 
WebNavigator, you will need to prevent them from running in WinCC using preprocessor 
instructions for C scripts. The same applies to displaying objects which trigger these functions. 
The following preprocessor instructions can be used:

Table 9-1 Preprocessor applications for C scripts in WinCC

Variant Notation
1 #ifdef RUN_ON_WEBNAVIGATOR

<< instructions, which run on the WebNavigator >>
#else
<< instructions, which do not run on the WebNavigator >>
#endif

2 #ifndef RUN_ON_WEBNAVIGATOR
<< instructions, which do not run on the WebNavigator >>
#else
<< instructions, which run on the WebNavigator >>
#endif

Installing the WinCC WebNavigator client (remote PC)
1. Install the WinCC WebNavigator client and SIMOCRANE CMS client on the remote PC.

Enabling the firewall port
The WinCC WebNavigator server requires an open port on the CMS station for remote access.  

Port "443" is set as default by IIS. 

1. Enable the port for the WinCC WebNavigator server.

This setting can be configured in IIS. 
See: Setting up the SSL certificate for remote access (Page 299)

Result
The WinCC WebNavigator server is configured for access by the WebNavigator client.  The 
WinCC WebNavigator client is set up on the remote PC. 

You must now create an SSL certificate in order to facilitate secure access via HTTPS.
See: Setting up the SSL certificate for remote access (Page 299)

To test, you can start the WinCC WebNavigator client on the remote PC.
See: Remote access via WinCCViewerRT (Page 292)
See: Remote access via web browser (WebNavigator) (Page 294)

For details of how to configure the remote PC for the WinCC WebNavigator Client, see Section 
PC configuration of the web client station (Page 406).
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9.2.2 Remote access via WinCCViewerRT
You can open the WinCCViewerRT on a remote PC and have read access to the user 
interfaces of the connected CMS stations without affecting local operation at the CMS station. 

On the remote PC, the WinCC option "WebNavigator Client", and the "SIMOCRANE CMS 
Client" must be installed. 

NOTICE

Danger of blocking Replay mode!

If you close remote access while Replay mode is active, Replay mode will remain blocked for 
all other users. The blockage remains effective until you log on again and end Replay mode.

It is essential that you end Replay mode before you close remote access.

See also: General information about remote access to CMS stations (Page 287)

Preconditions
● Remote access to CMS stations has been set up.

See: Setting up remote access (WebNavigator) (Page 289)

● The SSL certificate for remote access has been created
See: Setting up the SSL certificate for remote access (Page 299)

● The WinCC WebNavigator client suitable for the CMS station has been installed. 

● The SIMOCRANE CMS client suitable for the CMS station has been installed.
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Processing steps
1. Open the WinCCViewerRT on the remote PC.

The WinCCViewerRT properties are opened when establishing the connection for the first 
time.

Figure 9-5 WinCCViewerRT properties

Note

You can call the WinCCViewerRT properties using the key combination "Ctrl + Alt + P".
Additional information is provided in the WinCC WebNavigator documentation.

2. Enter the IP address of the CMS station to which you want to have read access in the login 
dialog box.
Enter the user name and the password.

You will be given read access to the required CMS station. You can now navigate through the 
images on the CMS station.
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9.2.3 Remote access via web browser (WebNavigator)
You can open a web browser on a remote PC and have read access via the WinCC 
WebNavigator to the user interfaces of the connected CMS stations without influencing local 
operation at the CMS station. 

Note

We recommend using the WinCCViewerRT for remote access.

See also: Remote access via WinCCViewerRT (Page 292)

NOTICE

Danger of blocking Replay mode!

If you close remote access while Replay mode is active, Replay mode will remain blocked for 
all other users. The blockage remains effective until you log on again and end Replay mode.

It is essential that you end Replay mode before you close remote access.

See also: General information about remote access to CMS stations (Page 287)

Preconditions
● Remote access to CMS stations has been set up.

See: Setting up remote access (WebNavigator) (Page 289)

● The SSL certificate for remote access has been created
See: Setting up the SSL certificate for remote access (Page 299)

● The WinCC WebNavigator client suitable for the CMS station has been installed. 

● The SIMOCRANE CMS client suitable for the CMS station has been installed.
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Processing steps
1. Open Internet Explorer on the remote PC and enter 

<<IP address of local CMS station>>/WebClient.asp 
in the address bar.

Figure 9-6 Opening the WebNavigator client on a remote PC

If any problems arise with ActiveX controls, consider the following FAQs: What does the 
message "You must enable ActiveX Controls on your browser" mean? (https://
support.industry.siemens.com/cs/document/8957877=en-WW)

2. Enter an existing user name and the corresponding password in the login dialog box.

You will be given read access to the required CMS station. You can now navigate through the 
images on the CMS station.
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9.3 WebUX

9.3.1 Setting up remote access (WebUX)

Initial situation / objective
The WinCC WebUX server runs on the CMS station for remote access via WinCC WebUX. An 
HTML5-capable web browser is required on the remote PC.

See also: General information about remote access to CMS stations (Page 287)

WebUX client (terminal device)
You only need one HTML5-capable web browser, e.g. Chrome, Firefox, Internet Explorer or 
Safari, on a terminal device which accesses the WebUX server.

Note
Browser-dependent display

Differences in display and behavior are possible with different browser versions.

To display a configured character set, for example, it must also be available in the browser or 
on the device.

Installing the WebUX server
You can also install WinCC/WebUX during the WinCC installation.

Proceed as follows to install the WebUX server retrospectively:

1. Start the WinCC installation DVD.

2. Select "Custom Installation" as the "Installation Type".

3. Select the "WinCC WebUX" entry in the "WinCC" group of the "Programs" dialog box.

4. Transfer the WebUX licenses. 
See also:Transferring a license (Automation License Manager) (Page 93)

The WinCC WebUX Configurator opens after the installation and a PC restart.

You can find information about configuring WebUX here: WinCC Basic Options V7.4 SP1: 
WebNavigator, DataMonitor, WebUX, Connectivity Pack (https://
support.industry.siemens.com/cs/ww/en/view/109746337)

Enabling the firewall port
The WinCC WebUX server requires an open port on the CMS station for remote access.  

Port "443" is set as default by IIS. 

1. Enable the port for the WinCC WebUX server.
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This setting can be configured in IIS. 
See: Setting up the SSL certificate for remote access (Page 299)

Result
The WinCC WebUX server is configured for access via an HTML5-capable web browser. 

You must now create an SSL certificate in order to facilitate secure access via HTTPS.
See: Setting up the SSL certificate for remote access (Page 299)

See also
Transferring a license (Automation License Manager) (Page 93)

9.3.2 Remote access via web browser (WebUX)
You can open a web browser on a remote PC and have read access via WinCC WebUX to the 
user interfaces of the connected CMS stations without influencing local operation at the CMS 
station. 

Figure 9-7 Remote access via WebUX

Note
No Replay mode!

Replay mode is not possible via WinCC WebUX.

You need the WebNavigator in order to be able to start Replay mode via remote access.
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Note the following:

● Close the session before you exit the browser to free up an assigned license.

● Close the browser, especially in the case of mobile devices, to reduce power consumption 
and the amount of data that is transferred.
If a process screen is open in the browser, the display will be updated continuously.

● Avoid the following operations, as the session will otherwise be terminated:

– Browser navigation (Back / Forward)

– Reloading web page (Refresh or <F5>)

Preconditions
● Remote access to CMS stations via WebUX has been set up.

See: Setting up remote access (WebUX) (Page 296)

● The SSL certificate for remote access has been created
See: Setting up the SSL certificate for remote access (Page 299)

● An HTML5 web browser is in use

Processing steps
1. Enter the address of the WebUX server in the address line of the browser:

– https://<servername>

If you are not using the default port, add the port number in the URL:

– https://<servername>:<portnumber>

If you are using a virtual folder instead of a website, add the name of the virtual web folder:

– https://<servername>/<directoryname>

2. Enter the user name and password.

You will be given read access to the required CMS station. You can now navigate through the 
images on the CMS station.
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9.4 Setting up the SSL certificate for remote access
The CMS station is remotely accessed via a secure HTTPS connection. 
To do this, an SSL certificate must be created on the CMS station.

Preconditions
● The CMS station is prepared for remote access. 

See also: Setting up remote access (WebNavigator) (Page 289)

Processing steps
1. Start the "Microsoft Internet Information Services (IIS) Manager" on the CMS server.

2. Select "Server Certificates"

Figure 9-8 Deleting the IIS SSL certificate
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3. Select "Create Self-Signed Certificate..." and create a new SSL certificate with the name 
"WebNavigator".

Figure 9-9 Server Certificates

A default SSL certificate is created.

4. Select "Sites" → "WebNavigator" and then select "Bindings".

Figure 9-10 WebNavigator Home
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5. Select "Add..." and then select connection type "https", the port and the newly created SSL 
certificate.

Figure 9-11 Add Site Bindings

Note

Port 443 is the default port – however, you can select any other free port.

The port must be enabled in the firewall of the CMS station, otherwise the WebNavigator will 
not be able to run.

6. Click on "OK" to assign the SSL certificate to the WebNavigator and to select the connection 
type involved.

Figure 9-12 Site Bindings

7. Delete connection type "http" to prevent remote access via a non-secure HTTP connection.

You can now access the WebNavigator of the CMS station via HTTPS.

Note

When configuring the crane in the "Edit crane" dialog box of the RCMS web application, the 
URL in field "CMS station URL" must match the specified URL in the SSL certificate of the CMS 
station! 

If problems occur with the SSL certificate, check that the two URLs precisely match.
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The Replay function 10
10.1 General information about the Replay function

10.1.1 About the Replay function
With the Replay function, SIMOCRANE CMS can replay data from the past. The crane data are 
stored unchanged in the WinCC archive and can be replayed in Replay mode if necessary. 

In Replay mode, you can:

● replay the crane data or the archived data any number of times, 

● choose the period to replay, 

● control the replay speed, 

● pause replay. 

This enables you to reproduce crane events that caused problems and reduce their causes.

For detailed analysis of problematic processes on the crane, you still have to evaluate the crane 
data.

The Replay function can only be used on the CMS station. The Replay function is not installed 
on an RCMS server.

The use of all other CMS functionalities is not restricted by the Replay function.

Replay Configuration Editor and Replay Runtime
The Replay function comprises two components:

● Replay Configuration Editor (see Section The Replay Configuration Editor (Page 315)): 
With the Replay Configuration Editor, you can prepare, check, and repair pictures from a 
WinCC application for Replay.

● Replay Runtime (see Section Replay Runtime (Page 327)): 
Replay Runtime is responsible for preparing and replaying historical Replay data.

Before you can use Replay Runtime, the following conditions must be met:

● WinCC Runtime has been activated. 

● CMS Runtime has been activated. 

● Replay Runtime has been activated. 

● Crane data has been archived for the period to be replayed with Replay.
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Note
Valid license required

The Replay function can only be used with a valid license

10.1.2 General information about configuring the Replay function
The Replay Configuration Editor is available for adapting the Replay function to your 
requirements and to the particular features of your crane.

The following figure provides a general view of how Replay is configured:

Figure 10-1 Overview: Replay configuration

Note

Do not make any changes to the configuration files and descriptor files in folder "CMS\Replay" 
of the WinCC project directory otherwise Replay will not function correctly.

With the Replay Configuration Editor, you can make the following settings required for Replay: 

● Specify the maximum number of archive tags 

● Select the pictures to be prepared for Replay 
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● Check one/all pictures prepared for Replay 

● Repair pictures prepared for Replay 

● Clean up tags that are no longer needed 

● Deselect pictures

See: "The Replay Configuration Editor (Page 315)"

You may need to modify the application in various ways for Replay.

● Adapt navigation buttons for Replay 

● Create a button for activating/deactivating Replay mode 

● Un-nest picture windows 

● Insert controls in a Replay picture 

● Adapt and trigger C and VB scripts for Replay

See: "Adapt the CMS application for the Replay function (Page 332)"

10.1.3 Restrictions
The following restrictions apply to the Replay function:

● Not all object types are supported by Replay. 
See: "Picture objects supported by Replay (Page 364)"

● The maximum duration for replaying with Replay is limited to 60 minutes. 

● The inner pictures of a main picture are supported up to the 1st level.  
Nested inner pictures are not processed while the main picture is being prepared. 
The same inner pictures can be processed several times side by side in different picture 
windows in the main picture.

● The maximum number of pictures whose historical data can be loaded and retained at any 
one time for Replay is limited to 20.

● WinCC Graphics Designer and the Replay Editor cannot be used concurrently. The Replay 
Editor might then not work correctly. In this case, an error message will appear on the 
screen.

● Events are not supported (e.g. a script that is run when a button is clicked). 

● The resolution of Replay Runtime is limited to 500 ms. 

● The archiving period is limited depending on how the cyclic archive has been configured. 

● The maximum number of archive tags depends on your WinCC license.
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10.1.4 Required tags, structures, and archives

Tags and structures 
The Replay function requires the following tags and structures: 

● ReplayControl structure 

● Tags of the "ReplayControl" group with ReplayControl structure tags 

● Tags of the "Screens" group that are relevant for Replay 

● Tags of the "Settings" group that are relevant for Replay 

● Tags of the ReplayTags group 

Moreover, the following structures and tags are created automatically:

● Structure ReplayControl

● @ReplayControl instance of the ReplayControl structure

● Picture selector tags

Archives
The following archives are required in the TagLogging database of WinCC:

● ReplayArchive 

The Replay Configuration Editor automatically creates the Replay archive tags for the Replay 
function when it prepares pictures. 

For each picture, a descriptor file is created (picture name e.g. "Hoist.pdl"; name of the 
descriptor file: "Hoist.xml"). 

All tag-related information is stored in the descriptor file. 

The ReplayArchive is automatically created in the TagLogging of WinCC as soon as the first 
picture is prepared for Replay. It contains the ReplayArchive tags required to query historical 
data from the database in order to replay the picture in Replay mode. 

See also
The tag prefix mechanism (Page 309)

10.1.5 Requirements for the pictures
All pictures are made available with the file extension "*.pdl" for preparation in the Replay 
Configuration Editor. 

Note

All pictures listed in the Replay Configuration Editor that start with the string "@..." are pictures 
used, for example, for navigation within the WinCC project or in which settings for the 
visualization interface can be made. These pictures are irrelevant to user-specific configuration 
of Replay.
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Main pictures and inner pictures
A main picture can contain picture windows. The images displayed in these windows are 
referred to as “inner pictures".  

The Replay Configuration Editor can process main pictures with one or more inner pictures. 

Note

You need to adapt the main picture accordingly for inner pictures with dynamic picture names. 

See: "Working with dynamic picture windows (Page 338)"

Nested inner pictures
Inner pictures must not contain further inner pictures because these are not prepared for 
Replay mode. If a main picture is prepared with an impermissible structure, a warning is output.

Figure 10-2 Main picture with nested inner pictures

Multiple copies of an inner picture
Multiple copies of an inner picture can be inserted in the same main picture. To ensure that 
inner pictures are nevertheless correctly addressed, tag prefixes are used. In the tag list of the 
Replay Editor, the names of the tags are displayed in the inner pictures as soon as preparation 
of the main picture for Replay has been completed.
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Links to pictures that are not integrated in a main picture
If a button is linked to a picture that is included in the main picture, the Replay Configuration 
Editor cannot separate the link. 

Figure 10-3 Button in picture.pdl linked to detail_picture.pdl

For instructions on how to adapt these buttons, please see: "Adapt buttons in Replay pictures 
(Page 336)"

10.1.6 Maximum number of archive tags
A different number of archive tags will be available to you depending on your WinCC license. 
512 archive tags (with CMS Lean) or 1500 archive tags (with CMS Advanced) are supplied as 
standard. For higher requirements, other WinCC licenses with a greater number of archive tags 
can be provided as a license upgrade.  

You must enter this maximum number of archive tags in the Replay Configuration Editor in the 
input field of the "Maximum number of archive tags" menu. This enables the Replay 
Configuration Editor to output a warning when the maximum number of archive tags has been 
reached. 

The number of archive tags that can be used for the Replay function is determined by the 
number of available archive tags (depends on the license), minus the archive tags already in 
use. 

Note

The Replay function reserves archive tags for archiving operational data (move data, counters, 
MMBFs). These cannot be used for the Replay function.

See also
Replay pictures: Cleaning up tags (Page 325)

Specify the maximum number of archive tags (Page 319)

The Replay function
10.1 General information about the Replay function

Crane Management System (CMS)
308 System Manual, 11/2019



10.1.7 The tag prefix mechanism
The objects inside a picture can be supplied from two data sources:

● in productive mode from process tags of the crane control system

● in Replay mode from Replay tags whose values originated from the ReplayArchive

The Replay tag prefix "R_"
An internal Replay tag is created for each process tag relevant for Replay and stored in an 
appropriate archive. The names of these Replay tags start with the prefix "R_". 

Figure 10-4 Archive tag name and Replay tag name in the Replay Configuration Editor

In Replay mode, the Replay tag prefix "R_" is automatically appended to the front of all tags 
relevant for Replay of the PDL files that are called.

Example

Original tag name Replay tag name Archive tag name in the ReplayArchive
myTag R_myTag myTag
innerpicPrefix.myInnerTag R_innerpicPrefix.myInnerTag innerpicPrefix.myInnerTag
innerpicPrefix2.myInnerTag R_innerpicPrefix2.myInnerTag innerpicPrefix2.myInnerTag

The Replay function
10.1 General information about the Replay function

Crane Management System (CMS)
System Manual, 11/2019 309



The tag prefix mechanism in picture windows
When you assign a tag prefix to a picture window, a tag prefix is appended to the front of each 
tag in the picture window. This ensures that a picture that is integrated in a picture window has 
access to its own tags. 

Example:  
● Productive mode:   

In a picture window, the "fltSpeedSetpoint" tag is requested on an object. The tag prefix is 
"HoistDrive1".  
Result: "HoistDrive1.fltSpeedSetpoint"

● Replay mode: 
In Replay mode, the Replay tag prefix "R_" is also added. 
Result: "R_HoistDrive1.fltSpeedSetpoint"

The prefix "@NOTP::" (no tag prefix)
Some tags must remain unchanged in Replay mode. In other words, a Replay tag prefix must 
not be assigned to them. This is prevented by appending the prefix "@NOTP::" to the front of 
these tags. 

For example, the login dialog and navigation must work independently of Replay mode. In this 
case, for example, the tag "@ReplayButtonVisibleXY," which controls visibility of navigation 
buttons, must not be used with the Replay prefix. The preceding string "@NOTP::" prevents the 
Replay prefix from being appended to the front of the tag (e.g. 
"@NOTP::@ReplayButtonVisibleXY"). 

The string "@NOTP::" can be used in all properties, events, and scripts.  

Note

"@NOTP::" must not be used in the CMS example application in the property "tag prefix" of 
picture windows or main windows. 

See: "Runtime data in Replay mode (@NOTP::) (Page 332)"
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Picture window of the example application with the tag prefix mechanism

Figure 10-5 Tag prefix mechanism is active in the picture windows marked red

The picture windows of the example application in which the tag prefix mechanism is used are 
marked red in the figure. The following picture windows contain the tag prefix for Replay mode:

● picMenue

● picDetail

● picStatusBar

If you want to change the standard picture window, see Chapter "Important note about adapting 
the CMS application (Page 332). 

See also
Adapt the CMS application for the Replay function (Page 332)
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10.1.8 The picture selector tags
For the Replay function, Replay Runtime requires the "picture selector tags" described below. 
They are automatically created when a picture is prepared or repaired in the Replay 
Configuration Editor. 

Figure 10-6 Picture selector tags

From these picture selector tags, Replay Runtime reads which tags are to be loaded into the 
Replay buffer from which pictures.

The Replay function
10.1 General information about the Replay function

Crane Management System (CMS)
312 System Manual, 11/2019



Figure 10-7 CMS standard window PictureSelectorTags

① Currently loaded main picture (via "@ReplayedDynPic1" in the buffer)

② Status bar added as standard (via "@ReplayedFixedPic1" in the buffer)

Dynamic PictureSelectorTags "@ReplayedDynPicX"
The tags with the names "@ReplayedDynPic1" to "@ReplayedDynPic10" contain the names 
of the current pictures loaded into the buffer. 

In this case, "@ReplayedDynPic1" is always the currently loaded main picture including the 
inner pictures linked to it. 
For detailed information about inner pictures in main pictures, please see: "Requirements for 
the pictures (Page 306)"

The project module "ReplayLoadPic.bmo" fills tags "@ReplayedDynPic1" to 
"@ReplayedDynPic10" with values. It is normally only the tag "@ReplayedDynPic1" that is 
filled.  

In the example application, the module is called by means of the unused picture properties 
"Background Colour" of the corresponding navigation bar. You can fill the other 
PictureSelectorTags here.

Static PictureSelectorTags "@ReplayedFixedPicX"
The "@ReplayedFixedPic1" to "@ReplayedFixedPic10" tags contain permanently defined 
pictures, which are always visible in Replay mode (e.g. status bar). These pictures are always 
loaded to the Replay buffer. 

In the CMS example application, the two tags "@ReplayedFixedPic1" and 
"@ReplayedFixedPic2" are already defined in the script "ReplayLoadPic.bmo". In this script, 
you can edit the pictures that always have to be loaded (FixedPicture1 ... FixedPicture10).
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Figure 10-8 Definition of the pictures to be loaded in the script "ReplayLoadPic.bmo"
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10.2 The Replay Configuration Editor

10.2.1 About the Replay Configuration Editor
The Replay Configuration Editor is part of the CMS Configuration Editor. 

With the Replay Configuration Editor, you can make the following settings required for Replay:

● Define the maximum number of archive tags 
see: "Maximum number of archive tags (Page 308)"

● Select and deselect the pictures to be prepared for Replay 
see: "Replay pictures: Preparing pictures (Page 320)"

● Check one/all pictures prepared for Replay 
see: "Replay pictures: Checking prepared pictures (Page 322)"

● Repair pictures prepared for Replay 
see: "Replay pictures: Repairing prepared pictures (Page 324)"

● Clean up tags that are no longer needed 
see: "Replay pictures: Cleaning up tags (Page 325)"

For further information about configuring the Replay function, see: "Adapt the CMS application 
for the Replay function (Page 332)".

The Replay Configuration Editor automatically creates the Replay archive tags for the Replay 
function when it prepares pictures.

Figure 10-9 Replay Configuration Editor
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10.2.2 Start the Replay Configuration Editor
The Replay Configuration Editor can be launched via the CMS configuration editor. 

Note

The functions in the Replay Configuration Editor are only available if WinCC Runtime is 
deactivated. If the Replay Configuration Editor is opened while WinCC Runtime is activated, a 
corresponding message will appear.

1. Deactivate WinCC Runtime.

2. Select the menu entry "Replay" in the CMS configuration editor.

The Replay Configuration Editor opens and shows all pictures in the WinCC project.

10.2.3 The user interface of the Replay Configuration Editor

Figure 10-10 User interface of the Replay Configuration Editor
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No. Description
① You can make the general settings in this area: 

● "Picture Selector Tags" 
"Read Only" list of the created picture selector tags.
These tags are automatically created when the very first picture is prepared for replay. 
See: "Internal tags (Page 356)"

● "Maximum number of archive tags"  
Notifies the Replay Configuration Editor of the maximum number of available archive tags. This number must be 
calculated by the user.
As soon as this number is reached, the Replay Configuration Editor issues a warning.
See: Specify the maximum number of archive tags (Page 319)

② In this area, you will find all Replay-specific information for the pictures.  
● "Check" button:  

Checks a prepared picture for integrity and compatibility.  
See: "Replay pictures: Checking prepared pictures (Page 322)"

● "Check All" button: 
Checks all prepared pictures for integrity and compatibility. 

● "Repair" button:  
Resolves conflicts when a picture is changed retrospectively. 
See: "Replay pictures: Repairing prepared pictures (Page 324)"

● "Clean up" button:  
Removes superfluous Replay tags and archive tags. 
See: "Replay pictures: Cleaning up tags (Page 325)"

● List of the pictures available in the WinCC project: 
Prepared: Specifies whether a picture is prepared for Replay. 
Picture name: Shows the picture name. 
Inner pictures: Shows the number of inner pictures. 
Tags: Shows the number of successfully processed tags. 
Status: Shows the status. See: "The various picture statuses (Page 319)"

③ In this area, you will find a table of the tags and archives of a picture prepared for Replay:
● "Original tag name" 

Name of the original WinCC tag 
● "Archive tag name" 

Name of the archive tag in which the historical data required for Replay are stored. 
● "Replay tag name" 

Replay Tag Name, originated from the original tag name. An object of a picture is supplied via this tag instead of 
the original tag in Replay mode. 

● "Created on":  
Creation date
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10.2.4 The report window / exporting a report
After completion of one of the following operations, the report window opens with the current 
results:

● Select a picture for Replay 

● Deselect a Replay picture 

● Check a picture prepared for Replay 

● Check all pictures prepared for Replay 

● Repair a picture prepared for Replay 

● Clean up superfluous information of all pictures prepared for Replay

Figure 10-11 Report window
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Export a report
Layout of the report window:

● Processed Pictures:  
In the case of main pictures, the picture names and in the case of inner pictures, picture 
names and tag prefixes are displayed. 

● Affected WinCC Objects:  
Name of the tags, type of tags, and action detected / processed by the Replay Configuration 
Editor (missing, created, deleted) 

● Warnings:  
Contain information about the picture affected, the object affected, or the action affected.

You can export the report as a "*.csv file". 

1. Click the "Export" button in the report window.

10.2.5 The various picture statuses
In the list of pictures in the Replay Configuration Editor, the status of each picture is shown in 
the "Status" column. The pictures can have one of the following statuses:

● N/A (grayed out): 
The status of the picture is not known. If a picture has not been prepared for Replay, it has 
this status.

● OK: 
The picture has been prepared for Replay. The picture can be used for Replay. 

● Changed (yellow background):
The picture has been changed after the last Replay preparation in the Graphics Designer

● Conflict (red background):
The assignment of tags to the picture has been changed since the last Replay preparation. 
A picture can only have this status if it has first been checked for picture changes.

10.2.6 Specify the maximum number of archive tags
In the Replay Configuration Editor, you must enter the maximum number of archive tags that 
are provided to you by your WinCC license.
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This enables the Replay Configuration Editor to output a warning when the maximum number 
of archive tags is reached. 

1. Open the WinCC project.

Note

The WinCC project must be open so that the maximum number of tags in use can be 
calculated.

2. Open "<WinCC installation folder>\diagnose\LicenseLog.xml".

① Number of archive tags currently used
② Number of archive tags available in total

Displayed only if WinCC Runtime has been started
Figure 10-12 Calculating the maximum number of archive tags

10.2.7 Replay pictures: Preparing pictures
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A picture must be prepared for replay before it can be viewed using the Replay function. This 
process creates all the necessary tags and structures. 
See: "Required tags, structures, and archives (Page 306)"

1. Open the Replay Configuration Editor. 
The Replay Configuration Editor shows all the pictures (with extension .pdl) in the WinCC 
project. Faceplates are not shown in the list. 

Figure 10-13 Preparing pictures

2. Select the checkbox for the relevant picture in the "Prepared" column in the list of Replay 
pictures. 
The "Prepare picture" window appears. 

Note

If the selected picture (e.g. "Hoist.pdl") contains a detail window (e.g. "HoistDetails.pdl"), 
that was integrated into the picture in way that is suitable for Replay (as described in Chapter 
1.4.5), the two pictures "Hoist.pdl" and "HoistDetails.pdl" are prepared for Replay. 
"HoistDetails.pdl" is subordinate to the "Hoist.pdl" picture after preparation and does not 
need to be selected again in the list of pictures in the Replay Editor.

3. Click "OK" to start preparing the picture. 
The picture is checked for Replay capability.

This operation can be canceled. 

If an insufficient number of archive tags is available, preparation of this picture will be canceled 
and an appropriate message displayed. 

If any objects or scripts are found that are not supported, a warning will appear. These warnings 
are also included later in the report. 
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A report about this operation is displayed and can be exported as required. For details about 
the report, see: "The report window / exporting a report (Page 318)".

Note

Depending on the number of tags used in the picture (incl. the tags used in the inner pictures), 
this operation may take a few minutes. 

All required tags and structures are created. 

The picture is marked as "Prepared". 

If you now select the Replay picture in the Replay Configuration Editor, all its Replay-specific 
information will be displayed:

10.2.8 Replay pictures: Checking prepared pictures
Changes to a picture (e.g. opening and saving the picture in Graphics Designer) are marked in 
the Replay Configuration Editor. The picture name has a yellow background and the status is 
marked as "Changed". 

Note

Changes to the ReplayArchive or to the WinCC tag management are not automatically 
recognized by the Replay Configuration Editor! 

If a picture displays the status "OK" but does not run correctly in the Runtime, the picture must 
be analyzed with "Check." The problem will then be displayed.  
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You can find additional information about various picture statuses here: "The various picture 
statuses (Page 319)".

1. Open the Replay Configuration Editor. 
The Replay Configuration Editor shows all the pictures in the WinCC project and their 
status. 

Figure 10-14 Replay Configuration Editor

2. In the list of Replay pictures, select the picture that you want to check

3. Click the "Check" button. 
The picture is then checked and an appropriate status assigned to it. 

This operation can be canceled.

Note

Using the "Check all" function, you can check the changes to all pictures.

A report about this operation is displayed and can be exported as required. For details about 
the report, see: "The report window / exporting a report (Page 318)".

You can use the "Repair" button to repair any pictures that have the "Conflict" status. See: 
"Replay pictures: Repairing prepared pictures (Page 324)"
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10.2.9 Replay pictures: Repairing prepared pictures
An existing picture that has been modified or has "Conflict" status can be repaired with the 
"Repair" button so that it can be replayed. Any missing Replay tags and Replay archives are 
created during the repair process.

Note

However, Replay tags and archives that are no longer needed are not deleted, but they can be 
removed with the "Clean up" function. 
See: "Replay pictures: Cleaning up tags (Page 325)"

1. Open the Replay Configuration Editor. 
The Replay Configuration Editor shows all the pictures in the WinCC project and their 
status. 

Figure 10-15 Picture with the "Conflict" status

2. In the list of replay pictures, select the picture with the "Conflict" status and click on "Repair". 
The picture is then repaired. 

This operation can be canceled.

A report about this operation is displayed and can be exported as required. For details about 
the report, see: "The report window / exporting a report (Page 318)".
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10.2.10 Replay pictures: Cleaning up tags
Deleting tags in a picture does not automatically delete the associated internal Replay tags and 
archive tags. It results in unused tags.  

The "Clean up" function checks whether internal tags or archive tags created for Replay are 
used in the pictures. Unused tags are deleted

Note
Potential loss of data

If required, the historical data of unused tags may be retained in the archive or recorded so that 
they can subsequently be integrated into a picture again without any loss of data. 

The "Clean up" function permanently deletes the historical data of unused tags!

1. Open the Replay Configuration Editor. 
The Replay Configuration Editor shows all the pictures in the WinCC project and their 
status. 

2. Click on "Clean up". 
Unused tags and archives are deleted. 

This operation can be canceled. 

A report about the operation is displayed and can be exported. You will find a detailed 
description in Section: "The report window / exporting a report (Page 318)".

Note

If you need to make more tags available, check the configuration of your Replay pictures to 
determine whether you can evaluate and manually delete archive tags.

See also
Maximum number of archive tags (Page 308)

10.2.11 Deselect pictures
A picture prepared for Replay can be deselected by clearing the checkmark in the "Prepared" 
column. This process deletes all Replay-specific information, tags and archives of the picture 
that are not being used by any other picture.

Note
Potential loss of data!

It is possible that the historical data of the picture may be retained in the archive or be recorded 
for display at a later time.  

When you deselect a picture, the historical data of unused tags are permanently deleted!
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1. Open the Replay Configuration Editor. 
The Replay Configuration Editor shows all the pictures in the WinCC project and their 
status. 

2. Clear the checkmark in the "Prepared" column for the relevant picture in the list of Replay 
pictures. 
The window "Replay picture will be deselected" appears. 

3. Click "OK" to start the deselection process. 
The picture is deselected and is assigned "N/A" status. Unused Replay-specific information, 
tags and archives as well as the descriptor file are deleted.

This operation can be canceled.

A report about this operation is displayed and can be exported as required. For details about 
the report, see: "The report window / exporting a report (Page 318)".
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10.3 Replay Runtime

10.3.1 About Replay Runtime
Replay Runtime is responsible for preparing and replaying historical Replay data.

You will find information about preparing the pictures for Replay here: 
The Replay Configuration Editor (Page 315)
Adapt the CMS application for the Replay function (Page 332)

To ensure that Replay Runtime is launched automatically, it must be entered in the start list of 
WinCC Runtime.  
See: "Set the Replay Runtime autostart function (Page 331)"

This icon in the Windows taskbar indicates that Replay Runtime is running.

In Replay mode, Replay Runtime reads the recorded data out of the Replay archive and replays 
them in the corresponding Replay pictures. Recording of current data continues.

Figure 10-16 Overview: Replay Runtime communication

Note

For a detailed interface description, please see: "Internal tags (Page 356)".
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Archiving
The process values to be archived are stored in a configurable cyclic archive in the archive 
database. The Replay archive is part of the WinCC TagLogging database. If the configured size 
of a segment of the cyclic archive is reached or the time period is exceeded, a transition to the 
next segment is made. When all segments are full, the process data in the first segment are 
overwritten again.  

To protect process data from being overwritten, they can be exported to an external medium. 
You will find more information on this topic in the WinCC documentation. 

Figure 10-17 TagLogging database

Note

For more details about WinCC TagLogging functionality and configuring archives, see the 
WinCC documentation.

The log file
A log file is created in the WinCC project directory under ...\CMS\Replay. Events from Replay 
Runtime and the Replay Configuration Editor are entered here.

The data buffer
To speed up reading data from the Replay archive, Replay Runtime also administers a data 
buffer. If replay of the data is started on the Replay operating bar, the Replay data will first be 
transferred into this buffer in the background and the buffer status will be displayed on the 
operating bar.
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10.3.2 The Replay user interface in the CMS example application
In the CMS example application, the user interface in Replay mode consists of the following 
elements:

Figure 10-18 CMS standard window in Replay mode

No. Description
① Replay operating bar 

See: "The Replay operating bar of the CMS example application (Page 329)"
② Primary navigation bar for switching over and starting main windows 
③ Replay window 
④ Status bar 
⑤ Lines with current messages. 

Note: 
Current operational messages are also displayed during Replay mode.  

⑥ Replay button (to start and exit Replay mode)

10.3.3 The Replay operating bar of the CMS example application
The CMS example application includes a Replay operating bar with the following functions: 

For further information about the scripts and tags of the individual operator controls in this 
Replay operating bar, please see: "Application components in the WinCC project (Page 356)"
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Figure 10-19 Replay operating bar

No. Description
① Enter start time.  

Format: Year, month, day, hour, minute, second 
YYYY,MM,DD,hh,mm,ss

② Enter Replay time. 
Format: Minutes, 1 .. 60

③ Enter Replay speed. 
If an "-" is entered in front of the number, Replay data are replayed backwards. 
Factor: -999 .. 999

④ Display (tooltip) of the status of Replay Runtime by messages from the Replay operating bar.
⑤ Start button for loading Replay data and starting Replay.
⑥ Pause button for pausing Replay.
⑦ Reverse button, can be operated after the pause button has been pressed, jumps 500 ms backward in time when 

pressed.
⑧ Forward button, can be operated after the pause button has been pressed, jumps 500 ms forward in time when 

pressed.
⑨ Stop button for canceling buffering or stopping Replay.
⑩ Slider of the Replay operating bar. Slider can be moved to jump to any Replay times between the Replay start time and 

end time.
⑪ Display of current Replay time.

10.3.4 Start/stop Replay mode.

Note

In the CMS example application supplied, the Replay function is not available to users with the 
"operator" role. To use the Replay function, you must have logged onto the CMS with one of the 
roles "maintenance," "management," or "administrator."

Requirement: Replay Runtime has been activated.

The Replay button is gray in live mode and green in Replay mode.

1. You can switch from live mode to Replay mode by pressing the "Replay button". 
Press the "Replay button" again to exit Replay mode.
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The Replay operating bar is displayed at the top in the CMS example application. In the primary 
and secondary navigation, only the buttons whose picture objects have been prepared for 
Replay will be displayed. 

10.3.5 Set the Replay Runtime autostart function
If you add Replay to the start list of WinCC Runtime, Replay Runtime will always be activated 
and deactivated with WinCC Runtime.

For further information about setting the autostart function, please refer to the WinCC 
documentation.

Figure 10-20 Add Replay Runtime to WinCC start list 
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10.4 Adapt the CMS application for the Replay function

10.4.1 Important note about adapting the CMS application

Note
Technical requirements for adapting the example application:
● Very good knowledge of WinCC 
● Detailed knowledge of the Replay function 
● If scripts have to be written: Experience with writing scripts (VB scripts and/or C scripts)
Required VBS project modules

To be able to adapt the Replay function to your needs, the following VBS project modules are 
needed. 
● NavigationVisible.bmo

Required for switchover between live and Replay mode.
Responsible for showing/hiding navigation buttons that are available or unavailable for 
Replay depending on how Replay is configured.

● NoReplayAvailable.bmo 
Required if the WinCC runtime was not activated for the time replayed in Replay. No archive 
data are available either. In this case, the message "No replay data available during the 
actual replayed time" is displayed.

● ReplayLoadPics.bmo 
In this script, you can edit the pictures that always have to be loaded.
See:The picture selector tags (Page 312)

You will find the VBS project modules in the example application in the project folder "ScriptLib".

- or -

You can edit the modules via the WinCC Explorer under GlobalScript / VBS Editor.

10.4.2 Runtime data in Replay mode (@NOTP::)
You can prevent tags from being supplied with Replay data in Replay mode. Instead, you can 
set the system so that tags are supplied with current runtime data. 

1. Use the prefix "@NOTP::" for all tags that are to be supplied with runtime data.  

The string "@NOTP::" can be used in all properties, events, and scripts. All tags that have the 
prefix "@NOTP::" will also be supplied with the current process values instead of Replay data 
during replay in Replay mode.

Note

The Replay Configuration Editor does not create a replay tag nor an archive tag in the 
ReplayArchive for tags that have the prefix "@NOTP::".
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Example: "@NOTP::" in VB script

 
Dim elapsed_ms 
Dim ReplaySpeed 
Dim replayTime  
Dim startTime  
elapsed_ms      = 
HMIRuntime.Tags("@NOTP::@ReplayControl.Out_Elapsed_ms").Read() 
ReplaySpeed     = 
HMIRuntime.Tags("@NOTP::@ReplayControl.In_ReplaySpeed").Read() 

Example: "@NOTP::" in C script

 
// WINCC:TAGNAME_SECTION_START  
    // syntax: #define TagNameInAction "DMTagName"  
    // next TagID: 1  
    #define wrdStarttimeYear "@NOTP::@ReplayControl.In_StartYear"  
    #define bytStarttimeMonth "@NOTP::@ReplayControl.In_StartMonth"  
    #define bytStarttimeDay "@NOTP::@ReplayControl.In_StartDay"  
    #define bytStarttimeHour "@NOTP::@ReplayControl.In_StartHour"  
    #define bytStarttimeMinute "@NOTP::@ReplayControl.In_StartMinute"  
    #define bytStarttimeSecond "@NOTP::@ReplayControl.In_StartSecond"  
    #define chrStarttime "@NOTP::@ReplayStartTime"  
    // #define chrMoveStoptime "@CMSMoveTableStoptime" 
// WINCC:TAGNAME_SECTION_END

10.4.3 Creating a Replay button
This section describes how to create a Replay button.

This button switches between the current process visualization (live mode) and visualization of 
Replay data (Replay mode).

Note

In the CMS example application, the Replay button has already been created in the picture 
"@CMSStatusBarReplay.pdl". 

Create a button that executes the following commands or calls scripts when clicked: 
[Code]
Item.Operation = FALSE 
Call OnClickButtonReplayInit()
Call NoReplayAvailable
Item.Operation = TRUE
[/Code]
The script "OnClickButtonReplayInit" is part of the project module "NavigationVisible.bmo". 
The script "NoReplayAvailable" is part of the project module "NoReplayAvailable.bmo". 
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Figure 10-21 Configuration of the Replay button

10.4.4 Adapting navigation button for Replay
This section describes how to get a navigation button on a primary or secondary navigation bar 
to work with Replay mode.

Note

The navigation buttons of the example application are already prepared for Replay.

@NOTP:: Tags
In the object properties of the navigation buttons, the string "@NOTP::" must be placed in front 
of each tag.

Adapt the name and visible tag of the navigation button for Replay
The following condition must be met so that navigation buttons in the primary and secondary 
navigation bars can be shown and hidden depending on the pictures prepared in the Replay 
Configuration Editor:

● The button names must conform to the relevant naming convention.

● The tags for visibility control must be assigned to the buttons.

The Replay function
10.4 Adapt the CMS application for the Replay function

Crane Management System (CMS)
334 System Manual, 11/2019



You will find detailed information about the naming convention and visible tag here: "Naming 
convention of navigation buttons and visible tags for Replay (Page 237)".

1. Adapt the name of the navigation buttons:
"Object properties" → "Properties tab" → "Status display" → "Object name"
For primary navigation buttons: "ButtonX"
For secondary navigation buttons: "ButtonX_PictureName"

2. Assign a visible tag to the button:
"Object properties" → "Properties tab" → "Miscellaneous" → "Display
for primary navigation buttons: "@NOTP::@ReplayButtonVisibleX"
for secondary navigation buttons: "@NOTP::@ReplayButtonVisibleXY"
"X" indicates the position of the navigation button in the primary navigation bar (values: 
1..10). 
"Y" indicates the position of the navigation button in the secondary navigation bar (values: 
1..10).

Adapt the script for Replay
Depending on whether or not a navigation button is required in Replay mode, it is displayed or 
hidden by the project module "NavigationVisible.bmo". 

This script requires the visible tag "@ReplayButtonVisibleX" or "@ReplayButtonVisibleXY".

Before adapting the script, read Chapter Important note about adapting the CMS application 
(Page 332)

Note

You can leave the script unchanged for navigation buttons of the secondary navigation bar.

1. Insert the name of the picture that is called with the button of the primary navigation bar 
(here: "@CMSMenu7.pdl").

2. Insert the tag for the secondary navigation bar (here: "@CMSMenu7Pic").
You can find the name of this tag by checking the object property "Picture name" of the 
picture window of the secondary navigation bar.

3. Insert the status tag that is responsible for the color change of the buttons (here: 
"@CMSMenu7Selection").
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Figure 10-22 Work steps in the script "NavigationVisible.bmo"

See also
Creating a navigation button (Page 241)

Navigation button: Adapting the position (Page 243)

Navigation button: Adapting the link destination (Page 245)

10.4.5 Adapt buttons in Replay pictures
This section describes how you can adapt a button that links to an inner picture for use with the 
Replay function.

You will find information on dynamic link destinations here: "Working with dynamic picture 
windows (Page 338)"
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Figure 10-23 Button in "MainPicture.pdl" links to "DetailPicture.pdl"

The Replay Configuration Editor recognizes a linked picture only when it is integrated into the 
main picture as a picture window. To do this, you can integrate the image into the main picture 
as an invisible picture window.

If you prepare a main picture with a linked inner picture in the Replay Configuration Editor 
although the inner picture is not integrated in the main picture, a warning is output.

Example: A button is linked to a detail picture "DetailPicture.pdl" in the picture 
"MainPicture.pdl". 

If you integrate the linked picture ("DetailPicture.pdl") as an invisible picture window into the 
main picture ("MainPicture.pdl"), the picture ("DetailPicture.pdl) can be recognized by the 
Replay Configuration Editor and included in preparation. As a consequence, the button link will 
also work correctly in Replay mode.

1. Make sure that the prefix "@NOTP::" has been appended to the button tags so that the link 
will also work in Replay mode. 
To do this, select the button and click on Object properties > Event > Mouse and then check 
the tags in the corresponding actions. 

2. Create a picture window and position it wherever you like.

Note

This picture window can be as large as you wish. What matters is that it is included in the 
picture. 

3. Enter the following settings for the picture window under "Object properties > Properties > 
Picture window > Miscellaneous": 
Attribute "Picture name": Enter here the name of the picture to which the button is linked. 
Attribute "Tag prefix": If a detail picture for multiple components or objects of the same type 
(HoistMotor1 and HoistMotor2, for example) are used or called, the tag prefix must be 
entered in the attributes of the associated picture window object.
Attribute "Display": Select the value "No" so that this picture window is not visible during 
runtime. 

4. Prepare the picture for replay. 
See: "Replay pictures: Preparing pictures (Page 320)"

5. Check whether the link works in Replay mode.
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10.4.6 Working with dynamic picture windows
This section describes how you adapt dynamic picture windows for Replay.

Figure 10-24 Main picture with dynamic inner picture

The Replay Configuration Editor cannot automatically prepare the images of a picture window 
("DynPicture") if this picture window can call different pictures ("DynPictureA" or 
"DynPictureB"). If you prepare such a picture for Replay, a warning is output.

For a main picture with a dynamic picture window to be prepared, you must work out which 
inner pictures are called. Link each of these inner pictures in an invisible picture window into the 
main picture ("MainPicture.pdl"). If you do this, all inner pictures that are called ("DynPictureA" 
and "DynPictureB") can be recognized by the Replay Configuration Editor and included in the 
preparation process.

Example
The following figure shows the picture "Gantry.PDL" from the example application. It contains 
3 inner pictures (i.e. 3 PictureWindow objects) used for direct display of a further picture within 
the main picture. The picture "Gantry.PDL" also contains 6 further picture windows that are not 
visible in the WinCC runtime. 
Background: The pictures that are opened by clicking a button cannot be recognized by the 
Replay Configuration Editor in the normal way because they are configured in the events of the 
buttons. For that reason, further picture windows that are invisible in the WinCC runtime are 
inserted containing the names of the pictures that can be called via the buttons. This ensures 
that all pictures that can be opened with the buttons are prepared for Replay at the same time 
as the picture "Gantry.PDL."
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Figure 10-25 Gantry.PDL with three inner pictures in FPLDrive.PDL
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Analyzing link destinations (using the example of Gantry.PDL)
1. Open the button whose content you want to process in Replay to look at the linked events. 

Figure 10-26 Linked events

– Event "mouse click": 
The value "1" is written into the tag "@CMSDetailVisible." This makes the picture window 
"picDetail" of the start picture "@CMSRoot1920.pdl" visible in the foreground:

– Event "Press left": 
The picture name "DriveDetail.PDL" is written into the tag "@CMSDetailPic." The picture 
window "picDetail" of the start picture "@CMSRoot1920.pdl" takes over the picture 
name in its object property "Picture name" and displays the picture "DriveDetail.PDL":
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– Event "Release left": 
The "HoistDrive1." prefix is written into the "@CMSTagPrefix" tag for further use in the 
picture "DriveDetail.PDL": 

Make sure that the prefix "@NOTP::" is used for linked events on which you write to tags.

2. Check whether the linked picture (in this example: "DriveDetail.pdl") is addressed by one or 
more pictures.

Figure 10-27 Addressed images

The example shows that you can navigate through three pictures in this picture. The names 
of the pictures contained in the picture window are dynamically addressed via a mouse click 
event. For this reason, they are not picked up by Replay. Therefore note the names of the 
three called pictures (FPLDriveControl.PDL, FPLDriveStatus.PDL, 
FPLApplicationStatus.PDL).

3. Examine the "DriveDetail.PDL" picture for further elements that may be affected by Replay. 
One example is the "iofTagPrefix" output field. The "@CMSTagPrefix" tag linked behind it 
is only described if the detail button is pressed (see Step 1.) Then, the name of the drive 
addressed in the picture window is to be displayed (here: HoistDrive1.). Append "@NOTP::" 
to the front of the tag linked in the output value so that the drive name is correct in Replay 
mode. 
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Figure 10-28 Output field "iofTagPrefix" - Adapting the output value

Creating invisible picture windows
1. Create a picture window for each inner picture and position it wherever you like. 

Note

This picture window can be as large as you wish. What matters is that it is included in the 
picture. 

2. Enter the following settings for the picture window under "Object properties" → "Properties" 
→ "Picture window" → "Miscellaneous": 
Attribute "Picture name": Enter here the name of the nested picture. 
Attribute "Tag prefix": Specify the necessary tag prefix here if applicable. 
Attribute "Display": Select the value "No" so that this picture window is not visible during 
runtime. 

3. Prepare the picture for replay. 
See: "Replay pictures: Preparing pictures (Page 320)"

4. Check the picture in Replay mode.

10.4.7 Insert an alarm control in a Replay picture
To switch between productive and Replay mode in a picture using alarm controls, you require 
2 alarm controls. One alarm control is used to display the current messages in productive mode 
and the other to display the messages in Replay mode. These controls are then shown or 
hidden depending on which mode is selected.
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Duplicate an alarm control
The following instructions assume that you have already created a picture for productive mode 
that is functional to display messages with an alarm control. 

1. Use the shortcuts "Ctrl" + "C" and "Ctrl" + "V" in Graphics Designer to duplicate an already 
configured alarm control. 

This gives you 2 alarm controls:  

● Runtime AlarmControl: This is required to display alarms in productive mode. 

● Replay AlarmControl: This is required to display alarms in Replay mode.

Adapt Runtime AlarmControl
1. Configure Runtime AlarmControl so that it is displayed during productive mode. 

Select: "Object properties" → "Miscellaneous" → "Display"  
Show when @ReplayActive = FALSE
Hide when @ReplayActive = TRUE

Figure 10-29 Dynamic value ranges - Runtime AlarmControl
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Adapt Replay AlarmControl
1. Configure Replay AlarmControl so that it is displayed during Replay mode. 

Select: "Object properties" → "Miscellaneous" → "Display"  
Show when @ReplayActive = TRUE
Hide when @ReplayActive = FALSE

Figure 10-30 Dynamic value ranges - Replay AlarmControl

2. Configure Replay AlarmControl so that it is not activated until replay of data is started in 
Replay mode.  
Select: "Object properties" → "Control properties" → "Activate"  
Activate with "@ReplayControl.In_TriggerStart"

Figure 10-31 Activate Replay AlarmControl
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3. Configure Replay AlarmControl so that it is supplied with the necessary SQL statements. 
Select: "Object properties" → "Control properties" → "MsgFilterSQL"

Figure 10-32 SQL script for Replay AlarmControl

The required script is already implemented as an example in the supplied CMS example 
application in picture "Messages.pdl."

4. Set the trigger of this script to the following tags: 
"@NOTP::@ReplayControl.In_TriggerStart" 
"@NOTP::@ReplayControl.Out_IsReplaying" 
"@NOTP::@ReplayControl.Out_Elapsed_ms"

Figure 10-33 Trigger for Replay AlarmControl

The script calls up contents from the "SplitAlarms.bmo" project module from the VB Script 
Editor to read alarms out of the archive and display them in blocks. The required script/
project module is implemented in the CMS example application supplied.
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Figure 10-34 Project modules

10.4.8 Insert the online table control in a Replay picture
The online table control is found in the pictures "MoveData.pdl" and "MMBFData.pdl." In the 
WinCC CMS example application, these have already been prepared for Replay.

Duplicate the online table control
1. Use the shortcuts "Ctrl" + "C" and "Ctrl" + "V" in Graphics Designer to duplicate the already 

configured Online Table Control and its buttons.

Figure 10-35 Duplicate the online table control
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You now have 2 online table controls:  

● Runtime Online Table Control: This is required to display values in productive mode. 

● Replay Online Table Control: This is required to display values in Replay mode.

Adapt the Runtime Online Table Control
1. Configure the Runtime Online Table Control and its buttons so that it is displayed during 

productive mode. 
Select: Object properties > Miscellaneous > Display:  
Show when @ReplayActive = FALSE
Hide when @ReplayActive = TRUE

Figure 10-36 Dynamic value ranges - Runtime Online Table Control
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Adapt the Replay Online Table Control
1. Configure the Replay Online Table Control and its buttons so that it is displayed during 

Replay mode. 
Select: Object properties > Miscellaneous > Display:  
Show when @ReplayActive = TRUE
Hide when @ReplayActive = FALSE

Figure 10-37 Dynamic value ranges - Replay Online Table Control

2. To ensure that only those data that are important for Replay are displayed in the Replay 
Online Table Control, set the time range to "start to end time". 
Select: Object properties > Control properties  
TimeColumnBeginTime = @NOTP::@ReplayStartTime 
TimeColumnEndTime = @NOTP::@ReplayEndTime

Figure 10-38 Settings of time range for object properties (Online Table Control)
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3. Insert the script that marks the line of the move data that matches the Replay time.  
Select: Object properties > Control properties > TimeColumnActualize

Figure 10-39 Adapt the online table control script

In the CMS example application supplied, the required script is already contained in the 
pictures "MoveData.Pdl" and "MMBFData.Pdl".

4. Set the trigger of this script to the "@NOTP::@ReplayControl.Out_Elapsed_ms" tag.

Figure 10-40 Trigger for the Replay Online Table Control

10.4.9 Insert an online trend control in a Replay picture
The online trend control shows the curve values for the complete Replay period. To configure 
this, perform the steps described below.
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Duplicate the online trend control
1. Use the shortcuts "Ctrl" + "C" and "Ctrl" + "V" in Graphics Designer to duplicate an already 

configured Online Trend Control and its buttons.

Figure 10-41 Duplicating the online trend control

You now have 2 online trend controls:  

● Runtime Online Trend Control: This is required to display values in productive mode. 

● Replay Online Trend Control: This is required to display values in Replay mode.
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Adapt the Runtime Online Trend Control
1. Configure the Runtime Online Trend Control and its buttons so that they are displayed in live 

mode. 
Select: "Object properties" → "Miscellaneous" → "Display"  

– Show when @ReplayActive = FALSE

– Hide when @ReplayActive = TRUE

Figure 10-42 Dynamic value ranges - Runtime Online Trend Control
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Adapt the Replay Online Trend Control
1. Configure the Replay Online Trend Control and its buttons so that they are displayed in 

Replay mode. 
Select: "Object properties" → "Miscellaneous" → "Display"  
Show when @ReplayActive = TRUE
Hide when @ReplayActive = FALSE

Figure 10-43 Dynamic value ranges - Replay Online Trend Control

2. Make sure that the ruler control that is visible in Replay mode is connected to the correct 
trend control.

Figure 10-44 Properties of WinCC RulerControl

3. To ensure that only those data that are important for Replay are displayed in the Replay 
Online Trend control, set the time range to "start to end time". 
Select: "Object properties" → "Control properties"  
TimeAxisBeginTime = @NOTP::@ReplayStartTime 
TimeAxisEndTime = @NOTP::@ReplayEndTime

Figure 10-45 Settings of time range for object properties (online trend control)
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10.4.10 Adapt scripts for Replay

Adapting C scripts
Replay Runtime only detects the tags created in the declaration part and linked in the script 
trigger. No other tags are detected automatically.

To ensure that Replay recognizes the tags linked into the C script, they must be created in the 
declaration part. 

Note

If you have correctly created the declaration part of the script, use of the Cross Reference 
Assistant is not necessary. 

Manual tag declaration
1. Declare all the tags used in the C script. 

Figure 10-46 Correct tag declaration in the C script

Automatic tag declaration using the Cross Reference Assistant
To be able to use the Cross Reference Assistant, you have to have installed the SmartTools 
during the WinCC installation.

1. Open the WinCC project to be analyzed in the WinCC Explorer.

2. Start the Cross Reference Assistant by selecting "Start > All programs > Siemens 
Automation > SIMATIC > WinCC > Tools > Cross Reference Assistant"
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The Cross Reference Assistant declares all the tags used in the script in the declaration part of 
a C script. 

You will find details about Cross Reference in the WinCC online help for example under "Cross 
Reference".

Adapting VB Scripts
To ensure that Replay recognizes the tags linked in the VB script, you have to address the tags 
with the syntax "HMIRuntime.Tags("<Tagname>")". It is immaterial whether the tag is 
addressed via an object reference or not.

Figure 10-47 Correct tag declaration in the VB script

10.4.11 Triggering scripts
For C scripts and VB scripts, the following applies: 

The Replay configuration editor automatically detects the triggers linked into the script and 
creates a Replay tag and an associated archive tag for the trigger tags during preparation of a 
picture.
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Figure 10-48 Changing a trigger
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10.5 Application components in the WinCC project

10.5.1 Scripts for the Replay function
The following scripts are relevant for the Replay function. 

The scripts are already included in the example application. Please contact the hotline if you 
have any questions. 

● Script for switching to Replay mode 
NavigationVisible.bmo 

● Script for hiding unnecessary navigation elements in Replay 
NavigationVisible.bmo 

● Script for filling the picture selector tags  
ReplayLoadPics.bmo  

● Script for message if Replay time is not valid 
NoReplayAvailable.bmo 

● Script for calculating the Replay start time  
Date_Conversion_c.bmo 

● Script for the reverse button

● Script for the forward button

● Script for the slider control

● Script for the alarm control 
GetSelectedMessage.bmo 

● Subroutines for the alarm control 
SplitAlarms.bmo 

● Script for the online table control

● Script for setting user rights in the application 
UserLogin.pas

10.5.2 Internal tags

Tags of the "ReplayControl" group
The internal tags of the ReplayControl group are created by the Replay configuration. 
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@ReplayControl structure tags 

Note
● Tags that start with the string "In_" contain information about the CMS example application 

that are set by the user or by the application.
● Tags that start with the string "Out_" contain information set by the Replay Runtime about 

the Replay process that is running.
● The "Out_" tags must not be changed by the user and the application.

Tag name Type Description
Tags for controlling Replay Runtime

In_TriggerStart BIT ● Set this tag to 1 to start replay (and to start buffering)
● Set this tag to 0 to stop replay (and to stop buffering) 
● If you set this tag to 0 while buffering, you will delete the buffer of the currently 

buffered picture. The previously buffered picture information is still retained.
In_TriggerPause BIT ● Set this tag to 1 to pause replay

● Set this tag to 0 to resume replay 
In_ReplaySpeed SIGNED 

SHORT
● Set this tag to 1 for normal Replay speed 
● Set this tag > 1 for fast forward
● Set this tag < 1 for fast reverse

Parameter to start Replay
In_StartYear
In_StartMonth
In_StartDay
In_StartHour
In_StartMinute
In_StartSecond

WORD
BYTE
BYTE
BYTE
BYTE
BYTE

The start time of the Replay interval must be set by the user before Replay is 
started. 

In_Duration_min DWORD The time interval in minutes for which Replay data are to be replayed. The value 
must be > 0 and ≤ 60. The value is set before Replay is started.

Status tags
Out_IsReplayOnline BIT If ReplayRuntime.exe is running this bit is 1.
Out_IsBuffering BIT If the pictures are being buffered, this bit is 1.
Out_IsReplaying BIT If replay is running or paused and buffering has been completed, this bit is 1.
   
Out_StatusMessage TEXT16 This tag shows messages that come from Replay Runtime.
Out_BufferProgressValue BYTE Progress of the buffering as a percentage.
Out_WinCcWasUp BIT This tag is 1 if Replay is active and WinCC Runtime has run at the Replay time.
TlgReference BYTE This tag is archived cyclically to store the value of the "Out_WinCWasUp" tag. 

This value is not used by the application.
Tags of the Replay time
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Tag name Type Description
Out_CurrentYear
Out_CurrentMonth
Out_CurrentDay
Out_CurrentHour
Out_CurrentMinute
Out_CurrentSecond
Out_CurrentMillisecond

WORD
BYTE
BYTE
BYTE
BYTE
BYTE
WORD

During replay, these tags contain the current Replay time at which the tags are 
displayed in the pictures.

Out_Elapsed_ms DWORD This tag shows the current time in milliseconds. The current Replay time minus 
the start time is calculated here.

Tags that are used by the slider
Out_Duration_ms DWORD The duration from the tag “In_Duration_min“ that has been converted to millisec‐

onds. This is used as the maximum value of the slider.
In_SliderPos_ms DWORD Slider position (is required to jump to a certain time)
InOut_SliderState BYTE This tags displays the status of the slider:

● 0: normal – the value of the “Out_Elapsed_ms” tag is copied into the “In_Sli‐
derPos_ms” tag every 500 ms

● 1: Slider is moved.
● 2: Slider has been set.
Using the slider status, Replay Runtime reads out the time at which Replay data 
will be replayed.
This tag is set both by a VBS script and by the Replay Runtime. The jump from 0 
to >1 and 1 to >2 is performed by the VBS. The jump from 2 to >0 by Replay 
Runtime

Out_DaylightSavingTime BIT      1, if the corresponding tag was been acquired at Replay time during daylight 
saving time (for example, UTC + 2 and not UTC + 1 in Germany or Hungary).

Out_TimeOffset FLOAT This tag contains the time difference between UTC and the recording time so that 
the correct data can be read from the message archive at the end.

General tags
These tags are created by the Replay configuration but are not part of the @ReplayControl 
structure tag. These tags are all created in the "ReplayControl" group.

Tag name Type Description
Time tags

@ReplayStartTime TEXT16 Tag that is supplied with values by the CMS application using scripts, for example, 
to ensure correct functioning of the Online Table Control and Online Trend Con‐
trol in Replay mode.

@ReplayEndTime TEXT16 Tag that is supplied with values by the CMS application using scripts, for example, 
to ensure correct functioning of the Online Table Control and Online Trend Con‐
trol in Replay mode.

Picture selector tags
@ReplayedDynPic1...
@ReplayedDynPic10
@ReplayedFixedPic1 ...
@ReplayedFixedPic10

TEXT16 For example, if the “@ReplayedDynPic1” tag contains the value “Hoist.Pdl” and 
all other picture selector tags are empty, only those tags are buffered that are in 
the "Hoist.pdl" picture.
If one of these tags changes and Replay is not active at the same time, replay of 
the Replay data will be set to pause. 

Tags for the picture list of Replay
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Tag name Type Description
@ReplayPic1 ...
@ReplayPic100

TEXT16 These tags contain the names of the pictures that have been selected for Replay 
in the Replay Configuration Editor. They are created on request. For example, if 
two pictures are selected for Replay ('Hoist.Pdl', 'Trolley.Pdl'), two tags will be 
created. The start value of the first tag is “Hoist.pdl”; the start value of the second 
tag is “Trolley.pdl”.  

@ReplayNavigationPrepara‐
tionProgress 

Text16 This tag contains status information and is written to by the application while the 
navigation elements are being prepared for Replay.

@ReplayActive BIT This bit indicates whether Replay has been selected by the Replay button in the 
application. 

Tag for defining the tag prefix
@ReplayTagPrefix TEXT8 The value of this tag is either "R_" or an empty string, depending on whether 

Replay is running or not.  

Additional Replay tags
These tags are not automatically created by the Replay Configuration, but are already 
contained in the standard application. They can be found in the "ReplayControl" group and are 
absolutely essential to proper functioning of the Replay mode.

Tag name Type Description
@PictureLoaded BIT This tag indicates whether the picture has been correctly and completely loaded:

● 1: Picture successfully loaded
It is needed to ensure that Replay mode is correctly loaded

@ReplayActiveProjectWide BIT This tag displays the status of Replay mode:
● 1: Active
● 0: Inactive
In contrast to the computer-local tag "@ReplayActive", this one is a project-wide 
tag.

@ReplayInUseBy Text8 This tag contains the name of the user who activated Replay mode.
The tag is empty if Replay mode is not active.

@ReplayInUseOnComputer Text8 The tag contains the name of the computer from which Replay mode has been 
activated.
The tag is empty if Replay mode is not active.

@ReplayWebNavIndicator BIT This tag indicates the location at which Replay mode has been activated:
● 1: WebClient
● 0: Local

Tags of the "Screens" group

Tag name Type Description
Tags for hiding the navigation buttons, primary navigation

@ReplayButtonVisible1 ...
@ReplayButtonVisible10

BIT These tags are used for hiding the primary navigation buttons in Replay mode 
(menus 1 through 10). 
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Tag name Type Description
Tags for hiding the navigation buttons, secondary navigation

@ReplayButtonVisible11...
@ReplayButtonVisible110
@ReplayButtonVisible21...
@ReplayButtonVisible210
@ReplayButtonVisible31...
@ReplayButtonVisible310
@ReplayButtonVisible41...
@ReplayButtonVisible410
@ReplayButtonVisible51...
@ReplayButtonVisible510
@ReplayButtonVisible61...
@ReplayButtonVisible610
@ReplayButtonVisible71...
@ReplayButtonVisible710
@ReplayButtonVisible81...
@ReplayButtonVisible810
@ReplayButtonVisible91...
@ReplayButtonVisible910
@ReplayButtonVisible101...
@ReplayButtonVisible1010

BIT These tags are used for hiding the secondary navigation buttons in Replay mode 
(menus 1 through 10).

Tags of the "Settings" group

Tag name Type Description
@CMSSettingsReplayIn‐
stalled 

BIT This tag is described in the settings. If the checkmark is set for "Replay installed," 
this is 1.

See also
Tags and configuration of the Replay operating bar (Page 360)

10.5.3 Tags and configuration of the Replay operating bar
If you want to create your own operating bar, you can use elements from the Replay operating 
bar of the CMS example application (ReplayBar_Head.pdl). This section explains how Replay 
operating and display elements used in the CMS example application are configured and to 
which tags they have been linked. With this knowledge, you can create your own Replay 
operating bar.
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Replay operating bar, left part

Num‐
ber

Description Properties / events

① *) Input of the start year for re‐
playing the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_StartYear

② *) Input of the start month for 
replaying the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_StartMonth

③ *) Input of the start day for re‐
playing the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_StartDay

④ *) Input of the start hour for re‐
playing the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_StartHour

⑤ *) Input of the start minute for 
replaying the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_StartMinute

⑥*) Input of the start second for 
replaying the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_StartSecond

⑦ Input of the Replay speed I/O field Properties > Miscellaneous > Operating enable: 
@NOTP::@ReplayControl.Out_IsReplayOnline
Output value:
@NOTP::@ReplayControl.In_ReplaySpeed

⑧ Display of the status of the 
Replay operating bar

Tooltip text: @NOTP::@ReplayControl.Out_StatusMessage

⑨ Input of the duration for re‐
playing the Replay data

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.In_Duration_min

⑩ Display "Load data" Static text, Properties > Miscellaneous > Display: No tag con‐
nection: @NOTP::@ReplayControl.Out_IsBuffering

⑪ Loading bar of the buffer Properties > Miscellaneous > Process connection: 
@NOTP::@ReplayControl.Out_BufferProgressValue
Properties > Miscellaneous > Display: No tag connection: 
@NOTP::@ReplayControl.Out_IsBuffering

⑫ Display of the buffer pro‐
gress

I/O field, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.Out_BufferProgressValue
Properties > Miscellaneous > Display: No tag connection: 
@NOTP::@ReplayControl.Out_IsBuffering

⑬ Display "%" Static text, Properties > Miscellaneous > Display: No tag con‐
nection: @NOTP::@ReplayControl.Out_IsBuffering

*) Properties > Miscellaneous > Operating enable > Dynamic dialog: 
@NOTP::@ReplayControl.Out_IsReplayOnline - @NOTP::@ReplayControl.Out_IsReplaying > 0
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Note

When the dynamic dialog is saved, WinCC may output a warning that the tags used in the 
dynamic dialog have not been created. That is because the prefix "@NOTP::" is used in the 
dialog. If this is the case, click the "Ignore" button. The functionality is assured nevertheless.

Replay operating bar, right part

When configuring a new Replay operating bar, note that buttons 1 through 5 are locked in 
sequence from top to bottom. 

● The start button can only be pressed once. 

● Once the start button has been pressed and buffering starts, the stop button is released for 
operation.

● Once buffering has been completed, the pause button is released for operation. 

● The forward and reverse buttons can only be operated in the "paused" state. 

The following table provides an overview of the properties and events of the various buttons on 
the operating bar.

Number Description Properties / events
① Play button for starting buffering and 

replaying Replay data.
Properties:
Operating enable > Dynamic dialog: 
!'@NOTP::@ReplayControl.In_TriggerStart' || '@NOTP::@ReplayCon‐
trol.Out_IsReplaying'&&'@NOTP::@ReplayControl.In_TriggerPause'
Expression TRUE: Operating enable = 1
Expression FALSE: Operating enable = 0
Events: 
Mouse > Press left: VB script that sets the start trigger, resets the pause 
trigger, and also calculates the end time for replay. The required script is 
already implemented as an example in the supplied CMS example ap‐
plication. 

② Pause button for pausing replay of Re‐
play data

Properties:
Operating enable > Dynamic dialog:  '@NOTP::@ReplayControl.Out_Is‐
Replaying'&&!'@NOTP::@ReplayControl.In_TriggerPause'
Expression TRUE: Operating enable = 1
Expression FALSE: Operating enable = 0
Events: 
Mouse > Press left:
Direct connection: Source: Constant: 1; objective: Tag: @NOTP::@Re‐
playControl.In_TriggerPause
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Number Description Properties / events
③ Reverse button, can be operated after 

the pause button has been pressed; 
jumps 500 milliseconds backward in 
time when pressed.

Properties:
Operating enable > Dynamic dialog:  '@NOTP::@ReplayControl.Out_Is‐
Replaying'&&'@NOTP::@ReplayControl.In_TriggerPause'
Expression TRUE: Operating enable = 1
Expression FALSE: Operating enable = 0
Events: 
Mouse > Release left: VB script with which the slider jumps back 500 ms 
in time and tag @NOTP::@ReplayControl.InOut_SliderState = 2 is set, 
so that CMS Replay writes the time value of the slider onto the current 
Replay time. The required script is already implemented as an example 
in the supplied CMS example application. 

④ Forward button, can be operated after 
the pause button has been pressed; 
jumps 500 milliseconds forward in 
time when pressed.

Properties:
Operating enable > Dynamic dialog:
'@NOTP::@ReplayControl.Out_IsReplaying'&&
'@NOTP::@ReplayControl.In_TriggerPause'
Expression TRUE: Operating enable = 1
Expression FALSE: Operating enable = 0
Events: 
Mouse > Release left: VB script with which the slider jumps forward 
500 ms in time and tag @NOTP::@ReplayControl.InOut_SliderState = 2 
is set, so that the CMS Replay writes the time value of the slider onto the 
current Replay time. The required script is already implemented as an 
example in the supplied CMS example application. 

⑤ Stop button for canceling buffering or 
stopping Replay

Properties:
Operating enable > Dynamic dialog:
'@NOTP::@ReplayControl.Out_IsReplaying' +'@NOTP::@ReplayCon‐
trol.Out_IsBuffering' > 0
Expression TRUE: Operating enable = 1
Expression FALSE: Operating enable = 0
Events: 
Mouse > Press left:
Direct connection: Source: Constant: 0; objective: Tag: @NOTP::@Re‐
playControl.In_TriggerStart
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Number Description Properties / events
⑥ Slider of the Replay operating bar dis‐

plays the current time. Sliding navi‐
gates to any Replay times between 
the Replay start time and end time.

Properties:
Operating enable: @NOTP::@ReplayControl.Out_IsReplaying
Maximum value: @NOTP::@ReplayControl.Out_Duration_ms
Process connection:
@NOTP::@ReplayControl.In_SliderPos_ms
Minimum value: VB script that does not prescribe the minimum value but 
writes to the process connection of the slider every 500 ms so that the 
slider moves. The required script is already implemented as an example 
in the supplied CMS example application. 
Events: 
Mouse > Press left:
Source: Constant: 1; objective: Tag: @NOTP::@ReplayControl.In‐
Out_SliderState
Mouse > Release left:
Source: Constant: 2; objective: Tag: @NOTP::@ReplayControl.In‐
Out_SliderState
Property topics > Miscellaneous > Process connection > Change: 
Source: Property: this object: Process connection; objective: Tag: 
@NOTP::@ReplayControl.In_SliderPos_ms

⑦ Display of the current hour of Replay Output, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.Out_CurrentHour

Display of the current minute of Replay Output, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.Out_CurrentMinute

Display of the current second of Re‐
play

Output, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.Out_CurrentSecond

Display of the current millisecond of 
Replay

Output, Properties > Output/Input > Output value:
@NOTP::@ReplayControl.Out_CurrentMilliSecond

Note

For a complete overview of the tags of the interfaces of the Replay operating bar, see Chapter: 
"Internal tags (Page 356)".

10.5.4 Picture objects supported by Replay
WinCC makes a distinction between different types of picture objects. 

The Replay function
10.5 Application components in the WinCC project

Crane Management System (CMS)
364 System Manual, 11/2019



Standard objects

Figure 10-49 Standard objects

Standard objects can be replayed by Replay with restriction (events). 
See: "Restrictions (Page 305)"

Smart objects

Figure 10-50 Smart objects

Not all smart objects can be replayed by Replay. "Moreover, the same restrictions (events) for 
the standard objects also apply to all smart objects.

Picture windows are only acquired by Replay if they have a static picture name. 
See: "Restrictions (Page 305)"
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Windows objects

Figure 10-51 Windows objects

Windows objects can be replayed by Replay with restriction (events). 
See: "Restrictions (Page 305)"

Tube objects

Figure 10-52 Tube objects

Tube objects can be replayed by Replay with restriction (events). 
See: "Restrictions (Page 305)"

ActiveX controls

Figure 10-53 ActiveX controls

Not all ActiveX controls can be replayed by Replay. For that reason, controls such as the table 
control and the alarm control have been adapted manually with scripts so that they work in 
Replay. 

See also:
Restrictions (Page 305)
Insert an alarm control in a Replay picture (Page 342)
Insert the online table control in a Replay picture (Page 346)
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Backup, backward compatibility, and migration 11
11.1 Backup

11.1.1 Creating a backup
You can create a backup of your CMS project.

You must always create the backup in the corresponding WinCC version. 

● SIMOCRANE CMS 4.1. SP1 up to 4.2: WinCC 7.0. 

● SIMOCRANE CMS 4.3 (SP1): WinCC 7.2 

● SIMOCRANE CMS 4.4 (SP2): WinCC 7.4

Note

For projects from SIMOCRANE CMS V4.1 SP1 to V4.2, indirect migration via SIMATIC WinCC 
7.2 may be necessary. In this case, preparation has to be repeated after successful migration 
to SIMATIC WinCC V7.2.

1. Open the project to be migrated in the correct WinCC Version.

2. Open the CMS Editor.

3. Open screen form "System" → "Maintenance".

4. Activate "Including configuration data," enter the path under "Backup," and click "Start."

Figure 11-1 Preparing export of existing projects

After export has been successfully completed, "Backup ok" will be displayed at the bottom 
of the window.

The backup has been created
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If you want to change to a higher version of SIMOCRANE CMS, you can now install the current 
versions of SIMATIC WinCC and SIMOCRANE CMS. 
See also: Installation (Page 87).

You can now re-import the backup:
See also: Importing the backup (Page 368)

11.1.2 Importing the backup
You can import a backup of your project.
See also: Creating a backup (Page 367)

1. Open the migrated project in the WinCC Explorer.

2. Open the CMS editor.

3. Go to "System" → "Maintenance"
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4. Activate "Including configuration data," enter the path to the configuration file under 
"Restore", and click "Start."

Figure 11-2 Selecting a database

After the restore has been successfully completed, "Restore ok" will be displayed at the 
bottom of the window.

5. Check that the configuration data have been correctly transferred.

Figure 11-3 Have the configuration data been correctly transferred?

The backup has now been imported.
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11.2 Backward compatibility

11.2.1 General information about backward compatibility
CMS 4.4 (SP3) and RCMS 4.4 (SP3) are backward compatible with the following CMS / RCMS 
components:

● CMS station 4.4 (SP3) with RCMS server 4.3 SP1 
CMS station 4.4 (SP3) behaves like CMS station 4.3 SP1. 
Data are exchanged between the CMS station and the RCMS server via XML files.  
See also: CMS 4.4 with RCMS server 4.3 SP1 (Page 371) 

● CMS station 4.3 SP1 with the RCMS web application 4.4 (SP3)
CMS station 4.3 SP1 transfers the data to Process Historian, which communicates with the 
RCMS web application. 
See also: CMS 4.3 with RCMS 4.4 web application (Page 390) 

 RCMS
CMS  4.2 4.3 SP1 4.4 (SP3)

4.2 - - -
4.3 SP1 - Yes Yes

4.4 (SP3) No Yes Yes

Compatibility matrix

Figure 11-4 Backward compatibility: CMS 4.4 (SP3)

Figure 11-5 Backward compatibility: RCMS 4.4 (SP3)
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11.2.2 CMS 4.4 with RCMS server 4.3 SP1

11.2.2.1 Instructions and restrictions (CMS with RCMS (WinCC))
When you operate CMS 4.4 with RCMS 4.3 SP1, you must observe the following instructions 
and restrictions.

For further details on data transfer, the topology, and the RCMS station, please see observe the 
documentation of your RCMS server.

Limited transfer of messages and operational data
The following aspects must be considered when configuring the topology of CMS and RCMS:

Messages
Configuration of 5 CMS is considered below by way of example.

The following performance data from the WinCC documentation must be considered in 
particular:

Continuous message load without loss (single user/server) 10 messages s-1   
Message burst (single user/server) 2000 messages per 10 s-1   every 5 min1)

1) If the interval before the next message burst is under five minutes, messages may be lost.

The consequence of this is that, for example, for a total of 5 CMS per RCMS, the following limits 
apply to each CMS:

● No more than 2 messages per second on average can be transmitted simultaneously from 
each CMS station to the RCMS server.

● However, the WinCC system also provides a data buffer that can intercept a burst of 
messages for a short time (see table above -> Message burst). 

Operational data
The following performance data from the WinCC documentation must be considered in 
particular:

Archiving in database for server/single user ("Tag Logging 
Fast")

5000 s-1    2)

Archiving in database for server/single user ("Tag Logging 
Slow")

1000 s-1     2) 3)

2) The stated values apply to archiving without signing-off of data.
3) With "Tag Logging Slow," you must expect longer picture selection times for identical quantities than 

with "Tag Logging Fast."

This consequence of this is that, for a total of 5 CMS per RCMS, the following limits apply to 
each CMS:

● No more than 1000 values per second can be transmitted simultaneously from each CMS 
to the RCMS.
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In the CMS example application, all process values are archived in the Tag Logging Fast. The 
following quantities are applied per CMS: 

Process value 
archive

Number of tags Acquisition cycle Data rate CMS -> RCMS

MoveData 13 On average 1 move per mi‐
nute

13 min-1 ≈ 0.22 s-1

MMBFData 5 1 x per month 5 month-1 ≈ 2 * 10-6 s-1

CounterHourly 45 1 x per hour 45 hours-1 ≈ 12.5 * 10-3 s-1

TimerDaily 18 1 x per day 18 day-1 ≈ 2.1 * 10-4 s-1

     
  Total on the CMS ≈ 0.24 s-1

  Total on the RCMS ≈ 5 * 0.24 s-1 ≈ 1.25 s-1

It can be seen that only a fraction of the performance capacity is used by the CMS example 
application. This makes it possible to extend the tag logging of the individual CMS stations in 
the configuration.

Equivalent considerations apply to the topology with 25 CMS per RCMS. 
A maximum topology of 25 CMS per RCMS is currently defined.

Note

The performance limits of SIMATIC WinCC 7.4 also apply to the link between PLC and CMS.

Time synchronization is required between CMS and RCMS

NOTICE

Time synchronization is absolutely essential!

Data stamped with a time in the future cannot be archived in the RCMS archive.
If the clock of the CMS station is ahead of the RCMS server clock, it is not possible to archive 
data on the RCMS.

For this reason, time synchronization between the hardware modules is crucial in 
SIMOCRANE CMS/RCMS systems. 

See: Time synchronization (Page 156)

Limited length of the archive names and process tag names
On the RCMS, the archive name and process tag name are preceded by the crane name + "_" 
as a prefix.
Example "STSCrane1_MoveData"
Including this prefix, the archive name must not be longer than 32 characters and the process 
tag name not longer than 64 characters.
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"String" data type prohibited in archive tags

NOTICE

Data loss due to use of "String" data type in archive tags 

Use of the "String" data type in the definition of archive tags in tag logging archives is forbidden!

Only with WinCC 7.4.1 or higher may this data type be used in archive tags. 

Older WinCC versions cannot use this data type in tag logging archives. 

Errors will otherwise occur when data from XML files are entered in the tag logging archives 
of the RCMS server, resulting in rejection of the entire data set.

11.2.2.2 Setting the topology (CMS with RCMS (WinCC))
These instructions show you how to set up a CMS station, which is connected with a RCMS 
server 4.3 SP1.

For further information on the RCMS server, please also observe the documentation of your 
RCMS server.

Selecting the topology
1. Open the CMS Editor.

2. Open screen form "System" → "Basic settings" → "Topology".

Figure 11-6 Changing the topology

3. Select the setting "CMS with RCMS (WinCC)"

4. Confirm with "OK".
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Note
Close the CMS Editor

To apply the setting, close and re-open the CMS Editor.

Result
You have now defined a topology for a CMS station, which is connected to an RCMS server 4.3 
SP1.

You now only have to define the equipment type and the crane.
See: Defining the equipment type (CMS with RCMS (WinCC)) (Page 374)
See: Defining the crane (CMS with RCMS (WinCC)) (Page 376)

11.2.2.3 Defining the equipment type (CMS with RCMS (WinCC))
Each crane must be assigned to a certain equipment type. To do this, you must create an 
equipment type.

Note

This assignment must be identical on the CMS station and the RCMS server.
You will find further information in the documentation of your RCMS server.
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1. Open screen form "Topology" → "Equipment".

Figure 11-7 Defining the equipment type

2. Create a name for the equipment type.
The name of the equipment type must only contain letters and numerals.
The first character of the name must be a letter.

3. In the "Icons" field, select the icons for representing the cranes of this equipment type in the 
topology hierarchy.
The icons can be adapted.
See also: Settings: Icons (Page 203)

4. In the "Status values" field, define the relevant values of the crane status tag. 
The crane status tag is defined in screen form "Topology" → "Crane".
You can enter individual digits or ranges, each separated from the next by a semicolon. 
Ranges include the start and stop value and are linked by a minus sign. 
Spaces are allowed and the length of the number range is limited to 255 characters.

5. Under equipment information, select the WinCC tag for outputting the comment typical of 
the equipment.

Note

This function can be used, for example, to display an accompanying equipment-specific 
comment in a WinCC screen on the RCMS server for each crane.

6. Confirm with "OK".
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11.2.2.4 Defining the crane (CMS with RCMS (WinCC))

Note

Each crane must have been created both on the CMS station and on the RCMS server.

The following settings for the crane must be identical on the CMS station and on the RCMS 
server: 
● Name of the crane
● Equipment type of the crane
● Computer name of the CMS station
● Port number
● IP address NIC (if required)

You will find further information in the documentation of your RCMS server.

1. Open screen form "Topology" → "Cranes".

Figure 11-8 Entering cranes

2. Enter the name of the crane in the "Name" field.
The name of the crane must only contain letters and numerals. 
The first character of the name must be a letter.

3. Enter the computer name for the CMS station in the "Computer name" field.

Note

The computer name must not be exactly "CMS"! 
Also follow the WinCC guidelines for the assignment of computer names. 
The computer name and crane name can be identical

4. Select an equipment type in the "Equipment" field.

5. Specify the IP address of the associated RCMS server in the "IP-Address RCMS" field.
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6. In the field "Port number", enter the number of the port that is to be used for communication.

Note

Under Windows 2008, this communication port has to be activated manually.

See also: Activation of the communication port (CMS with RCMS (WinCC)) (Page 379)

7. If your PC has several network cards, the IP address via which communication is 
established must be written in the "IP address NIC" field.

8. In the field "Crane status tag", select the WinCC process tag in which the controller sends 
the status of the crane.

9. Specify the RCMS update cycles for messages and operational data.

10.Select "Crane is synchronized with RCMS". 
If this option is not selected, neither configuration data nor runtime data will be transferred.

11.Confirm with "OK".

12.Restart the CMS Runtime to activate the changes to the communication parameters.

11.2.2.5 Setting data transfer (CMS with RCMS (WinCC))
These instructions show you how to set the data transfer to a RCMS 4.3 SP1.

To ensure that the acquired data are transferred to the RCMS server, in the following screen 
forms you must select which data will be transferred: 

● CMS-RCMS data transfer: Transfer messages 

● CMS-RCMS data transfer: Transfer operational data 

● CMS-RCMS data transfer: Transfer Taglist

For further details on data transfer, please refer to the documentation of your RCMS server.

Sequence of steps
1. Open the CMS editor  

2. In the screen form "CMS-RCMS data transfer" → "Transfer messages", select the "Runtime" 
check box for all messages to be transferred to the RCMS server. 
See also: CMS-RCMS data transfer: Transfer messages (Page 192) 

3. In screen form "CMS-RCMS data transfer" → "Transfer operational data", select the 
"Runtime" check box for all operational data to be transferred to the RCMS server. 
See also: CMS-RCMS data transfer: Transfer operational data (Page 194) 

4. In the screen form "CMS-RCMS data transfer" → "Transfer Taglist", enter the acquisition 
interval for all tags to be transferred to the RCMS server.
Select the "Data transmission" check box to transfer the data to the RCMS server.
See also: CMS-RCMS data transfer: Transfer Taglist (Page 195) 
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11.2.2.6 Buffer for XML files and setting its storage limit (CMS with RCMS (WinCC))
These instructions show you how to set the buffer for XML files for data transfer to an RCMS 
4.3 SP1.

The buffer for the XML files can be limited in the CMS editor. CMS Runtime not only deletes the 
XML files in the transfer directories, but also deletes the files in the lower-level error directories, 
which are older than, for example, 30 days.

The CMS Runtime monitors the disk space as soon as you have activated CMS-RCMS data 
synchronization on the basis of XML files. 
If the free disk space falls below this lower limit when an XML file is written (data transferred to 
the RCMS server), the function for writing XML files will be stopped.

1. Open the "Computer" tab under System → Basic settings.

Figure 11-9 "Computer" tab

2. In the field "Maximum XML buffer", enter the number of days for which the XML files will be 
saved (e.g. 30 days).
Using the button "Clear buffer", you can empty the entire buffer with a single click.

Note

Do not use any method other than the "Clear buffer" button to delete the XML files and 
transfer directories. By doing this, you ensure that the system can continue to generate XML 
files.

If you delete the transfer directories manually, you might also delete the directory required 
for current XML files. This directory is created only once per day or when the CMS is 
restarted.

3. Enter the reserved disk space in megabytes ("MB") in the "Minimum disk space" field.
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11.2.2.7 Activation of the communication port (CMS with RCMS (WinCC))
These instructions show you how to set the communication port of a CMS station for 
communication with an RCMS 4.3 SP1.

To ensure CMS/RCMS communication, certain settings must first be made in the Windows 
firewall.

These instructions show you what settings of the Windows Firewall have to be made on the 
CMS station.

For information on setting the Windows Firewall on the RCMS server, observe the 
documentation of your RCMS.

Under Windows 7 / Windows 10:
The first time you start CMSRuntime.exe, with the firewall activated, the following window will 
appear:

Figure 11-10 Windows firewall is blocking CMSRuntime

Click the "Allow access" button to add CMSRuntime.exe to the white list. After that, you can set 
the firewall ports.
See also: Setting of the firewall port (CMS with RCMS (WinCC)) (Page 380)
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11.2.2.8 Setting of the firewall port (CMS with RCMS (WinCC))
These instructions explain which firewall ports have to be enabled on the CMS station to allow 
communication with a WinCC-based RCMS server.

1. In the CMS Editor on screen form "Topology" → "Cranes", select the port that will be used 
for communication between the RCMS and CSS.
Example: 
Port 1482 should be used for communication between CMS and RCMS.

Note

The same port must also be selected on the RCMS in screen form "Topology" → "Cranes"!

For further details on setting the Firewall ports on the RCMS server, observe the 
documentation of your RCMS server.

2. Open the advanced firewall settings. 

Figure 11-11 Windows firewall, inbound rules
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3. Create a new rule under "Inbound Rules" as shown in the following figures.

Figure 11-12 Create rule, step 1

Figure 11-13 Create rule, step 2
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Figure 11-14 Create rule, step 3

Figure 11-15 Create rule, step 4
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Figure 11-16 Create rule, step 5

4. Adapt the settings to any hardware firewall there may be between the CMS and RCMS 
computer so that the ports set in "Protocols and Ports" are activated.
Example: 
Release port "1482-1487" if you specified port 1482 in the CMS Editor in the screen form 
"Topology" → "Crane".

Note

In addition, port "24942" must always be released!
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Figure 11-17 CMS runtime properties

The firewall is now set up for communication between the RCMS server and CMS station.

11.2.2.9 Uploading / downloading configuration data (CMS with RCMS (WinCC))

General information on uploading / downloading configuration data (CMS with RCMS (WinCC))

Note

The upload and download function is only available for the topology "CMS with RCMS 
(WinCC)".

 The upload and download function is used to exchange and maintain the consistency of the 
configuration data between the cranes of a particular equipment type and the equipment type. 
Configuration of the RCMS server is simplified by transferring this configuration data between 
the cranes (CMS stations) and the equipment type on the RCMS server.  
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The upload and the download belong together. The process is only completed after the 
download.

● Upload: 
The upload sends the configuration data of a crane (CMS station) to the associated 
equipment type on the RCMS server. 

● Download: 
The download sends the configuration data of the equipment type from the RCMS server to 
the selected cranes (CMS stations). This operation completes the process.

These uploads and downloads are only performed between the cranes of one equipment type 
and the associated equipment type.  

The configuration data for the equipment type are located on the RCMS server. The 
configuration data for the cranes of the equipment type are located on the associated CMS 
stations.  

You can recognize any differences between the configuration data of the crane (CMS station) 
and the equipment type on the RCMS server by the color marking in the CMS Editor. 

Note

The upload or download overwrites the corresponding configuration data on the target 
computer. 
If additional configuration data are located on the target computer (for example, additional 
messages), they are retained on the target computer. 
WinCC tags that are used in messages and Tag Logging archives are not created by the 
download.

The crane status tag is not set on downloading! 
The crane status tag must be manually set for each CMS station in the screen form "Topology" 
→ "Cranes".

For further information on uploading and downloading, please also observe the documentation 
of your RCMS server.

What are configuration data?
Configuration data is configured data in the WinCC and CMS Editors. This configuration data 
is initially part of the WinCC project of the CMS stations. The configuration data of the 
equipment type are located on the RCMS server.

Configuration data are: 

● Topology data 

● WinCC messages (including message classes, message types, message blocks and group 
messages) 

● Maintenance instructions, which are assigned to one message 

● References, which are assigned to an equipment type, a crane, or a message 

● WinCC Tag Logging archives that are defined for the acquisition of move data 
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● WinCC Tag Logging archives that are defined for the acquisition of counter differences 

● WinCC Tag Logging archives that are defined for the acquisition of MMBF data

What configuration data are transferred?
This section shows what configuration data are transmitted during uploading or downloading. 
In the table, you will find detailed information on how the data on the RCMS server and the CMS 
station are handled.

Figure 11-18 Transferring configuration data

Type Upload (CMS → RCMS) Download (RCMS → CMS)
Topology On the RCMS, the topology data are overwritten. On the CMS station, the topology data are over‐

written.
Note:
Any WinCC tags that are used must exist, other‐
wise the download is canceled with an error.

Messages 
(incl. message 
classes, messages 
types, message 
blocks)

On the RCMS, existing messages are overwrit‐
ten and new messages are generated for each 
equipment type in the WinCC Alarm Logging. 
This adds an offset to the WinCC message num‐
bers. This offset is defined in the CMS Editor for 
each existing equipment type.
Message classes, message types, message 
blocks and group messages that are not yet 
available are automatically created.

On the CMS station, existing messages are over‐
written and new messages are generated in the 
WinCC Alarm Logging.  
In this case, the offset of the WinCC message 
numbers at the RCMS is subtracted.
Message classes, message types, message 
blocks and group messages that are not yet 
available are automatically created.
Note:
Any WinCC tags that are used must exist, other‐
wise the download is canceled with an error.

Maintenance instruc‐
tions

Existing maintenance instructions are overwrit‐
ten on the RCMS and are then created again.

Existing maintenance instructions are overwrit‐
ten on the CMS station and then created again.

Remarks on mainte‐
nance instructions

No synchronization No synchronization

References 
(programs and macros)

Existing references are overwritten on the RCMS 
and are created again.

Existing references are overwritten on the CMS 
station and then created again.
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Type Upload (CMS → RCMS) Download (RCMS → CMS)
Operating data ar‐
chives (move data, 
counter differences, 
MMBF data)

On the RCMS, the operational data archives are 
overwritten and new archives are created in the 
WinCC Tag Logging.  
The crane name followed by "_" is placed as a 
prefix in front of the archive name of the CMS 
station. 
The process tags used are created in the tag 
group "Crane name" (e.g. "STSCrane1"). If this 
group does not yet exist, it is created.

On the CMS station, the operational data ar‐
chives are overwritten and new archives are cre‐
ated in the WinCC Tag Logging. 
The crane name prefix followed by "_" is re‐
moved. 
Note:
Any WinCC tags that are used must exist, other‐
wise the download is canceled with an error.

Tags 
(tags, structure tags, 
and structure types)

A structure type is created on the RCMS with the 
tags defined in the tag list of the CMS station.
A structure type is created for each equipment 
type. The name of the structure is the equipment 
type with the prefix "@CMS" (e.g. 
@CMSSTSCrane).
In addition, a WinCC structure tag is generated 
with the crane name as the tag prefix from this 
type (e.g. "STSCrane1.tag1", …). The tag is cre‐
ated in the tag group "Crane name" 
(e.g."STSCrane1"). If this group does not yet ex‐
ist, it is created.

Note: 
WinCC tags that are used must exist, otherwise 
the download is canceled with an error.

Uploading / downloading configuration data (CMS with RCMS (WinCC))

Note

The upload and download function is only available for the topology "CMS with RCMS 
(WinCC)".

When you set up a new RCMS project, it does not initially contain any configuration data for the 
crane. To simplify configuration at the RCMS server, particularly for large quantities, we 
recommend the following procedure.

For further information on uploading and downloading, please also observe the documentation 
of your RCMS server.

Sequence of steps
1. Create the topology on the CMS stations.

See Setting the topology (CMS with RCMS (WinCC)) (Page 373)

2. Configure one CMS station per equipment type.

Note

If you created additional tags during configuration, create these additionally required tags on 
all CMS stations of the same equipment type.
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3. Select all configuration data on the CMS station that is to be transferred to the RCMS server.
See: Operating data: Move data (Page 186)
See: Operating data: Counters (Page 189)
See: Operating data: MMBF (Page 191)

4. Perform an upload for this CMS station to transfer the configuration data to the RCMS 
server.
See: CMS-RCMS data transfer: Upload (CMS station) (Page 197)

5. If necessary, adapt the configuration data to the equipment type on the RCMS server.

Note

If you created additional tags during configuration, create these additionally required tags on 
all CMS stations of the same equipment type.

6. Perform a download for all CMS stations of one equipment type.
For further information on downloading, please also observe the documentation of your 
RCMS server.

Note

The crane status tag is not set on downloading! 
The crane status tag must be manually set for each CMS station in screen form "Topology" 
→ "Cranes"!

Result
All CMS stations of one equipment type are now consistent.

11.2.2.10 Renaming cranes retrospectively (CMS with RCMS (WinCC))

Note
Loss of archive data

If you subsequently change the crane name, then you create a new entry for this crane on the 
RCMS server. This new entry has no link to the archive data that has been acquired up till then. 
From now on all archive data is written to a new archive! 

Only change the crane name in exceptional situations!

Follow the sequence of steps given below if you wish to rename a crane retrospectively in a 
CMS / RCMS scenario:

1. On the CMS station: 
Open the "Topology" → "Cranes" dialog and change the name of the crane.

2. On the RCMS station:
Open the "Topology" → "Cranes" dialog and change the name of the crane.

3. On the CMS station: 
Open the "CMS-RCMS data transfer" → "Upload" dialog and perform an upload.

You have now successfully renamed the crane.
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11.2.2.11 System messages (CMS with RCMS (WinCC))
CMS Runtime displays general execution and error information in the CMS system messages. 
These system messages use reserved message classes that are created in the WinCC Alarm 
Logging. The messages of these classes only use the status "came in". 

Message class 15 "CMSTimeZone"

This message class contains the following message type:

● CMSTimeZoneWarning: Message type 225 

Message class 16 "CMS"

This message class contains the following message types:

● CMS_Fault: Message type 241

● CMS_Warning: Message type 242

● CMS_Info: Message type 243

The system messages have an offset of 50000 in the WinCC Alarm Logging.

Table 11-1 CMS system messages

Message 
number

Message type Message text
(user text block 5)

Messages at the CMS station and at the RCMS server
50000 CMS_Info Crane name: Configuration data upload has been started.
50001 CMS_Fault Crane name: Configuration data upload completed with errors.
50002 CMS_Info Crane name: Configuration data upload successfully completed.

Additional messages at the CMS station
50200 CMS_Info n XML files were deleted from the transfer directories.
50201 CMS_Info n XML files were deleted from the error directories.
50210 CMS_Info Connection to the RCMS server established.
50211 CMS_Info Connection to the RCMS server disconnected.
50212 CMS_Info Connection to WinCC Runtime established.
50213 CMS_Info Connection to WinCC Runtime aborted.
50220 CMS_Info Crane name: Configuration data download started.
50221 CMS_Fault Crane name: Configuration data download completed with errors.
50222 CMS_Info Crane name: Configuration data download successfully completed.
Time zone warnings
50400 CMSTimeZo‐

neWarning:
MMBF: PLC time stamp invalid, replaced by current PC time.

50401 CMSTimeZo‐
neWarning:

MoveData: PLC time stamp invalid, replaced by current PC time.

Additional messages at the RCMS server
50510 CMS_Info Crane name: Connection established.
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Message 
number

Message type Message text
(user text block 5)

50511 CMS_Info Crane name: Connection aborted.
50512 CMS_Info Connection to WinCC Runtime established.
50513 CMS_Info Connection to WinCC Runtime aborted.

11.2.3 CMS 4.3 with RCMS 4.4 web application

You can connect a CMS 4.3 to the Process Historian. In this way, a RCMS 4.4 web application 
can read the data from the Process Historian.

For this purpose, you need to consider the following:

● You must set the topology of the CMS 4.3 to "CMS without RCMS Server"
See the documentation of your CMS 4.3 

● You must configure the CMS 4.3 like a CMS 4.4 in topology "CMS with RCMS (Process 
Historian)".
See also: Configuring a CMS station (Page 99)

● You must connect the CMS 4.3 to Process Historian
See also: Connecting CMS station to Process Historian (Page 110)
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11.3 Migration of existing projects

11.3.1 General information about migrating projects
In order to be able to use a project that runs under an older WinCC version (WinCC 7.0.x or 
higher), you must migrate this.

Note
Backup required!

A number of tables need to be deleted for the purposes of migration.

The contents of these tables have to be restored again from the backup file.

See also: Creating a backup (Page 367)

Note

The Replay function has been added to CMS V4.2. 

If you want to use the Replay function for projects from CMS V.4.1 SP1, you must configure 
these accordingly. 

See also: The Replay function (Page 303)

Note

Current projects are only released for use with the current version of SIMOCRANE CMS. 

It is not permissible that they are migrated to previous versions of SIMOCRANE CMS and 
operated.
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11.3.2 Preparing for migration
1. Create a backup copy of the project.

Note
Backup copy of the project recommended!

If migration cannot be performed successfully, it is necessary to have a copy of the original 
project.  
● Store the backup copy in a safe place. 
● Make sure that the backup copy cannot be changed before you continue.

2. Make a backup copy of the project.
See: Creating a backup (Page 367)

Note
Backup required!

A number of tables need to be deleted for the purposes of migration.

The contents of these tables have to be restored again from the backup file.

3. Make sure that the following conditions are fulfilled:

– CMS Runtime has been stopped

– WinCC Runtime has been stopped

– The WinCC project is closed.

– The WinCC Explorer is closed 
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4. Open the "SQL Server 2014 Management Studio" as an administrator.

Note

You can find the SQL Server 2014 Management Studio by clicking on Start and searching 
for "SQL Server 2014 Management Studio".

In order to launch this program as an administrator, click on the option "Run as 
administrator" in the shortcut menu for the executable file.
If a prompt appears asking whether you will allow the program to make changes to your 
computer, confirm with OK.

The "Connect to Server" dialog box appears.

Figure 11-19 Migration, step 1

5. Select the setting "Windows Authentication" and click on "Connect".

6. Right click on "Databases" and then select "Attach...". 

Figure 11-20 Connecting a database
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7. Click on "Add…".

Figure 11-21 Adding a database

8. Navigate to the WinCC project folder of the project to be migrated. 

9. In the project folder, select the database (mdf file) with a name does NOT end in "RT," and 
confirm with "OK." 

Figure 11-22 Selecting the database without the ending "...RT"

The name of the added database is displayed in the "Attach As" column. 
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10.Confirm with "OK".

11.Click on "View" → "Object Explorer Details".

Figure 11-23 Setting the detailed view in the Object Explorer.

12.Expand the database (with the + symbol) and click on "Tables."
 All the tables in the database appear in the right hand section of the window. 

Figure 11-24 Selecting tables in the database

13.Select all tables with a name starting "CMS."
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14.Press the Delete key and confirm the delete operation by clicking on "OK".
The selected tables are deleted. Some tables may remain undeleted because of 
dependencies between the tables.

Figure 11-25 Deleting the tables

15.Click on "OK" again to delete the remaining entries.
Now, no tables should be listed that have a name starting "CMS."

16.Ignore the message indicating the errors have been found.
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17.Click on "Views". 
All the views in the database appear in the right hand portion of the window.

Figure 11-26 Migration, step 6.5

18.Select all views with a name starting "CMS."

19.Press the Del key.
The selected views are deleted.

20.Right click on the database and select "Tasks" → "Detach" in order to detach the link to the 
database.

Figure 11-27 Detaching from the database.

Note
The connection must be detached!

If you do not disconnect from the database, the WinCC Project Migrator will cancel migration 
with an error message.
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21.Close the "SQL Server Management Studio".

22.Using the "WinCC Project Migrator", you can now migrate the old CMS project.
See: Migrating the project (Page 398)

11.3.3 Migrating the project

Preliminary remark
When migrating using the WinCC Project Migrator, there is no difference between single-user 
projects, multi-user projects, and clients with a dedicated project.

The projects are migrated to UNICODE. Tables that do not originate from WinCC are not 
migrated.

The time required depends on the size of the project to be migrated and the performance of the 
computer used. The time required for migration of the Runtime data varies according to the 
number of messages and tags. It can take several hours.

Note

Note that WinCC 7.4 SP1 Update 11 and CMS 4.4 SP3 must be installed before you can 
perform the following steps.

Procedure
Make sure that the following conditions are fulfilled:

● WinCC 7.4 SP1 Update 11 and CMS 4.4 SP3 are installed.
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1. Open WinCC "Project Migrator".

Note

You can find the WinCC "Project Migrator" by clicking Start and searching for "Project 
Migrator".

The start window of the Project Migrator "CCMigrator - Step 1 of 2" opens.

Figure 11-28 CCMigrator - step 1 of 2

2. Select the project directory in which the WinCC project is located by clicking the "..." button. 
If you want to migrate more than one project in one step, select the path with the directories 
containing the WinCC projects.

3. Set the language of the computer on which the project or projects were created. The default 
setting is the language version defined in the language options of the operating system for 
non-Unicode programs or in the system locale. 
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4. Click the "Migrate" button. 
The window "CCMigrator - Step 2 of 2" opens. The Project Migrator shows the steps of the 
migration. Wait until the migration has been successfully completed. Migration of a project 
can take several hours. 

– If the following error message is displayed, an error has occurred during preparation of 
the migration.
You must perform the entire migration again with the backup copy of the project.
See: Preparing for migration (Page 392)

– If the following error message is displayed, this could mean that the connection between 
the Microsoft SQL Server and the database was not detached.
Detach the Microsoft SQL Server from the database and start migration again. 
See: Preparing for migration (Page 392)

5. When the migration is completed successfully, the Project Migrator displays the message: 
"WinCC project successfully migrated." 

6. Click the "Finish" button.

7. Restart CMS Runtime.
This will ensure that the deleted tables are restored in the database.

8. Import the backup.
See: Importing the backup (Page 368)

9. Set a suitable topology for the CMS station.
See also: Setting the topology (Page 106)
See also: Setting the topology (CMS with RCMS (WinCC)) (Page 373)
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Administering hardware and software 12
12.1 General

This chapter describes PC configuration within the entire CMS topology. This includes the 
computers of the CMS level and the computers of the RCMS level. Two aspects are highlighted 
during configuration:

● Autostart of the computer and all applications

● Security settings

The PC forms the basis of the SCADA system. Most users should only have access to the 
operator control and monitoring functions of the CMS application.
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12.2 PC configuration of the CMS station

Software installation
● Before installing the software packages, define the definitive name of the computer for the 

local CMS station.

Note

Please note that the computer name cannot be precisely called "CMS". 

You should also observe the WinCC guidelines for the assignment of computer names. If 
the computer name should be the same as the crane name, then it may contain letters and 
numbers only. The first character of the computer name must be a letter.

● Assign the computer's IP address according to your network configuration.

● Install the software packages required on the PC. Note the installation instructions for the 
respective software.

Table 12-1 Software packages on the local CMS station

Prerequisite Software component
General SIMATIC WinCC

SIMOCRANE CMS for CMS
For Web Navigator access WinCC / WebNavigator Server

Automatic start
● Autostart of PC as soon as there is a supply voltage: You can define how the PC behaves 

in its BIOS.

– Set the boot behavior such that the PC starts up automatically as soon as there is a 
supply voltage.

● Automatic Windows user log-on

– Set up automatic user log-on as described in Chapter Automatic user logon in Windows 
(Page 407).
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● Automatic activation of the WinCC project: Launch the CMS example application using the 
WinCC "AutoStart Configuration" application.

– From the Windows start menu, start "AutoStart Configuration".

– Enter the path to the WinCC project in the "Project" field.

– Set check mark for "Activate Project at Startup".

– Remove check mark from "Allow "Cancel" during activation".

– Enter the WinCC AutoStart Configuration application in the Windows autostart ("Add to 
AutoStart") button.

Figure 12-1 WinCC AutoStart Configuration

● Automatic activation of the WinCC options: You can enter the WinCC optional packages 
and add-ons (e.g. SIMOCRANE CMS) in the WinCC startup list.

– Use "Computer properties" and "Startup" tab to open the startup list.

– "Add…" opens the "Applications to add" window.

– Enter the path and startup parameters of the application you want here.

Security settings
You can make most of the security settings in WinCC-Explorer under "Computer settings".

● Open the "Computer properties" in WinCC Explorer by selecting "Computer" → "Properties".

● Open the "Parameters" tab.
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● Under "Disable Keys" you can deactivate a series of shortcuts which the user can use to 
access Window components from the CMS user interface. Do this by removing the check 
mark from the selection boxes.

Figure 12-2 WinCC computer properties, "Parameters" tab

● Open the "Graphics Runtime" tab.
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● You can set attributes for the graphics window in the "Window Attributes" field. Select the 
"Full Screen" attribute. The WinCC graphics runtime environment is then shown in full 
screen. The Windows user interface cannot be seen.

● You can deactivate various functions in the "Turn Off" field. Select the "Alt-F4" function to 
prevent the user interface being closed using the Alt-F4 shortcut.

Figure 12-3 WinCC computer properties, "Graphics Runtime" tab
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12.3 PC configuration of the web client station

Software installation
1. Before installing the software packages, define the definitive name of the PC for the web 

client station.

2. Assign the PC's IP address according to your network configuration.

3. Install the software packages required on the PC. Note the installation instructions for the 
individual components. These software components are:

Table 12-2 Software packages on the web client station

Prerequisite Software component
General WinCC/Web Navigator Client

SIMOCRANE CMS for the web client
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12.4 User administration

12.4.1 Information for Windows users
You must set up one main user and password on all PCs. 

● Create a user with the same username and password on all the CMS stations.

● The user must have administrator rights.

● Refer to the WinCC documentation to check all other user rights required.

12.4.2 Automatic user logon in Windows
You can set up automatic logon for a Windows user upon the system starting in the user 
accounts:

1. Select "Start" → "Run" → "control userpasswords2" to access the "User accounts".

Figure 12-4 Windows user accounts

2. Remove the check mark from "User must enter a user name and password to use this 
computer".

3. When you click on "OK", the dialog appears for entering the user who is to be automatically 
logged on when the computer starts.

4. Enter the user's name and password for logging on.
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Service and maintenance 13
13.1 Checking the data volume

13.1.1 Log files
The CMS Runtime produces log files on the local crane station to output error messages, 
operating processes and import processes. The error log (*.err) only contains an entry if an 
error has occurred. The trace (*.out) very quickly absorbs a huge volume of data because the 
CMS Runtime writes a lot of output to the file for diagnostics purposes. A new file is created in 
the specified directory for each month. The default setting for the directory creates the log files 
in the "CMS" sub-folder in the WinCC project directory.

You can block or re-enable the output to the log files in the CMS editor. We would strongly 
recommend blocking the outputs to the trace log file during operation and only using this 
diagnostic function for commissioning. If you don't do this, huge volumes of data will collect 
because old files are not automatically deleted. 

You can also prohibit the output of error logs to the error file. 

Figure 13-1 Enabling/blocking log files in the CMS editor

1. Open the CMS editor in WinCC Explorer.

2. Navigate to "System" → "Basic settings" → "Trace".

3. Remove the check mark from the "Enable" box for "Trace" and also for the "Error Log" and 
"Import Log" if necessary.
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13.2 Data archiving and backup

13.2.1 Backup of WinCC messages
Messages archived in WinCC can be swapped out of the archive database (WinCC Alarm 
Logging) as a backup. You can configure the swap-out in the archive manager of WinCC Alarm 
Logging.

13.2.2 Backup of WinCC process values
Process values in WinCC can be swapped out of the archive database (WinCC Tag Logging) 
as a backup. You can configure the swap-out in the archive manager of WinCC Tag Logging.

13.2.3 Backup of user data in the CMS editor
You can save all your user data in the CMS editor as a backup.

You will find the backup function under "Settings" → "Maintenance". Here you can back up data, 
restore backed up data and reset the CMS database contents to the CMS delivery condition.

Figure 13-2 Backup of user data in the CMS editor
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Appendix A
A.1 Design guidelines

A.1.1 Introduction
The design guidelines form the basis of the CMS example applications in the interests of 
creating a standard and easily recognizable look and feel. The guidelines relating to the 
external look of the user interface should apply to all crane applications both on the crane itself 
and as the central terminal application.

The user interface should always ensure user-friendly operation. The needs of different end 
users (crane drivers, maintenance technicians, terminal operators) should be satisfied in 
particular. The design guideline aims to provide simple rules and concepts to also simplify 
configuration.

A.1.2 Screen design and layout
The layout of the CMS example applications deviates from the standard WinCC screen design. 
The concept is based on the idea of always giving the viewer a familiar framework which helps 
him or her find their way around the CMS user interface.

Symbolic displays rather than realistic graphics:

One design aspect is the use of simple but meaningful symbols to display screen objects. Using 
just a few graphic details produces an independent look. 

Reduction in volume of information on display

The less information is displayed, the faster it can be taken in by the observer. The user 
interface screens shouldn't be used to pack as much information as possible onto the screen 
area provided. On the contrary, that information which the crane driver or service technician 
needs to reliably perform his work is displayed. Detailed information can also be called up if 
necessary.

Touch operation

The CMS is designed for touch operations, i.e. a mouse isn't used, the user simply touches the 
on-screen keypad. In terms of size, the control buttons are large enough that they can be 
operated by people wearing gloves. Simple settings can usually be undertaken using just one 
button.
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A.1.3 Navigation
All screen navigation in the user interface is controlled using internal tags and picture windows. 
The user interface is split by hierarchy into four levels. All picture windows are in the 
@CMSRootxyz.pdl start screen. A picture tag is assigned to each picture window, which 
dynamizes its screen content. The tag content is controlled using the navigation bars for the first 
and second screen levels and using elements in the screen content for the third and fourth 
levels. 

The fourth level simply contains the selection dialogs for the user.

Figure A-1 Navigation

A.1.4 Color scheme
The color palette for the user interfaces has been reduced to a limited number of colors, based 
on the workbench design.
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The static elements or normal operating modes are shown in a few colors from one family of 
colors (gray). Their job is to show the position of the components and not to stand out from the 
background.

Process values within the normal range and normal component operating modes are indicated 
by a few colors of another family of colors (blue) which clearly do stand out from the static 
background. 

These unobtrusive gray and blue shades put the least strain on the human eye.

Using unobtrusive colors for static elements and normal operating modes means that the 
observer can quickly see fault states which stand out due to the use of high-contrast color 
shades when the components are not the focus of his or her field of vision.

Figure A-2 CMS color palette
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A.1.5 Naming conventions
Naming conventions for all parts of the project make it easier for the configuration to be traced. 
When using WinCC and its extensive functionality as a SCADA system, it is a good idea to 
observe the guidelines for naming throughout the project.

The naming conventions include:

● Tag names in the tag management (external and internal tags)

● Screen names for WinCC graphics

● Procedure names for project functions and actions

● Tag names within procedures

● Names for objects in WinCC graphics

The following applies: The more meaningful the element designations, the easier it is to 
navigate in a project. All designations are in English. Note that it is very hard to read extremely 
long names. We would therefore recommend using clear abbreviations for long names which 
are used frequently (e.g. "Res" for reset). But if using an abbreviation be sure to consistently 
use this abbreviation for the same expression.

The names are structured so that individual words are split by using a combination of upper and 
lower case (e.g. blnMoveTrigger).

Naming convention for tags

Tags in the tag management for the automation system or within procedures are designated 
such that both their type and wherever possible the components they are assigned to are 
clearly recognizable. Both parts are preceded by a meaningful designation.

 Type + component + designation → e.g.: blnMoveTrigger

In scripts all WinCC tags used are defined at the start (#define). The prefix for the tags in the 
definition section is "tag".

Table A-1 Naming conventions for tags

Type Type abbreviation as prefix Example
Bool(ean) bln blnMoveTrigger
Byte byt bytHoistStateMotor
Short srt srtHoistCurrent
Word wrd wrdHoistStateDrive
Integer int intHoistCurrent
Double Word dwd dwdCounterReset
Long lng lngHoistDistance
Character chr chrPictureName
Tag tag tagPictureName

Naming convention for internal system tags

The internal CMS system tags are used for screen navigation, selecting objects or for general 
settings. They have the @CMS prefix. This prefix suggests that a system tag labeled in this way 

Appendix
A.1 Design guidelines

Crane Management System (CMS)
414 System Manual, 11/2019



should be neither deleted nor changed. If they are deleted or changed, malfunctions may arise 
within the screens.

 @CMS + designation → e.g.: @CMSMainPic

Naming convention for WinCC graphics

Just the same as the designation of internal tags, all CMS navigation screens in an example 
application start with the system prefix @CMS, e.g. @CMSMenu1.PDL.  

Naming conventions for objects in WinCC graphics

Regardless of the HMI product used, as well as observing the conventions for naming tags and 
scripts, attention should also be paid to conventions for naming screen objects. Through the 
introduction of graphic standard objects (such as square-wave, line etc.), most HMI products 
support an object-focused development process. 

The function of an object can therefore be recognized in the way all objects are depicted in the 
screen. Incorrectly inserted objects, which bear the standard name, can also be delimited.

The table below shows naming conventions for objects in WinCC screens.

Table A-2 Naming conventions for screen objects

Type Type abbreviation as pre‐
fix

Example

Button btn btnCloseWindow
Control ctrl ctrlTrend
Graphic Object gco gcoCrane
Line lin linBorder
Picture Window pic picMainWindow
Rectangle rcl rclBorder
Status Display std stdMotor1
Text txt txtCounterName

Naming conventions for procedures ("Scripting")

The body of all tag / procedure names should be meaningful and reflect the tag function as well 
as possible. Procedure names should also start with a verb which contains the functionality 
realized, such as "InitNameArray" or "CloseDialog". 

A.1.6 Code conventions
Code conventions are suggestions which aim to help you write VBS or C code for procedures 
and actions.

All the procedures (project functions) and global actions created should start with a brief 
comments header (see below), which briefly summarizes their functionality. Detailed 
descriptions should be moved to the code itself so that minor changes to code do not have to 
be constantly made in the header.

Function parameters in particular should be described in the header if their function is not clear 
from the name or if the procedure only permits certain values or value ranges. The same 
applies to return values and WinCC tags which are changed by the procedure.
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Another key component of the comment header is the tracking of changes, with a product brief 
of the modifications made and an entry for the date and author for possible queries.

/////////////////////////////////////////////////////////////////
// Author: 
//
// Version: 
//
// Date:
//
// Function:
//    
// Parameters:
//
// Return values:
//
///////////////////////////////////////////////////////////////

///////////////////////////////////////////////////////////////
//
// Change Log:
//
//    -DATE-         -AUTHOR-         -DESCRIPTION-
//
///////////////////////////////////////////////////////////////

A.1.7 Conventions for the screen structure

Screen levels
When producing the screen structure in the WinCC Graphics Designer, we would recommend 
using the WinCC principle of levels. The principle improves clarity during configuration.

Levels 1-7 were given preference in application projects. The conventions shown in the table 
have been used in these. In exceptional cases (due to the nesting of objects), there have been 
deviations from the convention:

Description Level
Static background elements, screen frame 1-2
Static texts 2-3
Dynamic screen elements which cannot be operated 4
Screen elements which can be operated 5
Controls 6
Screen window 7
Faceplates and types 8
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Description Level
Superimposed elements 12
Invisible elements 15

Font sizes
To ensure a standard look, it is essential to keep the font sizes uniform. The following font sizes 
have been used in CMS example applications for a screen resolution of 1024 x 1280:

Designation Size Bold Underlined Use
Standard text 14 + - Standard I/O fields, standard texts
Standard title 14 + + Title for linked groups of I/O fields
Window title 1 16 + - Window title of detail and dialog windows
Text 1 18 + - Highlighting of important information / process 

values (I/O fields, texts)
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A.2 XML import formats

A.2.1 General information
All import and export formats are structured as follows:

 Basic structure of the import and export formats:
<?xml version="1.0" standalone="yes"?>
 <TableName-ExportDate>
  <TableName>
   <AttributeName>attribute_value</AttributeName>
   ...
  </TableName>
  <CMS_SYS_TBL_Version>
   <MajorNumber>1</MajorNumber>
   <MinorNumber>0</MinorNumber>
   <Revision>4</Revision>
  </CMS_SYS_TBL_Version>
 </TableName-ExportDate>

The tag names are case-sensitive, i.e. they differentiate between upper-case and lower-case 
letters. All mandatory fields must be filled in, optional fields can be left empty or excluded 
completely. 

The coding format of the export date in the root tag of the export file is as follows: 
yyyy-mm-dd_HH-MM-SS
(yyyy: four-digit year;  mm: Month;   dd: Day;   HH: Hours;   MM: Minutes;   SS: seconds)

The database version used to create the XML file is output in each XML file. These details must 
not be deleted or changed. If necessary, this version information can also be used for the 
purpose of importing XML files that are compatible with all versions once changes have been 
made to the database pattern.

Note

The database version is not listed in all of the following examples.
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A.2.2 Terminals
Table name: CMS_TOP_TBL_Terminals

Table A-3 Terminals

XML tag Meaning Format Mandatory 
field

TerminalName Name of the terminal Text yes
IconName Name of the icon assigned to the terminal Text yes
Comment Optional comment Text no

Example:
<CMS_TOP_TBL_Terminals-2007-12-30_14-45-45>
 <CMS_TOP_TBL_Terminals>
  <TerminalName>Terminal 1</TerminalName>
  <IconName>Terminal</IconName>
 </CMS_TOP_TBL_Terminals>
</CMS_TOP_TBL_Terminals-2007-12-30_14-45-45>

A.2.3 Equipment types
Table name: CMS_TOP_TBL_Equipments

Table A-4 Equipment types

XML tag  Meaning Format Mandatory 
field

EquipmentName Name of the equipment type Text yes
IconName Name of the icons assigned to the equipment 

type
Text yes

Description Equipment-specific comment to be displayed in 
a WinCC screen

Text no

WinCCTag Name of a WinCC tag for displaying an equip‐
ment-specific comment

Text no

BandConditionFault Range of numbers for "Fault" status Text no
BandConditionOk Range of numbers for "OK" status Text no
BandConditionStandby Range of numbers for "Idle" status Text no
BandConditionWarning Range of numbers for "Warning" status Text no
OffsetMessageNumber Offset for WinCC message numbers in the 

WinCC Alarm Logging
Numeric yes

Comment Optional comment Text no
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Example:
CMS_TOP_TBL_Equipments-2010-09-07_14-27-35>
 <CMS_TOP_TBL_Equipments>
  <EquipmentName>STSCrane</EquipmentName>
  <IconName>Crane</IconName>
  <Description>80 tons</Description>
  <WinCCTag>Eq_Desc</WinCCTag>
  <BandConditionFault>128</BandConditionFault>
  <BandConditionOk>1</BandConditionOk>
  <BandConditionStandby>2-32</BandConditionStandby>
  <BandConditionWarning>64</BandConditionWarning>
  <OffsetMessageNumber>1000</OffsetMessageNumber>
 </CMS_TOP_TBL_Equipments>
</CMS_TOP_TBL_Equipments-2010-09-07_14-27-35>

A.2.4 Cranes
Table name: CMS_TOP_TBL_Nodes

Table A-5 Cranes

XML tag Meaning Format Mandatory field
TerminalName Identifier of terminal to which the crane is assigned Text yes
EquipmentName Identifier of the equipment type to which the crane is as‐

signed
Text yes

NodeName Name of the crane Text yes
ComputerName Name of the computer on which the CMS is running Text yes
IPAddress IP address of the relevant link partner Text yes
PortNumber Number of the port used for communication with the RCMS Numeric yes
IPAddressNIC IP address of the network card, via which the CMS station is 

connected with the RCMS server. 
This setting must only be made for the topology "CMS with 
RCMS (WinCC)".

Text no

isNodeViaTCPIP Crane is linked to RCMS via TCP/IP true/false yes
isServer Identifier indicating whether this involves an RCMS server true/false yes
TagNodeState Name of a WinCC tag that can be used to read the crane 

status for controlling the display of the crane in the CMS No‐
deTree control.

Text no
(for CMS sta‐

tion)
SyncIntervalMessages Interval in seconds where messages are transferred to the 

RCMS
Numeric yes

(for CMS sta‐
tion)

SyncIntervalOperationalData Interval in seconds where operating data (such as move 
data, MMBF data, etc.) is transferred to the RCMS

Numeric yes
(for CMS sta‐

tion)
Comment Optional comment Text no
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Example
<CMS_TOP_TBL_Nodes>
     <TerminalName>Terminal1</TerminalName>
     <EquipmentName>RCMS</EquipmentName>
     <NodeName>RCMSServer</NodeName>
     <ComputerName>RCMS01</ComputerName>
     <IPAddress>192.168.11.1</IPAddress>
     <PortNumber>1482</PortNumber>
     <isNodeViaTCPIP>false</isNodeViaTCPIP>
     <isServer>true</isServer>
     <isDataTransformNeeded>false</isDataTransformNeeded>
     <Comment>RCMS Server PC</Comment>
</CMS_TOP_TBL_Nodes>
<CMS_TOP_TBL_Nodes>
     <TerminalName>Terminal1</TerminalName>
     <EquipmentName>STSCrane</EquipmentName>
     <NodeName>STSCrane1</NodeName>
     <ComputerName>CMS01</ComputerName>
     <IPAddress>192.168.11.10</IPAddress>
     <PortNumber>1482</PortNumber>
     <isNodeViaTCPIP>true</isNodeViaTCPIP>
     <isServer>false</isServer>
     <TagNodeState>Kran1.wrdCraneStatus</TagNodeState>
     <isDataTransformNeeded>false</isDataTransformNeeded>
     <SyncIntervalMessages>10</SyncIntervalMessages>
     <SyncIntervalOperationalData>10</SyncIntervalOperationalData>
     <Comment>CMS-Station of STSCrane1</Comment>
</CMS_TOP_TBL_Nodes>

A.2.5 Maintenance instructions
Table name: CMS_MSG_TBL_Causes

Table A-6 Maintenance instructions

XML tag Meaning Format Mandatory 
field

Description Maintenance instruction text Text yes
EquipmentName Identifier of the equipment type to which the crane 

is assigned
Text yes

PossibleCause Description of the possible cause of the fault Text no
PossibleRemedy Description of a possible repair measure Text no
Comment Comment on the maintenance instruction, is also 

displayed in CMSFaults.
Text no

Example:
<CMS_MSG_TBL_Causes-2010-09-07_14-09-12>
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Example:
 <CMS_MSG_TBL_Causes>
  <Description> Crane 4711 elevator jerks</Description>
  <PossibleCause> Cause2</PossibleCause>
  <PossibleRemedy> Remedy2</PossibleRemedy>
  <Comment> Comment2</Comment>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_MSG_TBL_Causes>
</CMS_MSG_TBL_Causes-2010-09-07_14-09-12>

A.2.6 Comments on maintenance instructions
Table name: CMS_LOG_TBL_LogEntries

Table A-7 Logbook

XML Tag Meaning Format Mandatory 
field

Author Name of the author Text yes
DateTimeEntered Date entered Date yes
Scope Indicates whether the comment is assigned to a 

message or a maintenance instruction text (only 
"Message" can be specified).

Text yes

Entry Comment text or logbook entry text Text no

Example:
<CMS_LOG_TBL_LogEntries-2007-12-30_14-45-45>
 <CMS_LOG_TBL_LogEntries>
  <Author>Adam</Author>
  <DateTimeEntered>2000-12-30T17:56:12+01:00</DateTimeEntered>
  <Entry>Entry</Entry>
  <Scope>Message</Scope>
 </CMS_LOG_TBL_LogEntries>
</CMS_TOP_TBL_LogEntries-2007-12-30_14-45-45>

A.2.7 Assignment of comments to maintenance instructions
Table name: CMS_MSG_TBL_AssignLog

Table A-8 Assignment of comments to maintenance instructions

XML Tag Meaning Format Mandatory field
Author Name of the author Text yes
DateTimeEntered Date entered Date yes
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XML Tag Meaning Format Mandatory field
ColumnName Column where an entry was made

(PossibleCause, PossibleRemedy, Comment )
Text yes

SourceType Type of assignment
(Message, Cause)

Text yes

SourceName Name of the element that is assigned to the the 
comment (WinCC message number, name of the 
maintenance instruction)

Text yes

Example:
<CMS_LOG_TBL_AssignLog-2011-01-31_10-15-31>
 <CMS_LOG_TBL_AssignLog>
  <DateTimeEntered>2000-12-30T17:56:12+01:00</DateTimeEntered>
  <Author>Adam</Author>
  <ColumnName>Comment</ColumnName>
  <SourceType>Message</SourceType>
  <SourceName>1</SourceName>
 </CMS_LOG_TBL_AssignLog>
</CMS_LOG_TBL_AssignLog-2011-01-31_10-15-31>

A.2.8 Assignment of maintenance instructions
Table name: CMS_MSG_TBL_AssignCause

Table A-9 Assignment of maintenance instructions

XML tag Meaning Format Mandatory 
field

Description Name of the maintenance instruction that is as‐
signed

Text yes

EquipmentName Identifier of the equipment type to which the 
crane is assigned

Text yes

MessageNumber Message number from WinCC Numeric yes

Multiple items of information must be linked when maintenance instructions are assigned. 
Firstly, the maintenance instruction must be uniquely identifiable. This is achieved by 
specifying the maintenance instruction identifier. Secondly, the object to which the 
maintenance instruction is assigned must be exactly specified. 

Example:
<CMS_MSG_TBL_AssignCause-2010-09-07_13-50-08>
 <CMS_MSG_TBL_AssignCause>
  <Description>Crane 4711 Limit switch tripped</Description>
  <EquipmentName>STSCrane</EquipmentName>
  <MessageNumber>1</MessageNumber>
 </CMS_MSG_TBL_AssignCause>
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Example:
</CMS_MSG_TBL_AssignCause-2010-09-07_13-50-08>

In the example, the maintenance instruction with identifier "Crane 4711 Limit switch tripped" is 
assigned to the WinCC message with number 1 from "STSCrane" equipment type.

A.2.9 References
Table name: CMS_REF_TBL_References

Table A-10 References

XML tag Meaning Format Mandatory 
field

ReferenceName Reference identifier Text yes
ReferenceTypeName Type of reference Text yes
EquipmentName Identifier of the equipment type to which the crane 

is assigned
Text yes

ReferencePath Path for accessing the reference Text no
MacroList List of macros used, separated by tabs Text no
Comment Optional comment Text no
ProgramName Program with which the reference should be 

opened
Text yes

Example:
<CMS_REF_TBL_References-2010-09-07_13-43-02>
 <CMS_REF_TBL_References>
  <ReferenceName> crane 4711 Motor Operating Instructions</ReferenceName>
  <ReferenceTypeName>Manuals</ReferenceTypeName>
  <ReferencePath>/A "page=%Page% %adobeFilename%</ReferencePath>
  <MacroList>%adobeFilename%        %Page%    </MacroList>
  <Comment> Notice! Big changes to XALM12</Comment>
  <ProgramName>Acrobat Reader</ProgramName>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_REF_TBL_References>
</CMS_REF_TBL_References-2010-09-07_13-43-02>
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A.2.10 Assignment of references
Table name: CMS_MSG_TBL_AssignReference

Table A-11 Assignment of references

XML tag Meaning Format Mandatory 
field

EquipmentName Identifier of the equipment type to which the 
crane is assigned

Text yes

Reference Identifier of the assigned reference Text yes
Type Object type to which the reference is assigned 

(Equipment, Node, Message)
Selection yes

Source Name of the object to which the reference is as‐
signed (name of crane or name of equipment 
type or message number)

Text yes

ParameterList List of macros and macro values used, separa‐
ted by tabs Format: macro name <tab> macro 
value <tab>, etc.

Text no

Multiple items of information must be linked when references are assigned. Firstly, the 
reference must be uniquely identifiable. This is achieved by specifying the reference identifier. 
Secondly, the object to which the reference must be assigned must be exactly specified. 

If macros are used in the assignment, these macros are stored in the "ParameterList" tag along 
with the value to be substituted. The individual values are stored one after the other using the 
format <macro name> <tab> macro value <tab>, etc.

References can be assigned to the following types of object:

● An equipment type (type: Equipment)

● A message (type: Message)

● A crane (type: Node)

The type of assignment is defined by the "Type" tag. In addition to the type of assignment, the 
name of the object to which the reference is assigned is also required. This name is passed in 
the "Source" tag which contains either the name of the equipment type or of the crane.

Example:
<CMS_REF_TBL_AssignReference-2010-09-07_13-40-12>
 <CMS_REF_TBL_AssignReference>
  <EquipmentName>STSCrane</EquipmentName>
  <Reference>Crane 4711 Wind Meter Operating Instructions</Reference>
  <Type>Message</Type>
  <Source>1</Source>
  <ParameterList>=%Page% 4 %adobeFilename% wind.pdf</ParameterList>
 </CMS_REF_TBL_AssignReference>
</CMS_REF_TBL_AssignReference-2010-09-07_13-40-12>

In the example, the reference with identifier "Crane 4711 Wind Meter Operating Instructions" is 
assigned to the message with message number 1 for the "STSCrane" equipment type.
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A.2.11 Cargo handling data
Table name: CMS_OPD_TBL_MoveArchives

Table A-12 Cargo handling data

XML tag Meaning Format Mandatory 
field

ArchiveName Name of the WinCC Tag Logging archive 
in which the data are entered.

Text yes

EquipmentName Identifier of the equipment type to which 
the crane is assigned

Text yes

TagStartMoveTrigger Name of a WinCC tag, which contains the 
trigger event at the instant that the cargo 
handling operation starts.

Text no

TagStartTimestampYear Name of a WinCC tag, which contains the 
year of the start time.

Text no

TagStartTimestampMonth Name of a WinCC tag, which contains the 
month of the start time.

Text no

TagStartTimestampDay Name of a WinCC tag, which contains the 
day of the start time.

Text no

TagStartTimestampHour Name of a WinCC tag, which contains the 
hour of the start time.

Text no

TagStartTimestampMinute Name of a WinCC tag, which contains the 
minute of the start time.

Text no

TagStartTimestampSecond Name of a WinCC tag, which contains the 
second of the start time.

Text no

TagStopMoveTrigger Name of a WinCC tag, which contains the 
trigger event at the instant that the cargo 
handling operation stops.

Text yes

TagStopTimestampYear Name of a WinCC tag, which contains the 
year of the stop time.

Text no

TagStopTimestampMonth Name of a WinCC tag, which contains the 
month of the stop time.

Text no

TagStopTimestampDay Name of a WinCC tag, which contains the 
day of the stop time.

Text no

TagStopTimestampHour Name of a WinCC tag, which contains the 
hour of the stop time.

Text no

TagStopTimestampMinute Name of a WinCC tag, which contains the 
minute of the stop time.

Text no

TagStopTimestampSecond Name of a WinCC tag, which contains the 
second of the stop time.

Text no

TagDurationMove Name of a WinCC tag, which contains the 
duration of the cargo handling operation.

Text no

TimestampFromStartEvent Identifier as to whether the start time is al‐
so the archiving time. In the other case, the 
stop time is the archiving time.

true/false no

isDisabled Identifier as to whether processing is disa‐
bled

true/false no

Comment Optional comment Text no
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For cargo handing data, you must always specify an archive name, the name of the equipment 
type as well as the selection as to which time stamp should be entered into the archive. Using 
the WinCC tags for the start and stop times, you control which acquisition mode should be 
selected. 

You can either specify only the start and stop triggers, or you can specify the start and stop 
triggers as well as tags for the start and/or the stop time stamp from the control.

As a third possibility, you can just specify the stop trigger as well as the tags for the start time 
stamp and the stop time stamp.

As soon as you specify one of the time stamp components (year, month, …), then you must also 
specify all of the other components in the time stamp.

Example:
<CMS_OPD_TBL_MoveArchives-2010-09-07_10-47-15>
 <CMS_OPD_TBL_MoveArchives>
  <ArchiveName>Process Value Archive</ArchiveName>
  <TagStartMoveTrigger>MoveStart</TagStartMoveTrigger>
  <TagStartTimestampYear>MoveStartYear</TagStartTimestampYear>
  <TagStartTimestampMonth> MoveStartMonth</TagStartTimestampMonth>
  <TagStartTimestampDay> MoveStartDay</TagStartTimestampDay>
  <TagStartTimestampHour> MoveStartHour</TagStartTimestampHour>
  <TagStartTimestampMinute> MoveStartMinute</TagStartTimestampMinute>
  <TagStartTimestampSecond> MoveStartSecond</TagStartTimestampSecond>
  <TagStopMoveTrigger> MoveStop</TagStopMoveTrigger>
  <TagStopTimestampYear> MoveStopYear</TagStopTimestampYear>
  <TagStopTimestampMonth> MoveStopMonth</TagStopTimestampMonth>
  <TagStopTimestampDay> MoveStopDay</TagStopTimestampDay>
  <TagStopTimestampHour> MoveStopHour</TagStopTimestampHour>
  <TagStopTimestampMinute> MoveStopMinute</TagStopTimestampMinute>
  <TagStopTimestampSecond> MoveStopSecond</TagStopTimestampSecond>
  <TagDurationMove>MoveDuration</TagDurationMove>
  <TimestampFromStartEvent>true</TimestampFromStartEvent>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_OPD_TBL_MoveArchives>
</CMS_OPD_TBL_MoveArchives-2010-09-07_10-47-15>

In the example, the buffered cargo handling data acquisition is imported with start and stop 
trigger for the "STSCrane" equipment type.
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A.2.12 Counters
Table name: CMS_TOP_TBL_Nodes

Table A-13 Counters

XML tag Meaning Format Mandatory field
ArchiveName Name of the WinCC Tag Logging archive in which the data are 

entered
Text yes

EquipmentName Identifier of the equipment type to which the crane is assigned Text yes
AcquisitionCycle Selection of the acquisition cycle for calculating the difference. Numeric yes
FirstStartDay Parameters for the acquisition cycle; acquisition day. Numeric no
FirstStartHour Parameters for the acquisition cycle; acquisition hour. Numeric no
FirstStartMinute Parameters for the acquisition cycle; acquisition minute. Numeric no
isDisabled Identifier as to whether processing is disabled. true/false no
Comment Optional comment Text no

For the counters, you must always specify an archive name, the name of the equipment type 
as well as the acquisition cycle. 

The acquisition cycle is coded as a numeric value. You can specify the following acquisition 
cycles:

● 2: Hourly

● 3: Daily

● 4: Weekly

● 5: Monthly

Depending on the acquisition cycle you select, the following parameters apply as mandatory 
fields:

● Hourly: FirstStartMinute (0-59)

● Daily: FirstStartMinute (0-59); FirstStartHour (0-23)

● Weekly: FirstStartMinute (0-59); FirstStartHour (0-23); FirstStartDay (1-7)

● Monthly: FirstStartMinute (0-59); FirstStartHour (0-23); FirstStartDay (1-31)

Example:
<CMS_OPD_TBL_CounterArchives-2010-09-07_11-00-55>
 <CMS_OPD_TBL_CounterArchives>
  <ArchiveName> CounterHourly </ArchiveName>
  <AcquisitionCycle>2</AcquisitionCycle>
  <FirstStartMinute>0</FirstStartMinute>
  <EquipmentName>TEST</EquipmentName>
 </CMS_OPD_TBL_CounterArchives>
 <CMS_OPD_TBL_CounterArchives>
  <ArchiveName>CounterMonthly</ArchiveName>
  <AcquisitionCycle>5</AcquisitionCycle>
  <FirstStartDay>1</FirstStartDay>
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Example:
  <FirstStartHour>0</FirstStartHour>
  <FirstStartMinute>0</FirstStartMinute>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_OPD_TBL_CounterArchives>
</CMS_OPD_TBL_CounterArchives-2010-09-07_11-00-55>

In this example, two archives are imported for calculating the counter difference for the 
"STSCrane" equipment type. The first archive records the data hourly to minute 0, the second 
archive records the data monthly to the first day of the month at 00:00:00.

A.2.13 MMBF
Table name: CMS_OPD_TBL_MMBFArchives

Table A-14 MMBF

XML tag Meaning Format Mandatory field
ArchiveName Name of the WinCC Tag Logging archive in which the data are 

entered.
Text yes

EquipmentName Identifier of the equipment type to which the crane is assigned Text yes
TagMMBFTrigger Selection of the acquisition cycle for calculating the difference Text yes
TagTimestampYear Name of a WinCC tag, which contains the year of the time 

stamp
Text no

TagTimestampMonth Name of a WinCC tag, which contains the month of the time 
stamp

Text no

TagTimestampDay Name of a WinCC tag, which contains the day of the time 
stamp

Text no

TagTimestampHour Name of a WinCC tag, which contains the hour of the time 
stamp.

Text no

TagTimestampMinute Name of a WinCC tag, which contains the minute of the time 
stamp.

Text no

TagTimestampSecond Name of a WinCC tag, which contains the second of the time 
stamp.

Text no

isDisabled Identifier as to whether processing is disabled. true/false no
Comment Optional comment Text no

For the MMBF data, you must always specify an archive name, the name of the equipment type 
as well as the trigger. 

As soon as you specify one of the time stamp components (year, month, …), then you must also 
specify all of the other components in the time stamp.

Example:
<CMS_OPD_TBL_MMBFArchives-2010-09-07_11-39-49>
 <CMS_OPD_TBL_MMBFArchives>
  <ArchiveName>Process Value Archive</ArchiveName>
  <TagMMBFTrigger>MmbfTrigger</TagMMBFTrigger>
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Example:
  <TagTimestampYear> MmbfYear</TagTimestampYear>
  <TagTimestampMonth>MmbfMonth</TagTimestampMonth>
  <TagTimestampDay>MmbfDay</TagTimestampDay>
  <TagTimestampHour>MmbfHour</TagTimestampHour>
  <TagTimestampMinute>MmbfMinute</TagTimestampMinute>
  <TagTimestampSecond>MmbfSecond</TagTimestampSecond>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_OPD_TBL_MMBFArchives>
</CMS_OPD_TBL_MMBFArchives-2010-09-07_11-39-49>

In the example, an MMBF data archive is imported for the "STSCrane" equipment type. WinCC 
tags are defined to acquire the time stamp.

A.2.14 Tag list
Table name: CMS_OPD_TBL_Taglists

Table A-15 Tag list

XML tag Meaning Format Mandatory field
TagName Name of the WinCC tag to be transferred Text yes
isSystemTag True: Identifier for CMS system variable true/false no
AcquisitionCycle Selection of the acquisition cycle for the tag Numeric yes
FirstStartHour Parameters for the acquisition cycle; acquisition hour Numeric no
FirstStartMinute Parameters for the acquisition cycle; acquisition minute Numeric no
VariableTypeID ID for WinCC tag type (see table below) Numeric yes
VariableTypeLength Length of the WinCC tag Numeric yes
isSyncRTDisabled True: Selection Runtime data transfer true/false No
isSyncCSDisabled True: Selection, configuration data transfer true/false no
EquipmentName Identifier of the equipment type to which the crane is assigned Text yes

For the tag list, for each tag that you wish to transfer you must specify a tag name, the name of 
the equipment type as well as the acquisition cycle. 

The acquisition cycle is coded as a numeric value. You can specify the following acquisition 
cycles:

● 0: Every minute

● 1: Every second

● 2: Every hour

● 3: Daily

● 7: Upon change
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Depending on the acquisition cycle you select, the following parameters apply as mandatory 
fields:

● Every hour: FirstStartMinute (0-59)

● Daily: FirstStartMinute (0-59); FirstStartHour (0-23)

For each tag, the tag type is coded in the form of an ID:

Example:
<CMS_OPD_TBL_TaglistTags-2011-01-17_10-52-27>
 <CMS_OPD_TBL_TaglistTags>
  <TagName>StartAus</TagName>
  <isSystemTag>false</isSystemTag>
  <AcquisitionCycle>3</AcquisitionCycle>
  <FirstStartHour>12</FirstStartHour>
  <FirstStartMinute>0</FirstStartMinute>
  <VariableTypeID>11</VariableTypeID>
  <VariableTypeLength>0</VariableTypeLength>
  <isSyncRTDisabled>false</isSyncRTDisabled>
  <isSyncCSDisabled>false</isSyncCSDisabled>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_OPD_TBL_TaglistTags>
</CMS_OPD_TBL_TaglistTags-2011-01-17_10-52-27>

In the example, a tag is imported for the "STSCrane" equipment type. The tag is acquired daily.

A.2.15 Icons
Table name: CMS_TOP_TBL_Icons

Table A-16 Icons

XML tag Meaning Format Mandatory 
field

IconName Name of the icon Text yes
IconOk Icon for displaying the "OK" status; 16 x 16 

pixels
Base64String no

IconLargeOk Icon for displaying the "OK" status 32 x 32 
pixels

Base64String no

IconOffline Icon for displaying the "Offline" status; 16 x 
16 pixels

Base64String no

IconLargeOffline Icon for displaying the "Offline" status; 32 x 
32 pixels

Base64String no

IconFault Icon for displaying the "Fault" status; 16 x 
16 pixels

Base64String no

IconLargeFault Icon for displaying the "Fault" status; 32 x 
32 pixels

Base64String no
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XML tag Meaning Format Mandatory 
field

IconWarning Icon for displaying the "Warning" status; 16 
x 16 pixels

Base64String no

IconLargeWarning Icon for displaying the "Warning" status; 32 
x 32 pixels

Base64String no

IconStandby Icon for displaying the "Idle" status; 16 x 16 
pixels

Base64String no

IconLargeStandby Icon for displaying the "Idle" status; 32 x 32 
pixels

Base64String no

IconCMSRuntimeDown Icon for displaying that the CMS Runtime 
has not been started; 16 x 16 pixels

Base64String no

IconLargeCMSRuntime‐
Down

Icon for displaying that the CMS Runtime 
has not been started; 32 x 32 pixels

Base64String no

IconWinCCRuntime‐
Down

Icon for displaying that the WinCC Runtime 
has not been started; 16 x 16 pixels

Base64String no

IconLargeWinCCRunti‐
meDown

Icon for displaying that the WinCC Runtime 
has not been started; 32 x 32 pixels

Base64String no

IconPLCNotConnected Icon for displaying that there is no connec‐
tion to the control; 16 x 16 pixels

Base64String no

IconLargePLCNotCon‐
nected

Icon for displaying that there is no connec‐
tion to the control; 32 x 32 pixels

Base64String no

IconUndefined Icon for displaying an undefined status; 16 
x 16 pixels

Base64String no

IconLargeUndefined Icon for displaying an undefined status; 32 
x 32 pixels

Base64String no

Comment Optional comment Text no

Note

Base64 defines a method for coding 8-bit binary data (e.g. executable programs, zip files or 
screens) in a string comprising only a few codepage-neutral ASCII characters. External tools 
are available for displaying and/or generating base64-coded information. Services for the 
online coding or decoding of base64-coded information are also available on the Internet.

Example:
<CMS_TOP_TBL_Icons-2007-12-30_14-45-45>
 <CMS_TOP_TBL_Icons>
  <IconName>Crane</IconName>
  <IconOk>Qk32AAAAAAAAAHYAAAAoAAAAEAA  ...  AAAAAAAA==</IconOk>
  <IconOffline>Qk32AAAAAAAAAHYAAAAoAAAAEAA ...  AAAAAAAAAA==</IconOffline>
  <IconFault>Qk32AAAAAAAAAHYAAAAoAAAAEA   ...   BAAAAAAAAAAAAA==</IconFault>
  <IconWarning>Qk32AAAAAAAAAHYAAAAoAAA   ...   AAAAAAAAAA==</IconWarning>
  <Comment />
 </CMS_TOP_TBL_Icons>
</CMS_TOP_TBL_Icons-2007-12-30_14-45-45>
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A.2.16 Macros
Table name: CMS_REF_TBL_Macros

Table A-17 Macros

XML tag Meaning Format Mandatory 
field

MacroName Macro name Text yes
EquipmentName Identifier of the equipment type to which the 

crane is assigned
Text yes

MacroText Macro value for global macros Text no
isValueSuppliedBySystem Identifier, macro value determined by the sys‐

tem
true/false yes

isPredefined Identifier, predefined macro true/false yes
Comment Optional comment Text no

When manually adapting macros, no changes must be made to macros which have the value 
"true" in one or both of the "isPredefined" or "isValueSuppliedBySystem" identifiers. For all 
user-defined macros, the value for both these fields must always be "false".

Example:
<CMS_REF_TBL_Macros-2009-05-13_09-56-21>
 <CMS_REF_TBL_Macros>
  <MacroName>%ApplicationPath%</MacroName>
  <isValueSuppliedBySystem>true</isValueSuppliedBySystem>
  <isPredefined>true</isPredefined>
  <EquipmentName>STSCrane</EquipmentName>
 </CMS_REF_TBL_Macros>
</CMS_REF_TBL_Macros-2009-05-13_09-56-21>

A.2.17 Programs
Table name: CMS_REF_TBL_Programs

Table A-18 Programs

XML tag Meaning Format Mandatory 
field

ProgramName Name of the program as it is displayed in the se‐
lection fields

Text yes

CommandString Command to be executed Text no
MacroList List of macros used, separated by tabs Text no
Comment Optional comment Text no

Example:
<CMS_REF_TBL_Programs-2007-12-30_14-45-45>
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Example:
 <CMS_REF_TBL_Programs>
  <ProgramName>Acrobat Reader</ProgamName>
  <CommandString>%ProgramFiles%\Adobe\Reader 8.0\Reader\AcroRd32.exe</Command-

String>
  <MacroList>%ProgramFiles%</MacroList>
 </CMS_REF_TBL_Programs>
</CMS_REF_TBL_Programs-2007-12-30_14-45-45>

A.2.18 Reference types
Table name: CMS_ REF_TBL_ReferenceTypes

Table A-19 Reference types

XML tag Meaning Format Mandatory 
field

ReferenceTypeName Name of the reference type Text yes
TabOrder Sort identifier Numeric yes
EquipmentName Identifier of the equipment type to which the 

crane is assigned
Text yes

Comment Optional comment Text no

Example:
<CMS_REF_TBL_ReferenceTypes-2008-01-29_11-19-51>
 <CMS_REF_TBL_ReferenceTypes>
  <ReferenceTypeName>Manuals</ReferenceTypeName>
  <TabOrder>20</TabOrder>
  <EquipmentName>STSCrane</EquipmentName>
  <Comment />
 </CMS_REF_TBL_ReferenceTypes>
</CMS_REF_TBL_ReferenceTypes-2008-01-29_11-19-51>
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A.2.19 Languages

A.2.19.1 Transfer
The transfer export function is used, for example, to transport language-specific texts to other 
installations. This export file contains the content of several tables in the order given below:

● Table containing all dialog components or messages 
(CMS_SYS_TBL_UserTextComponents)

● Table with the language-specific content of the dialog components or messages 
(CMS_SYS_TBL_UserTexts)

Table A-20 Languages

XML tag Meaning Format Mandatory 
field

CountryRegion Unique language identifier Text yes
ShortSign Language code Text yes
LCID Windows local ID data Numeric yes
TabOrder Sorting criterion in the table of implemented lan‐

guages or sequence of tabs in the acquisition 
screens

Numeric yes

DefaultLanguage Identifier for default language True/False yes

Table A-21 Dialog components and messages

XML tag Meaning Format Mandatory 
field

ComponentName Message details ("MessageDetailRows") and 
reference types ("ReferenceTypes")

Text yes

UserText Text code for message details and reference 
types

Text yes

Comment Optional comment Text no

Table A-22 Language-specific content of dialog components or messages

XML tag Meaning Format Mandatory 
field

ComponentName Name of the dialog, data type or message group Text yes
UserName Name of the dialog component, language code 

value or message identifier
Text yes

CountryRegion Unique language identifier Text yes
Text Language-specific text Text yes
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Example:
<UserTextsTransfer>
 <CMS_SYS_TBL_ImplementedLanguages>
  <CountryRegion>German - default</CountryRegion>
  <ShortSign>de</ShortSign>
  <LCID>1031</LCID>
  <TabOrder>1</TabOrder>
  <DefaultLanguage>1</DefaultLanguage>
 </CMS_SYS_TBL_ImplementedLanguages>
 <CMS_SYS_TBL_UserTextComponents>
  <ComponentName>MessageDetailRows</ComponentName>
  <UserTextName>DBEquipment</UserTextName>
 </CMS_SYS_TBL_UserTextComponents>
 <CMS_SYS_TBL_UserTextComponents>
  <ComponentName>MessageDetailRows</ComponentName>
  <UserTextName>DBNode</UserTextName>
  <Comment />
 </CMS_SYS_TBL_UserTextComponents>
 <CMS_SYS_TBL_UserTexts>
  <ComponentName>MessageDetailRows</ComponentName>
  <UserTextName>DBNode</UserTextName>
  <CountryRegion>English - United States</CountryRegion>
  <Text>Crane name</Text>
 </CMS_SYS_TBL_UserTexts>
</UserTextsTransfer>

A.2.19.2 Translation
The export file for translation of language-specific texts contains only the parameters required 
for performing a translation. While the transfer export file always contains the language-specific 
information for all implemented languages, the translation export file contains only the 
language-specific texts of one language.

Table A-23 Languages

XML tag Meaning Format Mandatory 
field

EquipmentName Identifier of the equipment type to which the 
crane is assigned

Text yes

ComponentName Name of the data type Text yes
UserTextName Internal data key Text yes
Text Language-specific text Text yes
Comment Optional comment Text no
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Example:
<LanguagesTranslation>
 <CMS_SYS_TBL_UserTexts_English-UnitedStates>
  <EquipmentName>STSCrane</EquipmentName>
  <ComponentName>MessageDetailRows</ComponentName>
  <UserTextName>DBNode</UserTextName>
  <Comment />
  <Text>Crane name</Text>
 </CMS_SYS_TBL_UserTexts_English-UnitedStates>
</LanguagesTranslation>

A.2.20 FMDB import
The XML import format is a bought-in component and is therefore completely different to the 
scheme described above. The following data are supplied for the FMDB import:

Table A-24 FMDB import

XML tag Meaning Format Mandatory 
field

IFNo WinCC fault number Text yes
InstructionText Maintenance instruction (probable cause of 

fault)
Text no

TestText Maintenance instruction (probable fault remedy) Text no
CD_Page Content for macro: Absolute page in the circuit 

diagram
Numeric no

PLC_Block Content for macro: Block in the Step 7 project Numeric no
PLC_NW Content for macro: Network in the above men‐

tioned block of the Step 7 project
Numeric no

… Content for macro: … … …

For an FMDB import, maintenance instructions are imported as well as the assignment of 
references with defined wildcards for any number of existing message numbers. A reference is 
assigned if it contains an FMDB XML tag.

You can also add any XML tags, the content of which you define existing wildcards (macros) 
when assigning a reference to the specified message number. You must have first defined the 
macro in the dialog used to define macros in the CMS Editor. Observe the following notation: 
%FMDB_TagName%

Example:
<XML-Export>
 <IFNo>1</IFNo>
 <MessageText>ET200 fault Low voltage distribution-1</MessageText>
 <InstructionText>fgngfn</InstructionText>
 <TestText>fdbgfngn</TestText>
 <CD_Page>11</CD_Page>
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Example:
 <PLC_Block>FC1001</PLC_Block>
 <PLC_NW>1</PLC_NW>
</XML-Export>
<XML-Export>
 <IFNo>2</IFNo>
 <MessageText>ET200 fault Low voltage distribution-2</MessageText>
 <InstructionText>fgngfn</InstructionText>
 <TestText>fdbgfngn</TestText>
 <CD_Page>12</CD_Page>
 <PLC_Block>FC1001</PLC_Block>
 <PLC_NW>2</PLC_NW>
</XML-Export>

In the example above, the maintenance instructions as well as the content for three wildcards 
are imported for the reference assignment for two WinCC messages.
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